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Send Us Your Comments

Oracle® Retail Warehouse Management System UI User Guide, Release 16.0.2.

Oracle welcomes customers' comments and suggestions on the quality and usefulness 
of this document.

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example:

■ Are the implementation steps correct and complete?

■ Did you understand the context of the procedures?

■ Did you find any errors in the information?

■ Does the structure of the information help you with your tasks?

■ Do you need different information or graphics? If so, where, and in what format?

■ Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell 
us your name, the name of the company who has licensed our products, the title and 
part number of the documentation and the chapter, section, and page number (if 
available).

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number 
(optional).

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services. 

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at http://www.oracle.com.

Note: Before sending us your comments, you might like to check 
that you have the latest version of the document and if any concerns 
are already addressed. To do this, access the Online Documentation 
available on the Oracle Technology Network Web site. It contains the 
most current Documentation Library plus all documents revised or 
released recently.
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Preface

The Oracle Retail Warehouse Management System UI User Guide describes the Product 
user interface. It provides step-by-step instructions to complete most tasks that can be 
performed through the user interface.

Audience
This User Guide is for users and administrators of Oracle Retail Product. This includes 
merchandisers, buyers, business analysts, and administrative personnel.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired.

Related Documents
For more information, see the following documents in the Oracle Retail Warehouse 
Management System Release 16.0.2 documentation set:

■ Oracle Retail Warehouse Management System Installation Guide

■ Oracle Retail Warehouse Management System Implementation Guide

■ Oracle Retail Warehouse Management System RF User Guide

■ Oracle Retail Warehouse Management System Online Help

■ Oracle Retail Warehouse Management System Release Notes

■ Oracle Retail Warehouse Management System Data Model
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Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

■ Product version and program/module name

■ Functional and technical description of the problem (include business impact)

■ Detailed step-by-step instructions to re-create

■ Exact error message received

■ Screen shots of each step you take

Review Patch Documentation
When you install the application for the first time, you install either a base release (for 
example, 16.0) or a later patch release (for example, 16.0.2.). If you are installing the 
base release and additional patch releases, read the documentation for all releases that 
have occurred since the base release before you begin installation. Documentation for 
patch releases can contain critical information related to the base release, as well as 
information about code changes since the base release.

Improved Process for Oracle Retail Documentation Corrections
To more quickly address critical corrections to Oracle Retail documentation content, 
Oracle Retail documentation may be republished whenever a critical correction is 
needed. For critical corrections, the republication of an Oracle Retail document may at 
times not be attached to a numbered software release; instead, the Oracle Retail 
document will simply be replaced on the Oracle Technology Network Web site, or, in 
the case of Data Models, to the applicable My Oracle Support Documentation 
container where they reside.

This process will prevent delays in making critical corrections available to customers. 
For the customer, it means that before you begin installation, you must verify that you 
have the most recent version of the Oracle Retail documentation set. Oracle Retail 
documentation is available on the Oracle Technology Network at the following URL:

http://www.oracle.com/technetwork/documentation/oracle-retail-10
0266.html

An updated version of the applicable Oracle Retail document is indicated by Oracle 
part number, as well as print date (month and year). An updated version uses the 
same part number, with a higher-numbered suffix. For example, part number 
E123456-02 is an updated version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all 
previous versions.
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Oracle Retail Documentation on the Oracle Technology Network
Oracle Retail product documentation is available on the following web site:

http://www.oracle.com/technetwork/documentation/oracle-retail-10
0266.html

(Data Model documents are not available through Oracle Technology Network. You 
can obtain them through My Oracle Support.)

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1 Overview

Oracle Retail Warehouse Management System (RWMS), part of Oracle Retail's Supply 
Chain Planning and Execution solution group, facilitates the coordinated movement of 
merchandise and information throughout the distribution process in a warehouse. 
Using sophisticated, yet flexible configuration and built-in best practices, it ensures the 
efficient utilization of resources-people, equipment, and space in your distribution 
process. This chapter includes the following topics:

■ About Oracle Retail Warehouse Management System

■ Business Process

■ Processes Managed by RWMS

■ Benefits of RWMS

■ About the User Guide

About Oracle Retail Warehouse Management System
A Warehouse Management System is a key part of the supply chain of a retail 
organization. The Warehouse Management System is used to control the movement of 
goods from Vendor through Warehouses (Distribution Centers) to Stores/Customer. 
Within the warehouse the goods flow through these core processes: Appointment 
Scheduling, Receiving (ASN, PO, Pallet Receiving, Non Specified Casepack), Transport 
(putaway/move), replenishment, picking, cycle counting, returns, and shipping.

Oracle Retail Warehouse Management System (RWMS) is the focal point of the Oracle 
Retail Enterprise, a suite of software products that manages and optimizes retail and 
consumer-direct (catalog, e-commerce) supply chains. RWMS streamlines the supply 
chain for multichannel retailers, including store, catalog, and e-commerce retailers.

Business Process
The activities in a warehouse can be logically divided into three business processes:

■ Inbound Operations: Involves Advanced Shipment Notice (ASN), Purchase Order 
(PO), Appointments, Receiving, crossdocking, flowthrough, and Customer/Stores 
Returns Management.

■ Internal Operations: Involves Transport (putaway/move), Waving Store Orders, 
Replenishment, Picking, Cycle Counting, Task Management, Labor Management, 
and Inventory Management.

■ Outbound Operations: Involves Trailer Management, Shipping and Yard 
Management (both inbound and outbound).



Processes Managed by RWMS

1-2 Oracle® Retail Warehouse Management System UI User Guide

The business process flows corresponding to these activities and supported by RWMS 
are:

■ Yard Management: The yard is the physical parking lot for all the inbound and 
outbound trailers outside of the warehouse. Yard Management is the process of 
physically and logically keeping track of these trailers and moving them as needed 
to either the inbound or outbound side of the operation. RWMS has the ability to 
log the trailer entry and exit from the yard and track its location on the yard at any 
time. In order to use Yard Management an RF network must be deployed in the 
yard.

■ Inbound Operations: This process involves the download of Purchase Orders and 
or ASN's from the host management system. Carriers call when they need an 
appointment to deliver goods. An Appointment is scheduled at an available 
receiving door and information about the inbound trailer (PO's, items, Quantity) 
are entered into RWMS. There are three main ways in which the received goods 
are transferred/moved inside a warehouse: Cross Dock, Flow Through, or 
putaway to storage. The Inbound process involves receiving merchandise, 
collection of receipts, matching of Purchase Order (PO) or ASN, reverse logistics 
that involves return of defected goods, and value added services like labeling and 
so on.

■ Internal Operations: Is the process of moving the goods to the appropriate picking 
or storage locations in the warehouse and then generating outbound waves to pick 
store/customer orders. The generation of a wave, results in both replenishment 
and pick activities at the discreet location level. Task Management (optional) can 
be utilized to increase the priority of tasks to increase overall efficiency of the 
warehouse. Labor Management (optional) can be utilized to establish Labor 
Standards for specific activities to compare allotted time to actual time for 
completion of tasks. When inventory discrepancies are discovered during 
replenishment or pick activities cycle counting is utilized to correct the imbalance.

■ Outbound Operations: Is the process of defining shipment carriers and shipment 
schedules to support store or channel deliveries. Outbound trailers are opened 
based on scheduled delivery dates and then loaded based on the waved 
merchandise requirements. Upon Trailer Shipment outbound ASN's are sent to 
both the host management system and store systems to provide them early 
visibility to inbound deliveries.

Processes Managed by RWMS
RWMS has some primary processes or tasks as listed:

■ Appointment Scheduling: Refers to the creation of a placeholder time slot at a 
receiving door and recording information about the goods to be received which 
can then be used to print receiving labels, as necessary.

■ Receiving: Refers to the task of physically bringing goods into the warehouse at 
license plate level.

Note: The processes within the warehouse are enabled and 
supported by mobile applications, barcode and Radio Frequency (RF) 
capabilities. These help in enhancing the warehouse efficiency and 
utilizing manpower effectively. To learn more about RF capabilities, 
see the Oracle Retail Warehouse Management System Radio Frequency 
User Guide.
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■ Distribution and Wave Planning: Refers to distributing merchandise present in the 
warehouse to fulfill stock orders requesting inventory at other stores/warehouses. 
When a group of a stock orders is selected and attempted to be distributed, this is 
referred to as a wave. Distribution compiles a list of all eligible inventory in the 
warehouse based on the items being waved and tries to match it up with the stock 
allocations that were selected. The distribution logic determines the quantity to be 
distributed, type of picks to be performed and in which order - based on various 
criteria.

■ Transport: Refers to the process of moving the merchandise to the proper 
processing area within the warehouse. A transport putaway is a movement from 
the receiving dock to a storage location for future waving. A transport move is a 
movement from the receiving dock to a crossdock or flowthrough area for 
immediate outbound processing.

■ Picking: Refers to the act of physically picking merchandise (by pickers) as per the 
pick instructions created during the distribution planning process before it is 
shipped out of the warehouse.

■ Replenishment: Refers to the act of adding inventory to forward case or unit pick 
locations to sustain the pick activity assigned to those locations.

■ Returns: Refers to the process of returning inappropriate or damaged merchandise 
from the warehouse to the suppliers.

■ Task Management: Refers to tracking of all activities in the facility and increasing 
the priority of specific tasks based on defined criteria.

■ Labor Management (optional): Refers to establishing Labor Standards for specific 
activities to compare allotted time to actual time for completion of tasks.

■ Shipping: Refers to the loading of outbound trailers and the tracking of these 
shipments to their final destination (store, warehouse, or customer).

Benefits of RWMS
Some of the benefits offered by Oracle Retail Warehouse Management System include:

■ Accelerate the flow of merchandise through the supply chain, reducing lead times 
and freeing up working capital.

■ Real-time inventory management and best practices provide timely, accurate data, 
resulting in increased operating efficiencies and improved forecasting, planning, 
and allocation.

■ Built-in best practices, optimization algorithms, and workload monitoring.

■ Configurable solution supports all facility types and merchandise flows, including 
cross-dock, flow-through, and pick-by-line.

■ Built-in best practices support all facets of grocery, soft-lines, hard-lines, and 
consumer direct operations.

■ Extended execution capabilities beyond the four walls to trading partners through 
support of ASN, inbound planning, appointment scheduling, and yard 
management.

■ Standard integration to high-speed material handling and sorting equipment like 
unit, case, and garment sorters as well as pick/put-to-light equipment.
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■ Commerce Anywhere enhancements facilitating integration of Oracle Retail 
applications with Customer Order Management systems for order capture and 
orchestration.

■ Best-of-breed Task Management module utilizing concepts of permission, priority, 
and proximity in conjunction to assign the most productive task to each employee 
at a specific moment in time.

■ Integrated Labor Management module utilizing Labor Elements, Labor Factors, 
Labor Conditions, and Labor Allowances to establish Labor Standards at the 
specific activity level.

About the User Guide
The UI user guide provides an overview on how to use the RWMS application. The 
user guide contains the following topics:

■ Chapter 2, "Security and Access"

■ Chapter 3, "Navigation"

■ Chapter 4, "Support Functions"

■ Chapter 5, "Appointments"

■ Chapter 6, "Receiving"

■ Chapter 7, "Distribution Planning"

■ Chapter 8, "Inventory Management"

■ Chapter 9, "Processing"

■ Chapter 10, "Task Management"

■ Chapter 11, "Outbound"

■ Chapter 12, "Returns"

■ Chapter 13, "Activity Log History"

■ Chapter 14, "Database Administration"

■ Chapter 15, "BI Reports"

■ Chapter 16, "Dashboards"

■ Chapter 17, "Mobile User Interface"
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2
Security and Access

This chapter describes the security and logon features of Oracle Retail Warehouse 
Management System (RWMS).

Security
RWMS features two security measures: passwords and privilege levels.

Passwords
A password is required to access RWMS. 

Logon standards require that you change passwords after a predefined number of 
days have passed. The system administrator sets this parameter. The password expiry 
is controlled by the following two System Control Parameters (SCP):

■ password_old: This is the number of days since the last password change; 
suggests that users change their password.

■ password_expire: This is the number of days since the last password change; 
forces users to change their passwords.

Passwords must be: 

■ unique

■ at least seven characters in length

Note: When you login to the RWMS application for the first time, 
you are asked to change your default password. Refer to Change a 
Password section for instructions.

Note: The minimum length of the password is controlled by the SCP 
min_password_length.



Security

2-2 Oracle® Retail Warehouse Management System UI User Guide

■ have a minimum of one alphabet and one numeric character

■ different from the user name

Passwords are case-sensitive.

If an invalid password is used during login, the account gets locked after a few 
attempts. The number of attempts after which an account gets locked is set by the SCP 
max_invld_login_cnt. The account can be reset by the system administrator. If the 
account of the system administrator gets locked, it can be reset using a script rwms_
reset_app_user_pwd.sh or using the User Interface. Refer to Chapter 4 for more 
information.

Change a Password
1. In the New Password field, enter a new password.

2. In the Confirm Password field, enter the new password again.

3. Select Submit to save the new password.

The application returns to the login page. Login again using the new password.

Privilege Levels
Each user is assigned a privilege level by the system administrator. Not all menu 
options and windows in RWMS are accessible to users with lower privilege levels. 
RWMS recognizes each user's privilege level and allows menu or window entry 
accordingly.

RWMS privileges are allocated through two windows: User Editor and Menu Editor.

RWMS User Editor
RWMS provides an internal User ID creation and maintenance user interface called the 
User Editor. The access to the User Editor window is limited to a few users by setting 
the user privileges level higher than the typical RWMS users.

Note: This is controlled by the SCP password_complexity. Set to

■ N for numeric only passwords.

■ A for alphabetic only passwords.

■ AN for Alphanumeric only passwords (One alphabet and one 
number mandatory).

■ ANX for Alphanumeric and any other special character based 
password (Minimum of one alphabet , one number and one 
special character(Punctuation)  mandatory).

■ X for any character based password.

ANX is the suggested and the strongest setting. Any other setting 
leaves RWMS prone to attacks.

Note: Due to RWMS 14 installation, the passwords are reset to the 
respective User IDs. Change this password to a password of your 
choice.
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To access this window, select Setup - User > User Editor.

For security purposes, this window can be used to create or update new users, set 
privilege levels, and reset passwords. The logged on user can create users with a 
privilege less than or equal to the logged on user's privilege. This means an 
administrator with privilege 9 can create other administrators, and users with 
privilege 8 can create other users with a maximum privilege of 8. 

When the reset password functionality is used on this window, the password is set to 
equal the value of the user ID and the value in the user_logdate column is removed. 
Due to this the user is able to log into the application using the user ID as the 
password at which point the user is forced to create a new password. This mechanism 
also provides the functionality of administrators being able to log into the application 
as the user, set the password as desired, and then give the password to the end user. 

Figure 2–1 User Editor

Create Record
From the menu bar, select Setup - User > User Editor. The User Editor tab opens.

1. Click the Create Record link. The Create Record window opens.

2. Enter the required details:

■ Facility

■ Name

■ User Class

■ Privilege: You can enter 9 for Super Users or Administrators with all 
privileges, 8 for users with maximum privileges but less than administrator 
privileges, and 5 for default users with minimum privileges 

■ Language

■ Default Shift

■ Task Acceptance Mode: You can select between Always, Change, or Never

■ User ID

■ Password
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Figure 2–2 Create Record

3. Click Save. The record is saved and displayed in the User Editor table.

Delete a Record
To delete a record, click the Delete Record link. A confirmation alert appears. Click 
Yes to delete the record.

Figure 2–3 Delete a Record - Confirm Alert

The following editors in the Setup User module are used in the configuration of Task 
Management but are not needed for system access: 

■ User Activity Group Editor

■ User Attribute Editor

■ User Class Editor

■ User Equipment Class Editor

■ User Message Editor

For more information on these editors, refer to Chapter 4.
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Menu Editor
RWMS also restricts the number of menu options that should be available to users 
based on the user privileges. The configuration of the user privilege setting is based on 
business needs to determine which users should be able to perform certain activities in 
a distribution center. The general recommendation for the menu privilege settings is 
that the administrative windows for setting up the DC would be set higher than the 
windows used during day-to-day operations. The user privileges are configured 
through the Menu Editor window to determine what menu options should be 
available to a user.

To navigate to the Menu Editor window, select Setup - Administration Setup > Menu 
Editor. The menu options appear in the Menu Editor form.

Display Menu 
1. If any menu options are currently displayed, click Clear.

2. Click Query. An LOV button displays next to the Code and Menu Title fields 
respectively.

3. In the Code field, enter the code for the language, or click the LOV button and 
select the language.

4. In the Menu Item field, enter the menu item, or click the LOV button and select a 
menu item.

5. Click Search. The menu options associated with the selected criteria appear.

Figure 2–4 Menu Editor Window
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Edit a Translation
1. On the Menu Editor form, double-click the menu option that you want to edit. The 

Modify window opens. 

Figure 2–5 Menu Editor Window - Modify Window

2. Edit the title, its order on the menu, and its user privilege level as necessary.

3. Click Save to save any changes and close the Modify window.

Exit the Menu Editor
Click Exit to close the form.
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Navigation

This chapter describes how to navigate within Oracle Retail Warehouse Management 
System (RWMS).

Accessing RWMS
There are two ways to access RWMS. You can access RWMS by using either the:

■ RWMS Application Login

■ ADF Application Login 

RWMS Application Login
You can log into the RWMS application using the Oracle Forms window. The initial 
login takes you to the menu bar from where you will have access to Forms, Reports 
and Dashboards.

When you access the application, the User Logon window opens. 

Figure 3–1 RWMS Application: User Logon Window

1. In the User Logon window, enter the User ID in the Username field.

Note: Compatibility View must not be used when you access RWMS 
using Internet Explorer 11.
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2. Enter the password in the Password field. 

3. After entering the user ID and password, go to the Facility ID field. Enter the 
facility ID or select an ID from the drop-down list.

4. Click Submit. The RWMS User Interface opens.

Figure 3–2 RWMS Application: RWMS User Interface

If you enter a wrong ID, password, or facility ID, you receive an error message as 
shown in Figure 3–3.

Figure 3–3 Error Message

Note: You can use the TAB key to move to the next field. However, 
you cannot use the Enter key to move to the next field and an error 
message displays.

Note: Only one instance of a User ID must be logged into RWMS at a 
time.
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ADF Application Login
When you access the ADF application, the User Logon window opens. 

Figure 3–4 ADF Application: User Logon Window

1. In the ADF User Logon window, enter the User ID in the Username field.

2. Enter the password in the Password field. 

3. After entering the user ID and password, go to the Facility ID field. Enter the 
facility ID or select an ID from the drop-down list.

4. Click Submit. The RWMS User Interface opens.

Figure 3–5 ADF Application: RWMS User Interface

If you enter a wrong ID, password, or facility ID, you receive an error message as 
shown in Figure 3–6.

Note: You can use the TAB key to move to the next field. However, 
you cannot use the Enter key to move to the next field and an error 
message displays.

Note: Only one instance of a User ID must be logged into RWMS at a 
time.
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Figure 3–6 Error Message

Exit
To exit from the application, click the Exit icon. A Confirm Exit window opens. as 
shown in Figure 3–7. Click Yes to close RWMS.

Figure 3–7 Exit Window

RWMS User Interface
Before you begin using the Oracle RWMS user interface, familiarize yourself with the 
basic components and layout, which includes:

■ Menu Bar

■ Navigation Tree

■ Find Function

■ Favorites

Figure 3–8 shows the RWMS user interface, including its basic components and layout.
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Figure 3–8 RWMS User Interface Details

Menu Bar
The horizontal bar at the top-right corner of the window is composed of separate 
menu options:

Change Password
Displays a window where you can replace an existing password with a new one.

Figure 3–9 Change Password Window

Reports
Displays the Oracle BI Publisher Enterprise web page in a new window.
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Figure 3–10 Oracle BI Publisher Enterprise Window

Dashboard
Go to the Dashboard menu option. Click the Launch Dashboard link. If the user is 
authenticated, then RWMS redirects you to the ADF home page. Figure 3–11 and 
Figure 3–12 represents the accessible menus and submenus along with the 
functionalities through the Launch Dashboard link.

Figure 3–11 Launch Dashboard
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Figure 3–12 RWMS ADF Home Page

Figure 3–13 RWMS ADF Home Page with all Menu and Submenu Options 

Help
Displays information about the RWMS application such as copyright information, 
facility name and ID, language, user, patch number, and registry information. This 
information is segregated under three tabs: Copyright Info, General, and System 
Info. The General tab opens when you click the About link.
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Figure 3–14 About Window

Collapse Pane
A small arrow button is available in the top-right corner of the window that allows 
you to collapse or expand the application pane. When you log in to RWMS, the Menu 
bar displays. If you collapse the pane, the Menu bar is hidden. To view the Menu bar, 
click the button again to expand the pane.

Navigation Tree
The navigation tree consists of two window panes. The menu appears on the left pane 
and the submenus appear on the right pane. The right pane displays the menu options 
for the menu that is selected on the left pane. Double-click on the submenu to open the 
window.

■ Activity History Log

■ Appointments

■ DBA Administration

■ Distribution Planning

■ Inventory Management

■ Outbound

■ Processing

■ Receiving

■ Returns

■ Setup - Activity

■ Setup - Administration

■ Setup - DC

■ Setup - Equipment/Zone
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■ Setup - Item

■ Setup - Location

■ Setup - Processing/Returns

■ Setup - Transportation

■ Setup - User

■ Task Management

Find
The Find function helps you in accessing the menu for any submenu options. For 
example, suppose you type %editor in the Find Menu, all the menu options that have 
"editor" as part of the name for that user's language are displayed. The corresponding 
directory of the first option is highlighted on the left window pane. In the example 
given below, the "Appointment Trouble Codes Editor" is the first option and the 
corresponding menu - "Processing/Returns Setup" is highlighted. 

Figure 3–15 Find Menu

Favorites
You can save common tasks into your menu.

■ To add submenu options to Favorites: Select menu > submenu option and select 
the star next to it. The star changes color from gray to yellow, the submenu is 
added to Favorites and becomes part of your custom menu.

When you login to the RWMS application, a custom menu displays in alphabetical 
order under Favorites.

■ To delete a submenu from Favorites: Select menu > submenu option and clear the 
star next to it. The star changes color from yellow to gray and the submenu is 
removed from Favorites.

Note: The use of wildcard(%) is not mandatory during the search 
operation. The search string is not case-sensitive.



RWMS User Interface

3-10 Oracle® Retail Warehouse Management System UI User Guide

Figure 3–16 Favorites - Selecting a Submenu Option

Figure 3–17 Favorites - Custom Menu

Note: You can create any number of favorites as there is no limit to 
the number of favorites that you can add to your custom menu.
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Figure 3–18 Favorites - Cleared Submenu Option

Note: You can create any number of favorites as there is no limit to 
the number of favorites that you can add to your custom menu.
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Support Functions

The support function modules assist system administrators and users with high 
privilege levels in maintaining specifications for every integral part of the distribution 
center.

The modules found under the support functions umbrella are:

■ Setup - Activity 

The Activity Setup module is used to configure existing activities and to define 
indirect activities. 

■ Setup - Administration

The Administration Setup module is used to configure system level functions, 
such as facilities, menus, print queues, system parameters, translations, user 
messages, users, and working days.

■ Setup - DC

The DC Setup module is used to further define process areas within the DC. This 
includes defining aisles, regions, doors, putaway plans, put to store location 
relationships, and carton groups. 

■ Setup - Equipment/Zone

The Equipment/Zone Setup module is used to set up equipment classes, 
equipment, zones, and zone groups.

■ Setup - Item 

The Item Setup module is used to further define item warehouse characteristics to 
optimize distribution processing. It is also used to associate items to specific 
activities and locations within the DC. 

■ Setup - Labor Management

The Labor Management Module is used to define all of the components required 
to establish a Labor Standard. These components include labor elements, labor 
factors, labor conditions, labor PFD allowances, and so on.

■ Setup - Location

The Location Setup module is used to define location types, locations, and 
reference points in the DC so inventory can be tracked and processed effectively.

■ Setup - Processing/Returns

The Processing /Returns module is used to define WIP codes, attributes, and 
returns that enable value added processes.
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■ Setup - Transportation

The Transportation Setup module is used to shipping destinations, carriers, 
trailers, routes, route days, route destinations, and carrier service routes. 

■ Setup - User

The User Setup module is used to define users in RWMS, associate users to 
activity groups, and to associate users to equipment. 

Setup - Activity
The Activity Setup module is used to configure existing activities and to define 
indirect activities. This section includes the following topics:

■ Activity Attribute Editor

■ Activity Editor

■ Activity Equipment Editor

■ Activity Group Editor

■ Indirect Activity Editor

■ Indirect Task Maintenance

Activity Attribute Editor
The Activity Attribute Editor allows you to associate and view the attributes assigned 
to each activity.

To maintain activity attributes, navigate to Setup - Activity -> Activity Attribute 
Editor. The Activity Attribute Editor window opens.

Figure 4–1 Activity Attribute Editor Window

Display All Activity Attributes
Click Search.

Display a Subset of Activity Attributes
1. If any activity attributes are currently displayed, click Clear.

2. Click Query.
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3. To search for a single activity attribute, enter specific attribute in the Attribute 
field, or click the LOV button and select the attribute. To search for activity 
attributes by activity, enter the name of the activity in the Activity Name field, or 
click the LOV button and select the activity.

4. Click Search. The activity attributes that match the search criterion are displayed.

Edit an Activity Attribute
1. On the Activity Attribute Editor window, double-click the activity attribute that 

you want to edit. The Modify window opens.

Figure 4–2 Modify Window

2. Select or clear the Attribute Enabled check box as necessary.

3. Click Save to save any changes and close the Modify window.
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Assign an Attribute to an Activity
1. On the Activity Attribute Editor window, click Create Record. The Create Record 

window opens.

Figure 4–3 Create Record Window

2. In the Attribute Name field, enter the name of the activity or click the LOV button 
and select the activity.

3. In the Attribute field, enter the ID of the attribute you want to associate with the 
current activity, or click the LOV button and select the attribute.

4. To make the activity attribute available to users, select the Attribute Enabled check 
box.

5. Click Save to save the changes and close the Create Record window.

Delete an Activity Attribute
1. On the Activity Attribute Editor window, select the attribute that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Activity Attribute Editor Window
Click Exit to close the window.
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Activity Editor
The Activity Editor contains all of the core activities that are supported by RWMS. An 
activity is defined as any task that requires both physical and logical action. It allows 
you to see if the activity is task management enabled, and if yes, set the priority of the 
task and the priority threshold. It also allows you to turn on Labor Management for 
supported Activities as long as the System Parameter Enable Labor Management is set 
to Y.

Activities are classified as:

■ Basic Activity: A basic activity is an activity that can only be performed one way 
with no variations.

■ Basic Extended Activity: Basic extended activities are those activities where RWMS 
provides variations on how to perform the activity such as radio frequency versus 
paper, system generated label versus generic labels, and so on.

All Radio Frequency windows in the application and a limited number of GUI 
windows are defined as unique activities. The following is the limited list of GUI 
windows defined as activities:

■ Apply WIP Code

■ Confirm Paper Pick to Belt

■ Confirm Paper Pick to Pallet

■ Confirm Paper Unit Pick

■ Container Checking

■ Electronic Return Processing

■ Inventory Edit by Container

■ Order Consolidation

■ Packing

■ Paper Return Processing

■ Quality Assurance

■ Resolve Trouble

■ Ticketing

The Activity Editor window is used to capture and store all data interactions for the 
activities listed in this editor. For example, when a Bulk Pick is performed, the 
following details are captured: Entry into window, Location ID, Container ID, 
Quantity, Done key and Exit key.

Note: User activities are created by user based on Basic Activities 
and they were designed for use with ON-DEMAND printing and so 
defining priority rules on user activities does not apply.
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To maintain activities, navigate to Setup - Activity -> Activity Editor. The Activity 
Editor window opens.

Figure 4–4 Activity Editor

Display All Activities
Click Search.

Display an Activity
1. If any Activity Codes are currently displayed, click Clear.

2. Click Query.

3. To search for an Activity Code, enter the activity code in the Activity Code field, or 
click the LOV button and select the activity code. 

4. Click Search. The basic activities along with the extended activities and user 
activities that match the search criterion are displayed.

Note: To view the user activities associated to the selected basic 
activity, select the User Activities option.
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Edit an Activity
1. On the Activity Editor window, double-click the activity code that you want to 

edit. The Modify window opens.

Figure 4–5 Modify Window

2. The following fields are pre-populated and you cannot edit them:

■ Activity Code: is the name of the RWMS supported activity.

■ Description: is the long description for the activity.

■ Basic Activity Code: the only time this does not match the activity code field is 
when you copy an existing activity and create a user defined activity. The new 
activity code performs the exact same functions as the original activity code.

■ Functional Area: identifies the type of process (receiving, transport, picking, 
replenishment, cycle count, shipping) where the activity is actually performed.

■ Copy Allowed: this flag is enabled when the user is allowed to copy an 
existing activity to create a new user activity.

■ Task Creation: this flag indicates that this activity appears on the Task 
Command Queue.

■ Task Dispatch: this flag indicates that the task appears in the RF Task 
Administration window and allow for interleaving with the use of an activity 
group.

■ Labor Mgmt Available: this flag indicates if Labor Management is supported 
within the application for this activity. If selected this activity can calculate 
Labor Standards. (This flag is not editable by the user).



Setup - Activity

4-8 Oracle® Retail Warehouse Management System UI User Guide

■ Default Labor Code: this is the Labor Code currently marked as default from 
the Labor Template Editor. (This code viewable only and is not editable).

■ Presentation Type: this indicates how the activity can be performed (RF, GUI, 
Paper).

■ Transaction Timing: this indicates when the activity is generated (real time or 
post).

■ On Hold: this flag indicates whether a replenishment activity can be placed on 
hold until the location reaches it reorder point. This field is selected if the On 
Hold functionality is supported for the specific activity and blank if not 
supported.

3. Labor Management Enabled check box allows you to enable this specific activity 
for Labor Standards creation. This field can only be updated when Labor 
Management Available is selected.

4. The Display Labor Prediction check box allows you to see the Predicted Labor 
Standard on the RF screens for those activities that are Labor Management 
Enabled. The Labor Standard Prediction does not appear if enable_labor_mgmt 
is set off at the SCP level or the Labor Mgmt Enabled is set off at the activity level.

5. Max Inactive Time is the amount of time a user can go inactive on the RF session 
before RWMS asks “What is your current location”. This is used by Labor 
Management for travel calculations. This field can only be updated when Labor 
Management Available is selected.

6. Select the On Demand check box to print labels on demand instead of printing 
them all at once. This option allows you to request a specific number of labels from 
a printer on the warehouse floor. This flag is disabled for unsupported activities 
and enabled for supported activities. The default setting for enabled activities is 
blank meaning do not print on demand.

7. The Label Configuration field is populated from the Label Configuration Editor 
and the valid values are PRINT_WITH_WAVE and PRINT_ON_DEMAND.

8. The Screen Name field displays the technical screen name and cannot be edited.

9. Set the Default Priority. This is the numeric priority (ranging from 1 to 99) 
assigned by the user to an activity when the activity is first created. This field is 
enabled for all activities supported by task management and disabled for all other 
activities.

10. Set the Priority Threshold. This is the numeric priority where proximity (distance) 
takes precedence over priority. For example, if the priority threshold is set to 4, any 
activity with a priority 1 to a priority 4 is done in priority order. That is, all priority 
1 activities done first, followed by all priority 2 activities, followed by all 3 
activities and priority 4 activities. At the point where RWMS starts performing 
activities with priority 5 or higher, RWMS looks for the activities that are closest to 
the current location of the user.

11. Check the Assign Equipment Flag as necessary. This flag is selected when the 
activity requires equipment (forklift, turret truck, cherry picker, and so on.) to 
perform the activity.

12. Click Save to save the changes and close the Modify window.

Note: An activity with Default Priority set to 1 is more important 
than an activity with Default Priority set to 99.
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Define Rules for a Supported Activity
RWMS, when installed has rules for specific activities that can be defined (turned on). 
A rule is defined as a condition that triggers an action when it occurs. You can define 
the conditions that make the rule true and the resulting priority change.

The Activity Priority Rules Editor is used to assign rules to supported task 
management activities. The rules determine when a task's default priority should be 
raised.

You assign an operator (<, >, =) to each rule. This is used to compare the rule to a value 
you define. If the rule is met, the priority of the task changes by a factor you decide on.

1. On the Activity Editor window, select an activity, click Define Rules. The Activity 
Priority Rules Editor window opens.

Figure 4–6 Activity Priority Rules Editor Window

2. Validate that correct activity code has been selected by viewing the top block.

3. In the Rule Name field, select the rule using the LOV button.

4. In the Operator field, select an operator for the rule (=, <, >). For rules that do not 
require an operator this field is disabled.

5. In the Value field, enter the value that triggers the rule.

6. In the UOM (Unit of Measure) field click the LOV button and select the desired 
UOM for this rule.

7. In the Priority Change field, enter the number to raise the priority of the task if the 
rule is met. The lower the number the higher the priority. Based on the rule 
selection, the priority change is either absolute or incremental. 

Absolute means the priority changes from its current default priority to the new 
priority. 

Incremental means the priority changes from its current default priority and gets 
reduced by the incremental number. For example, if default priority is 10 and 
incremental change is 3, the new priority is 7.

8. Click Add. The rule moves to the Assigned Rules table.

9. Click Save to save the change and close the Activity Priority Rules Editor window.
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Delete a Defined Rule
1. On the Activity Editor, move the cursor to the desired activity and click Define 

Rules to open the Activity Priority Rules Editor.

2. On the Activity Priority Rules Editor, select the check box next to the rule you 
want to delete (disable).

3. Click Remove. The rule is removed from the Assigned Rules table.

4. Click Save to save the rules and close the window.

Table 4–1 Supported Rules

Activity Code Rule Name Description

BD_REPLEN FPL_QTY_VS_ROP_2 Unit Qty vs. Re-Order Qty as a percentage. Calculation: (Unit 
Qty / Re-order Qty)*100

BD_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty, Calculation: Unit 
Qty = 0, Demand Qty>0

BD_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

BD_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

BD_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

BD_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-order Point Qty

BD_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty

BD_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

BD_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

BP_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

BR_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

BR_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

BR_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

BR_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

BR_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-Order Point Qty

BR_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty

BR_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

BR_REPLEN FPL_QTY_VS_ROP_2 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

BR_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty. Calculation: Unit 
Qty = 0, Demand Qty>0

BT_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty
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BT_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty. Calculation: Unit 
Qty = 0, Demand Qty>0

BT_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

BT_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

BT_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

BT_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

BT_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

BT_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-Order Point Qty

BT_REPLEN FPL_QTY_VS_ROP_2 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

B_PICK TRAILER_OPENED Opened Trailer

B_PICK TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

B_PICK ORDER_SHIP_DATE Ship Date for an order is within the specified time range

B_PICK ORDER_IN_STORE_DATE In Store Date for an order is within the specified time range

CD_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty. Calculation: Unit 
Qty = 0, Demand Qty>0

CD_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty

CD_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

CD_REPLEN FPL_QTY_VS_ROP_2 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

CD_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

CD_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

CD_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-Order Point Qty

CD_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

CD_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

CE_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty

CE_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-Order Point Qty

CE_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

CE_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

CE_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

Table 4–1 (Cont.) Supported Rules

Activity Code Rule Name Description
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CE_REPLEN FPL_QTY_VS_ROP_2 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

CE_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty. Calculation: Unit 
Qty = 0, Demand Qty>0

CE_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

CE_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

CF_PICK TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

CF_PICK ORDER_SHIP_DATE Ship Date for an order is within the specified time range

CF_PICK ORDER_IN_STORE_DATE In Store Date for an order is within the specified time range

CF_PICK TRAILER_OPENED Opened Trailer

CO_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

CO_REPLEN FPL_QTY_VS_ROP_2 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

CO_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

CO_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

CO_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-Order Point Qty

CO_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty

CO_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

CO_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

CO_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty. Calculation: Unit 
Qty = 0, Demand Qty>0

CP_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

CR_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

CR_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

CR_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

CR_REPLEN FPL_QTY_VS_ROP_2 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

CR_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

CR_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-Order Point Qty

CR_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

CR_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty

Table 4–1 (Cont.) Supported Rules

Activity Code Rule Name Description
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CR_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty. Calculation: Unit 
Qty = 0, Demand Qty>0

CS_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

CT_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

CT_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

CT_REPLEN FPL_QTY_VS_ROP_2 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

CT_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

CT_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty. Calculation: Unit 
Qty = 0, Demand Qty>0

CT_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-Order Point Qty

CT_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty

CT_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

CT_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

CYCLE_COUNT CYCLE_COUNT_MM_
AUDIT

Location Manually Marked for a Cycle Count - with an Audit

CYCLE_COUNT CYCLE_COUNT_MM_NO_
AUDIT

Location Manually Marked for a Cycle Count - without an 
Audit

CYCLE_COUNT TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

CYCLE_COUNT CYCLE_COUNT_SS Location selected by RWMS for a Cycle Count

C_PICK TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

C_PICK ORDER_SHIP_DATE Ship Date for an order is within the specified time range

C_PICK ORDER_IN_STORE_DATE In Store Date for an order is within the specified time range

C_PICK TRAILER_OPENED Opened Trailer

LOAD_
CONTAINER

ORDER_IN_STORE_DATE In Store Date for an order is within the specified time range

LOAD_
CONTAINER

ORDER_SHIP_DATE Ship Date for an order is within the specified time range

LOAD_
CONTAINER

TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

LOAD_
CONTAINER

TRAILER_OPENED Opened Trailer

PL_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

PL_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-Order Point Qty

PL_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty

Table 4–1 (Cont.) Supported Rules

Activity Code Rule Name Description
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PL_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

PL_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

PL_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

PL_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

PL_REPLEN FPL_QTY_VS_ROP_2 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

PL_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty. Calculation: Unit 
Qty = 0, Demand Qty>0

PR_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

PR_REPLEN FPL_QTY_VS_ROP_2 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

PR_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

PR_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

PR_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty. Calculation: Unit 
Qty = 0, Demand Qty>0

PR_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

PR_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-Order Point Qty

PR_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty

PR_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

PT_REPLEN FPL_QTY_VS_ROP_2 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

PT_REPLEN FPL_QTY_VS_ROP_1 FPL Unit Qty vs. Re-Order Qty as a percentage. Calculation: 
(Unit Qty / Re-order Qty)*100

PT_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

PT_REPLEN FPL_QTY_IS_ZERO_
WITH_DIST_QTY

FPL is Empty with pending Distributed Qty. Calculation: Unit 
Qty = 0, Demand Qty>0

PT_REPLEN FPL_QTY_IS_ZERO FPL is Empty. Calculation: Unit Qty = 0

PT_REPLEN FPL_QTY_LESS_DIST_QTY FPL Unit Qty is less than Distributed Qty. Calculation: Demand 
Qty > Unit Qty

PT_REPLEN FPL_QTY_REACH_ROP FPL Qty is less than or equal to Re-Order Point Qty

PT_REPLEN FPL_QTY_VS_CAPACITY_
1

FPL Unit Qty vs. Capacity as a percentage. Calculation: (Unit 
Qty / Capacity)*100

PT_REPLEN FPL_QTY_VS_CAPACITY_
2

FPL Unit Qty vs. Capacity specified as a percentage. 
Calculation: (Unit Qty / Capacity)*100

TRANSPORT_
MOVE

TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

Table 4–1 (Cont.) Supported Rules

Activity Code Rule Name Description
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Copy an Activity
The Copy Activity function allows you to create a User Defined Activity by copying an 
existing activity with all supported functionality. The functionality of the new User 
Defined Activity cannot be changed but it allows you to differentiate same activities 
done in different areas of the warehouse such as ambient versus freezer.

1. On the Activity Editor window, once an Activity Code is selected, click the Copy 
Activity link. The Copy Activity window opens.

TRANSPORT_
MOVE

BBD_ITEM Best Before Date Item for the item is within specified time 
interval

TRANSPORT_
MOVE

NO_INVENTORY_FPL No inventory in any of the forward picking locations (FPL) - 
Case or Unit

TRANSPORT_
MOVE

NO_INVENTORY No inventory in the facility/building

TRANSPORT_
MOVE

TRAILER_OPENED Opened Trailer

TRANSPORT_
MOVE

CID_TO_EXTERNAL_DEST Container Assigned External Destination

TRANSPORT_
MOVE

CID_TO_INTERNAL_DEST Container Assigned Internal Destination

TRANSPORT_
MOVE

NO_INVENTORY_
RESERVE

No Inventory in Reserve

TRANSPORT_
PUTAWAY

NO_INVENTORY_FPL No inventory in any of the forward picking locations (FPL) - 
Case or Unit

TRANSPORT_
PUTAWAY

NO_INVENTORY_
RESERVE

No Inventory in Reserve

TRANSPORT_
PUTAWAY

NO_INVENTORY No inventory in the facility/building

TRANSPORT_
PUTAWAY

TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

TRANSPORT_
PUTAWAY

TRAILER_OPENED Opened Trailer

TRANSPORT_
PUTAWAY

BBD_ITEM Best Before Date Item for the item is within specified time 
interval

UP_REPLEN TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

U_PICK TASK_AGE Elevate the priority of aging tasks after a specified time interval 
incrementally

U_PICK ORDER_IN_STORE_DATE In Store Date for an order is within the specified time range

U_PICK ORDER_SHIP_DATE Ship Date for an order is within the specified time range

U_PICK TRAILER_OPENED Opened Trailer

Table 4–1 (Cont.) Supported Rules

Activity Code Rule Name Description
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Figure 4–7 Copy Activity Window

2. On the Copy Activity window, select the activity in the From Activity field using 
the LOV button. The From Activity Description field is automatically populated 
based on the activity selected.

3. In the To Activity field, enter the name of the new User Activity being created.

4. In the To Activity Description field enter the user description for this activity.

5. Click OK to save the changes and close the Copy Activity window.

Delete a User Activity
1. On the Activity Editor window, select the User Activity option in second block 

and then highlight the activity that you want to delete.

2. Once you select a User Activity, the Delete User Activity link is enabled. Click 
Delete User Activity.

3. When prompted to delete the record, click Yes.

Exit the Activity Editor Window
Click Exit to close the window.

Activity Equipment Editor
The Activity Equipment Editor allows you to associate one or more equipment classes 
to an activity. RWMS requires that one Equipment Class be designated as primary.

To access the Activity Equipment Editor window, navigate to Setup - Activity -> 
Activity Equipment Editor. The Activity Equipment Editor window opens.

Figure 4–8 Activity Equipment Editor Window
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Display All Activity Equipment Assignments
Click Search.

Display a Subset of Activity Equipment Assignments
1. Click Query.

2. To search for activity equipment by activity, enter the name of the activity in the 
Activity Code field, or click the LOV button and select the activity.

3. Click Search. The activity equipment assignments that match the search criterion 
appear.

Edit an Activity Equipment Assignment
1. On the Activity Equipment Editor window, double-click the assignment that you 

want to edit. The Modify window opens.

Figure 4–9 Modify Window

2. To add an Equipment Class to an Activity, in the Available panel select the check 
boxes next to the Equipment Class and then click Assign to move them to the 
Assigned panel.

3. To remove an Equipment Class from an Activity, on the Assigned panel, select the 
check boxes next to the Equipment Class and then click Unassign to move them in 
the Available panel.

4. Click Save to save any changes and close the Modify window.
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Add an Activity Equipment Assignment
1. On the Activity Equipment Editor window, click Create Record. The Create 

Record window opens.

Figure 4–10 Create Record Window

2. In the Activity Code field, enter the code for the activity, or click the LOV button 
and select the activity. When the Activity Code is selected RWMS automatically 
displays the Activity Code Description and the Available Equipment Classes with 
their descriptions.

3. To add an Equipment Class to an Activity, in the Available panel select the check 
boxes next to the Equipment Class and then click Assign to move them to the 
Assigned panel.

4. To remove an Equipment Class from an Activity, on the Assigned panel, select the 
check boxes next to the Equipment Class and then click Unassign to move them to 
the Available panel.

5. Click Save to save the changes and close the Create Record window.

Delete an Assignment
1. On the Activity Equipment Editor window, select the assignment that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Activity Equipment Editor Window
Click Exit to close the window.
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Activity Group Editor
An Activity Group is a group of one or more defined activities which are given a 
group name. One activity can make up an entire group. The same activity can exist in 
multiple groups.

The Activity Group Editor allows you to group individual activities to allow activity 
interleaving. 

The Zone Control Editor, which is accessible through the Activity Group Editor, allows 
you to define home zones for each activity in the group. If zone control is not defined, 
the activities with lowest priority and nearest proximity order are assigned to those 
users with permission to perform the activity across all available zones. If zone control 
is defined, the outstanding activities in the zone are sequenced according to the 
priority before assigning them to the users. 

Activity groups and zone control do not determine the priority for an activity. The 
assignment of zone control to an activity in an activity group limits where the user 
assigned to that activity group can perform the activity.

To access the Activity Group Editor window, navigate to Setup - Activity -> Activity 
Group Editor. The Activity Group Editor window opens.

Figure 4–11 Activity Group Editor Window

Display All Activity Groups
Click Search.

Display an Activity Group
1. If any activity group is currently displayed, click Clear.

2. Click Query.

3. In the Activity Group field, enter the code for the activity group, or click the LOV 
button and select the activity group.
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4. Click Search. The activities associated with the selected activity group appear in 
the Activity Group table. The activity codes associated with an activity group 
appear in the Activity Code table.

Edit an Activity Group

1. On the Activity Group Editor window, double-click the activity group record that 
you want to edit. The Modify window opens.

Figure 4–12 Modify Window

2. Edit the Description field as necessary.

3. To assign new activities to the activity group, select the activities from the 
Available Activities table using the check box and move them to Assigned 
Activities table by clicking Assign.

4. To remove the activities from the Assigned Activities table, select the activities 
using the check box and remove them by clicking Unassign.

5. Click Save to save any changes and close the Modify window.

Note: You can also edit the activities in an activity group using the 
Assign Activities link in the Activity Group Editor window.
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Add an Activity Group
1. On the Activity Group Editor window, click Create Group. The Create Group 

window opens.

Figure 4–13 Create Group Window

2. In the Activity Group field, enter the code for a new activity group.

3. In the Description field, enter the description of the task group.

4. Select the Active check box to make the group active.

5. To assign activities to the activity group, select the activities from the Available 
Activities table using the check box and move them to Assigned Activities table 
using the Assign button.

6. To remove the activities from the Assigned Activities table, select the activities by 
selecting their check box and remove them by clicking Unassign.

7. Click Save to save the changes and close the Create Record window.

Add Zone Control to an Activity

1. On the Activity Group Editor window, select the activity for which zones must be 
assigned.

2. Click Add Zone Control link. The Zone Control Editor window opens.

Note: To access the Zone Control Editor window, you can also 
double-click the Activity Code displayed for the selected Activity 
Group.
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Figure 4–14 Zone Control Editor Window

3. On the Zone Control Editor window, select the activity from the Available 
Activities table by selecting their check box and then move it to Activity table by 
clicking Assign.

4. Select the Source Zone and Destination Zone for the activity using the LOV 
buttons.

5. Click Save to save the changes and then click Exit to close the Zone Control Editor 
window.

Delete an Activity from an Activity Group
1. On the Activity Group Editor window, for an Activity Group, select the activity 

that you want to delete from the Activity Code table.

2. Click Delete Activity.

3. When prompted to delete the record, click Yes.

Delete an Activity Group
1. On the Activity Group Editor window, select the activity group record that you 

want to delete from the Activity Group table.

2. Click Delete Group.

3. When prompted to delete the record, click Yes.

Exit the Activity Group Editor Window
Click Exit to close the window.
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Indirect Activity Editor
The Indirect Activity Editor allows you to define activities that are not normally 
tracked by the application. These Indirect Activities are normally performed by users 
without the use of a GUI or RF window, for example: sweeping, facility maintenance, 
housekeeping, lunch, breaks. Once these Indirect Activities are defined, the application 
provides additional windows to capture the User ID, Start Time, and End Time for 
each Indirect Activity so the actual time spent on these activities can be reported.

To access the Indirect Activity Editor, navigate to Setup - Activity -> Indirect Activity 
Editor. The Indirect Activity Editor window opens.

Figure 4–15 Indirect Activity Editor Window

Display All Indirect Activities
Click Search.

Display a Subset of Indirect Activities
1. If any indirect activity is currently displayed, click Clear.

2. Click Query.

3. In the Indirect Activity field, enter the name of the indirect activity, or click the 
LOV button and select the indirect activity.

4. Click Search. The indirect activities matching the selection criterion are displayed.
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Edit an Indirect Activity
1. On the Indirect Activity Editor window, double-click the indirect activity you 

want to edit. The Modify window opens.

Figure 4–16 Modify Window

2. Modify the Description as needed.

3. Modify the Instructions as needed.

4. Check the Auto Approve flag as needed.

5. Click Save to save any changes and close the Modify window.
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Create an Indirect Activity
1. On the Indirect Activity Editor window, click Create Record. The Create Record 

window opens.

Figure 4–17 Create Record Window

2. In the Indirect Activity field, enter a name for the indirect activity.

3. In the Description field, enter the long description for the indirect activity.

4. In the Instructions field, enter the user instructions on how to perform the indirect 
activity.

5. In the Auto Approve field, check the flag if the indirect activity is approved 
without manager approval. If this indirect activity requires manager approval 
leave this flag clear. The Auto Approve flag is clear by default.

6. Click Save to save the changes and close the Create Record window.

Delete an Indirect Activity
1. On the Indirect Activity Editor window, select the indirect activity you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Indirect Activity Editor Window
Click Exit to close the window.

Note: The indirect activities can be approved by the manager using 
the Indirect Task Maintenance window.
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Indirect Task Maintenance
The Indirect Task Maintenance window allows you to assign a defined indirect activity 
to a user ID and indicate a start and stop time. A manager or a supervisor can assign a 
specific user to an indirect activity and indicate a start time.

You can view the indirect activities assigned to your user ID. The actual start and end 
time for that activity can then be entered. The activity can be started before or after the 
suggested start time.

The Indirect Task Maintenance window works for two different security levels. For 
employees, the Approved Flag column is disabled. For managers and supervisors, the 
Approved Flag column is enabled. The manager/supervisor can modify the start time, 
stop time, and Approved Flag check box. When approved, the activity is written to the 
Activity History file and then deleted from this editor.

To access the Indirect Task Maintenance Editor window, navigate to Setup - Activity -> 
Indirect Task Maintenance. The Indirect Task Maintenance Editor window opens.

Figure 4–18 Indirect Task Maintenance Window

Display an Indirect Activity Assignment
1. If any indirect activity is currently displayed, click Clear.

2. Click Query.

3. To search by indirect activity, enter the indirect activity name in the Indirect 
Activity field, or click the LOV button and select an indirect activity.

4. To search by user ID, enter the user ID in the User ID field, or click the LOV button 
and select a User ID.

5. Click Search.

Note: Any RF indirect activity started also displays on the Indirect 
Task Maintenance window and can be finished (by entering the stop 
time).

Note: An employee can update/create/delete only his own record. 
Managers/Supervisors can update records for all users till the indirect 
activities are approved.
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6. The user IDs and the assigned indirect activities that match the selection criterion 
are displayed.

Modify an Indirect Activity Assignment
1. On the Indirect Task Maintenance window, double-click the record you want to 

modify. The Modify window opens

Figure 4–19 Modify Window

2. Change the enabled fields as necessary.

3. Click Save to save the changes and close the Modify window.

Note: A record can be updated/modified till it is approved.
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Create an Indirect Activity Assignment
1. On the Indirect Task Maintenance window, click Create Record. The Create 

Record window opens.

Figure 4–20 Create Record Window

2. In the User ID field, enter the user ID, or click the LOV button and select the user 
ID.

3. In the Indirect Activity field, enter the name of the indirect activity, or click the 
LOV and select the indirect activity.

4. Enter the values in the Suggested Start Time, Suggested End Time, Comment 
fields.

5. Click Save to save the changes and close the Create Record window.

Approve an Indirect Activity

1. On the Indirect Task Maintenance window, select the check box for a record or 
multiple records and click Approve.

Note: The dates in the Suggested Start Time and Suggested End 
Time fields must be future dates.

Note:

■ You can approve an indirect activity only if a record is updated 
with Actual Start Time and Actual End Time, and the Approve 
link is enabled. The Actual Start Time and Actual End Time dates 
must be past dates or the current system date.

■ Only managers and supervisors can approve a record.
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2. To approve all the records, click Approve All.

Delete an Indirect Activity Assignment
1. On the Indirect Task Maintenance window, select the record you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Indirect Task Maintenance Window
Click Exit to close the window.

Setup - Administration
The Setup - Administration is used to configure system level functions, such as 
facilities, menus, print queues, system parameters, translations, user messages, users, 
and working days.

This section includes the following topics:

■ Administration Setup Overview

■ Code Translator Editor

■ Currency Editor

■ Disposition Code Editor

■ Facility Copy Editor

■ Facility Setup Editor

■ Inventory Adjustment Reason Code Editor

■ Inventory Disposition Editor

■ Label Configuration Editor

■ Menu Editor

■ Print Queue Editor

■ RF Function Key Inquiry

■ Stock Order Upload Code Editor

■ Supported Language Editor

■ System Parameters Editor

■ TCP Device Editor

■ Table Field Ownership Editor

■ Ticket Type Editor

■ Transaction Code Editor

■ Translation Editor

■ UOM Class Editor

■ UOM Conversion Editor

Note: Approve All option approves only those records which are 
ready for approval. The other records are skipped.
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■ Working Days Editor

Administration Setup Overview
System administration tasks are performed by system administrators or users with a 
high privilege level.

Business Process
The administration setup module allows you to set up parameters that affect the entire 
system. You can set up the following:

■ System parameters: Determine which features should be operational and enter the 
default settings for various areas of RWMS.

■ Facilities: Create or copy the environments in which users must work.

■ Translations: Identify the supported languages. Translate menu options, field 
labels, and user messages.

■ Currencies and tickets: Identify and set up the format for currencies. Identify the 
ticket types, their printer queues, and default print quantities.

■ Codes: Translate inventory disposition codes, stock order upload codes, and 
transaction codes in order to make them compatible with host systems.

■ Printers and reports: Identify the types of output devices that are available to 
RWMS. Set default parameters for generating reports.

■ Work days: Identify the work days, non-work days, and hours of operation for the 
distribution center.

■ Process configurations: Identify how processes may be presented to users. Set up 
label configurations which may be assigned to processes presented as Label. 
Review the function keys found on RF windows.

Code Translator Editor
The Code Translator Editor allows you to associate a long description for RWMS 
defined codes. These codes are defined while coding RWMS and users cannot add or 
delete these codes.

To access the Code Translator Editor, navigate to Setup - Administration -> Code 
Translator Editor. The Code Translator Editor window opens.

Figure 4–21 Code Translator Editor
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Display the Code Type
1. On the Code Translator window, enter the Language Code. 

2. Enter the Code Type and Code.

3. The Code Type, Code, Description, and Extended Description are displayed.

Exit Code Translator Window
Click Exit to close the window.

Currency Editor
The Currency Editor allows you to add, modify, and delete currency codes in RWMS. 
RWMS provides the ability to format each currency. Currency information is used 
when prices are printed on tickets.

To access the Currency Editor, navigate to Setup - Administration -> Currency Editor. 
The current currency codes appear in the Currency Editor window.

Figure 4–22 Currency Editor Window

Edit a Currency Code
1. On the Currency Editor window, double-click the currency that you want to edit. 

The Modify window opens.

Figure 4–23 Modify Window

2. Edit the description and formatting instructions as necessary.

3. Click Save to save the changes and close the Modify window.
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Add a Currency Code
1. On the Currency Editor window, click Create Record. The Create Record window 

opens.

Figure 4–24 Create Record Window

2. In the Currency Code and Description fields, enter the code and description for 
the currency.

3. In the Decimal Places field, enter the number of decimal places used in the 
currency. The number may 0, 1, or 2.

4. In the Symbol field, enter the symbol used for the currency. (For example: $ for US 
dollars.)

5. In the Sequence field, enter a number that represents where the currency code is 
printed on tickets.

6. In the Before or After field, enter B (before) or A (after) to indicate whether the 
symbol should appear before or after monetary amounts.

7. Click Save to save the changes and close the Create Record window.

Delete a Currency Code
1. On the Currency Editor window, select the currency code that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Currency Editor Window
Click Exit to close the window.
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Disposition Code Editor
The Disposition Editor allows you to add, modify, and delete inventory disposition 
codes used for returns. These codes are user definable but must be synchronized with 
your host management system and/or Order Orchestration System. Disposition codes 
indicate what is to be done with merchandise that is returned by the customer.

To access the Disposition Code Editor, navigate to Setup - Administration -> 
Disposition Code Editor. The current disposition codes appear in the Disposition 
Editor window.

Figure 4–25 Disposition Code Editor Window

Edit a Disposition Code
1. On the Disposition Code Editor window, double-click the disposition code that 

you want to edit. The Modify window opens.

Figure 4–26 Modify Window

2. Edit the description and container status as necessary.

3. Click Save to save any changes and close the Modify window.
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Add a Disposition Code
1. On the Disposition Code Editor window, click Create Record. The Create Record 

window opens.

Figure 4–27 Create Record Window

2. In the Disposition Code and Description fields, enter a code and description for 
the disposition.

3. In the Cont Status field, enter the status of containers associated with the 
disposition code. The status may be I (Inventory) or N (Nonsaleable).

4. Click Save to save the changes and close the Create Record window.

Delete a Disposition Code
1. On the Disposition Editor window, select the disposition code that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Disposition Editor Window
Click Exit to close the window.
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Facility Copy Editor
The Facility Copy Editor allows you to copy a facility and create a new facility in 
RWMS. When you copy a facility, you copy the data from an existing facility. You 
cannot delete the facilities that were installed with RWMS. You can, however, delete 
facilities that were added by users provided that the Delete Allowed option was 
selected for the facility upon setup.

To access the Facility Copy Editor, navigate to Setup - Administration -> Facility Copy 
Editor. The current facilities appear in the Facility Copy Editor window.

Figure 4–28 Facility Copy Editor Window

Edit a Facility
1. On the Facility Copy Editor window, double-click the facility that you want to 

edit. The Modify window opens.

Figure 4–29 Modify Window

2. Edit the description as necessary.

3. Click Save to save the change and close the Modify window.

Add a Facility

1. On the Facility Copy Editor window, click Copy Record. The Copy Record 
window opens.

Note: At least one facility must already be set up in RWMS, as new 
facilities are copied from an existing facility.
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Figure 4–30 Copy Record Window

2. In the From Facility field, enter the ID of the facility to be copied.

3. In the Facility and Description fields, enter the ID and name of the new facility.

4. In the Delete Allowed field, enter Y (Yes) if the facility may be deleted. Otherwise, 
enter N (No).

5. Click Save to save the changes and close the Copy Record window.

Delete a Facility
1. On the Facility Copy Editor window, select the facility that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Facility Copy Editor Window
Click Exit to close the window.

Facility Setup Editor
The Facility Setup Editor window allows you to create and maintain facilities. You can 
edit the following parameters for a facility: type, country, or labeled reserve attributes. 
It is recommended that three facilities be set up in RWMS: Production (PR), Testing 
(TS), and Training (TR). The Production facility is pre-installed in RWMS and cannot 
be deleted. The user chooses the appropriate facility when logging on to RWMS. Any 
changes they make to RWMS are applied to the selected facility only.

To access the Facility Setup Editor, navigate to Setup - Administration -> Facility Setup 
Editor. The current facilities appear in the Facility Setup Editor window.

Figure 4–31 Facility Setup Editor Window
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Edit a Facility
1. On the Facility Setup Editor window, double-click the facility that you want to 

edit. The Modify window opens.

Figure 4–32 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Facility
1. On the Facility Setup Editor window, click Create Record. The Create Record 

window opens.

Figure 4–33 Create Record Window

2. In the Facility field, enter the ID of the facility.

3. In the Facility Type field, enter the code for the type of facility.

4. In the Dest field, enter the destination ID of the distribution center, or click the 
LOV button and select the destination.

5. In the Description field, enter a description of the facility.

6. In the Oracle SID field, enter the Oracle system ID of the facility.

7. In the Country Code field, enter the code for the country in which the facility is 
located, or click the LOV button and select the country.
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8. In the Allow Opposite Labeled Reserve field, enter Y (Yes) or N (No) to indicate 
whether the facility accepts shipments from a facility that uses opposite labeled 
reserve.

9. In the Labeled Reserve field, enter Y (Yes) or N (No) to indicate whether the 
facility uses labeled reserve functionality.

10. Click Save to save the changes and close the Create Record window.

Delete a Facility
1. On the Facility Setup Editor window, select the facility that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Facility Setup Editor Window
Click Exit to close the window.

Inventory Adjustment Reason Code Editor
The Inventory Adjustment Reason Code Editor allows you to associate user-defined 
reason codes with reason codes defined in RWMS. Inventory Adjustment Reason 
codes are codes that provide a description as to why the adjustment is being made.

The user defined reason codes must synchronize with the reason codes on the host 
system.

To access the Inventory Adjustment Reason Code Editor, navigate to Setup - 
Administration -> Inventory Adjustment Reason Code Editor. The current reason 
codes appear in the Inventory Adjustment Reason Code Editor window.

Figure 4–34 Inventory Adjustment Reason Code Editor Window
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Edit a Reason Code
1. On the Inventory Adjustment Reason Code Editor window, double-click the 

reason code that you want to edit. The Modify window opens.

Figure 4–35 Modify Window

2. Edit the Description and Display Ind as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Reason Code
1. On the Inventory Adjustment Reason Code Editor window, click Create Record. 

The Create Record window opens.

Figure 4–36 Create Record Window

2. In the Reason Code field, enter a reason code that you want to translate, or click 
the LOV button and select the reason code.

3. In the User Reason Code and Description fields, enter a user-defined code and 
description for the reason.

4. To allow users to view the reason code in List of Values windows, select the 
Display Ind check box.

5. Click Save to save the changes and close the Create Record window.

Delete a Reason Code
1. On the Inventory Adjustment Reason Code Editor window, select the reason code 

that you want to delete.

2. Click Delete Record.
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3. When prompted to delete the record, click Yes.

Exit the Inventory Adjustment Reason Code Editor Window
Click Exit to close the window.

Inventory Disposition Editor
The Inventory Disposition Editor allows you to associate external (host system) 
inventory disposition codes with disposition codes provided by RWMS. In addition to 
translating the RWMS system code, you can indicate whether a message should be 
transmitted in order to notify the host system of the change.

To access the Inventory Disposition Editor, navigate to Setup - Administration -> 
Inventory Disposition Editor. The current codes appear in the Inventory Disposition 
Editor window.

Figure 4–37 Inventory Disposition Editor Window

Edit a Disposition Code
1. On the Inventory Disposition Editor window, double-click the code that you want 

to edit. The Modify window opens.

Figure 4–38 Modify Window

2. Edit the External Inv Disposition field as necessary.

3. To indicate that a message should be sent to the host system, select the OK to 
Transfer Message check box.

4. Click Save to save any changes and close the Modify window.
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Exit the Inventory Disposition Editor Window
Click Exit to close the window.

Label Configuration Editor
The Label Configuration Editor allows you to maintain a list of label configurations. A 
label configuration provides RWMS with the instructions needed to print the correct 
label type to the desired printer.

To access the Label Configuration Editor, navigate to Setup - Administration > Label 
Configuration Editor. The Label Configuration Editor window opens.

Figure 4–39 Label Configuration Editor Window

Display All Label Configurations
Click Search.

Display a Label Configuration
1. If any label configurations are currently displayed, click Clear.

2. Click Query.

3. In the Label Configuration field, enter the name of the label configuration, or click 
the LOV button and select the label configuration.

4. Click Search. The label configuration that matches the search criterion opens.

Edit a Label Configuration
1. On the Label Configuration Editor window, double-click the label configuration 

that you want to edit. The Modify window opens.

2. Edit the enabled fields as necessary.

3. Click Save to save the changes and close the Modify window.

Note: If you enter a partial name in the Label Configuration field, all 
label configurations that begin with the same characters are displayed.

Note: You cannot edit a label configuration if the system indicator is 
selected.



Setup - Administration

4-42 Oracle® Retail Warehouse Management System UI User Guide

Add a Label Configuration
1. On the Label Configuration Editor window, click Create Record. The Create 

Record window opens.

Figure 4–40 Create Record Window

2. In the Label Configuration and Description fields, enter a name and description 
for the label configuration.

3. Select Labeled Picking if necessary for the task.

4. Select GUI on Demand if you prefer that labels be printed for a GUI user only 
when requested.

5. In the GUI Print Qty field, enter the number to be printed.

6. Select RF on Demand if you prefer that labels be printed for an RF user only when 
requested.

7. In the RF Print Qty field, enter the number to be printed.

8. Click Save to save the changes and close the Create Record window.

Delete a Label Configuration
1. On the Label Configuration Editor window, select the label configuration that you 

want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Label Configuration Editor Window
Click Exit to close the window.

Note: You cannot delete a label configuration if the system indicator 
is selected.
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Menu Editor
The Menu Editor allows you to view the RWMS supported Menus and associate a user 
defined menu title, user privilege level, and the order in which this menu option 
should appear on main menu.

To access the Menu Editor, navigate to Setup - Administration -> Menu Editor. The 
menu options appear in the Menu Editor window.

Figure 4–41 Menu Editor Window

Display the Menu Options
1. If any menu options are currently displayed, click Clear.

2. Click Query.

3. In the Code field, enter the code for the language, or click the LOV button and 
select the language.

4. Click Search. The menu options associated with the selected language appear.

Note: You can also access this window from the Supported 
Language window.
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Edit a Translation
1. On the Menu Editor window, double-click the menu option that you want to edit. 

The Modify window opens.

Figure 4–42 Modify Window

2. Edit the title, its order on the menu, and its user privilege level as necessary.

3. Click Save to save any changes and close the Modify window.

Delete a Menu Option
1. On the Menu Editor window, select the menu option that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Menu Editor Window
Click Exit to close the window.

Print Queue Editor
The Print Queue Editor allows you to maintain a list of network printers to which 
reports and labels may be sent for printing.

You can enter multiple print queues, but only one file queue and one screen queue 
may be entered. Output may be directed to the following destinations:

■ Screen: Output opens on the monitor.

■ File: Output is saved to a file.

■ Printer: Output is directed to the designated printer.
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To access the Print Queue Editor window, navigate to Setup - Administration -> Print 
Queue Editor. The current print queues appear in the Print Queue Editor window.

Figure 4–43 Print Queue Editor Window

Edit a Print Queue
On the Print Queue Editor window, double-click the print queue that you want to edit. 
The Modify window opens.

Figure 4–44 Modify Window

1. Edit the type and description as necessary.

2. Click Save to save any changes and close the Modify window.
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Add a Print Queue
1. On the Print Queue Editor window, click Create Record. The Create Record 

window opens.

Figure 4–45 Create Record Window

2. In the Dest field, enter the destination. The destination may be Printer, File, or 
Screen.

3. In the Queue field, enter the name of the print queue. If the Destination is File or 
Screen, the Queue defaults to None.

4. In the Description field, enter the description of the print queue.

5. In the Location field, enter the location ID of the printer or click the LOV button to 
select a location.

6. Click Save to save the changes and close the Create Record window.

Delete a Print Queue
1. On the Print Queue Editor window, select the print queue that you want to edit.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Print Queue Editor Window
Click Exit to close the window.

RF Function Key Inquiry
The RF Function Key Inquiry allows you to view the function keys that appear on each 
screen of radio frequency (RF) devices. A screen may be composed of one or more 
sub-screens that have the same function keys.

Knowing which function keys are mandatory on RF screens becomes useful when you 
assign RF screens to a process type.
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To access the RF Function Key Inquiry window, navigate to Setup - Administration -> 
RF Function Key Inquiry. The RF Function Key Inquiry window opens.

Figure 4–46 RF Function Key Inquiry

Display All RF Screens
Click Search.

Display a Subset of RF Screens
1. If any RF screens are currently displayed, click Clear.

2. Click Query.

3. To display RF screens associated with a menu, enter the name of the menu in the 
RF Menu field, or click the LOV button and select the menu. To display a screen 
and any related sub-screens, enter the name of the RF screen in the Screen Name 
field, or click the LOV button and select the RF screen.

4. Click Search. The RF screens that match the search criteria appear.

Exit the RF Function Key Inquiry Window
Click Exit to close the window.

Stock Order Upload Code Editor
The Stock Order Upload Code Editor allows you to associate external Stock Order 
Upload Codes used by the host system to existing Codes provided by RWMS. In 
addition to translating the system code, you can indicate whether a message should be 
transmitted in order to notify the host system of the change.
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To access the Stock Order Upload Code Editor, navigate to Setup - Administration -> 
Stock Order Upload Code Editor. The current codes appear in the Stock Order Upload 
Code Editor window.

Figure 4–47 Stock Order Upload Code Editor Window

Edit a Stock Order Upload Code
1. On the Stock Order Upload Code Editor window, double-click the code that you 

want to edit. The Modify window opens.

Figure 4–48 Modify Window

2. Edit the translated upload code as necessary.

3. To indicate that a message should be sent to the host system, select the Generate 
Message check box.

4. Click Save to save any changes and close the Modify window.

Exit the Stock Order Upload Code Editor Window
Click Exit to close the window.

Supported Language Editor
The Supported Language Editor allows you to view a list of language codes supported 
by RWMS. After a language is identified, you can access the following windows in 
order to translate a variety of system elements:

■ Translation Editor: Displays the field labels used in RWMS.

■ User Message Editor: Displays the user messages found in RWMS.

■ Menu Editor: Displays the menu options used in RWMS.
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Users are able to see field labels, user messages, and menu options in the language that 
is associated with their user IDs.

To access the Supported Language Editor window, navigate to Setup - Administration 
-> Supported Language Editor. The current language codes appear in the Supported 
Language window.

Figure 4–49 Supported Language Editor Window

Edit a Language Code
1. On the Supported Language window, double-click the language code that you 

want to edit. The Modify window opens.

Figure 4–50 Modify Window

2. Edit the description as necessary.

3. Click Save to save any changes and close the Modify window.
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Add a Language Code
1. On the Supported Language window, click Create Record. The Create Record 

window opens.

Figure 4–51 Create Record

2. In the Code field, enter the standard code for the language.

3. In the Description field, enter the name of the language.

4. Click Save to save the changes and close the Create Record window.

Delete a Language Code
1. On the Supported Language window, select the language code that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Display the Menu
1. On the Supported Language window, select the language code and click Menu. 

The Menu Editor window opens.

2. The menu title in English, the corresponding title in Portuguese-Brazil, the order 
and the privilege are displayed.

Edit Menu
1. On the Menu Editor window, double click the field you want to edit. The Modify 

window opens. 

2. Edit the description as necessary.

3. Click Save to save the changes or Exit/Cancel to cancel the changes.

Translating the Data Base Value
1. On the Supported Language Editor, select the language and click Translator. The 

Translation Editor window opens.

2. The database value in English and the corresponding value in the selected 
language displays.

User Message Editor
1. On the Supported Language Editor, select the language and click User Message. 

The User Message Editor window opens.

2. Click the LOV button to choose the language and click Search.

3. The message displays in the selected language. In addition, the type of message 
displays.
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Exit the Supported Language Window
Click Exit to close the window.

System Parameters Editor
The System Parameters Editor allows you to view and modify the supported system 
parameters. System Parameters are individual value settings that change how 
processes are performed in the warehouse. Each warehouse facility must review and 
set the system parameters based on their desired process flow.

System parameters are grouped by functional area. If a parameter may be used in 
more than one functional area, it is grouped with the most affected area. You can 
choose to display system parameters by description or by functional area.

System parameters are defined when installed. You cannot add or delete a parameter. 
You can edit the current value, the functional area, and whether or not the parameter 
should be used by the system.

Only users with a high privilege level (privilege level 8 and 9) may edit system 
parameters.

To access the System Parameters Editor, navigate to Setup - Administration -> System 
Parameters Editor. The System Parameters Editor window opens.

Figure 4–52 System Parameters Editor Window

Display All System Parameters
1. Select the sort order:

■ Sort by Description: Sorts the system parameters in alphabetical order by 
description.

■ Sort by Area: Sorts the system parameters in alphabetical order by functional 
area.

2. Click Search. The system parameters appear in the selected sort order.

Display System Parameters by Description or Functional Area
1. If any system parameters are currently displayed, click Clear.

2. Click Query.
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3. To search for system parameters by:

■ Description: Enter all or part of the description in the System Parameter field, 
or click the LOV button and select the system parameter.

■ Functional area: Enter all or part of the area name in the Area field, or click the 
LOV button and select the area.

4. Click Search. The system parameters that match the search criterion appear.

Edit System Parameters
1. On the System Parameters Editor window, double-click the system parameter that 

you want to edit. The Modify window opens.

Figure 4–53 Modify Window

2. Edit the current value and functional area as necessary.

3. In the In Use field, enter Y (Yes) to turn on or N (No) to turn off a system 
parameter as necessary.

4. Click Save to save any changes and close the Modify window.

Exit the System Parameters Editor Window
Click Exit to close the window.

Note: You can use the percent (%) symbol as a wildcard character.
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TCP Device Editor
The TCP Device Editor allows you to set up an interface between RWMS and a 
Cubiscan device. Cubiscan devices provide RWMS with the dimensional and weight 
information needed to optimize loads for packing and shipment.

To access the TCP Device Editor, navigate to Setup - Administration -> TCP Device 
Editor. The TCP Device Editor window opens.

Figure 4–54 TCP Device Editor Window

Display all TCP Devices
Click Search.

Display a TCP Device
1. If any TCP parameters are currently displayed, click Clear.

2. Click Query.

3. To search for TCP Device, enter the name of the Cubiscan device in the Device 
Name field, or click the LOV button and select the device.

4. Click Search. The TCP Device that matches the search criteria appear.

Edit a TCP Device
1. On the TCP Device Editor window, double-click the TCP Device that you want to 

edit. The Modify window opens.

2. Edit the enabled fields as necessary.

3. Click Save to save the changes and close the Modify window.

Add a TCP Device
1. Click Create Record. The Create Record window opens.

2. In the Device Name field, enter the ID of the device you want to interface with.

3. In the Network ID field, enter the network ID the device is using.

4. In the Port Number field, enter the port the device is using.

5. If the device is online, select the Device Online check box.

6. In the Timeout field, enter the amount of time before the connection is lost.

7. Click Save to save your changes and close the Create Record window.



Setup - Administration

4-54 Oracle® Retail Warehouse Management System UI User Guide

Exit the TCP Device Editor Window
Click  Exit to close the window.

Table Field Ownership Editor
The Table Field Ownership Editor allows you to indicate whether the fields describing 
an item are owned by RWMS or by the host system.

The scenarios pertaining to field ownership are:

■ If a field is required by the host and is also a primary key in RWMS, it is 
automatically marked as owned by the host and the system indicator is selected. 
You cannot change the ownership of the field to the distribution center (DC).

■ If a field is normally owned by the host but is not a primary key in RWMS, it is 
automatically marked as owned by the host, but the system indicator is not 
selected. You can change the ownership to the DC.

■ All other fields may be marked as owned by the DC. If a field is owned by the DC, 
it is protected from modifications that are received from the host.

To access the Table Field Ownership Editor, navigate to Setup - Administration -> 
Table Field Ownership Editor. The Table Field Ownership window opens.

Figure 4–55 Table Field Ownership Editor Window

Display All Item Fields
Click Search.

Display an Item Field
1. If any Item Field Names are currently displayed, click Clear .

2. In the Item Field Name field, enter the item field name or click the LOV button 
and select and item field name.

3. Click Search.
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Modify an Item Field
1. On the Table Field Ownership Editor window, double-click the Item Field Name 

you want to edit. The Modify window opens.

Figure 4–56 Modify Window

2. Check the DC field as necessary.

3. Click Save to save the change and close the Modify window.

Exit the Table Field Ownership Editor Window
Click Exit to close the window.

Ticket Type Editor
The Ticket Type Editor allows you to define and view a list of ticket types. You can 
enter a message, the maximum quantity, and printer information.

To access the Ticket Type Editor window, navigate to Setup - Administration -> Ticket 
Type Editor. The current ticket types appear in the Ticket Type Editor window.

Figure 4–57 Ticket Type Editor Window

Edit a Ticket Type
1. On the Ticket Type Editor window, double-click the ticket type that you want to 

edit. The Modify window opens.

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.
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Add a Ticket Type
1. On the Ticket Type Editor window, click Create Record. The Create Record 

window opens.

2. In the Type field, enter the code for the ticket type.

3. In the Message field, enter the message to be printed with the ticket.

4. In the Ticket Qty field, enter the number of tickets to be printed.

5. In the Queue Name field, enter the name of the print queue, or click the LOV 
button and select the print queue.

6. In the Printer Type field, enter the name of the printer.

7. Click Save to save the changes and close the Create Record window.

Delete a Ticket Type
1. On the Ticket Type Editor window, select the ticket type that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Ticket Type Editor Window
Click Exit to close the window.

Transaction Code Editor
The Transaction Code Editor allows you to view the RWMS supported inventory 
transaction names and codes. You can change the code for a transaction name to match 
a code in the connected host management system.

To access the Transaction Code Editor window, navigate to Setup - Administration -> 
Transaction Code Editor. The current transaction codes appear in the Transaction Code 
Editor window.

Figure 4–58 Transaction Code Editor Window
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Edit a Transaction Code
1. On the Transaction Code Editor window, double-click the transaction code that 

you want to edit. The Modify window opens.

Figure 4–59 Modify Window

2. Edit the description and transaction code as necessary.

3. Click Save to save the change and close the Modify window.

Exit the Transaction Code Editor Window
Click Exit to close the window.

Translation Editor
The Translation Editor allows you to view the data base values in English and then the 
translated value in the language selected. Users can modify the translated value if 
necessary.

To access the Translation Editor, navigate to Setup - Administration -> Translation 
Editor. The Translation Editor window opens.

Figure 4–60 Translation Editor Window

Note: You can also access this window from the Supported 
Language window.
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Display the Field Labels
1. If any values are currently displayed, click Clear.

2. Click Query.

3. In the Code field, enter the code for the language, or click the LOV button and 
select the language.

4. Click Search. The values associated with the selected language appear.

Edit a Translation
1. On the Translation Editor window, double-click the value that you want to edit. 

The Modify window opens.

Figure 4–61 Modify Window

2. Edit the value as necessary.

3. Click Save to save any changes and close the Modify window.

Exit the Translation Editor Window
Click Exit to close the window.

UOM Class Editor
Unit of measure classes represent groups of units of measure with similar 
characteristics. The UOM Class Editor allows for the creation and viewing of UOM 
Classes and their associated specific Units of Measure. RWMS is delivered with a 
standard list of Oracle UOM classes (Area, Configuration, Dimension, LVolume, Mass, 
Miscellaneous, Pack, Qty, Speed, Time, and Volume). The Editor allows for the creation 
of new UOMs that can be associated to existing UOM classes. User created UOMs are 
the only UOMs that can get deleted.
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To access the UOM Class Editor, navigate to Setup - Administration -> UOM Class 
Editor. The UOM Class Editor window opens. 

Figure 4–62 UOM Class Editor Window

Display All UOM Classes 
Click Search. 

Display a Subset of UOM Classes 
1. Click Query. 

2. To search for a single UOM, enter specific UOM in the UOM field, or click the LOV 
button and select the UOM. To search for a specific UOM Class, enter the name of 
the UOM Class in the UOM Class field, or click the LOV button and select the 
UOM Class.

3. Click Search. The UOM Classes that match the search criteria appear.

Edit a UOM Class
RWMS does not allow for the modification of existing UOM Classes. If the UOM class 
was created by a user it can be deleted.

Add a New UOM to an Existing UOM Class
1. On the UOM Class Editor window, click Create Record. The Create Record 

window opens.

Figure 4–63 Create Record Window
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2. In the UOM field, enter the name of the Unit of Measure being created.

3. In the UOM Class field, enter the UOM Class or click the LOV button and select 
the UOM Class desired. RWMS does not allow the creation of a new UOM Class.

4. In the Description field, enter the specific description of the UOM.

5. In the Display field. Click Yes if you want this UOM displayed on screen.

6. Click Save to save the changes and close the Create Record window

Delete a UOM
1. On the UOM Class Editor window, select the UOM that you want to delete. The 

UOM must be user defined to allow delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the UOM Class Editor Window 
Click Exit to close the window. 

UOM Conversion Editor
The UOM Conversion Editor allows you to view the From UOM and the To UOM with 
the mathematical factor required for conversion.

To access the UOM Conversion Editor, navigate to Setup - Administration -> UOM 
Conversion Editor. The UOM Conversion Editor window opens. 

Figure 4–64 UOM Conversion Editor Window

Display All UOM Conversions 
Click Search. 

Display a Subset of UOM Conversions 
1. Click Query.

2. To search for a specific From UOM, enter the UOM in the From UOM field, or click 
the LOV button and select the UOM. To search for a specific To UOM, enter the 
UOM in the To UOM field, or click the LOV button and select the UOM.

3. Click Search . The UOMs that match the search criteria appear.
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Add, Modify and Delete of a UOM Conversion
RWMS prohibits the adding, modification, or deleting of a UOM Conversion. This 
data is pre loaded into the application.

Exit the UOM Class Editor Window 
Click Exit to close the window. 

Working Days Editor
The Working Days Editor allows you to define the working days and appointment 
window within each working day for your specific facility. Upon installation of the 
RWMS software a range of working days must be defined for the software to function. 
From the Working Day Editor you can jump to the Shift Editor by clicking the View 
Shifts link. The definition of shifts is optional in RWMS.

To access the Working Days Editor window, navigate to Setup - Administration -> 
Working Days Editor. The Working Days Editor window opens.

Figure 4–65 Working Days Editor Window

Display a Range of Dates
1. If any Dates are currently displayed, click Clear.

2. Click Query.

3. In the Date field, enter the start date, or click the Calendar icon and select the date.

4. Click Search. The dates from the selected date forward are displayed.

Note: The work day defaults are determined by system settings: 
Start Time, End Time, and whether Saturdays and Sundays are work 
days. You can override the default times when adding a work day. 
You can override the work day indicator when editing a record.
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Edit a Date
1. On the Working Days Editor window, double-click the work date that you want to 

edit. The Modify window opens. 

Figure 4–66 Modify Window

2. Edit the Work Day indicator and Start and End times as necessary.

3. Enter appointment times as necessary. The Appointment Start and End Time is the 
range between which you can receive appointments. The appointment time needs 
to be between the Work Days time range.

4. Enter or edit a comment as necessary.

5. Click Save to save any changes and close the Modify window.

Add One or More Days
1. On the Working Days Editor window, click Create Record. The Create window 

opens.

Figure 4–67 Create Record Window

2. To add one date, enter the same date in both the Start Date and End Date fields. To 
add a range of dates, enter the start date and end date in their respective fields.
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3. Use the check boxes to indicate the working days over a calendar range.

4. In the Start Time and End Time fields, enter the times when the work day begins 
and ends. Use 24 hour international standard notation.

5. Enter Appt Start Time and Appt End Time as necessary.

6. Click Save to save the changes and close the Create window.

View Shift
The View Shifts link on the Working Days Editor window allows you to view the shifts 
and breaks associated to a working day.

1. On the Working Days Editor window, click View Shifts. The Shift Definition 
window opens.

2. If any Shift IDs are currently displayed, click Clear.

3. Click Query.

4. Select the Shift ID using the LOV button on the right. Click Search.

5. Select the Shift ID to view the breaks for the shift.

Exit the Working Days Editor Window
Click Exit to close the window.

Setup - DC
The DC setup is used to set up the physical layout and container types in the 
distribution center. This includes defining DC departments, regions, location types, 
location attributes, and locations. Some types of locations, such as doors, forward pick 
locations, and put to store locations, require additional details. Common 
characteristics of locations may be defined at the location type level. Location classes 
can be used to group locations with similar defaults, processes, and equipment types. 
Unit pick systems can be set up and putaway plans can be defined.

This section includes the following topics:

■ Aisle Editor

■ Carton Group Editor

■ Container Type Editor

■ Door Editor

■ Door Zone Editor

■ Door Load Type Editor

■ Outbound Container Editor

■ Put To Store Setup

■ Put To Store Dynamic Assignment

■ Putaway Plan Editor

■ Region Editor

■ Shift Definition

■ Sorter Group Editor

■ Top off Rules Editor
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■ UPS Chute Editor

■ Unit Pick System Editor

■ Unit Pick Zone Editor

Aisle Editor
The Aisle Editor allows you to create and review the aisles within your facility. An 
Aisle is defined as a walking or driving path (forklift) between storage or pick 
locations.

To access the Aisle Editor, navigate to Setup - DC > Aisle Editor. The Aisle Editor 
window opens.

Figure 4–68 Aisle Editor Window

Display All Aisles
Click Search.

Display an Aisle
1. If any aisles are currently displayed, click Clear.

2. Click Query.

3. In the Aisle field, enter the aisle, or click the LOV button and select the aisle.

4. Click Search. The aisle that match the search criterion opens.
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Edit an Aisle
1. On the Aisle Editor window, double-click the aisle that you want to edit. The 

Modify window opens.

Figure 4–69 Modify Window

2. Edit the Description and Max Users fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add an Aisle
1. On the Aisle Editor window, click Create Record. The Create Record window 

opens.

Figure 4–70 Create Record Window

2. In the Aisle Field, enter the aisle designation (Alpha numeric up to 10 digits).

3. In the Description field, enter the desired long description for the aisle.

4. In the Max Users field, enter the maximum number of users that can be in the aisle 
at the same time. This is used in task management to prevent too many users 
being in the same aisle at the same time which reduces productivity.

5. Click Save to save any changes and close the Create Record window.

Delete an Aisle
1. On the Aisle Editor window, select the aisle that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Aisle Editor Window
Click Exit to close the window.
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Carton Group Editor
The Carton Group Editor allows you to create and view the different types of cartons 
(containers) used in your warehouse operation.

To access Carton Group Editor, navigate to Setup - DC -> Carton Group Editor. The 
Carton Group Editor window opens.

Figure 4–71 Carton Group Editor Window

Display All Carton Groups
Click Search.

Display a Carton Group
1. If any carton groups are currently displayed, click Clear.

2. Click Query.

3. In the Container Group field, enter the code for the carton group, or click the LOV 
button and select carton group.

4. Click Search. The container types in the selected carton group appear.

Edit a Carton Group
1. On the Carton Group Editor window, double-click the carton group that you want 

to edit. The Modify window opens.

Figure 4–72 Modify Window

2. Edit the Container Type as necessary.
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3. Click Save to save any changes and close the Modify window.

Add a Carton Group
You can also use this procedure to add another container type to an existing carton 
group.

1. On the Carton Group Editor window, click Create Record. The Create Record 
window opens.

Figure 4–73 Create Record Window

2. In the Container Group and Group Desc fields, enter a code and description for 
the carton group.

3. In the Container Type field, enter the code of the container type that you want to 
associate with the carton group, or click the LOV button and select the container 
type.

4. Click Save to save the changes and close the Create Record window.

Delete a Carton Group
You can also use this procedure to delete a container type from a carton group.

1. On the Carton Group Editor window, select the container group/container type 
record that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Carton Group Editor Window
Click Exit to close the window.

Container Type Editor
The Container Type Editor allows you to define a master list of container types. You 
can enter the dimensions, tare weight, and unit cost. You also indicate how a container 
is determined to be full. The volume types are:

■ Cube: The container is full when it reaches its cubic capacity.

■ Unit: The container is full when the maximum number of standard units are 
placed in it.

A container is defined as something that holds merchandise and/or other containers. 
A container might be a tote, pallet, carton, trolley, hanger set, tanker, and so on.
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To access the Container Type Editor, navigate to Setup - DC -> Container Type Editor. 
The current container types appear in the Container Type Editor window.

Figure 4–74 Container Type Editor Window

Edit a Container Type
1. On the Container Type Editor window, double-click the container type that you 

want to edit. The Modify window opens.

Figure 4–75 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.
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Add a Container Type
1. On the Container Type Editor window, click Create Record. The Create Record 

window opens.

Figure 4–76 Create Record Window

2. In the Type and Description fields, enter the code and description for the container 
type.

3. In the Length, Width, and Height fields, enter the dimensions of the container.

4. In the Tare Weight field, enter the weight of the empty container.

5. In the Volume Type field, enter Unit or Cube to indicate the method used to 
determine whether a container is full.

6. If the Volume Type is Unit, enter the number of standard units that would fill a 
container in the Max Std Units field.

7. In the Max Weight field, enter the maximum weight that the container type can 
hold.

8. In the Unit Cost field, enter the cost per unit.

9. Click Save to save the changes and close the Create Record window.

Delete a Container Type
1. On the Container Type Editor window, select the container type that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Container Type Editor Window
Click Exit to close the window.



Setup - DC

4-70 Oracle® Retail Warehouse Management System UI User Guide

Door Editor
The Door Editor allows you to maintain shipping and receiving doors. Before setting 
up a door, be sure a location ID (with type as Shipping Door or Receiving Door) exists 
for the door as every door must be identified as a location. You can indicate whether a 
door is used for shipping, receiving, or both. You can also indicate the type of 
merchandise handled at a door, such as hanging, flat, shoe, or all.

The status of the door may be Available, Out of Service, or Busy. You can change the 
status from Available to Out of Service and back to Available as necessary.

Each receiving door may be associated with one or more load types. Load types are 
defined at the item level and can also be at the appointment level. In order for RWMS 
to recommend best fit doors for inbound trailers, the load types need to be defined.

To access the Door Editor, navigate to Setup - DC -> Door Editor. The current doors 
appear in the Door Editor window.

Figure 4–77 Door Editor Window

Edit a Door
1. On the Door Editor window, double-click the door that you want to edit. The 

Modify window opens.

Figure 4–78 Modify Window

2. Edit the enabled fields as necessary.
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3. Click Save to save any changes and close the Modify window.

Add a Door
1. On the Door Editor window, click Create Record. The Create Record window 

opens.

Figure 4–79 Create Record Window

2. In the Door field, enter the ID for the door.

3. In the Location ID field, enter the ID of the door's location, or click the LOV button 
and select the location.

4. In the Recv Ship field, enter the code for the door's function. The function may be 
R (Receiving), S (Shipping), or X (Both).

5. In the Door Ind field, enter the code for the type of merchandise handled at the 
door. The type may be H (Hanging), F (Flat), S (Shoe), or A (All).

6. Click Save to save the changes and close the Create Record window.

Delete a Door
1. On the Door Editor window, select the door that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Change the Status of a Door
1. On the Door Editor window, select the door that you want to edit.

2. Click Service. If the status was Available, it becomes Out of Service. If it was Out 
of Service, it becomes Available.
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Door Zone Editor
The Door Zone Editor allows you to associate a receiving door to a storage zone so 
inbound merchandise is driven to that zone during the putaway process.

Each receiving door may be associated with one or more zones. When 
recommending/prioritizing doors for receiving appointments, RWMS considers item 
put-away zones for items on the appointment and select doors based on the number of 
items with matching zones.

The Door Zone Editor window allows you to create or delete a door zone record.

On the Door Editor window, select a door and click Zones. The Door Zone Editor 
window opens.

Figure 4–80 Door Zone Editor Window

Create Record
1. On the Door Zone Editor window, click Create Record. The Create Record window 

opens.

Figure 4–81 Create Record Window

2. Click the LOV button and select the zone.

3. Click Save to save any changes and close the Create Record window.
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Delete a Record
1. On the Door Zone Editor window, select the door that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Door Zone Editor Window
Click Exit to close the window.

Door Load Type Editor
The Door Load Type Editor window allows you to set load types per door.

On the Door Editor window, select a door and click Load Types. The Door Load Type 
Editor window opens.

Figure 4–82 Door Load Type Editor Window

Create Record
1. On the Door Load Type Editor window, double-click the door that you want to 

create. The Create Record window opens. 

Figure 4–83 Create Record Window

2. Click the LOV button and select the load type.

3. Click Save to save any changes and close the Create Record window.
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Delete a Record
1. On the Door Load Type Editor window, select the door that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Door Load Type Editor Window
Click Exit to close the window.

Exit the Door Editor Window
Click Exit to close the window.

Outbound Container Editor
The Outbound Container Editor allows you to define and review the outbound 
container types used within your facility. These container types are used for consumer 
direct shipments and require the amount of collateral and dunnage that will be added 
to the container.

To access the Outbound Container Editor, navigate to Setup - DC -> Outbound 
Container Editor. The current outbound container types appear in the Outbound 
Container Editor window.

Figure 4–84 Outbound Container Editor Window
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Edit an Outbound Container Type
1. On the Outbound Container Editor window, double-click the container type that 

you want to edit. The Modify window opens.

Figure 4–85 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add an Outbound Container Type
1. On the Outbound Container Editor window, click Create Record. The Create 

Record window opens.

Figure 4–86 Create Record Window

2. In the Container Type field, enter the ID of a container type, or click the LOV 
button and select the container type.

3. In the Owner field, enter the name of an owner if applicable. Otherwise, enter 
ALL.

4. In the Collateral Wgt field, enter the weight of advertisements, flyers, or other 
such materials that are expected to be included in the container.

5. In the Dunnage Wgt field, enter the weight of the packing materials.
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6. In the Min Dunnage Wgt field, enter the least amount of dunnage expected.

7. In the In Service field, enter Y (Yes) to place the outbound container type in 
service. Otherwise, enter N (No).

8. Click Save to save the changes and close the Create Record window.

Delete a Container Type
1. On the Outbound Container Editor window, select the outbound container type 

that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Outbound Container Editor Window
Click Exit to close the window.

Put To Store Setup
The Put to Store Setup window allows you to assign destinations (stores) to fixed put 
to store picking locations.

To access the Put To Store Setup window, navigate to Setup - DC -> Put To Store Setup. 
The Put To Store Setup window opens.

Figure 4–87 Put To Store Setup Window

Display all Put To Store Locations
Click Search.

Display Put To Store Locations for a Destination
1. If any destinations are currently displayed, click Clear.

2. Click Query.

3. In the Dest ID field, enter the destination ID. 

4. Click Search. The locations associated with the destination appear.
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Edit a Put To Store Location
1. On the Put To Store Location Setup window, double-click the location that you 

want to edit. The Modify window opens.

Figure 4–88 Modify Window

2. Edit the location ID as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Put To Store Location
1. On the Put to Store Location Setup window, click Create Record. The Create 

Record window opens.

Figure 4–89 Create Record Window

2. In the Dest ID field, enter the ID of the destination (store).

3. In the Location field, enter the ID of the location.

4. Click Save to save the changes and close the Create Record window.

Delete a Put To Store Location
1. On the Put to Store Location Setup window, select the location that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Put To Store Location Setup Window
Click Exit to close the window.
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Put To Store Dynamic Assignment
The Put to Store Dynamic Assignment Editor allows you to define and review a series 
of locations that can be dynamically assigned to a store each time a new wave is 
released.

To access the Put to Store Dynamic Assignment Editor, navigate to Setup - DC -> Put 
To Store Dynamic Assignment. The current location/store assignments appear in the 
Put to Store Dynamic Assignment window.

Figure 4–90 Put To Store Dynamic Assignment Window

Putaway Plan Editor
The Putaway Plan Editor allows you to define and view putaway plans. By clicking 
the Plan Detail link, you can create the actual putaway plan zone sequence with 
putaway methods (empty, same, different).

To access the Putaway Plan Editor, navigate to Setup - DC -> Putaway Plan Editor. The 
current putaway plans appear in the Putaway Plan Editor window.

Figure 4–91 Putaway Plan Editor Window
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Edit a Plan or Plan Details
1. On the Putaway Plan Editor window, double-click the plan that you want to edit. 

The Modify window opens.

Figure 4–92 Modify Window

2. Edit the description as necessary.

3. Click Save to save any changes and close the Modify window.

4. To edit details of the plan:

a. Select a plan and click Plan Detail. The details appear on the detail window.

Figure 4–93 Putaway Plan Editor (Details) Window
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b. Double-click the detail line that you want to edit. The Modify window opens.

Figure 4–94 Modify Window

c. Edit the enabled fields as necessary.

d. Click Save to save any changes and close the Modify window.

5. Click Exit to close the detail window.

Add a Plan or Plan Details
1. On the Putaway Plan Editor window, click Create Record. The Create Record 

window opens.

Figure 4–95 Create Record Window

2. In the Plan Name field, enter the name of the plan.

3. In the Description field, enter the description of the plan.

4. Click Save to save the changes and close the Create Record window.

5. To add details to the plan:

a. Select a plan and click Plan Detail. The detail window opens.

b. Click Create Record. The Create Record window opens.
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Figure 4–96 Create Record Window

c. In the Sequence field, enter the number of the step.

d. If the plan step uses concentric logic, enter Y in the Concentric field.

e. In the Zone field, enter the ID of the zone, or click the LOV button and select 
the zone.

f. In the Location Type field, enter the code for the location type, or click the 
LOV button and select the location type.

g. In the Putaway Method field, enter the name of the appropriate method. The 
method may be: Putaway to empty location (EMP), Putaway to location with 
same item/case pack/lot (SAM), or Putaway to location with different 
item/case pack/lot (DIF).

h. In the Max X Change field, enter the maximum amount that the X coordinate 
can vary by.

i. In the Max Y Change field, enter the maximum amount that the Y coordinate 
can vary by.

j. In the Max Locations field, enter the maximum number of locations that must 
be filled using the detail step.

k. In the Active/Reserve field, indicate whether the plan is for reserve locations 
(R) or active picking locations (A). Enter A or R as necessary.

l. Click Save to save the changes and close the Create Record window.

6. Click Exit to close the detail window.

Note:  The Max X Change and the Max Y Change fields are available 
only when you are using concentric logic.
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Delete a Plan Detail
1. On the Putaway Plan Editor window, select the plan that you want to edit.

2. Click Plan Detail. The details appear in the detail window.

3. Select the detail line that you want to delete.

4. Click Delete Record.

5. When prompted to delete the record, click Yes.

6. Click Exit to close the detail window.

Delete a Plan
1. On the Putaway Plan Editor window, select the plan that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Putaway Plan Editor Window
Click Exit to close the window.

Region Editor
The Region Editor allows you to define and review the regions (group of zones) used 
within your facility. The definition of regions is optional and is only used when 
conveyor is used in reserve storage.

To access the Region Editor, navigate to Setup - DC -> Region Editor. The current 
regions appear in the Region Editor window.

Figure 4–97 Region Editor Window
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Edit a Region
1. On the Region Editor window, double-click the region that you want to edit. The 

Modify window opens.

Figure 4–98 Modify Window

2. Edit the description and entry location as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Region
1. On the Region Editor window, click Create Record. The Create Record window 

opens.

Figure 4–99 Create Record Window

2. In the Region field, enter a code for the region.

3. In the Description field, enter a description of the region.

4. In the Entry Location field, enter the ID of the location where containers enter the 
region.

5. Click Save to save the changes and close the Create Record window.

Delete a Region
1. On the Region Editor window, select the region that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Region Editor Window
Click Exit to close the window.
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Shift Definition
The Shift Definition Editor is used to define and view the working shifts within your 
facility. Shifts are allowed to overlap exactly or partially as long as there is a unique 
shift number and name. Shifts can also span calendar days.

To access the Shift Definition window, navigate to Setup - DC -> Shift Definition. The 
Shift Definition window opens.

Figure 4–100 Shift Definition Window

Display All Shifts
Click Search.

Display a Specific Shift
1. On the Shift Definition window, if any shift is currently displayed click Clear.

2. Click Query.

3. Select a Shift ID from the LOV and click Search. The details of the shift selected 
and the associated breaks are displayed on the window.
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Edit a Shift Definition
1. On the Shift Definition window, double-click the shift that you want to edit. The 

Modify window opens.

Figure 4–101 Modify Window

2. Edit the Description, Start Time, End Time fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Shift Definition
1. On the Shift Definition window, click any cell in the shift block (upper block). The 

Create Shift link gets activated.

2. Click Create Shift. The Create Shift window opens. 

Figure 4–102 Create Shift Window

3. In the Shift ID filed, enter the Shift name (alpha numeric up to 10 digits).

4. In the Description field, enter the long description of the shift.

5. In the Start Time field, enter the time when the shift starts (military time).

6. In the End Time field, enter the time when the shift ends (military time).

7. Click Save to save the changes and close the Create Shift window.

Delete a Shift Definition
1. On the Shift Definition window, select the shift that you want to delete.

2. Click Delete Shift.
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3. When prompted to delete the record, click Yes.

Exit the Shift Definition Window
Click Exit to close the window.

Sorter Group Editor
The Sorter Group Editor is used to define and view the sorter groups within your 
facility. This editor allows you to define the conveyor dropoff location, non-conveyor 
dropoff location, and maximum number of pack wave allowed to be processed within 
this group.

To access the Sorter Group Editor, navigate to Setup - DC -> Sorter Group Editor. The 
current sorter groups appear in the Sorter Group Editor window.

Figure 4–103 Sorter Group Editor Window

Edit a Sorter Group
1. On the Sorter Group Editor window, double-click the sorter group that you want 

to edit. The Modify window opens.

Figure 4–104 Modify Window

2. Edit the drop-off locations and maximum pack waves as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Sorter Group
1. On the Sorter Group Editor window, click Create Record. The Create Record 

window opens.
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Figure 4–105 Create Record Window

2. In the Sorter Group field, enter a name for the group.

3. In the Convey Dropoff field, enter the ID of the location where conveyable 
merchandise should be dropped off, or click the LOV button and select the 
location.

4. In the Non-convey Dropoff field, enter the ID of the location where 
non-conveyable merchandise should be dropped off, or click the LOV button and 
select the location.

5. In the Max Packwaves field, enter the maximum number of pack waves to be 
distributed for each pick wave.

6. Click Save to save the changes and close the Create Record window.

Delete a Sorter Group
1. On the Sorter Group Editor window, select the sorter group that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Sorter Group Editor Window
Click Exit to close the window.

Top off Rules Editor
The Topoff Rules Editor allows you to enter a request for top-off replenishment at 
forward pick locations. You can include any of the following parameters in the request: 
item, velocity, location range, zone range, and priority by case or bulk. Replenishment 
tasks are generated in RWMS for the eligible forward pick locations.



Setup - DC

4-88 Oracle® Retail Warehouse Management System UI User Guide

To access the Top Off Rules Editor, navigate to Setup - DC -> Top off Rules Editor. The 
Top off Rules Editor window opens.

Figure 4–106 Top Off Rules Editor Window

Create a Request
1. On the Topoff Rules Editor window, enter criteria in the necessary fields. You can 

restrict the request by the following criteria:

■ Item: In the Item ID field, enter the ID of the item, or click the LOV button and 
select the item.

■ Velocity: In the Item Velocity field, enter the desired velocity.

■ Location range: In the From Location and To Location fields, enter the location 
IDs, or click the LOV buttons and select the locations.

■ Zone range: In the From Zone and To Zone fields, enter the zone IDs, or click 
the LOV buttons and select the zones.

■ Priority: Select either the Whole Number or the Delta option for either cases or 
bulk. If you select Whole Number, enter the new priority number in the 
appropriate Updated field. If you select Delta, enter the number to be 
subtracted from the Current priority.

2. Click Create Record. The request is submitted for processing.

Exit the Topoff Rules Editor Window
Click Exit to close the window.

UPS Chute Editor
The UPS Chute Editor allows you to maintain a list of chutes for each sorter (Bombay, 
tilt-tray, and so on). A sequence number must be assigned to each chute in order to set 
the priority for filling chutes during a pack wave. You can designate maximum 
capacities by cube, unit, and order for a pack wave and indicate whether a chute is out 
of service. 
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To access the UPS Chute Editor, navigate to Setup - DC -> UPS Chute Editor. The UPS 
Chute Editor window opens.

Figure 4–107 UPS Chute Editor Window

Display Chutes for a Unit Pick System
1. If any chutes are currently displayed, click Clear.

2. Click Query.

3. In the Unit Pick System field, enter the code for the UPS, or click the LOV button 
and select the UPS.

4. Click Search. The chutes for the selected UPS appear.

Edit a UPS Chute
1. On the UPS Chute Editor window, double-click the chute that you want to edit. 

The Modify window opens.

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Edit the Status of a Chute
1. On the UPS Chute Editor window, double-click the chute that you want to edit. 

The Modify window opens.

Figure 4–108 Modify Window
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2. To place a chute out of service, select the Out Srvc check box. To place a chute in 
service, clear the Out Srvc check box.

3. Click Save to save any changes and close the Modify window.

Add a UPS Chute
1. On the UPS Chute Editor window, click Create Record. The Create Record 

window opens.

Figure 4–109 Create Record Window

2. In the Logical Chute field, enter the name of the chute.

3. In the Seq Nbr field, enter the sequence in which the chute is to be filled in relation 
to other chutes in the sorter.

4. If you want to dedicate the chute to a specific brand, enter the brand name in the 
Brand field.

5. In the Max Cube, Max Units, and Max Orders fields, enter the maximum cubic, 
unit, and order capacities of the chute for one pack wave.

6. In the % Fill field, enter the percentage at which the chute is considered full for a 
pack wave.

7. In the % Reg Fill, enter the percentage of regular orders allowed in the chute. If the 
chute type is Regular, this percentage must equal the percentage in the % Fill field.

8. If you want to place the chute out of service, select the Out Srvc check box.

9. Click Save to save the changes and close the Create Record window.

Delete a UPS Chute
1. On the UPS Chute Editor window, select the chute that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.
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Exit the UPS Chute Editor Window
Click Exit to close the window.

Unit Pick System Editor
The Unit Pick System Editor is used to define and view the various unit pick system 
used in your facility (less than case, put to store unit, tilt tray, and so on).

To access Unit Pick System Editor, navigate to Setup - DC -> Unit Pick System Editor. 
The Unit Pick System Editor window opens.

Figure 4–110 Unit Pick System Editor Window

Display All Unit Pick Systems
Click Search.

Display a Unit Pick System
1. If any unit pick systems (UPS) are currently displayed, click Clear.

2. Click Query.

3. In the Unit Pick System field, enter the UPS code, or click the LOV button and 
select the UPS.

4. Click Search. The selected UPS opens.
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Edit a Unit Pick System
1. On the Unit Pick System Editor window, double-click the UPS that you want to 

edit. The Modify window opens.

Figure 4–111 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Unit Pick System
1. On the Unit Pick System Editor window, click Create Record. The Create Record 

window opens.

Figure 4–112 Create Record Window

2. In the UPS Code and Description fields, enter a code and description for the UPS.
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3. In the Activity Code field, enter the code of the activity performed by the UPS, or 
click the LOV button and select the activity.

4. In the Pack Wave Size field, enter the number of groups that are permitted in a 
pack wave.

5. In the Sorter Group field, enter the sorter group if the UPS is a sorter system.

6. In the UPS Sequence field, enter the order in which this UPS should be accessed 
within its defined sorter group.

7. In the Print Unit Labels field, enter Y (Yes) or N (No) to indicate whether unit 
labels should be printed for each unit pick group.

8. In the PTS field, select the check box if the UPS is a put to store system.

9. Click Save to save the changes and close the Create Record window.

Delete a Unit Pick System
1. On the Unit Pick System Editor window, select the UPS that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Unit Pick Zone Editor
The Unit Pick Zone Editor allows you to associate induction zones for each unit pick 
system (UPS).

On the Unit Pick System Editor window, select a UPS and click Zone. The induct zones 
for the selected UPS appear in the Unit Pick Zone Editor window.

Figure 4–113 Unit Pick Zone Editor Window
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Edit a Destination
1. On the Unit Pick Zone Editor window, double-click the destination that you want 

to edit. The Modify window opens.

Figure 4–114 Modify Window

2. Edit the destination ID as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Destination
1. On the Unit Pick Zone Editor window, click Create Record. The Create Record 

window opens.

Figure 4–115 Create Record Window

2. In the Induct Zone field, enter the ID of the induct zone.

3. In the Dest ID field, enter the ID of the destination, or click the LOV button and 
select the destination.

4. Click Save to save the changes and close the Create Record window.

Delete a Destination
1. On the Unit Pick Zone Editor window, select the destination that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.
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Exit Unit Pick Zone Editor Window
Click Exit to close the window.

Exit the Unit Pick System Editor Window
Click Exit to close the window.

Setup - Equipment/Zone
The Setup Equipment/Zone module is used to define: equipment classes, individual 
pieces of equipment, and operational zones within a distribution center.

This section includes the following topics:

■ Equipment/Zone Setup Overview

■ Equipment Class Editor

■ Equipment Editor

■ Equipment/Zone Restriction Editor

■ FCP Zone Group Editor

■ Zone Editor

Business Process
Upon installation of the RWMS software, it is mandatory to define all physical 
locations (storage, picking, staging, and so on) as logical locations in RWMS. Once this 
is achieved, the next step is to divide those locations into operational zones based on 
location and item characteristics. Based on the location and item characteristics within 
a zone, it may be necessary to restrict specific equipment types from operating in those 
zones.

Once equipment is defined (class or individual unit level), you can assign the 
equipment to activities, items, locations, and zones. This information is used by RWMS 
when calculating which tasks should be assigned to operators.

Equipment/Zone Setup Overview
The Setup Equipment/Zone module provides you with the ability to define all of the 
equipment and operational zones within your facility.

Equipment 
Setting up equipment classes and equipment is optional in RWMS if task management 
is not used. If task management is used with XYZ location coordinates, then 
equipment definition is required. The equipment can be defined at the class level or 
individual unit level.

Zones 
Zones are used to group locations based on operational (physical) or item 
characteristics.

Zones that are used for distribution and picking tasks may be grouped into zone 
groups. To set up zones:

■ Identify the zones and select the appropriate characteristics for each zone.

■ Define zone groups and assign zones to each zone group in order of priority.
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Equipment and zones 
Equipment zone restrictions can be defined as needed based on physical or item 
constraints.

Equipment Class Editor
The Equipment Class Editor allows you to maintain a master list of equipment classes. 
An equipment class is used to group equipment with similar characteristics. At the 
class level, you define the number of pallets and maximum weight that the equipment 
is designed to handle, the vertical reach of the equipment, and the horizontal and 
vertical clearance required by the equipment.

You can access the Equipment Editor window in order to define the pieces of 
equipment that are members of the equipment class.

Once the equipment classes are defined, you can assign them at the following levels: 
location class, location, item class, item configuration, and process.

The use of equipment classes is optional in RWMS. Equipment classes are required, 
however, if you activate task management.

From the main menu, select Setup Equipment/Zone > Equipment Class Editor. The 
Equipment Class Editor window opens.

Figure 4–116 Equipment Class Editor Window

Display All Equipment Classes
Click Search.

Display an Equipment Class
To display an equipment class:

1. Click Query.

2. In the Equipment Class field, enter the name of the equipment class, or click the 
LOV button and select the equipment class.

3. Click Search. The equipment class that matches the search criterion appears.

Note: You can access the Equipment Editor window from the 
Equipment Class Editor window. On the Equipment Class Editor 
window, click the Equipment link to access the Equipment Editor 
window.
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Edit an Equipment Class
To edit an equipment class:

1. On the Equipment Class Editor window, double-click the equipment class that you 
want to edit. The Modify window opens.

Figure 4–117 Modify Window

2. Edit the description and measurements as necessary.

3. Click Save to save any changes and close the Modify window.
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Add an Equipment Class
To add an equipment class:

1. On the Equipment Class Editor window, click Create Record. The Create Record 
window opens.

Figure 4–118 Create Record Window

2. In the Equipment Class and Description fields, enter a name and a description for 
the equipment class.

3. In the Type field, select one of the device categories (Handheld, Truckmount, or 
Wristmount) or select Vehicle. Vehicle is used for all material handling equipment 
such as Forklifts, Turret Trucks, and Cherry Pickers.

4. In the Assignment Required Field, set the flag to ON if using task management. 
When this flag is set to yes, RWMS validates that the tasks dispatched to this user 
can be performed by the equipment class assigned to the user.

5. In the Certification Required field, set the flag to ON if the user needs to be trained 
and receive a certification letter before operating this class of equipment.

6. In the Safety Check Field, set the flag to ON if this class of equipment requires 
periodic safety checks.

7. In the Nbr of Pallets field, enter the maximum number of pallets that the 
equipment is designed to handle.

8. In the Maximum Weight field, enter the maximum weight that the equipment is 
designed to carry.

9. In the Vertical Overhead field, enter the vertical clearance required by the 
equipment.

10. In the Horizontal Overhead field, enter the horizontal clearance required by the 
equipment.

11. In the Maximum Vertical Reach field, enter the maximum height to which the 
equipment can extend.
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12. In the Maximum Horizontal Reach field, enter the maximum reach to which the 
equipment can extend.

13. In the Vertical Lift Loaded Speed field, enter the normal speed for raising the 
forks/deck when carrying a pallet. This is a future use field for Labor 
Management.

14. In the Vertical Lift Unloaded Speed field, enter the normal speed for raising the 
forks/deck when empty. This is a future use field for Labor Management.

15. In the Vertical Drop Loaded Speed field, enter the normal speed for lowering the 
forks/deck when carrying a pallet. This is a future use field for Labor 
Management.

16. In the Vertical Drop Unloaded Speed field, enter the normal speed for lowering the 
forks/deck when empty. This is a future use field for Labor Management.

17. In the Horizontal Loaded Speed field, enter the normal speed of the equipment 
when moving with a loaded pallet. This is a future use field for Labor 
Management.

18. In the Horizontal Unloaded Speed field, enter the normal speed of the equipment 
when moving empty. This is a future use field for Labor Management.

19. In the Weight UOM field, select the appropriate weight Unit of Measure for your 
specific facility.

20. In the Dimension UOM field, select the appropriate dimension Unit of Measure for 
your specific facility.

21. In the Speed UOM field, select the appropriate speed Unit of Measure for your 
specific facility.

22. Click Save to save the changes and close the Add/Modify window.

Delete an Equipment Class

To delete an equipment class:

1. On the Equipment Class Editor window, select the equipment class that you want 
to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Equipment Class Window
Click Exit to close the window.

Note: You must delete any equipment assigned to an equipment 
class before you can delete the equipment class.
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Equipment Editor
The Equipment Editor window allows you to identify each piece of equipment with a 
unique ID and description. The equipment can then be associated with an equipment 
class. When the association is confirmed, the characteristics of the equipment class are 
copied to the specific equipment ID. You can then edit the characteristics for each 
specific piece of equipment (For example, the speed of one forklift brand is different 
than another brand).

When equipment is assigned to an activity, RWMS compares the location height and 
weight restrictions to the height and weight capabilities of the actual piece of 
equipment being proposed to complete the activity. If the equipment does not match 
the restriction criteria, then it cannot be assigned to the activity.

From the main menu, select Setup Equipment/Zone > Equipment Editor. The 
Equipment Editor window opens.

Figure 4–119 Equipment Editor Window

Display All Equipment
Click Search.

Display a Subset of the Equipment
To display a subset of the equipment:

1. Click Query.

2. To search for equipment by ID, enter the ID in the Equipment ID field, or click the 
LOV button and select the equipment ID. To search for equipment IDs by 
equipment class, enter the name of the equipment class in the Equipment Class 
field, or click the LOV button and select the equipment class

3. Click Search. The equipment IDs that match the search criterion appear

Note: You can also access this window from the Equipment Class 
window.
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Edit Equipment
To edit equipment:

1. On the Equipment Editor window, double-click the piece of equipment that you 
want to edit. The Modify window opens.

Figure 4–120 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.



Setup - Equipment/Zone

4-102 Oracle® Retail Warehouse Management System UI User Guide

Add Equipment
To add an equipment:

1. On the Equipment Editor window, click Create Record. The Create Record 
window opens.

Figure 4–121 Create Record Window

2. In the Equipment ID and Description fields, enter an ID and description for the 
equipment ID.

3. In the Equipment Class field, enter the desired equipment class or select an 
Equipment Class from the LOV button. When a class is selected all of the values 
from the class are inherited at the Equipment ID level. After the inherited 
information displays, the specific fields may then be edited at the equipment ID 
level:

■ The Type field is inherited from the Equipment Class and cannot be edited

■ The Assignment Required field is inherited from the Equipment Class and 
cannot be edited.

■ The Certification Required field is inherited from the Equipment Class and 
cannot be edited

■ The Safety Check field is inherited from the Equipment Class and cannot be 
edited.

4. In the Nbr of Pallets field, enter the maximum number of pallets that the 
equipment is designed to handle.

5. In the Maximum Weight field, enter the maximum weight that the equipment is 
designed to carry.

Note: All of the following fields are inherited from the Equipment 
Class, but can be edited.
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6. In the Vertical Overhead field, enter the vertical clearance required by the 
equipment.

7. Click Save to save the changes and close the Create Record window.

8. In the Horizontal Overhead field, enter the horizontal clearance required by the 
equipment.

9. In the Maximum Vertical Reach field, enter the maximum height to which the 
equipment can extend.

10. In the Maximum Horizontal Reach field, enter the maximum reach to which the 
equipment can extend.

11. In the Vertical Lift Loaded Speed field, enter the normal speed for raising the 
forks/deck when carrying a pallet. This is a future use field for Labor 
Management.

12. In the Vertical Lift Unloaded Speed field, enter the normal speed for raising the 
forks/deck when empty. This is a future use field for Labor Management.

13. In the Vertical Drop Loaded Speed field, enter the normal speed for lowering the 
forks/deck when carrying a pallet. This is a future use field for Labor 
Management.

14. In the Vertical Drop Unloaded Speed field, enter the normal speed for lowering the 
forks/deck when empty. This is a future use field for Labor Management.

15. In the Horizontal Loaded Speed field, enter the normal speed of the equipment 
when moving with a loaded pallet. This is a future use field for Labor 
Management.

16. In the Horizontal Unloaded Speed field, enter the normal speed of the equipment 
when moving empty. This is a future use field for Labor Management.

17. In the Weight UOM field, select the appropriate weight Unit of Measure for your 
specific facility.

18. In the Dimension UOM field, select the appropriate dimension Unit of Measure for 
your specific facility.

19. In the Speed UOM field, select the appropriate speed Unit of Measure for your 
specific facility.

20. Click Save to save the changes and close the Add/Modify window.

Delete Equipment
To delete equipment:

1. On the Equipment Editor window, select the piece of equipment that you want to 
delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Equipment Editor Window
Click Exit to close the window.
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Equipment/Zone Restriction Editor
The Equipment Zone Restriction Editor allows you to define zones where equipment 
cannot operate within. This is often necessary when the material handling equipment 
prevents the use of specific equipment types (forklifts, cherry pickers, and so on).

Restrict Equipment Classes from Zones
From the main menu, select Setup Equipment/Zone Setup > Equipment Zone 
Restrictions Editor. The Equipment Zone Restriction Editor window opens.

Figure 4–122 Equipment Zone Restriction Editor Window

Edit an Equipment Zone Restriction
To edit an equipment zone restriction:

1. On the Equipment Zone Restriction Editor window, double-click the equipment 
class that you want to edit. The Modify window opens.

Figure 4–123 Modify Window

2. To restrict zones, select the check boxes next to the zones on right side of the 
window and then click Assign to move them on the left side of the window.
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3. To remove zone restrictions, select the check boxes next to the zones on the left 
side of the window and then click Unassign to move them on the right side of the 
window.

4. Click Save to save any changes and close the Modify window.

Add an Equipment Zone Restriction
To add an equipment zone restriction:

1. On the Equipment Zone Restriction Editor window, click Create Record. The 
Create Record window opens.

Figure 4–124 Create Record Window

2. In the Equipment Class field, enter the Equipment Class or click the LOV button 
and select the class. When the Equipment Class is selected, RWMS populates all 
the available zones that can be restricted.

3. To restrict zones, select the check boxes next to the zones on right side of window 
and then click Assign to move them on the left side of the window.

4. Click Save to save the changes and close the Create Record window.

Delete an Equipment Zone Restriction
To delete an equipment zone restriction:

1. On the Equipment Zone Restriction window, select the Equipment Class Zone that 
you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Zone Equipment Window
Click Exit to close the window.



Setup - Equipment/Zone

4-106 Oracle® Retail Warehouse Management System UI User Guide

FCP Zone Group Editor
The FCP Zone Group Editor window can be used to link individual zones together for 
forward case picking. By grouping zones, shared characteristics and processes may be 
assigned across several zones in order to establish a more efficient picking path for 
forward case picking.

From the main menu, select Setup Equipment/Zone Setup > FCP Zone Group Editor. 
The FCP Zone Group Editor window opens.

Figure 4–125 FCP Zone Group Editor Window

Display All FCP Zone Groups
Click Search.

Display an FCP Zone Group
To display an FCP zone group:

1. Click Query.

2. In the Group Name field, enter the name of the zone group, or click the LOV 
button and select the FCP zone group.

3. Click Search. The FCP zone group that matches the search criterion opens.

Edit an FCP Zone Group
To edit an FCP zone group:

1. On the Zone Group Editor window, double-click the zone group that you want to 
edit. The Modify window opens.

Figure 4–126 Modify Window
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2. Edit the description, priority level for picking, and active option as necessary.

3. Click Save to save any changes and close the Modify window.

Add an FCP Zone Group
To add an FCP zone group:

1. On the Zone Group Editor window, click Create Record. The Create Record 
window opens.

Figure 4–127 Create Record Window

2. In the Group Name and Description fields, enter a name and description for the 
zone group.

3. In the Priority field, enter the priority level of the zone group for picking activities.

4. To make the zone group available to users, select the Active Flag check box.

5. Click Save to save the changes and close the Create Record window.

Assign Zones to an FCP Zone Group
To assign zones to an FCP zone group:

1. On the Zone Group Editor window, select the zone group that you want to edit.

2. Click Assign Zones. The Assign Zones window opens.

Note: An FCP Zone Group requires at least two forward case picking 
zones to be added to the group with defined container types on the 
zone at the time of the Zone Group being created. A message is 
displayed if there is only one zone being added to the group at the 
time the record is being saved
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Figure 4–128 Assign Zones Window

3. To assign zones:

a. Select the check box next to the desired zones on the Available Zones table.

b. Click Assign. The selected zones are moved to the Assigned Zones table.

4. To remove assigned zones:

a. Select the check box next to the desired zones on the Assigned Zones table.

b. Click Unassign. The selected zones are moved to the Available Zones table.

5. Click Save to save any changes and close the Assign Zones window.

Resequence the Zones in an FCP Zone Group
To resequence the zones in an FCP zone group:

1. On the Zone Group Editor window, select the zone group that you want to edit.

2. Click Assign Zones. The available and assigned zones for the zone group are 
displayed in the Assign Zones window.

3. To resequence the assigned zones:

a. Select the zone to be moved.

b. To move the zone closer to the top of the list, click Move Up.

c. To move the zone closer to the bottom of the list, click Move Down.

4. Click Save to save any changes and close the Assign Zones window.

Note: In the Assign Zones window, you can click Assign All to 
move all zones to the Assigned Zones table or Unassign All to move 
all zones to the Available Zones table. All zones are moved whether or 
not the check boxes are selected.
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Delete an FCP Zone Group
To delete an FCP zone group:

1. On the Zone Group Editor window, select the zone group that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the FCP Zone Group Editor Window
Click Exit to close the window.

Zone Editor
The Zone Editor allows you to define and view the operational zones used within 
your facility. These zones can then be attached to putaway and cycle count plans to 
further optimize those processes.

From the main menu, select Setup Equipment/Zone > Zone Editor. The Zone Editor 
window opens.

Figure 4–129 Zone Editor Window

Display All Zones
Click Search.

Display a Subset of Zones
To display a subset of zones:

1. Click Query.

2. To search for a single zone, enter the ID of the zone in the Zone field, or click the 
LOV button and select the zone. To search for zones by zone group, enter the name 

Note: You cannot delete a zone group if any zones have been 
assigned to the zone group.

Note: You can also access this window from the Location Editor 
window.



Setup - Equipment/Zone

4-110 Oracle® Retail Warehouse Management System UI User Guide

of the zone group in the Zone Group field, or click the LOV button and select the 
zone group.

Edit a Zone
To edit a zone:

1. On the Zone Editor window, double-click the zone that you want to edit. The 
Modify window opens.

Figure 4–130 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Zone
To add a zone:

1. On the Zone Editor window, click Create Record. The Create Record window 
opens.
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Figure 4–131 Create Record Window

2. In the Zone and Description fields, enter your desired zone name and description 
for the zone.

3. In the Priority field, enter the priority for this zone that is used for picking.

4. In the Container Type field, select from the List of Values, the type of container 
(pallet, roll cage, and so on) used for case picking or forward case picking.

5. In the Unit Pick Container Type field, select from the List of Values, the type of 
container (tote, carton, and so on) used for unit picking.

6. In the UPS Code field, select from the List of Values, the Unit Pick System used in 
this zone to perform unit picks.

7. In the Cycle Count Plan field, select the Cycle Count Plan that is used in this zone.

8. In the Region Field (informational only), select from the List of Values, the region 
in which this zone exists.

9. In the Distribution Method, select either Pick Clean (space) or Efficiency (speed):

■ Pick to clean means the software attempts to empty as many locations as 
possible when performing picks and replenishment. This may mean the 
operators visit more locations.

■ Efficiency means to select as few locations as possible to get inventory 
required for picks and replenishments.

10. In the Weight UOM field, select the appropriate weight Unit of Measure for this 
zone.

11. In the Dimension UOM field, select the appropriate dimension Unit of Measure for 
this zone.

12. In the Zone Group field, select from the List of Values, the Forward Case Pick 
Zone Group desired. The assignment of the FCP Zone group to this Zone means 

Note: The following fields are all specific to Forward Case Pick 
locations (FCP Details).
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that Forward Case Picking is done in this zone as well as other zones. The FCP 
Zone group allows the pickers to cross over forward pick zones/locations with the 
same pick to container (pallet).

13. In the Zone Group Sequence Number field, enter the sequence when you want this 
zone picked. In other words, if the Zone Group allows picking from zones 1 
through 3 you can force picking in zone 2 first by making zone 2's sequence 
number 1.

14. In the number of pickers per pallet field, enter the number of pick to pallets that 
will be used per user. This would normally be one unless the equipment (forklift, 
and so on) utilized can handle multiple pallets at same time.

15. In the group configuration field, select either minimum stop or maximum pallet:

■ Minimum Stop means that when the next pick will not fit (cubed out) on the 
pallet, the pallet is declared full and you will not leap frog to another location 
to try to fit additional picks on the pallet.

■ Maximum Pallet means keep moving through the pick path skipping locations 
as needed until the pallet is full (cubed out) or the path has come to an end.

16. In the Spread Picks field, select either case, location, or off:

■ Spreading by case means placing each new individual case picked on 
alternating pallets.

■ Spread by location means placing all cases from a given location on one pallet 
and then placing the next location's cases on to another pallet.

■ When spreading is turned off, the user can manually select the pallet for the 
pick.

17. In the Maximum Weight field, enter the maximum amount of weight allowed on 
the pallet for that specific zone.

18. In the Maximum Cube field, enter the maximum amount of cube allowed on the 
pallet for that specific zone.

19. In the Weight Tolerance field, enter a percentage of weight you will allow the 
pallet to be under or over and still be considered full. For example, if the 
maximum weight for this zone is 400 pounds and you have a 5% weight tolerance, 
the pallet would be considered full if between 380 and 420 pounds.

20. In the Cube Tolerance field, enter a percentage of cube you will allow the pallet to 
be under or over and still be considered full. For example, if the maximum cube 
for this zone is 500 and you have a 10% weight tolerance, the pallet would be 
considered full if between 450 and 550.

21. In the Value Type field, select either amount or percent:

■ If you select amount, this means the values in the maximum weight and 
maximum cube fields are absolute numbers and not percentages.

■ If you select percentage, this means the values in the maximum weight and 
cube fields are percentages.

22. Select the Group by Destination check box if you want your pallets grouped by 
destination (store).

23. Click Save to save the changes and close the Create Record window.

Delete a Zone
To delete a zone:



Setup - Item

Support Functions 4-113

1. On the Zone Editor window, select the zone that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Zone Editor Window
Click Exit to close the window.

Setup - Item
The Item Setup module is used to further define item warehouse characteristics to 
optimize distribution processing. It is also used to associate items to specific activities 
and locations within the DC.

This section includes the following topics:

■ Apply Item Class Editor

■ Differentiator Group Inquiry

■ Differentiator Inquiry

■ Item Attributes Editor

■ Item Class Editor

■ Build Item Class Rules

■ Item Class Editor

■ Item Default Editor

■ Item Differentiator Inquiry

■ Item Master Editor

■ Item Master Inquiry

■ Item Supplier Editor

■ Product Classification Inquiry

■ Product Classification Matrix

■ Transport Asset Editor

■ Transport Asset Item Editor

■ UPC Inquiry

■ Vendor Editor

Apply Item Class Editor
The Apply Item Class Editor allows you to:

■ Assign multiple items to a selected item class or

■ Assign an item class to a selected item

When you save the assignments, the items inherit the default characteristics, 
attributes, processes, and equipment classes of the item class.

Different fields appear on the window depending on whether you query by item or by 
item class.
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When you query by item class, the items that match the build rules of the item class 
and the items that are already assigned to the item class appear.

If there are any discrepancies between the settings of the items and the build rules of 
the item class, the Exceptions check box is selected next to such items.

When you query by item, the item classes whose build rules match the settings of the 
selected item appear. The Current check box is selected next to the item class, if any, 
that the item is assigned to.

From the main menu, select Setup Item > Apply Item Class. The Apply Item Class 
window opens.

Display Items by Item Class
1. If any items or item classes are currently displayed, click Clear.

2. Click Query.

3. In the Item Class field, enter the name of the item class, or click the LOV button 
and select the item class.

4. Click Search. The items that match the build rules of or are assigned to the item 
class appear on the Apply Item Class window.

Figure 4–132 Apply Item Class Window

Assign Items to an Item Class
1. On the Apply Item Class window, click Apply Class. The Apply Class window 

opens.

Note: You can also access this window from the New Item Inquiry 
window and the Item Class Editor window.
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Figure 4–133 Apply Class Window

2. To assign items:

a. Select the check box next to the desired items on the Available Items table.

b. Click Assign. The selected items are moved to the Assigned Items table.

3. To remove assigned items:

a. Select the check box next to the desired items on the Assigned Items table.

b. Click Unassign. The selected items are moved to the Available Items table.

4. Click Save/Apply to save the changes and close the Apply Item Class (Assign 
Items) window.

Display Item Classes by Item
1. If any items or item classes are currently displayed, click Clear.

2. Click Query.

Note: The items that are currently assigned to the location class 
appear in the Assigned Items table. The remaining items that match 
the build rules appear in the Available Items table.

Note: In the Apply Item Class (Assign Items) window, you can 1) 
click Assign All to move all items to the Assigned Items table or 2) 
click Unassign All to move all items to the Available Items table. All 
items are moved whether or not the check boxes are selected.
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3. In the Item ID field, enter the ID of the item, or click the LOV button and select the 
item.

4. Click Search. The item classes that match the selected item appear. The Current 
check box is selected next to the item class, if any, that is currently assigned to the 
item on the Apply Item Class (by Item) window.

Assign an Item Class to an Item

1. On the Apply Item Class window, select the item class that you want to assign to 
an item.

2. Click Apply Class. The Apply Item Class (Assign Item Class) window opens.

3. If the item class named in the New Item Class field is correct, click Save/Apply. 
The Apply Item Class (Assign Item Class) window is closed and the item class is 
assigned to the selected item.

Exit the Apply Item Class Window
Click Exit to close the window.

Differentiator Group Inquiry
The Differentiator Group Inquiry window allows you to view the diff groups that 
were received from the host system. You can view the diffs that are associated with 
each diff group.

Diffs are used to distinguish between items within an item family. The items may vary 
by size, color, flavor, scent, and so on. Diff groups are used to group multiple diffs of 
the same type under one ID.

From the main menu, select Setup Item > Differentiator Group Inquiry. The 
Differentiator Group Inquiry window opens.

Note: This procedure is applicable if the item matches more than one 
item class.
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Figure 4–134 Differentiator Group Inquiry Window

Display All Diff Groups
Click Search.

Display a Diff Group
1. If any diff groups are currently displayed, click Clear.

2. Click Query.

3. In either the Diff Group Description or Diff Group ID fields, enter a full or partial 
description or ID, or click either LOV button and select a diff group.

4. Click Search. The diff groups that match the criterion are displayed.

View Diffs
Select a diff group in the Diff Group table. The diffs associated with the diff group 
appear in the Diff table.

Exit the Differentiator Group Inquiry Window
Click Exit to close the window.

Differentiator Inquiry
The Differentiator Inquiry allows you to view the diffs that were received from the 
host system.

Diffs are used to distinguish between items within an item family. The items may vary 
by size, color, flavor, scent, and so on.

Note: You can also access this window from the Item Differentiator 
Inquiry window.
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From the main menu, select Setup Item > Differentiator Inquiry. The Differentiator 
Inquiry window opens.

Figure 4–135 Differentiator Inquiry Window

Display All Diffs
Click Search.

Display a Diff
1. If any diffs are currently displayed, click Clear.

2. Click Query.

3. In either the Diff Description or Diff ID fields, enter a full or partial description or 
ID, or click either LOV button and select a diff.

4. Click Search. The diffs that match the criterion appear.

Exit the Differentiator Inquiry Window
Click Exit to close the window.

Item Attributes Editor
The Item Attribute Editor allows you to assign attributes to an item. Your choices are 
restricted to those attributes that have been marked as available for item classes.

From this editor, you can access the Attribute WIP Editor window in order to assign 
WIP codes to an attribute.

From this editor, you can access the Attribute Type Editor window in order to edit the 
attribute type that is associated with an attribute.

Note: You can also access this window from the Item Differentiator 
Inquiry window.
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From the main menu, select Setup Item > Item Attributes Editor. The Item Attributes 
Editor window opens.

Figure 4–136 Item Attributes Editor Window

Display Item Attributes
1. If attributes for an item are currently displayed, click Clear.

2. Click Query.

3. In the Item ID field, enter the item ID, or click the LOV button and select an item.

4. Click Search. The attributes assigned to the selected item appear.

Edit an Item Attribute
1. On the Item Attribute Editor window, double-click the item attribute that you 

want to edit. The Modify window opens.

Figure 4–137 Modify Window

2. Select or clear the Attribute Enabled check box as necessary.

3. Click Save to save any changes and close the Modify window.

Note: You can also access this window from the following windows: 
Item Master Editor, Item Master Inquiry, and Quality Assurance.
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Assign an Attribute to an Item
1. On the Item Attribute Editor window, click Create Record. The Create Record 

window opens.

Figure 4–138 Create Record Window

2. In the Attribute field, enter the ID of the attribute that you want to associate with 
the current item, or click the LOV button and select the attribute.

3. To make the item attribute available to users, select the Attribute Enabled check 
box.

4. Click Save to save the changes and close the Create Record window.

Delete an Item Attribute
1. On the Item Attribute Editor window, select the attribute that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Item Attribute Editor Window
Click Exit to close the window.

Note: If no item was identified on the Item Attribute Editor window, 
enter the ID of the item in the Item ID field on the Create Record 
window.



Setup - Item

Support Functions 4-121

Item Class Editor
The Item Class Editor allows you to view, add, or delete item classes. An item class is 
used to group items with similar processing needs. You define the rules of the class in 
order to determine which items should belong to the class. As items are received from 
a host system, RWMS determines which item class the item belongs to. Items that 
match the rules inherit the default characteristics, attributes, processes, and equipment 
classes that were assigned to the item class. The processes and equipment classes are 
applied at the item configuration level.

You can access the Apply Item Class window in order to assign items to the item class. 
The default characteristics, attributes, processes, and equipment classes of the item 
class are then applied to the selected items.

From the main menu, select Setup Item > Item Class Editor. The Item Class Editor 
window opens.

Figure 4–139 Item Class Editor Window

Display All Item Classes
Click Search.

Assign Defaults
1. On the Item Class Editor window, select the item class that you want to edit.

2. Click Defaults. The Item Class Default window opens.

Figure 4–140 Item Class Default Window
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3. To add a default:

a. In the Column field, select the desired characteristic from the drop-down list.

b. In the Value field, enter the values of the characteristic.

4. To remove a default:

a. Select the desired characteristic.

b. Click Clear. The record is removed from the table.

5. [Optional] To apply the defaults to the items that are currently assigned to the item 
class, click Save/Apply.

6. Click Save to save the defaults and close the Item Class Default window.

Assign Attributes
1. On the Item Class Editor window, select the item class that you want to edit.

2. Click Assign Attributes. The Item Class Attributes window opens.

Figure 4–141 Item Class Attribute Window

3. To assign attributes, select an attribute from the drop-down lists.

4. Click Save to save any changes and close the Attributes window.
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Assign Equipment Classes
From the main menu, select Setup Item > Item Class Editor. The Item Class Editor 
window opens.

Figure 4–142 Item Class Editor Window

Display All Item Classes
Click Search.

Assign Equipment Classes
1. On the Item Class Editor window, select the item class that you want to edit.

2. Click Equipment Class. The current assignments appear on the Item Class 
Dimension Activity Equipment window.

Figure 4–143 Item Class Dimension Activity Equipment Window

3. Click Assign Eqp Cl. The Assign Item Class Dimension Activity Equipment 
window opens.

Note: This window is also accessible from the New Item Inquiry 
window.
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Figure 4–144 Assign Item Class Dimension Activity Equipment Window

4. In the Item Config field, enter the ID of the item configuration that you want to 
edit, or click the LOV button and select the item configuration. The available 
equipment classes appear.

5. To assign equipment classes:

a. Select the check box next to the desired equipment classes on the Available 
Equip Classes table.

b. Click Assign. The selected equipment classes are moved to the Assigned 
Equip Classes table.

6. To remove assigned equipment classes:

a. Select the check box next to the desired equipment classes on the Assigned 
Equip Classes table.

b. Click Unassign. The selected equipment classes are moved to the Available 
Equip Class table.

7. To make the assigned equipment classes available to users, select the Active check 
box next to the appropriate equipment classes.

8. [Optional] To apply the equipment classes to all items that are currently assigned 
to the item class, click Save/Apply.

9. Click Save to save any changes and close the Assign Item Class Config Equipment 
Class window.

10. Click Exit/Cancel to close the Item Class Config Equipment Class window.

Note: In the Assign Item Class Config Equipment Class window, 
you can 1) click Assign All to move all equipment classes to the 
Assigned Equip Classes table or 2) click Unassign All to move all 
equipment classes to the Available Equip Classes table. All equipment 
classes are moved whether or not the check boxes are selected.
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Assign Activities
From the main menu, select Setup Item > Item Class Editor. The Item Class Editor 
window opens.

Figure 4–145 Item Class Editor Window

Display All Item Classes
Click Search.

Assign Activities
1. On the Item Class Editor window, select the item class that you want to edit.

2. Click Assign Activity. The current assignments appear on the Item Class Config 
Activity window.

Figure 4–146 Item Class Config Activity Window

3. Click Assign Activities. The Assign Item Class Dimension Activity Equipment 
window opens.

Note: This window is also accessible from the New Item Inquiry 
window.
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Figure 4–147 Assign Item Class Dimension Activity Equipment Window

4. In the Item Config field, enter the ID of the item configuration that you want to 
edit, or click the LOV button and select the item configuration. The available 
activities appear.

5. [Optional] To filter the activities listed in the Available Activities table, enter the 
name of functional area in the Functional Area field, or click the LOV button and 
select the functional area.

6. To assign activities:

a. Select the check box next to the desired activities on the Available Activities 
table.

b. Click Assign. The selected activities are moved to the Assigned Activities 
table.

7. To remove assigned activities:

a. Select the check box next to the desired activities on the Assigned Activities 
table.

b. Click Unassign. The selected activities are moved to the Available Activities 
table.

8. To make the assigned activities available to users, select the Active check box next 
to the appropriate activities.

9. [Optional] To apply the activities to all items that are currently assigned to the 
item class, click Save/Apply.

10. Click Save to save any changes and close the Assign Item Class Dimension 
Activity Equipment window.

11. Click Exit/Cancel to close the Item Class Config Activity window.

Note: In the Assign Item Class Config Activities window, you can 1) 
click Assign All to move all activities to the Assigned Activities table 
or 2) click Unassign All to move all activities to the Available 
Activities table. All activities are moved whether or not the check 
boxes are selected.
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Resequence the Activities
1. On the Item Class Editor window, select the item class that you want to edit.

2. Click Assign Activity. The current assignments appear on the Item Class Config 
Activity window.

3. Click Assign Activity. The Assign Item Class Config Activity window opens.

4. In the Item Config field, enter the ID of the item configuration that you want to 
edit, or click the LOV button and select the item configuration. The available and 
assigned activities appear.

5. To resequence the assigned activities:

a. Select the activity to be moved.

b. To move the activity closer to the top of the list, click Move Up.

c. To move the activity closer to the bottom of the list, click Move Down.

6. Click Save to save any changes and close the Assign Item Class Config Activities 
window.

7. Click Exit/Cancel to close the Item Class Config Activity window.

Exit the Item Class Editor Window
Click Exit to close the window.

Build Item Class Rules
From the main menu, select Setup Item > Item Class Editor. The Item Class Editor 
window opens.

Figure 4–148 Item Class Editor Window

Display All Item Classes
Click Search.

Build Rules for an Item Class
The Load Item Class Rules window allows you to build and apply the rules defined 
for this specific item class:

■ Load/Append: Add the defined rules to any rules that may already exist for the 
current item class.

■ Load/Overwrite: Replace any rules that may already exist.
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The number of rules that each item class has opens on the Load Item Class Rules 
window. To see the rules for an item class, double-click that item class .

1. On the Item Class Editor window, select the item class that you want to edit.

2. Click Build Rules. The Build Rules window opens.

Figure 4–149 Build Rules Window

3. Define the rules for selecting the members of the item class:

a. In the Column fields, select the limiting factors.

b. In the Operator fields, select the relational operators.

c. In the Value fields, enter the values of the limiting factors.

4. [Optional] To copy the rules from another item class:

a. On the Build Rules window, click Load. The Load Item Class Rules window 
opens.

Figure 4–150 Load Item Class Rules Window

b. Select the item class whose rules you want to copy.

Note: To view the rules for an item class, double-click the desired 
item class. The rules appear in the Item Class Rules View Only 
window.
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c. Click Load/Append to add the rules to any existing rules, or click 
Load/Overwrite to replace any existing rules with the selected rules. You are 
returned to the Build Rules window.

d. If by appending the rules any duplicates occur, the Dup check box is selected 
next to the duplicate. Select the duplicate rule and click Clear to remove it.

5. Click Save to save the rules and close the Build Rules window.

Exit the Item Class Editor Window
Click Exit to close the window.

Item Class Editor
From the main menu, select Setup Item > Item Class Editor. The Item Class Editor 
window opens.

Figure 4–151 Item Class Editor Window

Display all Item Classes
Click Search.

Display an Item Class
1. If any item classes are currently displayed, click Clear.

2. Click Query.

3. In the Item Class field, enter the name of the item class, or click the LOV button 
and select the item class.

4. Click Search. The item class that matches the search criterion opens.

Note: This window is also accessible from the New Item Inquiry 
window.
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Edit an Item Class
1. On the Item Class Editor window, double-click the item class that you want to 

edit. The Modify window opens.

Figure 4–152 Modify Window

2. Edit the description, priority, and active status of the item class as necessary.

3. Click Save to save any changes and close the Modify window.

Add an Item Class
1. On the Item Class Editor window, click Create Record. The Create Record window 

opens.

Figure 4–153 Create Record Window

2. In the Item Class and Description fields, enter a name and description for the item 
class.

3. In the Priority field, enter the order in which the item class should be applied to an 
item when more than one item class may be applied.

4. To indicate whether the item class should be made available for use, select or clear 
the Active Flag check box.

Note: You cannot edit an item class if the system indicator is 
selected.
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5. Click Save to save any changes and close the Create Record window.

Copy an Item Class
1. On the Item Class Editor window, select the item class that you want to copy.

2. Click Copy. The Copy Existing Item Class window opens.

3. In the New Item Class and New Description fields, enter an ID and description for 
the item class that you want to create.

4. Click Save to copy the selected item class and close the Copy Existing Item Class 
window.

Delete an Item Class
1. On the Item Class Editor window, select the item class that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Item Class Editor Window
Click Exit to close the window.

Item Default Editor
The Item Default Editor allows you to set up and apply default characteristics for 
items at the department, class, subclass, or vendor style level. These characteristics are 
imperative to DC processing and are often not maintained by the host system.

The characteristics include user defined attributes, dimensions, and handling 
instructions.

An item inherits the item defaults that were set at the lowest level. For example: If item 
defaults are set up for department 1000, all classes, subclasses, and vendor styles in 
department 1000 inherit the same item defaults. If item defaults are set up for class 
4000 in department 1000, all subclasses in department 1000/class 4000 inherit the class 
level defaults instead of the department level defaults.

You can access the Attribute Default Editor window in order to define the default 
attributes.

Note: You cannot delete an item class if the system indicator is 
selected or if any build rules, defaults, activities, or equipment classes 
have been assigned to the item class.
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From the main menu, select Setup Item > Item Default Editor. The Item Default Editor 
window opens.

Figure 4–154 Item Default Editor Window

Display Item Defaults
1. Click Query.

2. Enter search criteria in the Department, Class, Subclass, and Vendor Style fields as 
necessary.

3. Click Search. The defaults for the selected merchandise level appear.

Note: You can choose to edit defaults at any one of the merchandise 
levels.
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Edit Item Defaults
1. On the Item Default Editor window, double-click any detail field. The Modify 

window opens.

Figure 4–155 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

4. If changes are made to defaults for a vendor style, click Update Style. The changes 
are applied to the items associated with the vendor style.
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Add Item Defaults
1. On the Item Default Editor window, click Create Record. The Create Record 

window opens.

Figure 4–156 Create Record Window

2. In the Department, Class, Subclass, and Vendor Style fields, enter the IDs for the 
merchandise levels that you want to set up.

3. Enter details in the required fields:

a. Single Container Bulk: Enter Y (Yes) or N (No) to indicate whether the item is 
a single container bulk item.

b. In the Unit Pick System Code field, enter the code for the unit pick system or 
click the LOV button and select the unit pick system.

c. In the CD Unit Pick System field, enter the code for the CD unit pick system or 
click the LOV button and select the code.

d. In the Roundable field, enter Y (Yes) or N (No) to indicate that the quantity 
may be rounded to the nearest case when replenished.

e. In the Catch Weight field, enter Y (Yes) or N (No) to indicate whether the item 
must be weighed upon receipt.

f. In the Perishable Ind field, enter Y (Yes) or N (No) to indicate whether the item 
is perishable.

g. In the Preticket Flag field, enter Y (Yes) or N (No) to indicate whether the item 
must ticketed upon receipt.

h. In the Single Price Flag field, enter Y (Yes) or N (No) to indicate whether the 
item has a single currency ticket.

i. In the Planned Residual field, enter Y (Yes) or N (No) to indicate whether the 
residuals are to be returned to stock.
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4. Enter any additional details as necessary.

5. Click Save to save the changes and close the Create Record window. The changes 
are applied to all items within the selected merchandise hierarchy.

6. If changes are made to defaults for a vendor style, click Update Style. The changes 
are applied to the items associated with the vendor style.

Delete Item Defaults
1. On the Item Default Editor window, click Delete Record.

2. When prompted to delete the record, click Yes. The changes are applied to all 
items within the selected merchandise hierarchy.

Exit the Item Default Editor Window
Click Exit to close the window.

Item Differentiator Inquiry
The Item Differentiator Inquiry allows you to view all the diff groups and diffs that are 
associated with an item.

Diffs are used to distinguish between items within an item family. The items may vary 
by size, color, flavor, scent, and so on. Diff groups are used to group multiple diffs of 
the same type under one ID.

You can access the Differentiator Inquiry window and the Differentiator Group 
Inquiry window.

From the main menu, select Setup Item > Item Differentiator Inquiry. The Item 
Differentiator Inquiry window opens.

Figure 4–157 Item Differentiator Inquiry Window

Display Item Diffs
1. If an item is currently displayed, click Clear.

2. Click Query.

3. Enter an item ID or UPC in the appropriate field, or click either LOV button and 
select the item.

Note: You can also access this window from the Item Master Editor 
window and the Item Master Inquiry window.
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4. Click Search. The diff groups and diffs that match the criterion appear.

View Diffs
Select a diff group in the Diff/Group table. The diffs associated with the diff group 
appear in the Diff table.

Exit the Item Differentiator Inquiry Window
Click Exit to close the window.

Item Master Editor
The Item Master Editor allows you to view and edit all item IDs currently defined in 
RWMS. These items comprise the merchandise that is supported at the distribution 
center. Items may be entered manually, but they are generally received from a host 
system.

After the item is added to RWMS, you can access the following windows in order to 
view or maintain additional details:

■ Item Supplier Editor: View vendors, origin countries, and item configurations. 
Edit the TI (tier) and HI (height) for pallets in the distribution center. Maintain 
item configurations, including dimensions, equipment classes, and processes.

■ Item UPC Inquiry: View universal product codes (UPC).

■ Item Attribute Editor: Maintain item attributes and attribute types.

■ Item Differentiator Inquiry: View item diff groups and diffs.

■ Bill of Materials Editor: Maintain the component items of a kit.

■ Currency Price: View retail prices in multiple currencies if tickets for an item 
contain multiple currencies.

For Labor Management you must set the following the two fields in the Item Master:

■ Average Unit Pick Grab Quantity

■ Average Case Pick Grab Quantity

Figure 4–158 Item Master

In the Average Unit Pick Grab Quantity field, enter the average number of units a 
picker can grab at one time from a pick location. For example, if you are picking 
individual cell phones, how many phones can you grab in one handful. If you can 
grab 3 each time then enter the value 3 in this field. The entered value is divided into 

Note: Both diffs and diff groups may be listed in the Diff/Group 
table. If the Group Flag is Y, the ID refers to a diff group. If the Group 
Flag is N, the ID refers to a diff.
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the pick quantity to determine how many grab elements to apply in the Labor 
standard Calculation. RWMS always defaults this value to 1.

Formula: 
Number of Cell Phones to pick = 12
Divided by Average Unit Pick Grab Qty = 3
Grab Element Applied to Labor Standard = 4 times

In the Average Case Pick Grab Quantity field, enter the average number of cases a 
picker can grab at one time from a pick location.  For example, if you are picking cases 
of cell phones, how many cell phone cases can you grab at one time. If you can grab 2 
cases each time then enter the value 2 in this field. The entered value is divided into 
the pick quantity to determine how many grab elements to apply in the Labor 
standard Calculation. RWMS always defaults this value to 1.

Formula: 
Number of Cell Phones cases to pick = 9
Divided by Average Case Pick Grab Qty = 2
Grab Element Applied to Labor Standard = 5 times

From the main menu, select Setup Item > Item Master Editor. The Item Master Editor 
window opens.

Figure 4–159 Item Master Editor Window

Display an Item
1. If an item is currently displayed, click Clear.

2. Click Query.

Note: You can also access this window from the Quality Assurance 
window.
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3. To search for an item by:

■ Item ID: In the Item ID field, enter the ID of the item, or click the LOV button 
and select the item.

■ UPC: In the UPC field, enter the item's UPC, the LOV button and select the 
item.

4. Click Search. The details for the selected item appear.

5. You can also search for an item using the Build Query link. The Build Query 
window opens.

Figure 4–160 Build Query Window

Select appropriate values using the drop-down menu. Click Run Query link. The 
details of the selected item appear.

Edit an Item
1. On the Item Master Editor window, double-click any of the detail fields. The 

Modify window opens.

Note: Perishable Indicator displays the expiry days for the item. If 
Perishable IND is set to Y, then default expiry days displays. If there is 
no default expiry days, then the value displayed is 0. If Perishable 
IND is set to N the default value displayed is NULL
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Figure 4–161 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add an Item
1. On the Item Master Editor window, click Create Record. The Create Record 

window opens.

Figure 4–162 Create Record Window

2. In the Item ID field, enter the ID of the item.
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3. Enter the following required information:

a. In the Vendor Nbr field, enter the vendor number, of click the LOV button and 
select the vendor.

b. In the Description field, enter a description of the item.

c. In the Standard UOM field, enter the standard unit of measure, or click the 
LOV button and select the standard UOM.

d. In the Unit Pick System field, enter the code for the unit pick system or click 
the LOV button and select the unit pick system.

e. In the Distribution Method field, indicate how merchandise is to be handled 
for distribution.

f.  In the Replen Dist Method field, indicate how merchandise is to be 
replenished.

4. Enter any additional details as necessary.

5. Click Save to save the changes and close the Create Record window.

Item Supplier Editor
1. On the Item Master Editor window, select an item and click Item Supplier Editor. 

The Item Supplier Editor window opens. 

Figure 4–163 Item Supplier Editor Window
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2. Select the data and double-click. The Modify window opens.

Figure 4–164 Modify Window

3. Edit the enabled fields as required. Click Save to save the changes.

Delete an Item
1. On the Item Master Editor window, click Delete Record.

2. When prompted to delete the record, click Yes.

Exit the Item Master Editor Window
Click Exit to close the window.

Item Master Inquiry
The Item Master Inquiry window allows you to view all of the characteristics 
pertaining to an item. These items comprise the merchandise that is supported at the 
distribution center.

You can access the following windows which contain additional details about an item:

■ Item Supplier Editor: Displays the vendors, origin countries, and item 
configurations that are associated with an item. View the equipment classes and 
processes assigned to item configurations.

■ Item UPC Inquiry: Displays universal product codes (UPC) that are associated 
with an item. If there are multiple UPCs, the primary UPC is designated.

■ Item Attribute Editor: Displays the attributes and attribute types that are 
associated with an item.

■ Item Differentiator Inquiry: Displays the diff groups and diffs that are associated 
with an item.

■ Currency Price: Displays retail prices in multiple currencies if an item's ticket 
contains multiple currencies.

This is a view-only window. If you need to edit an item, you must navigate to the Item 
Master Editor window. You may need a higher privilege level to access the Item 
Master Editor window than you would to access the Item Master Inquiry window.
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From the main menu, select Setup Item > Item Master Inquiry. The Item Master 
Inquiry window opens.

Figure 4–165 Item Master Inquiry Window

Display an Item
1. If an item is currently displayed, click Clear.

2. Click Query.

3. To search for an item by:

■ Item ID: In the Item ID field, enter the ID of the item, or click the LOV button 
and select the item.

■ UPC: In the UPC field, enter the item's UPC, the LOV button and select the 
item.

4. Click Search. The details for the selected item appear.

View Additional Details
■ To view the vendors, origin countries, configurations for the item, click Item Supp 

Editor. The Item Supplier Editor window opens. You can also view the equipment 
classes and processes that are assigned at the item configuration level.

■ To view the universal product codes (UPC) for the item, click Item UPC Inquiry. 
The Item UPC Inquiry window opens.

■ To view the attributes and attribute types for the item, click Item Attributes. The 
Item Attribute Editor window opens.

■ To view the diff groups and diffs for the item, click Item Diff Inquiry. The Item 
Differentiator Inquiry window opens.

■ To view retail prices in multiple currencies for the item, click Currency Price. The 
Multi Price Ticketing window opens.



Setup - Item

Support Functions 4-143

Figure 4–166 Item Currency Price Window

Exit the Item Master Inquiry Window
Click Exit to close the window.

Item Supplier Editor
The Item Supplier Editor window allows you to view the suppliers, origin countries, 
and item configurations for an item. You can edit the TI (tier) and HI (height) 
measurements by origin country. You can edit the dimensions, weight, and velocity by 
item configuration. Equipment classes and processes may be assigned at the item 
configuration level.

From the main menu, select Setup Item > Item Supplier Editor. The Item Supplier 
Editor window opens

Figure 4–167 Item Supplier Editor Window
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Display the Suppliers of an Item
1. If the suppliers of an item are currently displayed, click Clear.

2. Click Query.

3. In the Item ID field, enter the item ID, or click the LOV button and select an item.

4. Click Search. The suppliers of the selected item appear.

View Origin Countries and Item Configurations

1. On the Item Supplier Editor window, select a vendor. The origin countries for the 
item/vendor appear in the Origin Country table.

2. Select an origin country. The item configurations for the item/vendor/origin 
country appear in the Item Configuration table.

Edit Ti and HI Measurements
1. On the Item Supplier Editor window, double-click the origin country that you 

want to edit. The Modify Record window opens.

Figure 4–168 Modify Window

2. Edit the DC TI and DC HI fields as necessary.

3. Click Save to save the changes and close the Modify Record window.

Edit an Item Configuration
1. On the Item Supplier Editor window, double-click the item configuration that you 

want to edit. The Modify Record window opens.

Note: You can also access this window from the Item Master Editor 
window and the Item Master Inquiry window.

Note: There are three tables on this window. They are referred to as 
the Vendor table, Origin Country table, and Item Configuration table.
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Figure 4–169 Modify Window

2. Edit the dimensions, weight, and velocity as necessary.

3. Click Save to save the changes and close the Modify Record window.

Assign Equipment Classes
1. On the Item Supplier Editor window, select the item configuration that you want 

to edit.

2. Click Assign Eqp Cl. The Assign Item Dimension Activity Equipment window 
opens.

Figure 4–170 Assign Item Dimension Activity Equipment Window

3. To assign equipment classes:

a. Select the check box next to the desired equipment classes on the Available 
Equip Classes table.
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b. Click Assign. The selected equipment classes are moved to the Assigned 
Equip Classes table.

4. To remove assigned equipment classes:

a. Select the check box next to the desired equipment classes on the Assigned 
Equip Classes table.

b. Click Unassign. The selected equipment classes are moved to the Available 
Equip Class table.

5. To make the assigned equipment classes available to users, select the Active check 
box next to the appropriate equipment classes.

6. Click Save to save any changes and close the Assign Item Config Equipment 
window.

Assign Activities
1. On the Item Supplier Editor window, select the item configuration that you want 

to edit.

2. Click Assign Activities. The Assign Item Dimension Activity Equipment window 
opens.

Figure 4–171 Assign Item Dimension Activity Equipment Window

3. [Optional] To filter the activities listed in the Available Activities table, enter the 
functional area in the Functional Area field, or click the LOV button and select the 
functional area.

4. To assign activities:

Note: In the Assign Item Config Equipment window, you can 1) click 
Assign All to move all equipment classes to the Assigned Equip 
Classes table or 2) click Unassign All to move all equipment classes to 
the Available Equip Classes table. All equipment classes are moved 
whether or not the check boxes are selected.
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a. Select the check box next to the desired activities on the Available Activities 
table.

b. Click Assign. The selected activities are moved to the Assigned Activities 
table.

5. To remove assigned activities:

a. Select the check box next to the desired activities on the Assigned Activities 
table.

b. Click Unassign. The selected activities are moved to the Available Activities 
table.

6. To make the assigned activities available to users, select the Active check box next 
to the appropriate activities.

7. To assign activities for another item configuration, select the desired item 
configuration from the Item Config drop-down list. Repeat the previous steps.

8. Click Save to save any changes and close the Assign Item Dimension Activity 
Equipment window.

Resequence the Activities
1. On the Item Supplier Editor window, select the item configuration that you want 

to edit.

2. Click Assign Activities. The Assign Item Dimension Activity Equipment window 
opens.

3. To resequence the assigned activities:

a. Select the activity to be moved.

b. To move the activity closer to the top of the list, click Move Up.

c. To move the activity closer to the bottom of the list, click Move Down.

4. Click Save to save any changes and close the Assign Item Dimension Activity 
Equipment window.

Assign Code 128
1. On the Item Supplier Editor window, select the item configuration that you want 

to edit.

2. Click Code 128. The Assign Code128 Identifier window opens.

Note: In the Assign Item Dimension Activity Equipment window, 
you can 1) click Assign All to move all activities to the Assigned 
Activities table or 2) click Unassign All to move all activities to the 
Available Activities table. All activities are moved whether or not the 
check boxes are selected.
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Figure 4–172 Assign Code128 Identifier Window

3. To assign activities:

a. Select the check box next to the desired AI on the Available table.

b. Click Assign. The selected activities are moved to the Assigned AI table.

4. To remove assigned activities:

a. Select the check box next to the desired AI on the Assigned AI table.

b. Click Unassign. The selected activities are moved to the Available AI table.

5. Click Save to save any changes and close the Assign Code128 Identifier window.

Exit the Item Supplier Editor Window
Click Exit to close the window.

Product Classification Inquiry
The Product Classification Inquiry window is used to view the Product Classification 
Codes in RWMS. The product Classification Codes are published by the host system 
and consumed by RWMS. As this is an Inquiry window, no functionality other than 
view is available.

From the main menu, select Setup Item > Product Classification Inquiry. The Product 
Classification Inquiry window opens.

Note:  In the Assign Code128 Identifier window, you can 1) click 
Assign All to move all activities to the Assigned AI table or 2) click 
Unassign All to move all activities to the Available AI table. All 
identifiers are moved whether or not the check boxes are selected.
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Figure 4–173 Product Classification Inquiry Window

Product Classification Matrix
The Product Classification Matrix window allows a user to link specific Product 
Classifications that cannot be placed (combined) in the same container (case or tote). 
An example would be food with bleach.

From the main menu, select Setup Item > Product Classification Matrix. The Product 
Classification Matrix window opens.

Figure 4–174 Product Classification Matrix Window

Display a Product Class Code and Its Uncombinable Product Class Codes
1. Enter or select a Product Class Code from the list of values.

2. Click Search.

RWMS displays all of the Product Class Codes that are currently defined as not 
combinable with the Product Class Code entered at the top of the window 
(header).
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Select All
The Select All link is provided so you can select all Product Class Codes except the one 
in the header record. RWMS automatically selects  each of these class codes with a 
check mark. If you want all of these class codes to not be combinable with the header 
class code, click the Save link. If you want to clear some class codes, click the check 
mark in the Select column to clear them. When finished, click Save.

Deselect All
The Deselect All link is provided so you can clear all Product Class Codes except the 
one in the header record. RWMS automatically clears the check mark next to each of 
the class codes. Click Save to update RWMS.

Update Email
The Update Email link opens a window where you can enter an e-mail address. When 
an e-mail address is entered, RWMS triggers an e-mail every time a new product 
classification code is downloaded from the host management system.

Figure 4–175 Update Email Window

Transport Asset Editor
The Transport Asset Editor is used to create transport assets. This editor allows you to 
assign an item ID to a transport asset as well as assigning an asset type and ID.

From the main menu, select Setup Item > Transport Asset Editor. The Transport Asset 
Editor window opens.

Figure 4–176 Transport Asset Editor Window
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View an Item
1. If an item is currently displayed, click Clear.

2. Click Query.

3. To search for an item by:

■ Transport Item ID: In the Transport Item ID field, enter the ID of the item, or 
click the LOV button and select the item.

■ Transport: In the Transport field, enter the Transport's ID, or click the LOV 
button and select the item.

■ Vendor Name: In the Vendor Name field, enter the name of the vendor, or 
click the LOV button and select the item.

■ Asset Type: In the Asset Type field, enter the type in the field, or click the LOV 
button and select the item.

4. Click Search. The details for the selected item appear.

Create an Item

To create a Transport Asset item:

1. Click Create Record. The Create Record window opens.

Figure 4–177 Create Record Window 

2. Enter the Transport Item ID.

3. Enter the Description.

4. Enter the Transport Tag.

5. Enter the Asset Type.

6. Select a Pick Code.

Note: In order to set up an item as a transport asset, that item must 
be identified as a transport asset on the item_master table.
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7. Select if it is a unique item, if applicable.

8. Enter the ID Code.

9. Click Save.

10. Click Exit. The Transport Asset Editor window reopens.

Delete an Item
To delete a Transport Asset item:

1. Select a transport asset item.

2. Click Delete Record.

Exit the Transport Asset Editor Window
Click Exit to close the window.

Transport Asset Item Editor
The Transport Asset Item Editor is used associate a regular merchandise item to a 
transport asset item.

From the main menu, select Setup Item > Transport Asset Item Editor. The Transport 
Asset Item Editor window opens.

Figure 4–178 Transport Asset Item Editor Window

View an Item
1. If an item is currently displayed, click Clear .

2. Click Query.

3. To search for an item by:

■ Transport Item ID: In the Transport Item ID field, enter the ID of the item, or 
click the LOV button and select the item.

■ Transport: In the Transport field, enter the Transport's ID, or click the LOV 
button and select the item.

■ Vendor Name: In the Vendor Name field, enter the name of the vendor, or 
click the LOV button and select the item.

■ Asset Type: In the Asset Type field, enter the type in the field, or click the LOV 
button and select the item.

4. Click Search. The details for the selected item appear.
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Create a Transport Asset to Item Association

To create a transport asset item:

1. Click Create Record. The Create Record window opens.

Figure 4–179 Create Record 

2. Enter the Item ID.

3. Enter the Description.

4. Enter the Transport Item ID.

5. Enter the Description.

6. Enter the Asset Type.

7. Select if it is a default item, if applicable.

8. Click Save.

Note: Before associating a transport asset to an item, that transport 
asset must be set up properly (see 'Create a Transport Asset' section).
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9. Click Exit. The Transport Asset Item Editor window reopens.

Figure 4–180 Transport Asset Item Editor Window

Assign by Item/Item Class/Vendor
To assign by item:

1. Click Assign by Item or Assign by Item Class or Assign by Vendor. The Assign 
Transport Items window opens.

Figure 4–181 Assign Transport Items Window

2. Enter the Item ID, if applicable.

3. Enter the Description, if applicable.

4. Enter the Item Class, if applicable.

5. Enter the Vendor, if applicable.
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6. Enter the Asset Type, if applicable.

7. Select the available transport items to assign and click Assign.

8. Click Save.

9. Click Exit. The Transport Asset Item Editor window reopens.

Delete an Item
To delete a transport asset item:

1. Select a transport asset item.

2. Click Delete Record.

Exit the Transport Asset Editor window
Click Exit to close the window.

UPC Inquiry
The UPC Inquiry window allows you to view the universal product codes (UPC) that 
are associated with an item. If multiple UPCs exist for an item, one is designated as the 
primary UPC.

From the main menu, select Setup Item > UPC Inquiry. The Item UPC Inquiry window 
opens.

Figure 4–182 UPC Inquiry Window

Display Item UPCs
1. If an item is currently displayed, click Clear.

2. Click Query.

3. Enter an item ID or UPC in the appropriate field, or click either LOV button and 
select the item.

4. Click Search. The UPCs for the selected item appear.

Note: You can also access this window from the Item Master Editor 
window and the Item Master Inquiry window.
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Exit the Item UPC Inquiry Window
Click Exit to close the window.

Vendor Editor
The Vendor Editor allows you to view the vendors downloaded from the host system. 
Once downloaded, users can edit sampling and frequency percentages. You can also 
indicate whether the catch weight process may be bypassed when containers are 
received from the vendor.

If you enter quality audit (QA) and vendor audit (VA) details, the appropriate WIP 
codes are automatically assigned to inbound containers from the vendor. You can enter 
the following information about quality audits and vendor audits:

■ Frequency: Percentage of shipments to be audited.

■ Percent sampling: Percentage of each shipment to be audited.

From the main menu, select Setup Item > Vendor Editor. The Vendor Editor window 
opens.

Figure 4–183 Vendor Editor Window

Display All Vendors
Click Search.

Display One or Multiple Vendors
1. If any vendors are currently displayed, click Clear.

2. Click Query.

3. In the Vendor Nbr field, enter a full or partial vendor number, or click the LOV 
button and select the vendor.

4. Click Search. The vendors that match the full or partial vendor number appear.

View Addresses
1. On the Vendor Editor window, select the vendor that you want to view in detail.

2. Click Vendor Address. The vendor's addresses appear in the Vendor Address 
window.
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Figure 4–184 Vendor Address Window

3. Click Exit/Cancel to close the Vendor Address window.

Edit Vendor Audits
1. On the Vendor Editor window, double-click the vendor that you want to edit. The 

Modify window opens.

Figure 4–185 Modify Window

2. Enter sampling and frequency percentages in the appropriate fields.

3. To bypass weighing containers from the vendor, select the Bypass Check Weigh 
check box as necessary.

4. Click Save to save the changes and close the Modify window.

Exit the Vendor Editor Window
Click Exit to close the window.

Note: Frequency indicates the percentage of shipments to be audited. 
Sampling indicates the percentage of each shipment to be audited.
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Setup - Labor Management
Labor generally represents the largest cost component of a Distribution Center's 
operating budget. Yet relatively few distribution operations try to optimize this critical 
resource. The Labor Management Module provided in Oracle Retail Warehouse 
Management System helps to minimize labor inefficiencies and reduce costs within a 
warehouse operation by improving employee performance.

Labor Management is enabled for the following activities: Transport (putaway, 
directed move), Bulk Picking, Bulk Replenishment, Case Picking, Case Replenishment, 
Unit Picking, Unit Replenishment, Put to Store Case, Put to Store Unit, and Pick to 
Cart.

Labor Management is not supported in Receiving, Cycle Counting, PTO Picking, 3rd 
Party Picking or Replenishment (Remove), and Loading Trailers.

The Labor Management setup module is used to define the labor components required 
to establish an Engineered Standard at an activity level. This includes defining Labor 
Elements (System and Physical), Labor Factors, Labor Conditions, Labor Allowances, 
Labor Code Zones, and creating Labor Code Templates.

This section includes the following topics:

■ Labor Elements Editor

■ Labor Factors Editor

■ Labor Conditions Editor

■ Labor Allowance Editor

■ Labor Codes Zone Editor

■ Labor Template Editor

■ Z Coordinate Rules Editor

The following are additional setup requirements to enable Labor Management:

1. Determine your Global Unit of Measure settings before enabling Labor 
Management. RWMS uses these Global Unit of Measure settings in the final labor 
management calculations to determine the engineered standard.

a. SYS_DIMEN_UOM (feet, inches, meters, centimeters, and so on)

b. SYS_SPEED_UOM (mile per hour, kilometers per hour, and so on)

c. SYS_TIME_UOM (minutes, seconds, TMUs)

d. SYS_WEIGHT_UOM (pounds, ounces, grams, milligrams, and so on.)

2. Set system parameter TASK_LOG to 2 in order to get task log and task log details. 
This must be edited using SQL.

3. Set the following system parameters:

■ ENABLE_LABOR_MGMT to Yes

■ DISPLAY_STANDARD to Yes if you want the users to view the Labor 
Standard results on the RF Labor Standard Review.

Note: These four UOM system parameters can only be updated 
using SQL.
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■ LABOR_MGMT_LOG to 1 to populate the Labor Calculation details in the 
LABOR_MGMT_CALC_LOG and LABOR_MGMT_CALC_LOG_DETAILS 
tables.

4. Make sure you have assigned X, Y, Z coordinates to all of your locations in the 
Location Editor found in the Setup Location Module.

5. Make sure you have defined all of your reference points and assigned X, Y, Z 
coordinates to each Reference point in the Reference Point Editor found in the 
Setup Location Module.

6. Make sure you have associated each Reference Point to other line of sight 
Reference Points in the Reference Point Mapping Editor found in the Setup 
Location Module.

7. Make sure you have assigned individual locations to all reference points that are 
visible from that location and defined whether the reference point allows for travel 
both ways, inbound only, or outbound only in the Location Reference Editor found 
in the Setup Location Module.

8. Make sure the Labor Management flag is set to Yes (selected) at the Activity Level 
in the Activity Editor found in the Setup - Activity Module.

Labor Elements Editor
The Labor Elements Editor is used to define individual (atomic) elements that can be 
assigned to labor standard templates. The Element Editor is seeded upon installation 
with all system elements and exception elements for all supported activities. The 
Element Editor also supports the creation and deletion of user defined elements. Each 
element has a unique element code with associated description and indicates Element 
Handling UOM (units, cases, pallets, and so on.). This editor serves as a master library 
of elements and the same element can be utilized in as many labor standards as 
required. Many of the elements are repeated across activities.

For both RWMS and exception elements you can edit the time allotted (constant or 
variable value) to complete the element.

To access the Labor Elements Editor, navigate to Setup - Labor Management, and select 
Labor Elements. The Labor Elements Editor window opens.

Figure 4–186 Labor Elements Editor Window
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Edit a Labor Element
1. On the Labor Elements Editor move the cursor to the desired Element and then 

click the Edit icon on the tool bar. The Modify window opens.

Figure 4–187 Modify Window

2. Edit the following fields as needed:

a. Handling UOM (only editable for user defined elements)

b. Type (Constant or Variable). This is information only.

c. Value (time allotted to this element). The value can be edited in the Labor 
Template after importing it.

d. UOM (time unit of measure)

e. Value Source (historical, guestimation, engineered, and so on). This field is 
informational only.

f. Factor Code 

g. Condition Code (only for user defined elements)

3. Click Save to save any changes and close the Modify window.

Add a Labor Element
1. On the Labor Elements Editor click the Create icon on the tool bar. The Create 

Record window opens.

Note: RWMS can only create User Defined Elements. Users cannot 
create or delete System and or Exception Elements.
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Figure 4–188 Create Record Window

2. In the Element Code field, enter the short code name for this element.

3. In the Description field, enter the long description for this element.

4. In the Handling UOM field, select the unit of measure for the Element (Inner, 
Cases, Pallets, Grab Case, Grab Inner). This may or may not match the UOM for 
the entire Activity. This field is optional.

5. In the Type field, enter the valid type either constant or variable. This is 
information only.

6. In the Value field, enter the amount of time allotted to perform this Element for 
any Activity where the element is assigned.

7. In the UOM field, enter the time Unit of Measure assigned to each element for 
recording purposes. The Valid Entries are: Time Measurement Unit's (TMU's), 
seconds, or minutes.

8. In the Value Source field, select how the time element was derived (informational 
only). The valid choices are historical, guestimation, engineered, and studied.

9. In the Factor Code field, select any factor code that needs to be applied to this 
element. A factor code contains an SQL statement that when true either adds a 
constant time or a percent of time to the existing element.  For example if the factor 
said if the container weight is greater than 25 pounds add 2 seconds to the picking 
element.

10. In the Condition Code field, select any condition code that needs to be applied to 
the user element. An example of a condition is Hazmat. So if during pick the 
assigned task is for a hazmat item then add additional time.

11. Click Create to save any changes and close the Create Record window.



Setup - Labor Management

4-162 Oracle® Retail Warehouse Management System UI User Guide

Delete a Labor Element

Figure 4–189 Delete Record Window

1. On the Labor Elements Editor select the user defined element you want to Delete 
and then click the Delete icon on tool bar.

2. On the Delete window, click Yes when prompted.

Exit the Labor Elements Editor Window
Click Exit to close the window.

Labor Factors Editor
The Labor Factors Editor is used to define additional factors that must be applied to 
elements to account for product or location characteristics. The following factors are 
seeded into the RWMS as valid choices: Item ID, Item Cube, Item Weight, Case Cube, 
Case Weight, Fragile, Z Coordinate, Zone, and Location Type. The factors must be 
added to the normal time of the variable time of that element to create the adjusted 
normal time.

To access the Labor Factors Editor, navigate to Setup - Labor Management, and select 
Labor Factors Editor. The Labor Factors Editor window opens.

Figure 4–190 Labor Factors Editor Window

Display All Labor Factors
Click Search.

Note: You can only delete User Defined Elements not used in other 
tables.
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Display a specific Labor Factor
1. If any Labor Factors are currently displayed, Clear.

2. Click Query.

3. In the Factor Code field, enter the code for the Factor, or click the LOV button and 
select Factor Code.

4. Click Search. The Factor Codes related to your search appear.

Edit a Labor Factor
1. On the Labors Factor Editor window, double-click the Factor that you want to edit. 

The Modify window opens.

Figure 4–191 Modify Window

2. Next to the Factor name you want to modify, select the check box and click 
Remove.

3. Make the necessary changes to the Factor and then click Add.

4. Click Save to save any changes and close the Modify window.

Add a Labor Factor
1. On the Labor Factors Editor window, click Create Record. The Create Record 

window opens.

Figure 4–192 Create Record Window
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2. In the Factor Code field, enter your user defined Factor Code.

3. In the Description field, enter the long description for the Factor Code.

4. In the Factor Name field, select from the list of values . The following factors will 
be seeded into the RWMS as valid choices: Item ID, Item Cube, Item Weight, Case 
Cube, Case Weight, Fragile, Z Coordinate, Zone, and Location Type.  

5. In the Operator field, select from the list of values your desired operator. The 
following are the valid choices for Operators: =, >, <, Like, <>, >=, <=, Is Not Null, 
Is Null, Between, and In.

6. In the Unit of Measure field, select the desired UOM. The valid values differ based 
on the factors selected.

7. In the Value field, enter the Value that will be used by RWMS to determine if the 
operator is true which then will apply any adjusted value or percent.

8. In the Second Value field, enter the Second Value that will be used by RWMS if the 
operator is defined as between.

9. In the UOM field, enter the UOM of the adjusted Value. The valid values are 
minute, second, or TMU.

10. In the Adjusted Value field, enter the numeric value to be added to the base 
element when the factor is true.

11. In the Adjusted Percent field, enter the percentage to multiply the base element 
when the factor is true.

12. Click Add to add this formula to the Factor Code.

13. Repeat steps 4 through 12 to add more Factor names to the existing Factor Code.

14. When finished click Save to save the changes and close the Create Record window.

Delete a Factor Code
1. In the Labor Factors Editor, select the Factor Code you want to delete.

2. Click Delete Record.

3. When prompted to confirm request, click Yes.

Exit the Labor Factors Editor Window
Click Exit to close the window.

Labor Conditions Editor
The Labor Conditions Editor is used to define conditions that are applied to elements. 
The definition of a condition is a situation that is true sometimes but not all the time. 
Conditions can only be associated to user defined elements. When the condition 
occurs, RWMS applies the time value for the element. If not true, the time value is not 
included in the calculation.

The following conditional choices are seeded into the RWMS: Aisle ID, Case Cube, 
Case Height, Case Length, Case Width, Case Weight, Class, Consumer Direct, 
Department, Destination ID, Destination Type, Division, Equipment Class, Equipment 
Type, Fragile, Hazmat, High Value Indicator, Item Cube, Item Height, Item Length, 
Item Width, Item Weight, Item ID, Item Master UDs, Location ID, Location Type, 
Perishable, Pre-ticket Flag, Product Class Code, and Zone.
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To access the Labor Conditions Editor, navigate to Setup - Labor Management, and 
select Labor Conditions Editor. The current Labor Conditions appear in the Labor 
Conditions Editor window.

Figure 4–193 Labor Conditions Editor Window

Display All Labor Conditions
Click Search.

Display a specific Labor Condition
1. If any Labor Conditions are currently displayed, Clear.

2. Click Query.

3. In the Condition Code field, enter the code for the Condition, or click the LOV 
button and select Condition Code.

4. Click Search. The Condition Codes related to your search appear.

Edit a Condition Code
1. On the Labor Conditions Editor window, double-click the condition code that you 

want to edit. The Modify window opens.

Figure 4–194 Modify Window

2. Next to the Condition name you want to modify, select the check box and click 
Remove.

3. Make the necessary changes to the Condition and then click Add.
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4. Click Save to save any changes and close the Modify window.

Add a Condition Code
1. On the Labor Conditions Editor window, click Create Record. The Create Record 

window opens.

Figure 4–195 Create Record Window

2. In the Condition Code field, enter your user defined Condition Code.

3. In the Description field, enter the long description for the Condition Code.

4. In the Evaluate Mode field, select the All Conditions or At Least One Condition 
option. All Conditions means that all conditions defined for the condition code 
must be true to apply the additional value. At Least One Condition means that 
only one condition of many defined for the condition code must be true to apply 
the additional value.

5. In the Condition Name field, select from the list of values. The following 
conditions will be seeded into the RWMS as valid choices: Aisle ID, Case Cube, 
Case Height, Case Length, Case Width, Case Weight, Class, Consumer Direct, 
Department, Destination ID, Destination Type, Division, Equipment Class, 
Equipment Type, Fragile, Hazmat, High Value Indicator, Item Cube, Item Height, 
Item Length, Item Width, Item Weight, Item ID, Item Master UD's, Location ID, 
Location Type, Perishable, Pre-ticket Flag, Product Class Code, and Zone.

6. In the Operator field, select from the list of values your desired operator. The 
following are the valid choices for Operators: =, >, <, Like, <>, >=, <=, Is Not Null, 
Is Null, Between, and In.

7. In the Unit of Measure field, select the desired UOM. The valid values will differ 
based on condition selected. Also some conditions will not require a UOM.

8. In the Value field, enter the Value that will be used by RWMS to determine if the 
operator is true. The second value field is only required when the between 
operator is selected.

9. Click Add to add this formula to the Condition Code.

10. Repeat steps 4 through 8 to add more Condition Names to the existing Condition 
Code.

11. When finished click Save to save the changes and close the Create Record 
window.



Setup - Labor Management

Support Functions 4-167

Delete a Condition Code
1. In the Labor Conditions Editor, select the Condition Code you want to delete.

2. Click Delete Record.

3. When prompted to Confirm Request, click Yes.

Exit the Labor Conditions Editor Window
Click Exit to close the window.

Labor Allowance Editor
The Labor Allowance Editor (Personal, Fatigue, Delay, and Contingency) is where the 
client can define time allowances (additional grace time) that can be added to 
standards at the element or Global level. PFD allowance is the adjustment done to the 
normal time to obtain the standard time for the purpose to recover the lost time due to 
personal needs, fatigue, and unavoidable delays. By providing a small increase to the 
normal time in each cycle, the worker can still cover lost time and complete the work 
assigned to him/her.

Allowances are further defined by type of interruption: (1) the interruption related to 
work (2) the interruption not related to work. For example, machine breakdown, rest 
break to overcome fatigue and receiving instruction from the manager are the 
interruption related to work, but personal needs, lunch break and personal calls are 
the interruption not related to work.

To access the Labor Allowance Editor, navigate to Setup - Labor Management, and 
select Labor Allowance Editor. The current allowances appear in the Labor Allowance 
Editor window.

Figure 4–196 Labor Allowance Editor Window

Display All Labor Allowances
Click Search.

Display a specific Labor Allowances
1. If any Labor Allowances are currently displayed, click Clear.

Note: Employee Training is also supported as an Allowance within 
RWMS.
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2. Click Query.

3. In the Allowance Code field, enter the code for the Allowance, or click the LOV 
button and select Allowance Code.

4. Click Search. The Allowance Codes related to your search appear.

Edit an Allowance Code
1. On the Labor Allowance Editor window, double-click the Allowance that you 

want to edit. The Modify window opens.

Figure 4–197 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add an Allowance Code
1. On the Labor Allowance Editor window, click Create Record. The Create Record 

window opens.

Figure 4–198 Create Record Window

2. In the Allowance Code field, enter the user defined Allowance Code

3. In the Allowance Description field, enter the long description for the Allowance 
Code.

4. In the Allowance Type field, select the type from the list of values. The valid 
values are: Personal, Fatigue, Delay, and Contingency (catch all).

5. In the Allowance Category field, select the type from the list of values. The valid 
values are: Work Related and Non-Work Related.
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6. Click Save to save the changes and close the Create Record window.

Delete an Allowance Code
1. On the Labor Allowance Editor window, select the Condition Code you want to 

delete.

2. Click Delete Record.

3. When prompted to confirm request, click Yes.

Exit the Labor Allowance Editor Window
Click Exit to close the window.

Labor Codes Zone Editor
The Labor Codes Zone Editor allows you to assign specific Labor Codes to specific 
zones in the warehouse. If you have the need for different labor standards for the same 
activity you first create multiple labor codes for that activity in the Labor Template 
Editor. Once multiple labor codes are created, you can set one labor code as the default 
in the Labor Codes Zone Editor. After assigning one labor code per activity as default, 
you then can assign the non-default labor codes to desired zones. All zones that are 
not defined in the Labor Code Zone Editor will utilize the default labor code. You can 
also click Mark Default Labor Code to switch a labor code from non-default to 
default. This functionality is often utilized where zones have different climate or 
material handing conditions.

To access the Labor Codes Zone Editor, navigate to Setup - Labor Management, and 
select Labor Codes Zone Editor. The current Zone assignments appear in the Labor 
Codes Zone Editor window.

Figure 4–199 Labor Codes Zone Editor window

Display All Labor Code Zones
Click Search.

Display a specific Labor Code Zone
1. If any Labor Code Zones are currently displayed, click Clear.

2. Click Query.
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3. You can query the information in the Labor Code Zone Editor by Activity Code or 
by Labor Code.

4. In the Activity Code field, enter the code for the Activity, or click the LOV button 
and select Activity Code, or

5. In the Labor Code field, enter the code for the Labor Code, or click the LOV button 
and select the Labor Code.

6. Click Search. The Labor Code Zones related to your search appear.

Modify Labor Code Zones
1. On the Labor Code Zones Editor, place cursor on desired labor code and then click 

Assign Zones. The Modify window opens.

Figure 4–200 Modify window

2. You can assign or un-assign zones using two methods:

a. Bulk - Allows you to specify a range of zones to add. All of the zones within 
range can be added all at once.

b. Individual - Allows you to select individual zones to add or remove them.

3. Make the necessary changes to your zones.

4. Click Save to save any changes and close the Modify window.
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Create Zone Assignments
1. On the Labor Codes Zone Editor window, select the non-default labor code and 

click Assign Zones. The Assign Zones window opens.

Figure 4–201 Assign Zones window

2. First selection whether you want to add zones by bulk (range) or individually. 
Select the appropriate option.

3. If you want to add zones individually then click the individual option button 
which enables the available Zones check box column.

a.  Next to the available zones that you want to assign to this labor code, select 
the check boxes and then click Assign .

b. After all of your desired zones appear in the Assigned Zones window (on 
right) click Save.

4. If you want to add zones by bulk, select the Bulk option and then click Assign. 
This opens the Assign Zone by Range window shown in Figure 4–202

Figure 4–202 Assign Zone by Range

a. Now select your operator from the list of values. The valid choices are: =, >, <, 
Like, <>, >=, <=, Between, and In.

b. Now enter the range of zones in the Value Fields and click Search. The zones 
in desired range will appear in the bottom of window.

c. If the zones displayed are all correct then select the Zone check box and click 
Save.

d. If some of the zones displayed are correct and some not correct, then clear the 
incorrect check boxes and click Save.
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5. Click Save to save any changes and close the Assign Zone window.

Exit the Labor Codes Zone Editor Window
Click Exit  to close the window.

Labor Template Editor
The Labor Template Editor is used to create a Labor Standard for a specified 
(supported) activity. RWMS supports multiple labor codes for the same activity code 
but applies them at zone level. When you select an Activity Code in the Labor 
Template Editor, RWMS automatically imports the system and exception elements 
related to that activity code. You can supplement these seeded elements with user 
defined elements to capture physical elements needed to complete the Labor Standard. 
For each element (seeded or user defined) time factors must be defined which when 
totaled provide the engineered time standard which is then compared to actual task 
time. For each Labor code defined RWMS provides the following:

■ System Seeded Elements (core system elements and exception system elements)

■ Ability to define User Elements (free form)

■ Ability to define element loops (recurring elements)

■ Ability to set frequency on user defined elements level

■ Ability to set factors at element level

■ Ability to set conditions on user defined elements

■ Ability to set PFD allowances at both the element and global level

■ Ability to set time values on all elements (system, system exception, and user 
defined)

■ Ability to set a training allowance at global and or activity level.

Since RWMS controls the travel during activity completion, travel time is calculated in 
the background and then added to the engineered standard. Travel elements utilize the 
specific equipment speed and the X, Y, Z distance between tasks to give an exact 
allotted time that gets added to the standard.

The following is a list of additional controls on the Labor Template editor:

■ Calculate Travel Check Box - When selected this means that background distance 
time speed calculations will be added to your engineered standard. We strongly 
recommend this box always be selected when Labor Management is being used. 
When clear this means travel is not calculated at all.

■ Include Travel in Global PFD - When selected this means the travel calculations 
are added to the element total time before Global PFD allowances are calculated. 
When clear this means the Global PFD allowance is only calculated against the 
element total time minus any travel time.

■ Log Labor Std Calculation - When selected this means RWMS will write labor 
standard records in both the LABOR_MGMT_CALC_LOG and LABOR_MGMT_
CALC_LOG DETAIL tables. When clear, RWMS will not write records to either 
table but records totals in task log.

Note: The system parameter LABOR_MGMT_LOG must be set to 1.
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To access the Labor Template Editor, navigate to Setup - Labor Management, and 
select Labor Template Editor. The current saved Templates appear in the Labor 
Template Editor window.

Figure 4–203 Labor Template Editor Window

Create Record
1. On the Labor Template Editor window, click Create and the Create Record 

window opens.

Figure 4–204 Create Record Window

2. Select your desired activity from the list of supported Activities. 

3. Enter your User Defined Labor Code

4. Enter the Long Description for the Labor Code.

Note: You can copy a Labor Code to create a new Labor Code by 
clicking the Copy Record icon.
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5. Click Save to open the Label Template Worksheet shown in Figure 4–205.

Figure 4–205 Label Template Worksheet Window

Steps for creating a Complete Labor Template are as follows:

1. When the template first opens the following is auto-populated by RWMS:

■ Labor Code - User Defined

■ Description -Long Description associated to Labor Code

■ Calculate Travel flag is set to Y (defaulted) meaning RWMS will calculate 
travel time in the background and apply it to the engineered time standard.

■ The Time UOM is defaulted to Seconds. The other valid values are Minutes or 
TMU's.

■ All Allowances default to percentage. These can be edited to Constant if you 
wish. We strongly suggest using percentage.

■ All System Elements are imported based on Activity assigned to Labor Code. 
These elements are sequenced as they occur during RF processing.

■ All Exception Elements are imported based on Activity assigned to Labor 
Code.

2. Add User Defined Elements (physical motion) by placing your cursor on the 
element where you want add a record. At this time, right click your mouse and 
select either Create Record or Create Child Record. If the User Defined Element 
added only happens once and does not recur while processing the activity use 
Create Record. If the User Defined Element recurs while processing the activity 
use Create Child Record. At any time you can move an element up or down in the 
sequence by right clicking your mouse and selecting these options.
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Figure 4–206 Options

3. Apply time values to all elements (System, User Defined, and Exception) by 
clicking on each record in the Value column.

4. Set your frequency for user defined elements. If the element always occurs the 
value will be one. If the element only happens X number of times then put the X 
value in the Frequency column.

5. Set your condition codes on User Defined Elements that require conditions.

6. Go back through the elements and add Factor Codes where they apply by clicking 
on the Factor Code column at the element level.

7. If you want to apply PDF allowances at the Element Level double click the 
element and add the allowance and type. You cannot add PDF allowances to 
Exception Elements.

Figure 4–207 Labor Element Allowances Window

8. Set the following Global Flags as desired.

■ Calculate Travel Check Box

■ Include Travel in Global PFD

■ Include Travel in Training Allowance

■ Log Labor Std Calculation

■ Set you Time UOM to Minute, Second, or TMU. The most used time setting is 
seconds or TMU's. TMU's are mostly used where clients have engineers on 
staff and are using Engineered Standards for pay incentives.

■ Set you allowances (Global, Element, and Training) to Percentage based or a 
Constant value. The Global and Training Allowances are best set at Percentage 
while the Element Allowance can utilize either setting. 

Note: Some elements may already have a time value imported from 
the Elements Editor. This value can be used or can be modified.
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9. Define any Global Allowances that you want applied to this Labor Code (upper 
right hand corner). Click Create to open the Create Record window.

a. Click the LOV button to select the Allowance Code you want to assign. 

b. Enter the value (percentage or constant) that you want to be added to the 
standard. This amount of time is applied to the total of the normal standard 
time.

c. You can add as many Allowances to the Labor Code as desired.

Figure 4–208 Create Record Window

10. Define any Training Allowances that you want applied to this Labor Code (lower 
right hand corner). Click Create to open the Create Record window.

a. Click the LOV button to select the Training Level you want to assign.

b. Enter the value (percentage or constant) that you want to be added to the 
standard. This amount of time is applied to the total of the normal standard 
time.

Figure 4–209 Create Record Window

11. Click Save to save the Labor Code Template.

Delete a Record
1. On the Labor Template window select the Labor Code you want to delete and 

click Delete.

Note: You cannot delete the default labor code if there is more than 
one labor code for the activity.



Setup - Labor Management

Support Functions 4-177

2. The Delete window opens.

Figure 4–210 Delete Record Window

3. When prompted to delete the record, click Yes.

Exit the Labor Template Editor Window
Click Exit to close the window.

Z Coordinate Rules Editor
The Z Coordinate Rules Editor provides you with three unique Z calculation choices 
that get applied to the Labor Standard. For each equipment class location type 
combination, you can specify how the Z coordinate is used in determining the travel 
distance applied to the Labor Standard. The valid choices are:

■ Include Z coordinate - this means that for every location visited during the activity 
the Z coordinate is utilized in the travel distance calculation. In other words, at 
each location and reference point you must go up to the Z coordinate and return 
back to the floor before going to the next location. This is used most often in pallet 
picks and pallet transports (move/putaway).

■ Exclude Z coordinate - this means that for every location visited during the 
activity the Z coordinate is not utilized in the travel distance calculation. In other 
words, as you go from location to location and from reference point to reference 
point the Z coordinate is not added into the travel distance calculation applied to 
the Labor Standard. This is used most often in unit pick module configurations.

■ Delta Only - this means that for every location and reference point visited during 
the activity the difference between Z coordinates is utilized in the travel distance 
calculation. In other words, if the first location is at Z level 30 feet and the next 
location is a Z level 20 feet RWMS will utilize the delta of 10 feet in the calculation. 
The Delta Only choice is designed for situations where man up equipment is used 
like case picking. However, the travel calculation does mandate that the man up 
equipment return to floor level at each reference point (turns and tunnels) for 
safety reasons. 
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To access the Z Coordinate Rules Editor, navigate to Setup - Labor Management, and 
select Z Coordinate Rules Editor. The Z Coordinate Rules Editor window opens.

Figure 4–211 Z Coordinate Rules Editor Window

Display All Records
Click Search.

Display a specific Equipment Class or Location Type combination
1. If any Z Coordinate Rules are currently displayed, click Clear.

2. Click Query.

3. In the Equipment Class field, enter the class for the Equipment, or click the LOV 
button and select Equipment Class.

4. In the Location Type field, enter the type for the Location, or click the LOV button 
and select Location Type.

5. Click Search. The Z Coordinate Rules related to your search appear.

Edit a Z Coordinate Rule
1. On the Z Coordinate Rules Editor place cursor on desired Equipment Class 

Location Type Combination and then double click. The Modify window opens.

Figure 4–212 Modify Window

2. You can assign or un-assign Z Coordinate choices to equipment classes and 
location types at the individual level or at All location type level.
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3. To add a Location Type to an Equipment Class, select the check box next to the 
desired Location Type and click Assign. This moves the Location Type to the right 
panel where you can then select your Z Coordinate Choice from the drop-down 
list

4. To add all Location Types to an Equipment Class, move the cursor anywhere in 
left panel and click Assign All. This moves the Location Types to the right panel 
where you can then select your Z Coordinate Choice from the drop-down list.

5. To delete a Location Type from an Equipment Class, select the check box next to 
the desired Location Type in left panel and click Un-assign. This moves the 
Location Type to the left panel where it becomes available for reassignment.

6. To delete all Location Types from an Equipment Class, move the cursor anywhere 
in right panel and click Un-Assign All. This moves the Location Types to the left 
panel where they all become available for reassignment.

7. Click Save to save any changes and close the Modify window.

Add a Z Coordinate Rule
1. On the Z Coordinate rules Editor click Create. The Create Record window opens.

Figure 4–213 Create Record Window

2. In the Equipment Class field, enter the desired Equipment Class or select it from 
the list of values.

3. In the Z Coordinate Choice field, select from the list of values (include Z 
coordinate, exclude Z coordinate, or Delta only).

4. Click in the right panel to get a list of available Location Types.

5. Select the check box next to the Location Type you want to associate with the 
equipment Class and click Assign. You can select all Location Types by simply 
placing cursor in right panel and clicking Assign All.

6. Click Save to save record and close the Create Record window.

Delete a Z Coordinate Rule
1. On the Z Coordinate Rules Editor, click to select a record and then click Delete.
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Figure 4–214 Confirm Alert Window

2. When prompted, click Yes.

Exit the Z Coordinate Rules Editor 
Click Exit to close the window.

Setup - Location
The Location Setup module is used to map the physical material handling equipment 
and locations to logical location types and locations. In this module, you define each 
location type with dimensions, define each location with dimensions, and if using task 
management, create reference points that get mapped to locations.

This section includes the following topics:

■ Apply Location Class

■ Forward Pick Location Editor

■ Location Attribute Editor

■ Location Class Editor

■ Build Location Class Rules

■ Assign Location Class Equipment Classes

■ Assign Location Class Activities

■ Location Editor

■ Location Reference Editor

■ Location Type Editor

■ Reference Point Editor

■ Reference Point Map Editor

Apply Location Class
The Apply Location Class Editor allows you to 1) assign multiple locations to a 
selected location class or 2) assign a location class to a selected location. When you 
save the assignments, the locations inherit the default characteristics, processes, and 
equipment classes of the location class.

Different fields appear on the window depending on whether you query by location or 
by location class.

When you query by location class, the locations that match the build rules of the 
location class and the locations that are already assigned to the location class appear.
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If there are any discrepancies between the settings of the locations and the build rules 
of the location class, the Exceptions check box is selected next to such locations.

When you query by location, the location classes whose build rules match the settings 
of the selected location appear. The Current check box is selected next to the location 
class, if any, that the location is assigned to.

From the main menu, select Location Setup > Apply Location Class. The Apply 
Location Class window opens.

Figure 4–215 Apply Location Class Window

Display Locations by Location Class
1. If any locations or location classes are currently displayed, click Clear.

2. Click Query.

3. In the Loc Class field, enter the name of the location class, or click the LOV button 
and select the location class.

4. Click Search. The locations that match the build rules of or are assigned to the 
location class appear.

Assign Locations to a Location Class
1. On the Apply Location Class window, click Apply Class. The Apply Class 

window opens.

Note: You can also access this window from the Location Class 
Editor and Location Editor windows.
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Figure 4–216 Apply Class Window

2. To assign locations:

a. Select the check box next to the desired locations on the Available Locations 
table.

b. Click Assign. The selected locations are moved to the Assigned Locations 
table.

3. To remove assigned locations:

a. Select the check box next to the desired locations on the Assigned Locations 
table.

b. Click Unassign. The selected locations are moved to the Available Locations 
table.

4. Click Save/Apply to save the changes and close the Apply Location Class (Assign 
Locations) window.

Display Location Classes by Location
1. If any locations or location classes are currently displayed, click Clear.

2. Click Query.

Note: The locations that are currently assigned to the location class 
appear in the Assigned Locations table. The remaining locations that 
match the build rules appear in the Available Locations table.

Note: In the Apply Location Class (Assign Locations) window, you 
can 1) click Assign All to move all locations to the Assigned Locations 
table or 2) click Unassign All to move all locations to the Available 
Locations table. All locations are moved whether or not the check 
boxes are selected.
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3. In the Location field, enter the ID of the location, or click the LOV button and 
select the location.

4. Click Search. The location classes that match the selected location appear. The 
Current check box is selected next to the location class, if any, that is currently 
assigned to the location.

Assign a Location Class to a Location
1. On the Apply Location Class window, click Apply Class. The Apply Location 

Class (Assign Location Class) window opens.

Figure 4–217 Apply Class Window

2. In the Loc Class field, enter the name of the location class, or click the LOV button 
and select the location class.

3. Click Save/Apply to save the changes and close the Apply Location Class (Assign 
Location Class) window.

Exit the Apply Location Class Window
Click Exit/Cancel to close the window.

Forward Pick Location Editor
The Forward Pick Location Editor allows you to associate items to available forward 
pick locations. Depending on the option you choose, you can define unit pick or 
forward case pick locations. You can also mark the location for cycle count. 

From the main menu, select Setup Location > Forward Picking Location Editor. The 
Forward Pick Location Editor window opens.
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Figure 4–218 Forward Picking Location Editor Window

Display a Forward Pick Location
1. If the details of a forward pick location are currently displayed, click Clear.

2. Select either the Unit or the Case option depending on whether you are searching 
for a forward unit pick or forward case pick location.

3. Click Query.

4. In the Location ID field, enter the ID of the forward pick location, or click the LOV 
button and select the location.

5. Click Search. The items associated with the selected location appear.

Edit an Item in a Forward Pick Location
1. On the Forward Pick Location Editor window, double-click the item that you want 

to edit. The Modify window opens.

Figure 4–219 Modify Window

2. Edit the enabled fields.

3. Click Save to save any changes and close the Modify window.

Note: You can also access this window from the Location Editor 
window and the Task Maintenance window. On the Location Editor 
window, the Location Type must pertain to unit picks or forward case 
picks. On the Task Maintenance window, the Activity must pertain to 
creating forward pick locations.
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Mark a Forward Pick Location for Cycle Count

1. On the Forward Pick Location Editor window, click Mark.

2. When prompted to confirm the operation, click Yes. The status of the Cycle Count 
changes to MM. This indicates that the location was manually marked for cycle 
counts.

Add an Item to a Forward Pick Location
1. Display the location you want to add the item to.

2. On the Forward Pick Location Editor window, click Create Record. The Create 
Record window opens.

Figure 4–220 Create Record Window

3. In the Item ID field, enter the ID of the item, or click the LOV button and select the 
item.

4. In the Capacity field:

■ [Unit option] Enter the capacity of the location measured in max units.

■ [Case option] Enter the capacity of the location measured in max number of 
cases.

5. In the Replen Qty field,

■ [Unit option] Enter the max units at which replenishment is triggered.

■ [Case option] Enter the max cases at which replenishment is triggered.

6. In the Qty field:

■ [Unit option] Enter the number of standard units currently stocked at the 
location.

Note: The option to mark a location for cycle count is not available to 
all users. If the privilege level of the user is less than the value of the 
system control parameter mm_sec_level_gu, the following error 
message displays: Insufficient privileges to perform the operation.

Note: Reorder point replenishment must be enabled.
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■ [Case option] In the Case Qty field, enter the number of cases currently 
stocked at the location.

7. [Case option] In the Casepack field, enter the number of standard units packed in 
a case.

8. In the Release Qty field, enter the quantity at which replenishment tasks begin.

9. If the location can be filled beyond capacity:

■ In the Overflow Pct field, enter the percentage over capacity allowed.

■ In the Overflow Amt field, enter the quantity over capacity allowed.

10. Click Save to save the changes and close the Create Record window.

11. Respond to any prompts that may appear.

Delete an Item from a Forward Pick Location
1. On the Forward Pick Location Editor window, select the item that you want to 

delete from the forward pick location.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Forward Pick Location Editor Window
Click Exit to close the window.

Location Attribute Editor
The Location Attribute Editor allows you to assign attributes to a location or to all 
locations of the same type. Your choices are restricted to those attributes that have 
been marked as available for location classes.

You can access the Attribute Type Editor window in order to edit the attribute type 
that is associated with an attribute.

From the main menu, select Setup Location> Location Attribute Editor. The Location 
Attribute Editor window opens.

Note:  This field is used for Time Release replenishment methods.

Note: You can assign either percentage or quantity. The Overflow 
fields are available if the Overflow attribute has been assigned to the 
location.

Note: You can delete an item assigned to an FCP location only if 
there is no inventory present in the location



Setup - Location

Support Functions 4-187

Figure 4–221 Location Attribute Editor Window

Display Location Attributes
1. If location attributes are currently displayed, click Clear .

2. Click Query.

3. To search for a specific location, enter the location ID in the Location ID field, or 
click the LOV button and select a location. To search for all locations of the same 
type, enter the ID of the location type in the Loc Type field, or click the LOV 
button and select a location type.

4. Click Search. The attributes associated with the selected location or locations 
appear.

Edit a Location Attribute
1. On the Location Attribute Editor window, double-click the location attribute that 

you want to edit. The Modify window opens.

Note: You can also access this window from the Location Editor 
window.
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Figure 4–222 Modify Window

2. Select or clear the Attribute Enabled check box as necessary.

3. Click Save to save any changes and close the Modify window.

Assign an Attribute to a Location
1.  On the Location Attribute Editor window, click Create Record. The Create Record 

window opens.

Figure 4–223 Create Record Window

2. In the Attribute field, enter the ID of the attribute that you want to associate with 
the current location, or click the LOV button and select the attribute.
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3. To make the location attribute available to users, select the Attribute Enabled 
check box.

4. Click Save to save the changes and close the Create Record window.

Assign an Attribute to Multiple Locations
1. On the Location Attribute Editor window, click Create Loc Type. The Create Loc 

Type window opens.

Figure 4–224 Create Loc Type Window

2. In the Attribute field, enter the ID of the attribute that you want to associate with 
the current location type, or click the LOV button and select the attribute.

3. To make the location attribute available to users, select the Attribute Enabled 
check box.

4. Click Save to save the changes and close the Create Loc Type window.

Assign Values to Attributes
1. On the Location Attribute Editor, click Attribute Types. The Attribute Type Editor 

window opens.

Note: If no location was identified on the Location Attribute Editor 
window, enter the ID of the location in the Location ID field on the 
Create Record window.

Note: If no location type was identified on the Location Attribute 
Editor window, enter the ID of the location type in the Location Type 
field on the Create Loc Type window.
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Figure 4–225 Attribute Type Editor Window

2. Click the LOV button and select a value. Click Search. The values of the selected 
attribute are displayed. 

Create Attribute and Attribute Type
1. On the Attribute Type Editor, click Create Record. The Create Record window 

opens.

Delete an Attribute for a Location
1. On the Location Attribute Editor window, select the location attribute that you 

want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Delete an Attribute for Multiple Locations
1. On the Location Attribute Editor window, click Delete Loc Type. The Delete Loc 

Type window opens.

Figure 4–226 Delete Loc Type Window

2. In the Location Type field, enter the ID of the location type, or click the LOV 
button and select the location type.

3. In the Attribute field, enter the code for an attribute, or click the LOV button and 
select the attribute.

4. Click Delete All Locations. The attribute is deleted from all locations of the 
selected type.

Exit the Location Attribute Editor Window
Click Exit to close the window.



Setup - Location

Support Functions 4-191

Location Class Editor
The Location Class Editor allows you to define and view location classes. A location 
class is used to group locations with similar processing needs. You define the rules of 
the class in order to determine which locations should belong to the class. Locations 
that match those rules inherit the default characteristics, processes, and equipment 
classes that were assigned to the location class.

You can access the Apply Location Class window in order to assign locations to the 
location class. The default characteristics, processes, and equipment classes of the 
location class are then applied to the selected locations.

From the main menu, select Setup Location > Location Class Editor. The Location 
Class Editor window opens.

Figure 4–227 Location Class Editor Window

Display all Location Classes
Click Search.

Display a Location Class
1. If any location classes are currently displayed, click Clear.

2. Click Query.

3. In the Loc Class field, enter the name of the location class, or click the LOV button 
and select the location class.

4. Click Search. The location class that matches the search criterion opens.

Edit a Location Class
1. On the Location Class Editor window, double-click the location class that you 

want to edit. The Modify window opens.
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Figure 4–228 Modify Window

2. Edit the description and active status of the location class as necessary.

3. Click Save to save any changes and close the Modify window.

4. Edit the following as necessary:

■ Build rules

■ Default characteristics

■ Activities

■ Equipment classes

Add a Location Class
1. On the Location Class Editor window, click Create Record. The Create Record 

window opens.

2. In the Loc Class and Description fields, enter the name and description for the 
location class.

3. To indicate whether the location class should be made available for use, select or 
clear the Active Flag check box.

4. Click Save to save any changes and close the Create Record window.

5. Set up the following as necessary:

■ Build rules

■ Default characteristics

■ Activities

■ Equipment classes

Copy a Location Class
1. On the Location Class Editor window, select the location class that you want to 

copy.

2. Click Copy. The Copy window opens.

Note: You cannot edit a location class if the system indicator is 
selected.
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Figure 4–229 Copy Window

3. In the New Loc Class and New Description fields, enter a name and description 
for the location class that you want to create.

4. Click Save to copy the selected location class and close the Copy window.

5. Edit the following as necessary:

■ Build rules

■ Default characteristics

■ Activities

■ Equipment classes

Delete a Location Class
1. On the Location Class Editor window, select the location class that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Location Class Editor Window
Click Exit to close the window.

Build Location Class Rules
From the main menu, select Setup Location > Location Class Editor. The Location 
Class Editor window opens.

Note: You cannot delete a location class if the system indicator is 
selected or if any build rules, defaults, activities, or equipment classes 
have been assigned to the location class.
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Figure 4–230 Location Class Editor Window 

Display All Location Classes
Click Search.

Build the Rules for a Location Class
The Load Location Class Rules window allows you to build and load (apply) the rules 
defined for this location class:

■ Load/Append: Add the defined rules to any rules that may already exist for the 
current location class.

■ Load/Overwrite: Replace any rules that may already exist.

The number of rules that each location class has opens on the Load Item Class Rules 
window. To see the rules for a location class, double-click that location class.

1. On the Location Class Editor window, select the location class that you want to 
edit.

2. Click Build Rules. The Build Rules window opens.

Figure 4–231 Build Rules Window

3. Define the rules for selecting the members of the location class:

a. In the Column fields, select the limiting factors.

b. In the Operator fields, select the relational operators.
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c. In the Value fields, enter the values of the limiting factors.

4. [Optional] To copy the rules from another location class:

a. On the Build Rules window, click Load. The Load Location Class Rules 
window opens.

Figure 4–232 Load Location Class Rules Window

b. Select the location class whose rules you want to copy.

c. Click Load/Append to add the rules to any existing rules, or click 
Load/Overwrite to replace any existing rules with the selected rules. You are 
returned to the Build Rules window.

d. If by appending the rules any duplicates occur, the Dup check box is selected 
next to the duplicate. Select the duplicate rule and click Clear to remove it.

5. Click Save to save the rules and close the Build Rules window.

Exit the Location Class Editor Window
Click Exit to close the window.

Assign Location Class Equipment Classes
From the main menu, select Setup Location> Location Class Editor. The Location Class 
Editor window opens.

Display All Location Classes
Click Search.

Assign Equipment Classes
1. On the Location Class Editor window, select the location class that you want to 

edit.

2. Click Equipment Class. The Equipment Class window opens.

Note: To view the rules for a location class, double-click the desired 
location class. The rules appear in the Location Class Rules View Only 
window.
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Figure 4–233 Assign Equipment Class Window

3. To assign equipment classes:

a. Select the check box next to the desired equipment classes on the Unassigned 
Equip Class table.

b. Click Assign. The selected equipment classes are moved to the Assigned 
Equip Class table.

4. To remove assigned equipment classes:

a. Select the check box next to the desired equipment classes on the Assigned 
Equip Class table.

b. Click Unassign. The selected equipment classes are moved to the Unassigned 
Equip Class table.

5. To make the assigned equipment classes available to users, select the Active check 
box next to the appropriate equipment classes.

6. [Optional] To apply the equipment classes to all locations that are currently 
assigned to the location class, click Save/Apply.

7. Click Save to save any changes and close the Equipment Class window.

Exit the Location Class Editor Window
Click Exit to close the window.

Note: In the Assign Equipment Class window, you can 1) click 
Assign All to move all equipment classes to the Assigned Equip Class 
table or 2) click Unassign All to move all equipment classes to the 
Unassigned Equip Class table. All equipment classes are moved 
whether or not the check boxes are selected.
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Assign Location Class Activities
From the main menu, select Setup Location> Location Class Editor. The Location Class 
Editor window opens.

Display All Location Classes
Click Search.

Assign Activities
1. On the Location Class Editor window, select the location class that you want to 

edit.

2. Click Assign Activity. The Assign Activity window opens.

Figure 4–234 Assign Activity Window

3. [Optional] To filter the activities listed in the Available Activities table, enter the 
name of activity type in the Activity Type field, or click the LOV button and select 
the activity type.

4. To assign activities:

a. Select the check box next to the desired activities on the Available Activities 
table.

b. Click Assign. The selected activities are moved to the Assigned Activities 
table.

5. To remove assigned activities:

a. Select the check box next to the desired activities on the Assigned Activities 
table.

b. Click Unassign. The selected activities are moved to the Available Activities 
table.

6. A location class may have multiple activities. Select the Primary check box next to 
the assigned activities which are considered to be the primary activities.

7. [Optional] To apply the activities to the locations that are currently assigned to the 
location class, click Save/Apply.

8. Click Save to save any changes and close the Assign Activity window.
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Exit the Location Class Editor Window
Click Exit to close the window.

Location Editor
The Location Editor allows you to define and view the locations required within the 
distribution center. Specific locations are then associated a location class, location type, 
and zone. If desired you can also define putaway, pick, and cycle count sequences. If 
task management is enabled X, Y, Z coordinates must be defined to minimize the 
distance traveled to the next available task.

The status of a location may be:

■ Hold: The location is not a candidate for putaway, but merchandise may be picked 
or moved out.

■ OK: The location is a candidate for moving, putaway, and picking.

Although processes and equipment classes may be assigned to the location at the 
location class level, you can edit the assigned processes and equipment classes at the 
location level.

You have access to the following windows:

■ Location Type Editor: Displays the physical characteristics and purpose of the 
location at the location type level.

■ Forward Pick Location Editor: Displays the items associated with the location if 
the location is a unit pick location or forward case pick location.

■ Zone Editor: Displays details at the zone level for a selected location.

■ Location Attribute Editor: Displays the attributes that are associated with the 
location.

■ Apply Location Class: Allows you to apply default characteristics, processes, and 
equipment classes of a location class to the location.

Note: In the Assign Activity window, you can 1) click Assign All to 
move all activities to the Assigned Activities table or 2) click Unassign 
All to move all activities to the Available Activities table. All activities 
are moved whether or not the check boxes are selected.



Setup - Location

Support Functions 4-199

From the main menu, select Setup Location > Location Editor. The Location Editor 
window opens.

Figure 4–235 Location Editor Window

Display All Locations 
To display all locations, click Search .

Display a Subset of Locations
1. Click Query.

2. Enter criteria in the Location, Loc Type, Zone, or Aisle fields.

3. Click Search. The locations that match the criteria appear.

Note: You can also access this window from the Location Type 
Editor window.
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Editing a Location
1. On the Location Editor window, double-click the location that you want to edit. 

The Modify window opens.

Figure 4–236 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Assign Items to Locations
1. On the Location Editor window, click Details. The Detail Link is used only for 

forward picking locations. If a storage location is selected an error will display. The 
window corresponding to that Location Type opens.

Figure 4–237 Forward Pick Location Editor Window 

2. Click Create Record to add items and Delete Record to delete the items.

3. Click Mark to mark the location for cycle count. 

4. Select an item and double-click. The Modify window opens.
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Figure 4–238 Modify Window

5. Edit the enabled fields as necessary.

6. Click Save to save the changes and close the Modify window. 

Change the Status of Locations in a Zone
Locations are put on hold to temporarily divert the flow of putaway merchandise to 
other zones.

1. On the Location Editor window, click Hold. The Hold window opens.

Figure 4–239 Hold Window

2. In the Zone field, enter the ID of the affected zone, or click the LOV button and 
select the zone.

3. Click Toggle. If the status of the locations was OK, it becomes Hold. If the status 
was Hold, it becomes OK.

Adding a Location
1. On the Location Editor window, click Create Record. The Create Record window 

opens.
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Figure 4–240 Create Record Window

2. In the Location ID field, enter the ID of the location.

3. In the Loc Class field, enter or select the location class that you want to associate 
with the location.

4. In the Type field, enter or select the location type that you want to associate with 
the location.

5. In the Zone field, enter or select the zone that you want to associate with the 
location.

6. In the Aisle field, enter or select the aisle that you want to associate with the 
location.

7. In the Status field, edit the status of the location if other than OK.

8. In the Logical Dest field (optional), enter the conveyor destination if needed. This 
associates a conveyor or sorter divert with this location.

9. In the Putaway Seq, Pick Seq and Cycle Count Seq fields, enter the sequence 
number for putaway, pick and cycle count purposes. When filled out, these fields 
override the normal location sequence and allow you to perform these processes 
in any order you wish.

10. In the XYZ UOM field, select the UOM being used to measure the dimensions of 
the locations (Example - Inch or feet).

11. In the X, Y, and Z Coordinate fields, enter the coordinates of the location. These 
coordinates are often loaded using an Excel spreadsheet.

12. In the Alternate Aisle field (optional), enter or select the Alternate Aisle used to 
replenish flow rack (pallet or case). This is used when the replenishment occurs in 
one aisle but the picking occurs in another aisle.

13. In the Alternate X Coordinate field (optional), enter or select the Alternate X 
Coordinate used to replenish flow rack (pallet or case). This is used when the 
replenishment occurs in one aisle but the picking occurs in another aisle.

Note: If the sequence number is not unique, then the priority is by 
sequence number and location ID.
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14. In the Alternate Y Coordinate field (optional), enter or select the Alternate Y 
Coordinate used to replenish flow rack (pallet or case). This is used when the 
replenishment occurs in one aisle but the picking occurs in another aisle.

15. In the Alternate Z Coordinate field (optional), enter or select the Alternate Z 
Coordinate used to replenish flow rack (pallet or case). This is used when the 
replenishment occurs in one aisle but the picking occurs in another aisle.

16. Click Save to save the changes and close the Create Record window.

Assign Activities
1. On the Location Editor window, select the location that you want to edit.

2. Click Assign Activities. The Assign Activities to Location window opens.

Figure 4–241 Assign Activities to Location Window 

3. [Optional] To filter the activities listed in the Available Activities table, enter the 
name of a activity type in the Activity Type field, or click the LOV button and 
select the activity type.

4. To assign activities:

a. Select the check box next to the desired activities on the Available Activities 
table.

b. Click Assign. The selected equipment classes are moved to the Assigned 
Activities table.

5. To remove assigned activities:

a. Select the check box next to the desired activities on the Assigned Activities 
table.

b. Click Unassign. The selected activities are moved to the Available Activities 
table.

6. To make the assigned activities available to users, select the Active check box next 
the appropriate activities.

7. Click Save to save any changes and close the Assign Activities to Location 
window.
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Assign Equipment Classes
1. On the Location Editor window, select the location that you want to edit.

2. Click Equipment Class. The Assign Equipment Classes to Location window 
opens.

Figure 4–242 Assign Equipment Classes to Location Window

3. [Optional] To filter the equipment classes listed in the Available Equip Class table, 
enter the name of a equipment class in the Equipment Class field, or click the LOV 
button and select the equipment class.

4. To assign equipment classes:

a. Select the check box next to the desired equipment classes on the Available 
Equip Class table.

b. Click Assign. The selected activities are moved to the Assigned Equip Class 
table.

5. To remove assigned equipment classes:

a. Select the check box next to the desired equipment classes on the Assigned 
Equip Class table.

b. Click Unassign. The selected equipment classes are moved to the Available 
Equip Class table.

6. Click Save to save any changes and close the Assign Equipment Classes to 
Location window.

Note: In the Assign Activities to Location window, you can 1) click 
Assign All to move all activities to the Assigned Activities table or 2) 
click Unassign All to move all activities to the Available Activities 
table. All activities are moved whether or not the check boxes are 
selected.
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Delete a Location
1. On the Location Editor window, select the location that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Location Editor Window
Click Exit to close the window.

Location Reference Editor
The Location Reference Editor allows you to define the reference points that can be 
seen (clear path) from a location. This association allows RWMS to calculate the 
distance that must be traveled to each location based on true travel paths and not as 
the crow flies.

Figure 4–243 Location Reference Editor Window

Display all Location Reference Points
Click Search.

Display a Location Reference Point
To display a location reference point:

1. Click Query.

2. In the Location ID field, enter the ID of the location, or click the LOV button and 
select the location ID.

Note: In the Assign Equipment Classes to Location window, you can 
1) click Assign All to move all equipment classes to the Assigned 
Equip Class table or 2) click Unassign All to move all equipment 
classes to the Available Equip Class table. All equipment classes are 
moved whether or not the check boxes are selected.

Note: You cannot delete a location if any activities or equipment 
classes have been assigned to the location class or if there is inventory 
in the location.
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3. Click Search. The location reference points that match the search criterion will 
appear.

Edit a Location Reference
To edit a location reference:

1. On the Location Reference Editor window, double-click the reference point that 
you want to edit. The Modify window opens.

Figure 4–244 Modify Window

2. Edit the fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Location Reference Point
1. On the Reference Editor window, click Create Record. The Create Record window 

opens.

Figure 4–245 Create Record Window

2. Enter a Location ID or click the LOV button and select the location ID.

3. Enter a Reference Point, or click the LOV button and select the location ID.

4. Select a Type. The type field indicates if the reference point is used for only specific 
directions of travel:

■ Inbound Only

■ Outbound Only

■ Inbound and Outbound

■ Alternate Inbound Only

■ Alternate Outbound Only

■ Alternate Inbound and Outbound

5. Click Save to create the new record.
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The Aisle field is for information only and will be populated automatically when a 
location is saved to a reference point. The Aisle is connected to the location in the 
Location Editor.

Delete a Location Reference
1. On the Location Reference Editor window, select the reference that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Location Reference Editor Window
Click Exit to close the window.

Location Type Editor
The Location Type Editor allows you to define and view the location types in your 
warehouse. For each location type defined, you must provide the dimensions and 
container capacity. Location types are used to group locations that share common 
physical characteristics.

From the main menu, select Setup Location > Location Type Editor. The Location Type 
Editor window opens

Figure 4–246 Location Type Editor Window

Display all Location Types
Click Search.

Display a Location Type
1. If any location types are currently displayed, click Clear.

2. Click Query.

3. In the Loc Type field, enter the name of the location type, or click the LOV button 
and select the location type.

Note:  You can also access this window from the Location Editor 
window.
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4. Click Search. The location type that matches the search criterion opens.

Edit a Location Type
1. On the Location Type Editor window, double-click the location type that you want 

to edit. The Modify window opens.

Figure 4–247 Location Type Editor Window > Modify Window

2. Edit the physical characteristics as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Location Type
1. On the Location Type Editor window, click Create Record. The Create Record 

window opens.
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Figure 4–248 Create Record Window

2. In the Loc Type and Description fields, enter a name and description for the 
location type.

3. Select the check box next to each physical characteristic that applies to the location 
type.

4. In the Volume Type field, enter either Cube or Unit as the determining factor for 
space availability.

■ If Unit, enter the maximum number of standard units in the Max Std Units 
field.

■ If Cube, enter the length, width, and height in the appropriate fields.

5. In the Cntr Capacity field, enter the number of containers that fit at the location 
type.

6. In the Threshold % field, enter the maximum utilization percentage. When 
utilization falls below the threshold, the location appears on the Space Utilization 
report.

7. In the Unit Cost field, enter the cost of storage per unit.

8. In the % Max Fill and % ROP fields, enter the percentages for 1) filling locations 
beyond the baseline capacity and 2) triggering reorders. These pertain to unit pick 
locations that are set up as auto-slottable.

9. In the Priority (% Priority ROP Task) field, enter the percentage of capacity at 
which replenishment tasks become a higher priority. This pertains to unit pick 
locations.

10. In the Hot Rep (% Hot Replenishment) field, enter the percentage of capacity at 
which to trigger hot replenishment requests. This pertains to unit pick locations 
that are set up as auto-slottable.

11. Click Save to save the changes and close the Create Record window.

Delete a Location Type
1. On the Location Type Editor window, select the location type that you want to 

delete.
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2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Location Type Editor Window
Click Exit to close the window.

Reference Point Editor
The Reference Point Editor allows you to define reference points throughout the 
warehouse which define your actual travel paths.

Reference points are used to 1) map distances between fixed points on a grid and 2) 
calculate distances between physical locations and fixed points on the grid. The goal is 
to define the best paths for moving merchandise throughout the site.

Reference points are required if you use XYZ functionality.

From the main menu, select Setup Location > Reference Point Editor. The Reference 
Point Editor window opens.

Figure 4–249 Reference Point Editor Window

Display All Reference Points
Click Search.

Display a Reference Point
1. If any reference points are currently displayed, click Clear.

2. Click Query.

3. In the Reference Point field, enter the ID of the reference point, or click the LOV 
button and select the reference point.

4. Click Search. The reference point that matches the search criterion opens.

Edit a Reference Point
1. On the Reference Point Editor window, double-click the reference point that you 

want to edit. The Modify window opens.
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Figure 4–250 Reference Point Editor Window > Modify Window

2. Edit the description and XY coordinates as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Reference Point
1. On the Reference Point Editor window, click Create Record. The Create Record 

window opens.

Figure 4–251 Reference Point Editor Window > Create Record Window

2. In the Reference Point and Description fields, enter the ID and description for the 
reference point.

3. In the X Coordinate and Y Coordinate fields, enter the position of the reference 
point in relation to an anchor point in the building.

4. Click Save to save the changes and close the Create Record window.

Delete a Reference Point
1. On the Reference Point Editor window, select the reference point that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.
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Exit the Reference Point Editor Window
Click Exit to close the window.

Reference Point Map Editor
The Reference Point Mapping Editor allows you to associate reference points to other 
reference points that are in clear sight of each other. The distance between the reference 
points is automatically calculated by the system be using the X, Y, Z coordinates.

From the main menu, select Setup Location > Reference Point Map Editor. The 
Reference Point Map Editor window opens.

Figure 4–252 Reference Point Map Editor Window

Display All Mapped Reference Points
Click Search.

Display a Subset of Mapped Reference Points
1. If any mapped reference points are currently displayed, click Clear.

2. Click Query.

3. In the From Point field, enter the ID of the reference point from which the distance 
is mapped, or click the LOV button and select the reference point.

4. In the To Point field, enter the ID of the reference point to which the distance is 
mapped, or click the LOV button and select the reference point.

5. Click Search. The mapped reference points that match the search criteria appear.

Map the Distance Between Two Reference Points
1. On the Reference Point Mapping Editor window, click Create Record. The Create 

Record window opens.

Note: You can query by From Point, To Point, or both.
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Figure 4–253 Create Record Window

2. In the From Point and To Point fields, enter the IDs of the reference points to be 
mapped.

3. The Distance between the two reference points will be calculated by RWMS.

4. Indicate if equipment can travel two ways between reference points by clicking 
Bi-Directional.

5. Click Save to save the changes and close the Create Record window.

Delete Mapped Reference Points
1. On the Reference Point Mapping Editor window, select the mapped reference 

points that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Reference Point Mapping Editor Window
Click Exit to close the window.

Setup - Processing/Returns
The Processing /Returns module is used to define WIP codes, attributes, and returns 
that enable value added processes.

This section includes the following topics:

■ Appointment Trouble Code Editor

■ Attribute Editor

■ Attribute Type Editor

■ Attribute WIP Editor

■ Bill of Materials Editor

■ Clean Up Rules Editor

■ Container Trouble Code Editor

■ Cycle Count Plans

■ Cycle Count Planning

■ Return Code Editor

■ Vendor Non Conformance Code Editor
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■ WIP Code Editor

Appointment Trouble Code Editor
The Appointment Trouble Codes Editor allows you to define a master list of Trouble 
Codes that can be applied to appointments. The trouble codes are used to document 
problems that are noticed when an appointment is received. No processing is 
performed for these trouble codes, but applying the trouble codes serves as 
documentation about vendor performance.

From the main menu, select Setup Processing/Returns> Appointment Trouble Codes 
Editor. The current trouble codes appear in the Appointment Trouble Codes Editor 
window.

Figure 4–254 Appointment Trouble Codes Editor Window

Edit a Trouble Code
1. On the Appointment Trouble Codes Editor window, double-click the trouble code 

that you want to edit. The Modify window opens.

Figure 4–255 Modify Window

2. Edit the description as necessary.

3. Click Save to save any change and close the Modify window.

Add a Trouble Code
1. On the Appointment Trouble Codes Editor window, click Create Record. The 

Create Record window opens.
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Figure 4–256 Create Record Window

2. In the Trouble Code field, enter a code for the trouble.

3. In the Description field, enter a description for the trouble.

4. Click Save to save the change and close the Create Record window.

Delete a Trouble Code
1. On the Appointment Trouble Codes Editor window, select the trouble code that 

you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Appointment Trouble Codes Editor Window
Click Exit to close the window.

Attribute Editor
The Attribute Editor allows you to view the master list of attributes. RWMS also 
allows for the creation and deletion of user attributes. Attributes inherit the 
characteristics of the attribute type that is associated with them. At the attribute level, 
you restrict the availability of an attribute to one or more classes (item, location, 
equipment, and user).

From the main menu, select Setup Processing/Returns > Attribute Editor. The current 
attributes appear in the Attribute Editor window.
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Figure 4–257 Attribute Editor Window

Edit an Attribute
1. On the Attribute Editor window, double-click the attribute that you want to edit. 

The Modify window opens.

Figure 4–258 Modify Window

2. Edit the description as necessary.

3. To make an attribute available for a class, select the check box next to each desired 
class.

4. Click Save to save any changes and close the Modify window.

Note: You can also access this window from the Attribute Type 
Editor window.

Note: You cannot edit an attribute type if the system indicator is 
selected.
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Add an Attribute
1. On the Attribute Editor window, click Create Record. The Create Record window 

opens.

Figure 4–259 Create Record Window

2. In the Attribute and Attribute Desc fields, enter an ID and description for the 
attribute.

3. In the Attribute Type field, enter the ID for the attribute type that you want to 
associate with the attribute, or click the LOV button and select the attribute type.

4. Select the check box next to each class that want to make the attribute available for.

5. Click Save to save the changes and close the Create Record window.

Delete an Attribute
1. On the Attribute Editor window, select the attribute that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Attribute Editor Window
Click Exit to close the window.

Attribute Type Editor
The Attribute Type Editor allows you to maintain a master list of attribute types. You 
can choose which operations are required when attributes are applied to processes, 
item classes, items, location classes, and locations. The operations include:

■ Capture: The attribute requires a user to obtain specific information about an item.

■ Validate: The attribute requires a user to verify that the information provided by 
RWMS in a field is correct.

■ Match: Both an item and a location must have the same attribute in order for the 
item to be stored in the location. 

You can access the Attribute Editor in order to maintain the attributes associated with 
the selected attribute type.

From the main menu, select Setup Processing/Returns > Attribute Type Editor. The 
Attribute Type Editor window opens.
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Figure 4–260 Attribute Type Editor Window

Display All Attribute Types
Click Search.

Display an Attribute Type
1. If any attribute types are currently displayed, click Clear.

2. Click Query.

3. In the Attribute Type field, enter the ID of an attribute type, or click the LOV 
button and select the attribute type.

4. Click Search. The attribute type that matches the search criterion opens.

Edit an Attribute Type
1. On the Attribute Type Editor window, double-click the attribute type that you 

want to edit. The Modify window opens.

Figure 4–261 Modify Window

Note: You can also access this window from the following windows: 
Attribute Editor, Item Attribute Editor, Attribute Default Editor, and 
Location Attribute Editor.

Note: You cannot edit an attribute type if the system indicator equals 
Y (Yes).
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2. Edit the description as necessary.

3. To associate the appropriate characteristics with the attribute type, select or clear 
the check boxes next to each characteristic.

4. Click Save to save any changes and close the Modify window.

Add an Attribute Type
1. On the Attribute Type Editor window, click Create Record. The Create Record 

window opens.

Figure 4–262 Create Record Window

2. In the Attribute Type and Description fields, enter an ID and description for the 
attribute type.

3. Select the Carton Group check box if the attribute type pertains to cartonization.

4. Select the Combinability check box if the attribute type pertains to combinability 
restrictions.

5. Select the check box next to the operations that you want to associate with the 
attribute type.

6. Click Save to save the changes and close the Create Record window.

Delete an Attribute Type
1. On the Attribute Type Editor window, select the attribute type that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Attribute Type Editor Window
Click Exit to close the window.

Note: You cannot delete an attribute type if the system indicator 
equals Y (Yes).
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Attribute WIP Editor
The Attribute WIP Editor allows you to assign WIP codes to attributes. Attributes with 
WIP codes are usually assigned to items that require some kind of value added service 
at the distribution center.

From the main menu, select Setup Processing/Returns > Attribute WIP Editor. The 
Attribute WIP Editor window opens.

Figure 4–263 Attribute WIP Editor Window

Display Attribute WIP Codes
1. If an attribute is currently displayed, click Clear.

2. Click Query.

3. In the Attribute field, enter the code for an attribute, or click the LOV button and 
select an attribute.

4. Click Search. The WIP codes associated with the selected attribute appear.

Add a WIP Code
1. On the Attribute WIP Editor window, click Create Record. The Create Record 

window opens.

Figure 4–264 Create Record Window

Note: You can also access this window from the Attribute Editor 
window and the Item Attribute Editor window.
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2. In the WIP Code field, enter the desired WIP code, or click the LOV button and 
select the WIP code.

3. Click Save to save the changes and close the Create record window.

Delete a WIP Code
1. On the Attribute WIP Editor window, select the WIP code that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Attribute WIP Editor Window
Click Exit to close the window.

Bill of Materials Editor
The Bill of Materials Editor window allows you to view, add, and delete the 
component items found in kits. The initial bill of materials is received from a host 
system.

You can access the Used In Kits window in order to view which kits a component item 
is a member of.

From the main menu, select Setup Processing/Returns > Bill of Materials Editor. The 
Bill of Materials Editor window opens.

Figure 4–265 Bill of Materials Editor Window

Display Component Items
1. If an item is currently displayed, click Clear.

2. Click Query.

3. In the Item ID field, enter the ID of the item, or click the LOV button.

4. Click Search.

Edit a Component Item
1. On the Bill of Materials Editor window, double-click the component item that you 

want to edit. The Modify window opens.

Note: You can also access this window from the Item Master Editor 
window.
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Figure 4–266 Modify Window

2. Edit the unit quantity as necessary.

3. Click Save to save any changes and close the Modify window.

Check Kit Members
1. On the Bill of Materials Editor window, select the component item that you want 

to check.

2. Click Used in Kits. The kits of which the component item is a member appear in 
the In Kits window.

Figure 4–267 In Kits Window

3. Click OK to close the In Kits window.

Add a Component Item
1. On the Bill of Materials Editor window, click Create Record. The Create Record 

window opens.
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Figure 4–268 Create Record Window

2. In the Component Item ID field, enter the ID of the component item, or click the 
LOV button and select the component item.

3. In the Unit Qty field, enter the required number of units.

4. Click Save to save the changes and close the Create Record window.

Delete a Component Item
1. On the Bill of Materials Editor window, select the component item that you want 

to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Bill of Materials Editor Window
Click Exit to close the window.

Clean Up Rules Editor
The Forward Pick Location Cleanup Editor allows you to enter a request for 
consolidating or deactivating forward pick locations (FPL). Cleanup and consolidate 
tasks are generated in RWMS for the eligible forward pick locations. This allows you to 
make the selected forward pick locations available for new uses.

From the main menu, select Setup Processing/Returns > Cleanup Rules Editor. The 
Forward Pick Location Cleanup Editor window opens.

Figure 4–269 Clean Up Rules Editor Window

Display all Forward Pick Locations
Click Search.
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Display a Subset of Forward Pick Locations
1. If forward pick locations are currently displayed, click Clear.

2. Click Query.

3. Use one or more of the following query criteria:

■ Item: Find all forward pick locations for a specified item.

■ Multiple Location: Find all forward pick locations where its item resides in 
one or more additional forward pick locations.

■ Days Since Last Stock Order/Purchase Order: Find all forward pick locations 
that have not had stock orders or purchase orders raised against them in a 
specified number of days.

■ Qty in Location: Find all forward pick locations with less than or equal to the 
specified quantity.

■ % of Capacity of Fill: Find all locations with less than or equal to the specified 
percentage of capacity filled.

4. Click Search. The forward pick locations that match the criteria appear.

Request Cleanup for One Location
1. On the Forward Pick Location Cleanup Editor window, select a location that is 

eligible for cleanup.

2. Click Cleanup. The record becomes grayed out which indicates that a cleanup 
request now exists for the location.

Request Cleanup for Multiple Locations
1. On the Forward Pick Location Cleanup Editor window, click Clean-up All.

2. When prompted to confirm the cleanup request, click Yes.

3. If prompted about exceptions to the cleanup request, click Yes.

4. Click CL Excep. The locations that do not meet the conditions for cleanup appear 
in the Cleanup Exceptions window.

Note: Records that appear grayed out are not eligible for cleanup or 
consolidation. A record appears grayed out if (1) either a request for 
cleanup or consolidation already exists or (2) inbound or outbound 
quantities are expected at the locations.

Note: The Cleanup check box must be selected and the record cannot 
be grayed out.
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Figure 4–270 Cleanup Exceptions Window

5. Click Exit/Cancel to close the Cleanup Exceptions window.

Request Consolidation
1. On the Forward Pick Location Cleanup Editor window, select a location that is 

eligible for consolidation.

2. Click Consolidate. The locations that are eligible for consolidation with the 
selected location appear in the Consolidate to Locations window.

Figure 4–271 Consolidate To Locations Window

3. Select the location that you want to consolidate to and click Save.

4. When prompted to confirm the consolidation request, click Yes.

Exit the Forward Pick Location Cleanup Editor Window
Click Exit/Cancel to close the window.

Note: The Consolidate check box must be selected and the record 
cannot be grayed out.
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Container Trouble Code Editor
The Container Trouble Code Editor allows you to maintain a master list of trouble 
codes that can be applied to containers. The trouble codes document problems that are 
noticed when a container is received or processed in some other way.

You can associate a WIP code and an activity with a trouble code. When the trouble 
code is applied to a container, its WIP code is automatically applied to the container. 
The container is then directed to the appropriate rework area.

From the main menu, select Setup Processing/Returns > Container Trouble Editor. The 
current trouble codes appear in the Container Trouble Editor window.

Figure 4–272 Container Trouble Editor Window

Edit a Trouble Code
1. On the Container Trouble Editor window, double-click the trouble code that you 

want to edit. The Modify window opens.

Figure 4–273 Modify Window

2. Edit the description, WIP code, and activity code as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Trouble Code
1. On the Container Trouble Editor window, click Create Record. The Create Record 

window opens.
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Figure 4–274 Create Record Window

2. In the Trouble Code field, enter a code for the trouble.

3. In the Description field, enter a description for the trouble.

4. In the WIP Code field, enter the WIP code that you want to associate with the 
trouble code, or click the LOV button and select the WIP code.

5. In the Activity Code field, enter the activity code that you want to associated with 
the trouble code, or click the LOV button and select the activity code.

6. Click Save to save the change and close the Create Record window.

Delete a Trouble Code
1. On the Container Trouble Editor window, select the trouble code that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Container Trouble Editor Window
Click Exit to close the window.

Cycle Count Plans
Cycle counting is the process of taking inventory at locations within a DC. Locations 
may be manually marked for cycle counts. Another option is to allow RWMS to 
automatically mark locations for cycle counts. RWMS marks locations depending on 
the method that you choose in the system settings. The methods you can choose from 
are by location, zone, and item.

Cycle Counts By Location
Specify how often, in days, the entire distribution center should be counted. Each day, 
a number of locations are automatically marked for counting. For example, if there are 
1000 locations and the frequency is 100 days, RWMS marks 10 locations every day for 
counting.

To set up cycle counts by location, the system parameter, cycle_count_type, must be set 
to location. The parameter, cycle_count_period, must be set to the desired number of 
days.

Note: WIP codes and activity codes are optional. 
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Cycle Counts by Zone
Specify how often, in days, the locations within each zone are counted. RWMS 
automatically marks the locations for cycle counting. Different zones can have 
different cycle count frequencies.

To set up cycle counts by zone, the system parameter, cycle_count_type, must be set to 
zone. Cycle count plans must be defined in the Cycle Count Planning window. On the 
Zone Editor window, select the appropriate cycle count plan for the zone.

Cycle Counts by Item
Specify how often, in days, the locations containing the specified item are counted. 
RWMS automatically marks the location for cycle counting. If the location contains an 
assortment of items, all items within the location must be counted. Different items can 
have different cycle count frequencies. Note that if a location contains an assortment of 
items, the location may be marked for counting more frequently than desired, since 
cycle counts may overlap each other.

To set up cycle counts by item, the system parameter, cycle_count_type, must be set to 
item. On the Cycle Count Planning window, define the cycle count plans. On the Item 
Master Editor window, select the appropriate cycle count plan for the item.

Cycle Count Planning
The Cycle Count Planning Editor allows you to define the cycle count plans utilized in 
your warehouse. You can indicate the frequency (in days) for each cycle count plan.

From the main menu, select Setup Processing/Returns > Cycle Count Planning. The 
Cycle Count Planning window opens.

Figure 4–275 Cycle Count Planning Window

Display All Plans
Click Search.

Display a Plan
1. If any plans are currently displayed, click Clear.

2. Click Query.
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3. In the CC Plan field, enter all or part of the plan's name, or click the LOV button 
and select the plan.

4. Click Search. The plans that match the name or partial name appear.

Edit a Plan
1. On the Cycle Count Planning window, double-click the plan that you want to edit. 

The Modify window opens.

Figure 4–276 Modify Window

2. Edit the description and frequency (in days) as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Plan
1. On the Cycle Count Planning window, click Create Record. The Create Record 

window opens.

Figure 4–277 Create Record Window

2. In the CC Plan and Description fields, enter the name and description of the plan.

3. In the Frequency field, enter how often, in days, that the cycle count must be 
performed.

4. Click Save to save the changes and close the Create Record window.
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Delete a Plan
1. On the Cycle Count Planning window, select the plan that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Cycle Count Planning Window
Click Exit to close the window.

Return Code Editor
The Return Code Editor allows you to view, add, and delete user defined return codes 
that are applied to containers when returned to vendor.

From the main menu, select Setup Processing/Returns > Return Code Editor. The 
current return codes appear in the Return Code Editor window.

Figure 4–278 Return Code Editor Window

Edit a Return Code
1. On the Return Code Editor window, double-click the return code that you want to 

edit. The Modify window opens.

Figure 4–279 Modify Window

2. Edit the description and code type as necessary.

3. Click Save to save any changes and close the Modify window.
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Add a Return Code
1. On the Return Code Editor window, click Create Record. The Create Record 

window opens.

Figure 4–280 Create Record Window

2. In the Return Code field, enter a code for the return.

3. In the Description field, enter a description for the return. The description states 
either the reason for the return or the action to be taken with the returned 
merchandise.

4. In the Code Type field, enter A for an action code or R for a reason code.

5. Click Save to save the change and close the Create Record window.

Delete a Return Code
1. On the Return Code Editor window, select the return code that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Return Code Editor Window
Click Exit to close the window.

Vendor Non Conformance Code Editor
The Vendor Non Conformance Codes Editor allows you to define and view a list of 
vendor non conformance codes. You can describe a vendor non conformance code and 
associate it with a trouble code, WIP code and an activity code.

From the main menu, select Setup Processing/Returns > Vendor Non Conformance 
Trouble Code Editor. The current trouble codes appear in the Vendor Non 
Conformance Trouble Code Editor window.
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Figure 4–281 Vendor Non Conformance Trouble Code Editor Window

Edit a Trouble Code
1. On the Vendor Non Conformance Trouble Code Editor window, double-click the 

trouble code that you want to edit. The Modify window opens.

Figure 4–282 Modify Window

2. Edit the Description, Trouble Code, WIP Code, and Sequence Number as 
necessary.

3. Change the Status to Active or Inactive by selecting an option button.

4. Click Save to save any change and close the Modify window.

Add a Trouble Code
1. On the Vendor Non Conformance Trouble Code Editor window, click Create 

Record. The Create Record window opens.
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Figure 4–283 Create Record Window

2. In the Non Conformance Code field, enter a code for the trouble.

3. In the Description field, enter a description for the trouble.

4. In the Trouble Code field, enter the trouble code that you want to associate with 
the vendor non conformance code, or click the LOV button and select the trouble 
code.

If the trouble code is associated with a WIP code, the WIP Code and Activity Code 
fields are automatically updated.

5. In the WIP Code field, enter the WIP code that you want to associate with the 
trouble code, or click the LOV button and select the WIP code. 

The Activity Code field is automatically updated with the activity code associated 
with the WIP code.

6. In the Sequence Number field, enter the sequence number for the non 
conformance code.

7. Click Save to save the change and close the Create Record window.

Delete a Trouble Code
1. On the Vendor Non Conformance Trouble Code Editor window, select the trouble 

code that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Vendor Non Conformance Trouble Code Editor Window
Click Exit to close the window.

Note: The Trouble Code, WIP Code, Activity Code, and Sequence 
Number fields are optional.

Note: A new Vendor Non Conformance code is always created in 
Active mode by default. Edit the Vendor Non Conformance code to 
change it to Inactive mode.
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WIP Code Editor
The WIP Code Editor allows you to define new WIP codes and view all existing WIP 
codes (both user defined and system seeded). WIP codes get associated with 
containers. They are used to direct the containers to the appropriate locations where 
value added services can be applied.

From the main menu, select Setup Processing/Returns > WIP Code Editor. The current 
WIP codes appear in the WIP Code Editor window.

Figure 4–284 WIP Code Editor Window

Edit a WIP Code
1. On the WIP Code Editor window, double-click the WIP code that you want to edit. 

The Modify window opens.

Figure 4–285 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Note: To view the instructions for a WIP code in a separate window, 
select the WIP code and click View Instructions.
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Add a WIP Code
1. On the WIP Code Editor window, click Create Record. The Create Record window 

opens.

Figure 4–286 Create Record Window

2. In the WIP Code and Description fields, enter a code and description for the WIP.

3. In the Location ID field, enter the ID of the location where the activity takes place, 
or click the LOV button and select the location.

4. In the Activity field, enter the code for the activity associated with the WIP, or click 
the LOV button and select the activity.

5. In the Instructions field, enter instructions for the activity if it pertains to gift 
wrapping or personalization.

6. In the Ship Unfinished field, enter Y (Yes) if merchandise may be shipped even if 
the WIP is not processed or N (No) if the WIP must be processed.

7. Click Save to save the changes and close the Create Record window.

Delete a WIP Code
1. On the WIP Code Editor window, select the WIP code that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the WIP Code Editor Window
Click Exit to close the window.
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Setup - Transportation
The Transportation Setup module allows you to set up shipping destinations, routes, 
carriers, and trailers. This information is used by RWMS to schedule appointments 
and shipments, load merchandise on trailers in a logical sequence, sequence the routes 
for each day, and track trailer status.

Business Process
There is a logical progression to follow when setting up routes, carriers, and trailers.

Routes
■ Identify the destinations to which merchandise may be shipped. Provide contact 

information and handling instructions for each destination.

■ Identify the routes and indicate whether they are active or inactive.

■ Assign routes to a day of the week or a specific date. Indicate the route sequence 
for each day or date.

■ Assign destinations to a route. Indicate the load sequence for each route.

You can look up route details by route number. The details include days on which the 
route is run, destinations, and load sequences.

Carriers
■ Identify the carriers and enter contact information.

■ Identify services and associate routes and staging locations with each carrier.

Trailers
Identify the trailers. Associate carriers with the trailers. State the cubic capacity of each 
trailer.

This section includes the following topics:

■ Carrier Editor

■ Carrier Service Route Editor

■ Delivery Slot Listing

■ Destination Day Route Summary

■ Destination Editor

■ Load Type Editor

■ Route Date Editor

■ Route Day Editor

■ Route Destination Editor

■ Route Editor

■ Trailer Editor

Carrier Editor
The Carrier Editor allows you to maintain a master list of carriers including the names 
and telephone numbers of contact persons.
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You can access the Carrier Service Route Editor by clicking the Details link to view the 
defined service routes for a carrier.

From the main menu, select Setup Transportation > Carrier Editor. The current carriers 
appear in the Carrier Editor window.

Figure 4–287 Carrier Editor Window

Edit a Carrier
1. On the Carrier Editor window, double-click the carrier that you want to edit. The 

Modify window opens.

Figure 4–288 Modify Window

2. Edit the carrier name and contact information as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Carrier
1. On the Carrier Editor window, click Create Record. The Create Record window 

opens.
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Figure 4–289 Create Record Window

2. In the Code and Name fields, enter the code and name for the carrier.

3. In the Phone field, enter the telephone number of the carrier.

4. In the Contact field, enter the name of the contact person.

5. Click Save to save the changes and close the Create Record window.

Delete a Carrier
1. On the Carrier Editor window, select the carrier that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Carrier Editor Window
Click Exit to close the window.

Carrier Service Route Editor
The Carrier Service Route Editor allows you to define the level of service and the 
routes for each Carrier.

From the main menu, select Setup Transportation > Carrier Service Route Editor. The 
Carrier Service Route Editor window opens.

Figure 4–290 Carrier Service Route Editor Window

Note: You can also access this window from the Carrier Editor 
window.
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Display Service Routes for a Carrier
1. If any service routes are currently displayed, click Clear.

2. Click Query.

3. In the Carrier field, enter the code for the carrier, or click the LOV button and 
select the carrier.

4. Click Search. The service routes for the selected carrier are displayed.

Edit a Service Route
1. On the Carrier Service Route Editor window, double-click the service route that 

you want to edit. The Modify window opens.

Figure 4–291 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Service Route
1. On the Carrier Service Route Editor window, click Create Record. The Create 

Record window opens.

Figure 4–292 Create Record Window

2. In the Service field, enter a code for the service.

3. In the Route field, enter the route, or click the LOV button and select the route.
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4. In the Location ID field, enter the ID of the staging or door location, or click the 
LOV button and select the location.

5. In the Default field, enter D for a default route or E for a default expedite route as 
necessary.

6. Click Save to save the changes and close the Create Record window.

Delete a Service Route
1. On the Carrier Service Route Editor window, select the service route that you want 

to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Carrier Service Route Editor Window
Click Exit to close the window.

Delivery Slot Listing
The Delivery Slot Listing allows you to view the different delivery slots. The 
information is sorted by ID, sequence, and description.

From the main menu, select Setup Transportation > Delivery Slot Listing. The Delivery 
Slot Listing window opens.

Figure 4–293 Delivery Slot Listing Window

Display All Delivery Slots
Click Search.

Display Assignments for One Delivery Slot
1. If any delivery slot are currently displayed, click Clear .

2. Click Query.

Note: You may be prompted to overwrite an existing default or 
default expedite route. Click Yes or No as necessary. Only one default 
route and one expedite route is permitted per facility.
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3. In the Delivery Slot ID field, enter the slot, or click the LOV button and select the 
slot.

4. Click Search. The delivery slots for the selected ID appear.

Exit the Delivery Slot Listing Window
Click Exit to close the window.

Destination Day Route Summary
The Destination Day Route Summary allows you to view route assignments by day 
with their corresponding destinations and load sequence number.

From the main menu, select Setup Transportation > Destination Day Route Summary. 
The Destination Day Route Summary window opens.

Figure 4–294 Destination Day Route Summary Window

Display Assignments for All Routes
Click Search.

Display Assignments for One Route
1. If any assignments are currently displayed, click Clear.

2. Click Query.

3. In the Route ID field, enter the route, or click the LOV button and select the route.

4. Click Search. The assignments for the selected route appear.

Exit the Destination Day Route Summary Window
Click Exit to close the window.

Destination Editor
The Destination Editor allows you to view destinations downloaded from the host 
management system. RWMS does allow the creation and deletion of destinations 
within the application but this is not a normal process.

The types of destinations that you might enter include the distribution center (DC), 
internal processing areas, return to vendor locations, stores, cross-dock centers, virtual 
stores, and third party locations.
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Some retailers direct outbound shipments through a break-bulk facility, which then 
sorts the cartons and facilitates delivery of merchandise to stores. If a break bulk code 
is associated with the destination, attributes are included on the shipping label (both 
UCC128 and non-UCC128 type labels). Based on the shipping label, personnel at the 
break-bulk facility can determine how to stage and route containers to their next 
destination.

From the main menu, select Setup Transportation > Destination Editor. The Ship 
Destination Editor window opens.

Figure 4–295 Destination Editor Window

Display a Destination
1. If a destination is currently displayed, click Clear.

2. Click Query.

3. In the Destination field, enter the ID of the destination, or click the LOV button 
and select the destination.

4. Click Search. The details for the selected destination are displayed.

Edit a Destination
1. On the Ship Destination Editor window, double-click any field except the fields 

with LOV buttons. The Modify window opens.



Setup - Transportation

Support Functions 4-243

Figure 4–296 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Destination
1. On the Ship Destination Editor window, click Create Record. The Create Record 

window opens.
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Figure 4–297 Create Record Window

2. In the Destination field, enter an ID for the destination.

3. In the Destination Type field, enter the type of destination, or click the LOV button 
and select the destination type.

4. In the Name and Address block, enter the name, address, telephone, and fax in the 
appropriate fields.

5. In the Detail block, enter or select the appropriate details for the destination.

6. Click Save to save the changes and close the Create Record window.

Delete a Destination
1. On the Ship Destination Editor window, click Delete Record.

2. When prompted to delete the record, click Yes.

Exit the Ship Destination Editor Window
Click Exit to close the window.

Load Type Editor
The Load Type Editor allows you to define inbound trailer load types. Load types are 
user definable and usually include such types as refrigerated, ambient, hazmat, 
hanging, and so on. You can define load types at the item and appointment level. Each 
receiving door may be associated with one or more load types. In order for RWMS to 
recommend best fit doors for users, load types can be defined for doors.
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From the main menu, select Setup Transportation > Load Type Editor. The current load 
types and descriptions appear in the Load Type Editor window.

Figure 4–298 Load Type Editor Window

Edit a Record
1. On the Load Type Editor window, double-click the record that you want to edit. 

The Modify window opens.

Figure 4–299 Modify Window

2. Edit the load type information as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Load
1. On the Load Type Editor window, click Create Record. The Create Record 

window opens.
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Figure 4–300 Create Record Window

2. Enter the Load Type, description, and the Load Type Indicator fields.

3. Click Save to save the changes and close the Create Record window.

Delete a Load
1. On the Load Type Editor window, select the load that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

4. Click Exit/Cancel to close the window and save your changes.

Exit the Load Type Editor Window
Click Exit to close the window.

Route Date Editor
The Route Date Editor allows you to assign routes to a specific date. Several routes 
may run on a particular date. A sequence number is used to logically order the routes.

From the main menu, select Setup Transportation > Route Date Editor. The current 
routes appear in the Route Date Editor window.

Figure 4–301 Route Date Editor Window
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Display all Routes
Click Search.

Display a Subset of Routes
1. If any routes are currently displayed, click Clear.

2. Click Query.

3. To search for a route, enter the name of the route in the Route field, or click the 
LOV button and select the route. To search for routes by ship date, enter the ship 
date of the routes in Ship Date field, or click the Calendar icon and select the ship 
date.

4. Click Search. The routes and ship dates that match the search criterion appear.

Edit a Route
1. On the Route Date Editor window, double-click the route that you want to edit. 

The Modify window opens.

Figure 4–302 Modify Window

2. Edit the route sequence as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Route
1. On the Route Date Editor window, click Create Record. The Create Record 

window opens.

Figure 4–303 Create Record Window

2. In the Ship Date field, enter the date, or click the Calendar icon and select the date.
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3. In the Route field, enter the route, or click the LOV button and select the route.

4. In the Route Sequence field, enter a number to indicate the order in which the 
route must be run on the selected date.

5. Click Save to save the changes and close the Create Record window.

Delete a Route
1. On the Route Date Editor window, select the route that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

4. Click Exit/Cancel to close the window and save your changes.

Exit the Route Date Editor Window
Click Exit to close the window.

Route Day Editor
The Route Day Editor allows you to assign routes to days of the week. Several routes 
may run on a particular day. A sequence number is used to logically order the routes.

From the main menu, select Setup Transportation > Route Day Editor. The Route Day 
Editor window opens.

Figure 4–304 Route Day Editor Window

Edit a Route
1. On the Route Day Editor window, double-click the route that you want to edit. 

The Modify window opens.
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Figure 4–305 Modify Window

2. Edit the route sequence as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Route
1. On the Route Day Editor window, click Create Record. The Create Record 

window opens.

Figure 4–306 Create Record Window

2. In the Day field, enter the day of the week, or click the Calendar icon and select 
the date.

3. In the Route field, enter the route, or click the LOV button and select the route.

4. In the Route Sequence field, enter a number to indicate the order in which the 
route must be run on the selected day.

5. Click Save to save the changes and close the Create Record window.

Delete a Route
1. On the Route Day Editor window, select the route that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Route Day Editor Window
Click Exit to close the window.
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Route Destination Editor
The Route Destination Editor window allows you to assign destinations and load 
sequences to routes. A route may have several destinations. The sequence number 
indicates a logical order for loading merchandise that must be shipped to multiple 
destinations.

From the main menu, select Setup Transportation > Route Destination Editor. The 
current route destinations appear in the Route Destination Editor window.

Figure 4–307 Route Destination Editor Window

Edit a Route Destination
1. On the Route Destination Editor window, double-click the route destination that 

you want to edit. The Modify window opens.

Figure 4–308 Modify Window

2. Edit the load sequence as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Route Destination
1. On the Route Destination Editor window, click Create Record. The Create Record 

window opens.
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Figure 4–309 Create Record Window

2. In the Ship Date field, enter the date to ship the merchandise, or click the Calendar 
icon and select a date.

3. In the Route field, enter the route, or click the LOV button and select the route.

4. In the Destination ID field, enter the ID of the destination, or click the LOV button 
and select the destination.

5. In the Load Sequence field, enter the sequence in which merchandise for the 
specified destination should be loaded.

6. Click Save to save the changes and close the Create Record window.

Delete a Route Destination
1. On the Route Destination Editor window, select the route destination that you 

want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Route Destination Editor Window
Click Exit to close the window.

Route Editor
The Route Editor allows you to define the shipping routes for the warehouse. You can 
indicate whether the route is active or inactive.

After routes are identified, you can use them to 1) assign routes by day, 2) assign 
destinations and load sequences to routes, and 3) view route assignments by day.

From the main menu, select Setup Transportation > Route Editor. The current routes 
appear in the Route Editor window.

Note:  If you use a third-party routing system, the ship date is filled 
in automatically.
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Figure 4–310 Route Editor Window

Edit a Route
1. On the Route Editor window, double-click the route that you want to edit. The 

Modify window opens.

Figure 4–311 Modify Window

2. Edit the status and description as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Route
1. On the Route Editor window, click Create Record. The Create Record window 

opens.

Figure 4–312 Create Record Window
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2. In the Route field, enter the name of the route.

3. In the Route Status field, select the status of the route. The status may be:

■ Active: Places the route in service.

■ Inactive: Takes the route out of service.

4. In the Description field, enter the description of the route.

5. Click Save to save the changes and close the Create Record window.

Delete a Route
1. On the Route Editor window, select the route that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Route Editor Window
Click Exit to close the window.

Trailer Editor
The Trailer Editor allows you to define and view a fleet of trailers. The editor shows 
the status of each trailer and allows you to specify the carrier and cubic capacity of the 
trailer. You can also check in or check out the trailer from the yard.

From the main menu, select Setup Transportation > Trailer Editor. The Trailer Editor 
window opens.

Figure 4–313 Trailer Editor Window

Display All Trailers
Click Search.

Display a Subset of Trailers
1. If any trailers are currently displayed, click Clear.

2. Click Query. The Advanced Search window opens.

3. In the criteria fields, enter a partial ID, or click the LOV button and select the 
criterion.

4. Click Search. The trailers appear on the Trailer Editor window.



Setup - Transportation

4-254 Oracle® Retail Warehouse Management System UI User Guide

Edit a Trailer
1. On the Trailer Editor window, double-click the trailer that you want to edit. The 

Modify window opens.

Figure 4–314 Modify Window 

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Trailer
1. On the Trailer Editor window, click Create Record. The Create Record window 

opens.

Figure 4–315 Create Record Window

2. In the Trailer ID field, enter the ID of the trailer.

3. In the Carrier field, enter the code for the carrier, or click the LOV button and 
select the carrier.

4. In the Cube field, enter the cubic capacity of the trailer.
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5. If the trailer record should be saved after the trailer is checked out of the DC, select 
the Permanent check box.

6. In the Location ID field, enter the ID of the yard location, or click the LOV button 
and select the location.

7. In the Trailer UDA 1 - 10 fields, enter the UDA ID, or click the LOV button and 
select the UDA.

8. Click Save to save the changes and close the Create Record window.

Delete a Trailer
1. On the Trailer Editor window, select the trailer that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Edit the Status of a Trailer
1. On the Trailer Editor window, select the trailer that you want to edit.

2. Click Check In to change the status of a trailer from Scheduled to Arrived 
Inbound or from Checked-out to Unloaded. Click Check Out to change the status 
of a trailer from Shipped or Unloaded to Checked Out.

Generate the Trailer Status Report
1. On the Trailer Editor window, click Print. The Trailer Status Setup window opens.

2. In the Destination type field, select the type of destination.

3. In the Destination name field, select the name of the destination.

4. To view the layout of the report, select the Layout tab.

5. Click Save. The report is sent to the selected destination.

Exit the Trailer Editor Window
Click Exit to close the window.

Setup - User
The User Setup module is used to define users in RWMS, associate users to activity 
groups, and to associate users to equipment. 

This section includes the following:

■ User Activity Group Editor

■ User Attribute Editor

■ User Class Editor

■ User Editor

■ User Equipment Class Editor

■ User Message Editor

■ User Training Editor

Note:  To return to the default settings, click Default.
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User Activity Group Editor
The User Activity Group Editor window is used to assign one or more activity groups 
to a specific user. When X, Y, Z coordinates are not populated, RWMS uses location 
and priority to assign tasks to the users. When X, Y, Z coordinates are populated, the 
coordinates and priority are used to assign tasks. If only one activity group is assigned 
to a user, that activity group gets pre-populated when they sign on to an RF window. If 
more than one activity group is assigned to a user, then the user has to select the 
activity group desired.

From the main menu, select Setup User > User Activity Group Editor. The User 
Activity Group Editor window opens.

Figure 4–316 User Activity Group Editor Window

Display an Assignment
1. On the User Activity Group Editor window, if any assignment is currently 

displayed, click Clear.

2. Click Query.

3. In the User ID field, enter the user ID, or click the LOV button and select a user ID.

4. You can also search using Activity Group. In the Activity Group field, enter the 
activity group, or click the LOV button and select an activity group.

5. Click Search. The user ID and the associated activity groups matching the selected 
criterion appear on the window.

Edit an Assignment
1. On the User Activity Group Editor window, double-click the assignment that you 

want to edit. The Modify window opens.
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Figure 4–317 Modify Window

2. To assign an activity group to a user, from the Available table, select the Activity 
Group using the check box and click Assign.

3. To unassign an activity group from a user, from the Assigned table, select the 
Activity Group using the check box and click Unassign.

4. Click Save to save any changes and close the Modify window.

Add an Assignment
1. On the User Activity Group Editor window, click Create Record. The Create 

Record window opens.

Figure 4–318 Create Record Window

2. To assign an activity group to a user, from the Available table, select the Activity 
Group using the check box and click Assign.
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3. To unassign an activity group from a user, from the Assigned table, select the 
Activity Group using the check box and click Unassign.

4. Click Save to save the changes and close the Create Record window.

Delete an Assignment
1. On the User Activity Group Editor window, select the assignment that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the User Activity Group Editor Window
Click Exit to close the window.

User Attribute Editor
The User Attribute Editor allows you to assign and view attributes to a user. Your 
choices are restricted to those attributes that have been marked as available for user 
classes.

From the main menu, select Setup User > User Attribute Editor. The User Attributes 
Editor window opens.

Figure 4–319 User Attributes Editor Window

Edit a User Attribute
1. On the User Attribute Editor window, double-click the user attribute that you 

want to edit. The Modify window opens.
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Figure 4–320 Modify Window

2. Edit the description and active status as necessary.

3. Click Save to save any changes and close the Modify window.

Add a User Attribute
1. On the User Attribute Editor window, click Create Record. The Create Record 

window opens.

Figure 4–321 Create Record Window

2. Enter appropriate information in the fields.

3. Click Save to save the changes and close the Create Record window.

Delete a User Attribute
1. On the User Attribute Editor window, select the user attribute that you want to 

delete.
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2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the User Attribute Editor Window
Click Exit to close the window.

User Class Editor
The User Class Editor allows you to define and view user classes. A user class is used 
to group users who are likely to perform the same processes. After defining the user 
class, you assign the appropriate attributes to a user class and you can assign users to a 
user class.

From the main menu, select Setup User > User Class Editor. The User Class Editor 
window opens.

Figure 4–322 User Class Editor Window

Display All User Classes
Click Search.

Display a User Class
1. If any user classes are currently displayed, click Clear.

2. Click Query.

3. In the User Class field, enter the name of the user class, or click the LOV button 
and select the user class.

4. Click Search. The user class that matches the search criterion opens.

Edit a User Class
1. On the User Class Editor window, double-click the user class that you want to 

edit. The Modify window opens.
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Figure 4–323 Modify Window

2. Edit the description and active status as necessary.

3. Click Save to save any changes and close the Modify window.

Add a User Class
1. On the User Class Editor window, click Create Record. The Create Record 

window opens.

Figure 4–324 Create Record Window

2. In the User Class and Description fields, enter a name and description for the user 
class.

3. To make the user class available to users, select the Active Flag check box.

4. Click Save to save the changes and close the Create Record window.

Assign Attributes
1. On the User Class Editor window, select the user class that you want to edit.

2. Click Assign Attributes. The Assign Attributes window opens.
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Figure 4–325 Assign Attributes Window

3. To assign attributes, select an attribute from the drop-down lists.

4. Click Save to save any changes and close the Attributes window.

Assign Users to a User Class
1. On the User Class Editor window, select the user class that you want to edit.

2. Click Assign Users. The Assign Users window opens.

Figure 4–326 Assign Users Window

3. To assign users:

a. Select the check box next to the desired user on the Available Users table.

b. Click Assign. The selected users are moved to the Assigned Users table.
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4. To remove assigned users:

a. Select the check box next to the desired users on the Assigned Users table.

b. Click Unassign. The selected users are moved to the Available Users table.

5. Click Save to save any changes and close the Assign User to Class window.

Delete a User Class
1. On the User Class Editor window, select the user class that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the User Class Editor Window
Click Exit to close the window.

User Editor
The User Editor allows you to set up User Names and Passwords for each distinct 
RWMS facility. Within this editor, you can also define the user’s window privilege 
level, user class, base language, default work shift, and task accept mode. The user 
inherits all the processes that were assigned to the user class.

From the main menu, select Setup User > User Editor. The current users appear in the 
User Editor window.

Figure 4–327 User Editor Window

Display All Users
To display all users, click Search.

Note:  In the Assign User to Class window, you can 1) click Assign 
All to move all users to the Assigned Users table or 2) click Unassign 
All to move all users to the Available Users table. All users are moved 
whether or not the check boxes are selected.

Note: You cannot delete a user class if the system indicator is 
selected or if any processes have been assigned to the user class.
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Edit a User
To edit a user:

1. On the User Editor window, double-click the user that you want to edit. The 
Modify window opens.

Figure 4–328 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a User
To add a user:

1. On the User Editor window, click Create Record. The Create Record window 
opens.
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Figure 4–329 Create Record Window

2. In the Facility field, enter the ID of the facility, or click the LOV button and select 
the facility.

3. In the Name field, enter the name of the user.

4. In the User Class field, enter the ID of the user class to which the user belongs, or 
click the LOV button and select the user class.

5. In the Privilege field, enter the privilege level for the user. The user privilege is 
compared to the privilege assigned to each window in the menu editor to 
determine whether a user has access to a window. For example, if a user is created 
with a privilege of 5 and a window has a privilege of 7, that specific user will not 
be able to use that window.

6. In the Language field, enter the code for the user's language preference, or click 
the LOV button and select the language.

7. In the Default Shift field, enter the default shift for the user, or click the LOV 
button and select the shift.

8. In the Task Accept Mode, click the LOV button and select Always, Change, or 
Never:

■ Always means that when using the RF Task Administration window, RWMS 
will always ask the user to accept the next activity (task) being assigned.

■ Change means that when using the RF Task Administration window, RWMS 
will only ask the user to accept the new activity (task) when the activity is 
different than the previously activity completed. In other words, if the user 
just completed a putaway and the next activity suggested is bulk picking, 
RWMS will ask the user to accept the new assignment.

■ Never means that when using the RF Task Administration window, RWMS 
never asks the user to accept the next task. This setting is used for experienced 
workers who can transition from one activity to another seamlessly.
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9. In the User ID and Password fields, enter the user ID and password that the user 
must use in order to log in to RWMS.

The password field is a non-editable field and the user's initial password is created 
by the system. When the user first signs onto RWMS, the system will prompt the 
user to create a new password that will replace the system-generated password.

10. Click Save to save the changes and close the Create Record window.

Delete a User
1. On the User Editor window, select the user that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the User Editor Window
Click Exit to close the window.

Maintain User Attributes
1. On the User Table Editor window, click Assign Attributes. The User Attribute 

Editor window opens.

Figure 4–330 User Attribute Editor Window

For more information, see User Attribute Editor.

Maintain User Activity Groups
1. On the User Table Editor window, click Activity Group. The User Activity Group 

Editor window opens.

Figure 4–331 User Activity Group Editor Window
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For more information, see User Activity Group Editor.

Associate Users to Equipment Classes
1. On the User Table Editor window, click Equipment. The User Equipment Editor 

window opens.

Figure 4–332 User Equipment Editor Window

For more information, see User Equipment Class Editor.

Exit the User Table Editor Window
Click Exit to close the window.

User Equipment Class Editor
The User Equipment Class Editor allows you to associate a user to one or more 
Equipment Classes within your facility. Once a user is assigned to an Equipment Class, 
that user is authorized to use that class of equipment to perform activities that require 
that type of equipment.

From the main menu, select Setup User > User Equipment Class Editor. The User 
Equipment Class Editor window opens.

Figure 4–333 User Equipment Class Editor Window

Display all Users and Equipment Class Assignments
Click Search.

Display a Specific User ID
1. Click Query.
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2. In the User ID field, enter the user ID, or click the LOV button to select from a list 
of users.

3. Click Search. The user and associated equipment classes that match the search 
criteria displays.

Edit a User Equipment Class
1. On the User Equipment Class Editor window, double-click the user that you want 

to edit. The Modify window opens.

Figure 4–334 Modify Window

2. Edit the modify fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add an Equipment Class to a User
1. On the User Equipment Class Editor window, click Create Record. The Create 

Record window opens.
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Figure 4–335 Create Record Window 

2. In the User ID Field, enter the desired User ID or select from the List of values. 
After making your selection, press Enter and the full User Name will be 
auto-populated.

3. In the Equipment Class Field, enter the desired Equipment Class or select from the 
List of values. After making your selection, press Enter and the full description of 
the user class will be auto-populated.

The Certificate Required flag is non-editable and is set in the Equipment Class 
Editor.

4. In the Licensed Field, select the check box if you are licensed to drive this class of 
equipment.

5. In the Certificate Number Field, enter the certificate number earned for this 
equipment class.

6. In the Issue Date field, enter the issue date that appears on the actual certificate.

7. In the Expiration Date field, enter the expiration date that appears on the actual 
certificate.

8. Click Save to save all entries and close the Create window.

Delete a User Equipment Class Assignment
1. On the User Equipment Class Editor window, click the record of the user that you 

want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the User Equipment Class Editor Window
Click Exit to close the window.
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User Message Editor
The User Message Editor allows you to view the system message codes in RWMS and 
modify the displayed message if needed. The message displays in the language 
associated to the User ID.

From the main menu, select Setup User > User Message Editor. The User Message 
Editor window opens.

Figure 4–336 User Message Editor window

Display the Messages
1. If any messages are currently displayed, click Clear. 

2. Click Query.

3. In the Code field, enter the code for the language, or click the LOV button and 
select the language.

4. Click Search. The messages associated with the selected language appear.

Edit a Translation
1. On the User Message Editor window, double-click the message that you want to 

edit. The Modify window opens.

Figure 4–337 Modify Window

2. Edit the message and type as necessary.

3. Click Save to save any changes and close the Modify window.
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Exit the User Message Editor Window
Click Exit to close the window.

User Training Editor
The User Training Editor allows you to define the training level (skill) for an employee 
at either the global level or the individual activity level. The valid values for training 
are: Beginner, Intermediate, and Expert. This information is only used in the Labor 
Management Template when you assign a Training Allowance.

When a training allowance is set in the Labor Management Template, RWMS then 
looks at this editor to determine if the user performing the activity has a matching 
training level and then it applies the training allowance to the Labor Standard.

For each user, RWMS supports the entry of a Training End Date. The training 
allowance will be given up to this date (inclusive) but after that date the user assumed 
to be an expert and the allowance is not given from that time forward.

To access the User Training Editor, navigate to Setup - User, and select User Training 
Editor.

Figure 4–338 User Training Editor Window

Display a specific User
1. Click Query.

2. In the User ID field, enter the desired User ID, or click the LOV button and select 
User ID.

3. Click Search. The User ID related to your search appears.

Edit a Training Level
1. On the User Training Editor, enter or select the desired User ID and click Search. 

Select the desired record you want to edit and double-click. The Modify window 
opens.
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Figure 4–339 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window

Add a Training Level to an Employee
1. On the User Training Editor, enter or select the desired User ID and click Search.

2. Define whether you want to set the training level at the user level (for all activities 
labor managed) or at the specific Activity level by selecting the appropriate option.

3. Click Create Record to open the Create Record window.

Figure 4–340 Create Record Window

4. In the Activity code field, select the activity from the List of values included in the 
activity group. If you applied training at the User Level this field will not be 
editable and will have the word ALL automatically inserted.

5. In the Training Level field, select your training level for this User ID (employee). 
The valid values are Beginner, Intermediate, and Expert.

6. In the Training End Date field, select the Date where the employee has successfully 
completed training. When this date is reached the User ID (employee) will no 
longer get a training allowance in the Labor Standard Calculation

7. Click Save to save the changes and close the Create Record window.

Delete a User Training Level
1. On the User Training Editor enter or select the desired User ID from the List of 

Values and then click Search.

2. Click Delete Record.

3. When prompted to confirm request, click Yes.
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Exit the User Training Editor Window
Click Exit to close the window.
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5
Appointments

An appointment is an arrangement to receive merchandise into the distribution center 
at a specified time and place. A valid appointment consists of the following details: 
date, time, and receiving door. Advanced Shipment Notices (ASN) or Purchase Orders 
with items and unit quantities are associated with appointments.

The receiving window (of opportunity), for an appointment is based on the Deliver 
Not Before and Deliver Not After dates found on a purchase order. Only one trailer 
may be assigned to an appointment, but one trailer may contain merchandise from 
multiple purchase orders or some of the merchandise from one purchase order.

RWMS tracks the status of an appointment from the moment it is entered into the 
system. The status may be:

■ Unscheduled (Unsc): The appointment was entered into the system without one or 
more of the following: date, time, or receiving door. A receiving package is not 
generated for unscheduled appointments.

■ Scheduled (Schd): The appointment appears on the calendar. The merchandise to 
be received may or may not be known.

■ Pending (Pend): A receiving package was printed in anticipation of the arrival of 
the expected merchandise.

■ Open (Open): The trailer that is associated with the appointment is being 
unloaded.

■ Unreconciled (Unrc): The appointment has some discrepancies concerning what 
was received. The appointment must be reconciled. The door, however, is 
available for another appointment.

■ Received (Rcvd): The expected merchandise was received during the appointment.

Business Process
An appointment may be entered into RWMS with minimal information. If the date, 
time, and receiving door are entered, the appointment appears on the calendar. 
Otherwise, it is held in RWMS as an unscheduled appointment.

The details of an appointment are entered from purchase orders or ASNs. Purchase 
orders and items are received from the host system. Purchase orders may also be 
created automatically in RWMS via store to DC transfers. ASNs may be received from 
an external source or entered manually.

Several types of appointments may be entered into RWMS:

■ Flexible Pallet Receiving with Details: Appointment details are created by 
attaching valid purchase orders and the desired items from those purchase orders. 
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The Casepack for each item is specified on the purchase orders. Generic pallet 
labels are applied during the receiving process.

■ Flexible Pallet Receiving without Details: Appointment details are created by 
attaching valid purchase orders but the items being received are not specified on 
the appointment. The item details are captured during the RF receiving process. 
The items being received must exist on the attached purchase orders. Generic 
pallet labels are applied during the receiving process. 

■ PO: Appointment details are created by attaching valid purchase orders and the 
desired items from those purchase orders. The Casepack for each item is specified 
on the purchase orders. Formatted/generic labels are produced by RWMS and 
applied during the receiving process.

■ ASN: Appointment details are created by attaching downloaded ASNs. The 
Casepack is known for container type and tare type ASNs but unknown for PO 
type ASNs.

■ NSC: Appointment details are created by attaching valid purchase orders and the 
desired items/quantities from those purchase orders. The Casepack is unknown. 

■ ASN/NSC: Appointment details are created by attaching valid purchase orders or 
valid ASNs. The Casepack is unknown. 

As you set up an appointment, you can indicate whether quality assurance or vendor 
audit checks should be made on the merchandise when it is received. In such cases, 
you can indicate the sampling percentages and number of containers at the style level.

Unscheduled appointments (those without a date, time, or receiving door) can be 
scheduled when the missing details are known. You can access schedules for receiving 
doors in order to:

■ Schedule unscheduled appointments

■ Change existing schedules

■ Block or unblock access to doors

■ View a bar chart that shows utilization percentages by door for a specified date

You can look up appointments, ASNs, and purchase orders in the Appointments 
module.

This chapter contains the following topics:

■ Appointed PO Inquiry

■ Appointment ASN

■ Appointment Calendar

■ Appointment Details

■ Appointment Schedule

■ Door Schedule Screen

■ FPR PO Assign

■ NSC Appointment Details

■ Purchase Order Inquiry

■ Standing Appointment Editor

■ Unscheduled Appointment Inquiry
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Appointed PO Inquiry
The Appointed PO Inquiry Editor allows you to view purchase orders that have an 
existing appointment against them. You can access the PO Detail window in order to 
view the items on a purchase order.

From the main menu, select Appointments > Appointed PO Inquiry. The Appointed 
PO Inquiry editor opens.

Figure 5–1 Appointed PO Inquiry Editor Window

Display all Appointments
In Appointment PO Inquiry editor, click Search to view all appointments.

Display a Subset of the Appointments
1. If any appointments are currently displayed, click Clear.

2. Click Query. An LOV button displays next to all the available fields such as PO, 
Vendor, Item, Department, PO Type, Subclass, and Class. 

3. In one or more of the fields, enter the desired criteria.

4. Click Search. The appointments that match the criteria are displayed.

View the Details of an Appointment
1. On the Appointment PO Inquiry tab, select the appointment that you want to view 

in detail.

2. Click Details. The details appear in the Appointment Detail editor.

Note: When querying a PO that is Preassigned, the Preassign field 
needs to be selected.
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Figure 5–2 Appointment Detail Editor Window

3. Click Exit to close the Appointment Detail editor and return to the Appointed PO 
Inquiry editor.

View a Door Schedule
1. On the Appointment PO Inquiry tab, select the appointment that you want to view 

the door schedule for.

2. Click the Door Schedule link. The details are displayed in the Door Schedule 
Screen editor.

3. Click Exit to close the Door Schedule editor and return to the Appointed PO 
Inquiry editor.

Figure 5–3 Door Schedule Editor Window

Exit the Appointed PO Inquiry Window
Click Exit to close the window.
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Appointment ASN
The Appointment ASN Editor allows you to maintain the advanced shipment notices 
(ASN) that are associated with an ASN type of appointment. You can add or delete 
ASNs on appointments which have a status of Unscheduled (Unsc) or Scheduled 
(Schd).

You can access the ASN Detail Inquiry window in order to view the details of an ASN. 
You can also access the Door Schedule window in order to view and maintain 
scheduling at the receiving doors

From the main menu, select Appointments > Appointment ASN. The Appointment 
ASN editor opens.

Figure 5–4 Appointment ASN Window

Display Appointment ASN
1. If any ASNs are currently displayed, click Clear.

2. Click Query. An LOV button displays next to the Appt Nbr field.

3. Select a number from the Appt Nbr LOV button or search for an appointment that 
has an ASN and the NSC check box cleared.

4. Click Search. The ASNs that match the criteria appear.

Add an ASN to an Appointment

1. Search for an unscheduled appointment by entering a number in the Appt Nbr 
field. The ASN that match the criteria displays.

2. Click the Create Record link. The Create Record window opens.

3. Enter an ASN number in the ASN field or select an ASN from the LOV button.

Note: You can access the Appointment ASN window from the 
Appointment Schedule, Appointment ASN, and PO Inquiry windows. 
You can also choose Appointments > Appointment ASN from the 
main menu. 

Note: Only Container type ASNs may be added.
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Figure 5–5 Create Record Window

4. Click Save. A new ASN record is created and displayed in the table.

View the Details of an ASN
The ASN Detail Inquiry Editor allows you to view the details of an advanced 
shipment notice (ASN). You can access the Style Detail window in order to view 
sampling percentages by style for quality assurance and vendor audits.

1. On the Appointment ASN editor, select the ASN that you want to view.

2. Click the ASN Detail link. The ASN Detail Inquiry editor opens with details.

Figure 5–6 ASN Detail Window

3. Click Exit to close the ASN Detail Inquiry editor.

Add a Standing Appointment
1. On the Appointment ASN editor, select the ASN that you want to add.

2. Click the Standing Appt link. The Door Slot/Time Selection editor opens.

Note: To view a style associated with the ASN, click the Style Detail 
link in the ASN Detail Inquiry editor. The Style Detail link is enabled 
only for appointments where the VA or QA check boxes are selected.
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Figure 5–7 Standing Appointment Window

3. Select a door.

4. Click Save to save the changes.

5. Click Exit to close the Door Slot/Time Selection editor.

Receive a Door Recommendation
1. On the Appointment ASN editor, select the ASN that you want to receive. 

2. Click Door Recommendation. The Door Slot/Time Selection editor opens.

3. Select a door.

Figure 5–8 Door Recommendation Window

4. Click Save to save the changes. 

5. Click Exit to close the Door Slot/Time Selection editor.

Sort Appointment Criteria
1. On the Appointment ASN window, select the ASN that you want to sort.

2. Click Sort Criteria. The Appointment Sort editor opens.
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Figure 5–9 Appointment Sort Window

3. To assign processes:

a. Select the check box next to the desired processes on the Available Sort Criteria 
table.

b. Click Assign. The selected processes are moved to the Assigned Sort Criteria 
table.

4. To remove assigned processes:

a. Select the check box next to the desired processes on the Assigned Sort Criteria 
table.

b. Click Unassign. The selected processes are moved to the Available Sort 
Criteria table.

5. To resequence the assigned criteria:

a. Select the criteria to be moved.

b. To move the criteria closer to the top of the list, click Move Up.

c. To move the criteria closer to the bottom of the list, click Move Down.

6. Click Save to save the changes. 

7. Click Exit to close the Appointment Sort editor.

Set a Manual Override
1. On the Appointment ASN editor, select the ASN that you want to set.

2. Click Manual Override. The Manual Override editor opens.
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Figure 5–10 Manual Override Window

3. Select a time or a door.

4. Click Save to save the changes.

5. Click Exit to close the Manual Override editor.

Delete an ASN from an Appointment
1. On the Appointment ASN editor, select the ASN that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Appointment ASN Window
Click Exit to close the editor.

Appointment Calendar
The Appointment Calendar provides a convenient method for the receiving staff to 
view appointments in varying statuses by time and door slot. The following statuses 
are displayed on the Calendar: 

■ Scheduled – Appointment details have been entered and door/time slot selected

■ Pending – Appointment Labels have been printed

■ Open – Appointment has been opened using the RF devices.

■ Received – Appointment has been physically received in Warehouse.

■ Standing - A specific door /time slot has been reserved over a period of time.

■ Late – The scheduled appointment has not been opened by the specified time. 

■ Block – The receiving door has been blocked from use for some reason.

■ Available – The date/time slot and door do not have any appointments assigned 
thus they are available for assignment.

Filters
You can further customize the Appointment Calendar view by utilizing the data filters 
at the top of the window singularly or in combination. The following filters are 
provided to customize the view: 

■ Date

■ Appointment Status
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■ Appointment Number

■ Carrier

■ Vendor

■ Door

■ Purchase Order Number

■ Item

Views
The Appointment Calendar provides two distinct views based on your needs:

■ All Doors across a range of time

■ One Door across a range of time.

Search
The Appointment Calendar can also be used to search for available time/door slots by 
setting the Appointment Status to Available and then setting the Date, Load Type, Total 
Cases, and/or Total Pallets filters if this information is available.

If this information is not available you can simply set the Appointment Status to 
Available, specify a Date, and then enter a time amount in the Duration field.

Access
To access the Appointment Calendar, navigate to Appointments then select 
Appointment Calendar. The Appointment Calendar window opens displaying the 
current date and time in the All Doors view.

Figure 5–11 Appointment Calendar - All Doors View
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Figure 5–12 Appointment Calendar - Single Door View

Appointment Calendar Functions
The Appointment Calendar opens in the All Doors view displaying the current date 
and time. The following sections describe the use and functionality of the 
Appointment Calendar.

Legend
The Appointment Status legend is located in the bottom right of the window and 
displays each status in a distinct color. To hide the legend, click the Hide/Show 
Legend icon that is located directly to the right of the View icon.

Time Scale
To change the Time Scale, click the View icon and then select Time Scale. You can 
modify the Major Axis to display in days or hours and the Minor Axis to display in 
hour, 30 minute, or 15 minute intervals. It is recommended to leave the default setting 
for the Major Axis at days.

Header Details
To view the header details of an Appointment either pause over that bar with your 
mouse or select the bar which populates the details in the bottom left hand side of the 
window.

View Change
To switch between the All Doors view and the Single Door view, click Door Calendar.

Carrier to Vendor Display
Each color-coded Appointment Bar displays the name of the carrier. To view the name 
of the vendor, select the Display Vendor check box. To view the name of the carrier, 
clear the Display Vendor check box.
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Customized Display Using Filters
To customize the information displayed within the Appointment Calendar enter 
information in any or all of these data filters at the top of the window. These Filters 
function for all appointment statuses with the exception of Available.

Search for Available Door Slots
There are two ways to find Available Door Slots for a new Appointment Perform the 
following steps for your desired search.

Search Using Cases and Pallets:

1. Modify the Date field as desired.

2. Modify the Appointment Status field to Available. RWMS enables fields used to 
find the available locations.

3. Select the desired Load Type (this step is optional).

4. Enter the estimated number of Cases on the appointment (can be used singularly 
or in conjunction with number of pallets).

5. Enter the estimated number of Pallets on the appointment (can be used singularly 
or in conjunction with number of cases).

6. Click Search. RWMS displays available Doors and time slots that fit your criteria.

Search Using Time:

1. Modify the Date field as desired.

2. Modify the Appointment Status field to Available. RWMS enables fields used to 
find the available locations.

3. Enter the desired Duration in Minutes of the time slot.

4. Click Search. RWMS displays available Doors and time slots that fit your criteria.

Exit
Click Exit to close the window.

Appointment Details
The Appointment Detail Editor allows you to view, add, or delete appointment details 
for PO and FPR with Details type of appointments. Once the appointment details have 
been added to the appointment, the Schedule Door link allows you to select a door 
and time slot for the appointment and the appointment moves to scheduled status.

From the main menu, select Appointments > Appointment Detail. The Appointment 
Detail editor opens.
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Figure 5–13 Appointment Detail Window

Edit a PO/Line Item on an Appointment
1. On the Appointment Detail window, double-click the PO/line item that you want 

to edit. You can only edit a Not Scheduled PO/Line Item. The Modify window 
opens.

Figure 5–14 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a PO List to an Appointment
The Add by PO List window allows you to specify a PO number and then display all 
line items on that PO. At that time, you can select all or select specific line items.

Note: You can access the Appointment Detail window from the 
Appointment Schedule, Appointment ASN, and PO Inquiry windows. 
You can also choose Appointments > Appointment Detail from the 
main menu.
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1. On the Appointment Detail editor, click Add by PO List. The Add by PO List 
window opens. 

Figure 5–15 Add by PO List Window

2. Click Query. An LOV button displays next to the PO Nbr field.

3. In the PO Nbr field, enter the purchase order number, or click the LOV button and 
select the purchase order.

4. Click Select All. All the rows under the Select column are selected. In addition the 
Cases column is populated with the current values in the Open Cases Quantity for 
all the rows that were not previously selected. This option is applied only to the 
rows that are not selected. Any rows that were already selected before clicking this 
button are not affected. This is to preserve any value entered by the user in the 
Cases field.

5. If the user-entered value in the Cases column (overrides the default) exceeds the 
open cases quantity plus the allowable tolerance, an error message displays. The 
warning is either a hard stop or soft warning and depends on the SCP.recv_
tolerance_unit parameter. If it is a soft warning, the entered quantity displays in 
red font. The amount of tolerance is configured on the Item Supplier table 
(tolerance_pct column). In case, the user-entered quantity in the Cases column 
(overrides the default) exceeds the open cases quantity, an error message displays 
and the quantity displays in red font.

6. Click Deselect All to set the values in the Cases column to Null. Also the 
Casepack column is reset to its original value (PO_DETAIL.ordered_casepack).

Note: In the Brazil localized environment, on the Appointment 
Detail editor, Add by PO List and Add by PO links are not available 
for PO and NSC appointments.

Note: Open Cases Quantity is determined by OPEN 
UNITS/CASEPACK. The Open Units = PO ordered units minus (PO 
detail received units + all open appointment unreceived units).

Note: If an Open Cases Quantity calculation results in a non-whole 
number of cases, the default quantity is always corrected to a lower 
number. For example, if the calculation for open cases quantity yields 
23.8, the default quantity that displays would be 23. When this 
happens, the number displays in blue font on the window.
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7. Select the Select check box to change/enter the value for the items in the Cases 
column. 

8. The only fields that can be edited are: Select, Casepack, Cases, Ti, Hi, and Bulk 
flag. If the items are to be received as the bulk pallets, select the Bulk check box.

9. Click Apply to include the item/items in the appointment. Click Apply to add the 
items to the appointment for the current PO before adding another PO to the 
appointment.

Add a PO/Line Item to an Appointment
1. On the Appointment Detail window, click Create Record. The Create Record 

window opens.

2. In the PO field, enter the purchase order number, or click the LOV button and 
select the purchase order.

3. In the Item ID field, enter the ID of the item, or click the LOV button and select the 
item.

4. In the Casepack field, enter the number of units per container.

5. In the Cntr Qty field, enter the container quantity.

6. If the item is received on bulk pallets, select the Bulk check box.

7. Click Save to save the changes and close the Create Record window.

Figure 5–16 Create Record Window

Add a Purchase Order to an Appointment
1. On the Appointment Detail window, click Add by PO. The Add by PO window 

opens.
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Figure 5–17 Add by PO Window

2. In the PO field, enter the purchase order number, or click the LOV button and 
select the purchase order.

3. If the items are received on bulk pallets, select the Bulk check box.

4. Click Save to save the changes and close the Add by PO window.

Delete a PO/Line Item from an Appointment
1. On the Appointment Detail window, select the PO/line item that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Add Lot Numbers to an Appointment
1. On the Appointment Detail window, select the PO/line item that you want to edit. 

2. Click Lot Detail. The Appointment Detail Lot editor opens.

Figure 5–18 Appointment Detail Lot Window

3. Click Create Record. The Create Record window opens.
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Figure 5–19 Create Record Window

4. In the Lot Number field, enter the lot number.

5. In the Cntr Qty field, enter the number of containers that you want to associate the 
lot number with.

6. Click Save to save the changes and close the Create Record window.

7. Click Exit to close the Appointment Detail Lot window.

Edit a Lot Number on an Appointment
1. On the Appointment Detail window, select the PO/Line item that you want to 

edit.

2. Click Lot Detail. The Appointment Detail Lot window opens.

3. Double-click the lot number that you want to edit. The Modify window opens.

Figure 5–20 Modify Window

4. Edit the container quantity as necessary.

5. Click Save to save any changes and close the Modify window.

6. Click Exit to close the Appointment Detail Lot window.

Delete a Lot Number from an Appointment
1. On the Appointment Detail editor, select the PO/line item that you want to edit.

2. Click Lot Detail. The Appointment Detail Lot editor opens.

3. Select the lot number that you want to edit.

4. Click Delete Record.

5. When prompted to delete the record, click Yes.

6. Click Exit to close the Appointment Detail Lot editor.

Exit the Appointment Detail Window
Click Exit to close the editor.
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Add a Standing Appointment
1. On the Appointment Detail editor, select the PO/line item that you want to add.

2. Click Standing Appt. The Door Slot/Time Selection editor opens.

Figure 5–21 Door Slot/ Time Selection Editor Window

3. Select a door.

4. Click Save to save the changes and close the Door Time Slot Selection window.

Receive a Door Recommendation
1. On the Appointment Detail editor, select the PO/line item that you want to 

receive.

2. Click Door Recommendation. The Door Slot/Time Selection editor opens.

Figure 5–22 Door Slot/ Time Selection Editor Window

3. Select a door.

4. Click Save to save the changes and close the Door Slot/Time Selection editor.

Set a Manual Override
1. On the Appointment Detail editor, select the PO/line item that you want to set.

2. Click Manual Override. The Manual Override editor opens.
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Figure 5–23 Manual Override Window

3. Enter the Start and End time.

4. Select a door.

5. Click Save to save the changes and close the Door Slot/Time Selection editor.

Sort Appointment Criteria
1. On the Appointment Detail window, select the PO/line item that you want to sort.

2. Click Sort Criteria. The Appt Sort window opens.

Figure 5–24 Appointment Sort Editor Window

3. To assign processes:

a. Select the check box next to the desired processes on the Available Sort Criteria 
table.

b. Click Assign. The selected processes are moved to the Assigned Sort Criteria 
table.

4. To remove assigned processes:

a. Select the check box next to the desired processes on the Assigned Sort Criteria 
table.

b. Click Unassign. The selected processes are moved to the Available Sort 
Criteria table.
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5. To resequence the assigned criteria:

a. Select the criteria to be moved.

b. To move the criteria closer to the top of the list, click Move Up.

c. To move the criteria closer to the bottom of the list, click Move Down.

6. Click Save to save the changes and close the Appointment Detail Sort Criteria 
window.

Exit the Appointment Detail Window
Click Exit to close the window.

Style Detail
The Style Detail window allows you to maintain the sampling percentages and 
quantities by style for quality assurance and vendor audits.

This window is accessible from appointment detail windows if an appointment is 
marked for quality assurance and vendor audits.

Appointment Schedule
The Appointment Schedule Editor allows you to schedule inbound trailers for all 
appointment types (ASN, PO, NSC, FPR with Details, and FPR without Details).

Depending on the type of appointment, you can access one of the following windows 
in order to maintain appointment details:

■ Appointment ASN: Enter details from ASNs. Casepack quantities are known.

■ Appointment Detail: Enter details from purchase orders. Casepack quantities are 
known.

■ NSC Appointment Detail: Enter details from ASNs and/or purchase orders. 
Casepack quantities are not known for PO type ASNs.

■ FPR PO Details: Enter the details from FPR without Details. The PO line items and 
casepacks are not specified in this window, only the valid Purchase orders for the 
appointment.

From the main menu, select Appointments > Appointment Schedule. The 
appointments for the current date appear in the Appointment Schedule editor.

Note: For Brazil installations, RWMS requires a schedule number to 
process an appointment. The schedule numbers are downloaded from 
the Oracle Retail Fiscal Management (ORFM) system. 

RWMS can create an appointment without a schedule number and the 
details of the appointment are uploaded to ORFM. The Distribution 
Center, however, cannot open any appointment or print any labels 
unless it has a schedule number included in the record. When ORFM 
downloads the Schedule Number, the Appointment is updated with 
the Schedule Number and the existing appointment details are deleted 
and replaced with the details attached to the Schedule number. The 
Appointment now can be opened.
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Figure 5–25 Appointment Schedule Window

Display Appointments by Date
1. If any appointments are currently displayed, click Clear.

2. Click Query. An LOV button displays next to all the fields.

3. In the Appt. Date field, enter a date or click the Calendar icon and select the date. 
The appointments for the selected date appear. 

Add an Appointment
1. On the Appointment Schedule window, click Create Record. The Create Record 

window opens.

Figure 5–26 Create Record Window

2. In the Start field, edit the default date and time as necessary.

Note: If you do not enter a receiving door, the appointment is saved 
as an unscheduled appointment.
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3. In the Carrier field, enter the carrier code, or click the LOV button and select the 
carrier.

4. In the Trailer ID field, enter the ID of the trailer, or click the LOV button and select 
the trailer.

5. In the Mode field, enter the ID of the receiving door, or click the LOV button and 
select the door.

6. In the Load Type field, enter the load type for the trailer from the drop-down list. 

7. In the Schd Nbr field, select the schedule number from the drop-down list. This 
field is enabled only if recv_schedule_nbr is set to Y.

8. In the Appt Type field, select the appointment type from the drop down list. You 
can select one of the following types of appointments:

■ FPR with details: To create appointments with PO/Item details using the 
Flexible Pallet Receiving workflow. 

■ FPR without details: To create appointments using only the PO numbers using 
the Flexible Pallet Receiving workflow.

■ PO: To create a PO based appointment.

■ ASN: To create an ASN based appointment.

■ NSC: To create an appointment for non-specified casepacks.

■ ASN/NSC: To create an ASN based appointment for non-specified casepacks.

9. Select the RF User Can Add Details, Scan Case Label and Bypass Apportionment 
check boxes as necessary.

■ RF User Can Add Details - When this attribute is applied to the FPR process 
and user the system allows the RF user to receive items on the Purchase Order 
being received which are not included in the appointment details. This 
attribute only applies to FPR with Detail appointments.

■ Scan Case Label - When this attribute is applied to the FPR process it checks 
the Scan Case Label flag on the create appointment header window. You have 
the ability to toggle the flag for each appointment. When selected, RWMS 
requests the RF user to scan each individual container (Case) during the 
receiving process.

■ Bypass Apportionment - When this attribute is applied to the FPR process the 
Bypass Apportionment flag is automatically set to yes in the create FPR 
appointment header window. You have the ability to toggle the flag for each 
appointment. This flag must be selected when receiving merchandise from 
trusted vendors who deliver complete shipments. When selected, the number 
of sub-pallets created by pre-distribution is significantly reduced saving labor.

Note: If you enter a new trailer ID, it is automatically added to 
RWMS.

Note: The FPR without details option is not supported in a Brazilian 
installation. 
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10. If quality assurance or vendor audit checks are to be performed on the 
appointment at the style level, select the QA and VA check boxes.

11. In the Labeled field, select the check box.

12. From the Asset Confirm field, select Start, During, or End.

13. Click Save to save the changes and close the Create Record window.

Edit an Appointment

1. On the Appointment Schedule window, double-click the appointment that you 
want to edit. The Modify window opens.

Figure 5–27 Modify Window

2. Edit the enabled fields as necessary. 

Note: For FPR without details type of appointment, the RF User Can 
Add Details check box is selected by default and you cannot update it.

Note:  You can enter the sampling percentages when you edit the 
details of an appointment. If the check boxes are not selected, the 
vendor's default sampling percentages are used by RWMS.

Note: You cannot edit an appointment which is in Received status.
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3. Click Save to save any changes and close the Modify window. 

Enter Appointment Weight Details
The Appointment Weight Detail Editor allows you to view the weight of specific 
containers on received shipments.

1. On the Appointment Schedule window, select the appointment that you want to 
weight details for.

2. Click Weight Details. The Appointment Weight Detail window opens.

Figure 5–28 Appointment Weight Detail Window

3. Double click the record you want to update. The Modify window opens.

4. In the Receipt Weight field, enter the weight of the item.

5. Click Save to save the changes and close the window.

6. Click Exit to close the window.

View Door Schedules
Please refer to the section on Maintaining Door Schedules.

View Standing Appointment Editor
Please refer to the section on Maintaining Standing Appointment Editor.

Delete an Appointment
An appointment may be deleted, if the labels have not been printed or the 
merchandise has been received and reconciled for the appointment. 

When the system control parameter recv_schedule_nbr is enabled, when you try to 
delete an appointment on which nothing has been received, the appointment is 

Note: You can add a schedule number to an existing ASN 
appointment. RWMS compares the total units for each PO/line item 
from ASN details to the total units for each PO/line item on the 
schedule number. If they do not match, you must delete the ASN 
appointment and create a Non ASN appointment.

Note: This window can also be accessed from the main menu, select 
Appointments > Appointment Weight Detail.
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deleted and the schedule number is available to create another appointment. You 
cannot delete the appointment on which items have been received. 

1. On the Appointment Schedule window, select the appointment that you want to 
delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Appointment Schedule Window
Click Exit to close the window.

Door Schedule Screen
The Door Schedule Screen allows you to schedule and maintain appointments at 
receiving doors. Enough time should be allotted to unload the trailer that is assigned 
to the door. A warning opens if the time period is too short, but you can override the 
warning.

The window is divided into the following areas:

■ Depending on how the window is accessed, the top part of the window may 
display details for a scheduled or unscheduled appointment. You can access the 
Modify window in order to edit the schedule.

■ The bottom part of the window displays the door ID, number of containers, and 
utilization percentages for the selected date. You can access the Appointments for 
Door window in order to view the day's activity for a specific door.

You can block out a period of time at a door. This block is viewed by RWMS as a 
scheduled hold. Appointments cannot be scheduled and merchandise cannot be 
received during the blocked out time period.

You can display a bar graph of the day's utilization percentages by door.

From the main menu, select Appointments > Door Schedule Screen. The Door 
Schedule editor opens.

Figure 5–29 Door Schedule Editor Window
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Display Doors by Date
1. If any doors are currently displayed, click Clear.

2. In the Date field, enter a date or click the Calendar icon and select the date.

3. Click Query. The door activity for the specified date displays.

View the Appointments Assigned to a Door
1. On the Door Schedule tab, click Next Block to move the cursor to the bottom part 

of the window.

2. Select the door that you want to view.

3. Click Details. The day's appointments for the selected door appear in the 
Appointments for Door window.

Figure 5–30 Appointments For Door Window

4. Click Exit to close the Appointments for Door window.

Edit a Door Schedule

1. On the Door Schedule tab, click Next Block to move the cursor to the top part of 
the window.

2. Double-click the Date Time field. The Modify window opens.

3. Edit the enabled fields as necessary.

4. Click Save to save any changes and close the Modify window.

Note: You can also access this window from the following windows: 
Appointed PO Inquiry, Appointment Detail, Appointment ASN, NSC 
Appointment Detail, Appointment Schedule, and Unscheduled 
Appointment Inquiry.

Note:  You can edit the schedule if the fields in the top part of the 
window are filled in. Whether data appears in that area depends on 
how you access the window.
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Block a Door
1. On the Door Schedule tab, click Block. The Block window opens.

Figure 5–31 Block Window

2. In the Door field, enter the ID of the door, or click the LOV button and select the 
door.

3. In the Start field, enter start date (DD-MON-YYYY) and time (HH:MM:SS) for the 
block. 

4. In the End field, enter the end date (DD-MON-YYYY) and time (HH:MM:SS) for 
the block.

5. Click Save to save the changes or click Exit to close the Block window.

Remove a Block
1. On the Door Schedule tab, click Next Block to move the cursor to the bottom part 

of the window.

2. Select the door that you want to edit.

3. Click Details. The day's appointments for the selected door appear in the 
Appointments for Door window.

4. Select a record where the type is B (Blocked).

5. Click Delete Appt.

6. When prompted to delete the record, click Yes.

7. Click Exit to close the Appointments for Door window.

Delete an Appointment from the Door Schedule
1. On the Door Schedule tab, click Next Block to move the cursor to the bottom part 

of the window.

2. Select the door that you want to edit.

3. Click Details. The day's appointments for the selected door appear in the 
Appointments for Door window.

4. Select the appointment that you want to delete from the door schedule.

5. Click Delete Appt.

6. When prompted to delete the record, click Yes.

7. Click Exit to close the Appointments for Door window.
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Exit the Door Schedule Tab
Click Exit to close the window.

FPR PO Assign
The FPR PO Assign editor is used to assign POs to FPR Without Details appointment 
types. For this appointment type, the vendor has only communicated the POs 
included on the appointment but has not indicated the items on the shipment. The 
items are identified during the actual receiving process. 

From the main menu, select Appointments > FPR PO Assign.

Figure 5–32 FPR PO Assign Window

Display Open Purchase Orders
1. If any appointments are currently displayed, click Clear.

2. Click Query. An LOV button displays next to all the fields.

3. Use all of the fields (Appt Nbr, Vendor Nbr, PO Nbr, item ID, and so on) to 
populate the window with the POs on the inbound trailer.

Adding Purchase Orders to Appointment
1. Use the Query criteria to populate the window with the desired POs for this 

appointment.

2. If all of the purchase orders on the window are included on the inbound trailer, 
click Select All. To clear all of the selected records, click Deselect All .

3. If you want to select specific POs from the list, you can accomplish this in two 
ways:

a. Click Select All and then clear individual POs by selecting the check box in 
the Select column for that PO.

b. Select the check box in the Select column for the desired POs.

4. When the desired POs are selected, click Apply to assign these POs to the 
appointment.
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Exit the FPR PO Assign Editor
Click Exit to close the window.

NSC Appointment Details
The NSC Appointment Detail allows you to view, add, and delete Purchase Order and 
item details for NSC (non-specified casepack) type appointments. 

From the main menu, select Appointments > NSC Appointment Detail.

Figure 5–33 NSC Appointment Detail Editor Window

Add an ASN to NSC Appointment

1. On the NSC Appointment Detail window, click Create Record. The Create Record 
window opens.

Note: Brazil Specific Notes:

The FPR without Details Appointment type is not supported in a 
Brazilian installation since details are always provided within a 
Schedule.

Note: You can access the NSC Appointment Detail window from the 
Appointment Schedule, PO Inquiry, and Appointment Details 
windows. Alternatively, you can access NSC Appointment Detail 
window from the main menu. Select Appointments > NSC 
Appointment detail.

Note: ASNs may be added to an appointment that is marked as an 
NSC type appointment.
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Figure 5–34 Create Record Window

2. In the ASN field, enter the ASN number, or click the LOV button and select the 
ASN.

3. Click Save to save the changes and close the Create Record window.

View Container Details on an Appointment
1. On the NSC Appointment Detail window, select the ASN that you want to view in 

detail.

2. Click Details. The details of the selected ASN appear in the Details window.

Figure 5–35 Details Window

3. Click Exit/Cancel to close the Details window.

Delete an ASN from an Appointment

1. On the NSC Appointment Detail window, select the ASN that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Note: Several records may refer to the same ASN. If you select and 
delete any one of the ASN records, all the records containing the same 
ASN are deleted.
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Add a PO/Line Item to an Appointment
1. On the NSC Appointment Detail window, click Create Record. The Create Record 

window opens.

2. In the PO field, enter the PO number, or click the LOV button and select the PO.

3. In the Item ID field, enter the ID of the item, or click the LOV button and select the 
item.

4. In the Unit Qty field, enter the number of units.

5. Click Save to save the changes and close the Create Record window.

Add a Purchase Order to an Appointment
1. On the NSC Appointment Detail window, click Add by PO. The Add by PO 

window opens.

Figure 5–36 Add by PO Window

2. In the PO field, enter the PO number, or click the LOV button and select the PO.

3. Click Save to save the changes and close the Add by PO window.

Edit a PO/Line Item on an Appointment
1. On the NSC Appointment Detail window, double-click the PO/line item that you 

want to edit. The Modify window opens.

2. Edit the unit quantity as necessary.

3. Click Save to save the changes and close the Modify window.

Delete a PO/Line Item from an Appointment
1. On the NSC Appointment Detail window, select the PO/line item that you want to 

delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Sort Appointment Criteria
1. On the NSC Appointment Detail window, select the Appt Nbr.

2. Select the ASN line that you want to sort.

3. Click Sort Criteria. The Appt Sort window opens.
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Figure 5–37 Appt Sort Window 

4. To assign processes:

a. Select the check box next to the desired processes on the Available Sort Criteria 
table.

b. Click Assign. The selected processes are moved to the Assigned Sort Criteria 
table.

5. To remove assigned processes:

a. Select the check box next to the desired processes on the Assigned Sort Criteria 
table.

b. Click Unassign. The selected processes are moved to the Available Sort 
Criteria table.

6. To resequence the assigned criteria:

a. Select the criteria to be moved.

b. To move the criteria closer to the top of the list, click Move Up.

c. To move the criteria closer to the bottom of the list, click Move Down.

7. Click Save to save the changes and close the Appt Sort window.

Exit the NSC Appointment Detail Window
Click Exit/Cancel to close the window.

Purchase Order Inquiry
The PO Inquiry allows you to view all downloaded purchase orders. You can access 
the PO Detail window in order to view the items on a purchase order. You can also 
access the Appointed PO Inquiry window in order to view any appointments that are 
associated with a purchase order.

From the main menu, select Appointments > PO Inquiry. The PO Inquiry tab opens.
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Figure 5–38 PO Inquiry Editor Window

Display one Purchase Order
1. If any purchase orders are currently displayed, click Clear

2. Click Query. An LOV button displays next to the PO field.

3. In the PO field, enter a purchase order number, or click the LOV button and select 
the purchase order.

4. Click Search. The selected purchase order opens.

Display all Purchase Orders
Click Search.

View the Details of a Purchase Order
1. On the PO Inquiry window, select the purchase order that you want to view in 

detail.

2. Click Details. The items appear in the Detail window

Figure 5–39 Details Window

3. To view the items on the purchase order:

a. Click Details. The Stock Order Inquiry editor opens.
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Figure 5–40 Stock Order Inquiry Window

b. Click Exit to close the Stock Order Inquiry tab and Details window.

4. To view appointments that are associated with the purchase order:

a. Click Appointment. The appointments appear in the Appointed PO Inquiry 
editor.

Figure 5–41 Appointed PO Inquiry Editor Window

b. Click Exit to close the Appointed PO Inquiry tab.

Exit the PO Inquiry Window
Click Exit to close the window.

Standing Appointment Editor
The Standing Appointment editor allows you to define and view standing 
appointments. These are appointments created for the future that occur on a routine 
basis at the same day and same time.

■ The start and end dates specify the length of time that the standing appointment is 
used.

■ The start and end times specify the expected duration of these appointments.

■ The check boxes for day of the week specify which days are used for these weekly 
appointments. (Multiple days may apply, for example, Monday, Wednesday, and 
Friday every week from noon until 1 p.m.)
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■ Vendor is a required field and must be selected.

■ Carrier is optional; but if specified, the standing appointment is available only for 
that vendor/carrier combination.

■ New standing appointments created are always active, but this field can be used to 
deactivate them prior to expiration.

From the main menu, select Appointments > Standing Appointment Editor. The 
Standing Appointment Editor opens.

Figure 5–42 Standing Appointment Editor Window

Display All Item Fields
Click Query.

Display a Standing Appointment 
1. If any item fields are currently displayed, click Clear.

2. Click Query. An LOV button displays next to each field, respectively.

3. Enter the search criteria.

4. Click Search. The appointment that matches the search criterion opens.

Create a Record
To create a standing appointment:

1. On the Standing Appointment Editor window, click Create Record button. The 
Create Record window opens.
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Figure 5–43 Create Record Window

2. Enter required fields.

3. Click Save.

Delete a Record
To delete a standing appointment:

1. On the Standing Appointment Editor window, select the item that you want to 
delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Standing Appointment Editor Window
Click Exit to close the window.

Unscheduled Appointment Inquiry
The Unscheduled Appointment Inquiry allow you to view unscheduled appointments 
and then make the determination to schedule or delete them. An unscheduled 
appointment is an appointment that was entered into RWMS without one or more of 
the following details: date, time, or receiving door.

From the main menu, select Appointments > Unschedule Appointments Inquiry. All 
unscheduled appointments appear in the Unschedule Appointments Inquiry tab.

Figure 5–44 Unschedule Appointments Inquiry Window
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Edit the Details of an Appointment
1. On the Unschedule Appointments Inquiry tab, select the appointment that you 

want to edit.

2. Click Details. If an ASN is associated with the appointment, the Appointment 
ASN tab opens; else, the Appointment Detail tab opens.

Figure 5–45 Appointment Detail Window

Figure 5–46 Appointment ASN Window

3. Edit the details as necessary.

4. Click Exit to close the detail window.

Schedule an Appointment
1. On the Unschedule Appointments Inquiry window, select the appointment that 

you want to schedule.

2. Click Door Schedule. The Door Schedule Screen tab opens.
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Figure 5–47 Door Schedule Tab Window

3. Click Next Block, if necessary, to move the cursor to the top part of the window.

4. Double-click the Date Time field. The Modify window opens.

Figure 5–48 Modify Window

5. Enter the missing details as necessary.

6. Click Save to save the changes and close the Modify window.

7. Click Exit to close the Door Schedule window.

Delete an Appointment
1. On the Unscheduled Appointment Inquiry window, select the appointment that 

you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Unscheduled Appointment Inquiry Window
Click Exit to close the window.
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6
Receiving

Receiving is the process of accepting the inbound merchandise from external entities 
such as, vendors or stores/DCs into the warehouse facility. Many of the receiving 
operations are performed using a hand-held, radio frequency (RF) device. The RF 
device can be used to open appointments, receive merchandise, perform quality 
checks, assign trouble codes if necessary, reconcile appointments, and close 
appointments. The GUI Receiving menu provides tools to print receiving labels, 
perform receipt adjustments post RF receiving, record any vendor non-conformance to 
expected standards as well as provide a holistic view of the expected and received 
inventory information.

The process of receiving goods within a warehouse starts with opening an 
appointment and then using RF devices to receive the physical merchandise. Based on 
the appointment type being received, you may need to print receiving labels or you 
may use generic labels.

Prior to receiving merchandise for each receiving type, you must determine if you are 
going to use formatted labels (includes PO, Item and destination details) or generic 
labels. To create formatted labels, the Labeled flag on the GUI Create Appointment 
window must be selected. Following is the decision process for each Receiving Type:

1. For FPR with Detail, FPR without Details, and Blind appointments: 

a. If the Labeled flag is selected, you must apply generic labels initially and 
when the pallets are confirmed for receipt, RWMS runs pre-distribution logic 
and generate formatted labels as required.

b. If the Labeled flag is not clear, you must apply generic labels and when the 
pallets are confirmed for receipt, RWMS runs pre-distribution logic and ask 
additional generic labels to be applied if a single pallet is going to multiple 
destinations.

2. For PO Appointments:

a. If the Labeled flag is selected, you must run the receiving label program which 
runs pre-distribution logic and generates formatted labels.

b. If the Labeled flag is clear, you must run the receiving label program which 
runs pre-distribution logic and generates a report. Generic labels are then 
applied to the containers.

3. For ASN Appointments, the Labeled flag is not considered but you must run the 
receiving label program so the pre-distribution logic can determine destinations 
for each container.

4. For NSC and ASN/NSC appointments, the Labeled flag is not considered and 
generic labels are applied to each case. Pre-distribution logic is run for each case 
received.
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For PO appointment where the Labeled flag is selected, you can null any unused 
labels.

It is critical to understand the inventory status of containers as they flow throughout 
the warehouse. The status of a container is tracked from Receiving all the way to 
shipping in RWMS. The following is a summary of supported RWMS statuses:

■ Appointed (A): The container is associated with an inbound appointment; it is not 
yet received.

■ Distributed (D): The container is received and the contents of the container are 
allocated to a store or customer. 

■ Inventory (I): The container is received and is not allocated to a store or customer 
at this time.

■ Manifested (M): The container is loaded on an outbound trailer.

■ Non-saleable (N): The container contains returned merchandise that is marked as 
not resalable.

■ Pick (P): The container is associated with a pick package.

■ Return to vendor (R): The container contains merchandise that is marked for 
return to the vendor.

■ Shipped (S): The container is released from the distribution center and in transit to 
a ship-to destination.

■ Troubled (T): The container contains merchandise that is marked with one or more 
trouble codes that must be resolved.

■ Expired (X): The container contains merchandise that has passed the designated 
pick not-after date and is no longer valid.

This chapter contains the following topics:

■ ASN Entry

■ Create a PO Level ASN

■ ASN Inquiry

■ Container Checking

■ Door Status

■ Vendor Non Conformance Code Details

■ Receipt Inquiry

■ Generate Receiving Labels

■ Receiving Package Monitor

ASN Entry
One of the appointment types supported by RWMS is ASN Receiving and it is 
important to understand the structure and benefits of ASNs. ASN (Advanced Ship 
Notice) has shipment details (PO, Items, and Container IDs) from suppliers. ASNs are 
sent by a supplier before the goods actually reach the warehouse. Once the ASN is 
transmitted to the warehouse, the ASNs can be attached to an appointment and 
scheduled for receipt.

A typical ASN has information about contents of a shipment of goods as well as 
additional information relating to the shipment, such as order information, product 
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description, physical characteristics, type of packaging, marking, carrier information, 
and configuration of goods. ASN enables the sender to describe the contents and 
configuration of a shipment in various levels of detail and provides an ordered 
flexibility to convey information.

Most ASNs are transmitted to RWMS, but an ASN Entry function is provided that 
allows direct entry into RWMS with a standard web browser and Internet or an 
intranet connection. This feature offers low cost and global access to an existing 
Internet infrastructure. After ASNs are entered, inbound freight scheduling can be 
handled in the standard way.

The ASN Entry Editor allows you to create the ASN Header record for a new ASN. 
This consists of the ASN Number, ASN Type, Carrier, and Number of Containers on 
the entire ASN. Once the ASN header is created, RWMS allows you to create the 
container and item detail for the ASN by clicking the associated links.

Vendors can log in to RWMS and access their own ASN information. RWMS users can 
access details of ASNs associated with all vendors.

The ASN may be one of the following types:

■ Container type ASN: Merchandise comes to the warehouse in pre-labeled 
containers (UCC128 labels). Typically, these labels are provided by the vendor. 
Container type ASNs can have generic labels also.

■ Purchase order (PO) type ASN: A PO type ASN does not have containers - only 
items and quantities. Merchandise does not come pre-labeled.

■ Tare type ASN: Merchandise is received on pallets with unlabeled child 
containers. The pallet may have mixed items (but single sku cases). If the pallet is 
destined to a predefined location, it is immediately cross docked; otherwise, the 
pallet is put away to storage. Tare type ASNs are downloaded.

Business Process
You begin adding an ASN by entering header details. Before continuing, you must 
indicate whether the ASN is a PO type ASN or a container type ASN. If the ASN is a 
PO type ASN, you can add all line items on a selected PO or add line items 
individually from one or multiple POs.

Details are added at a container level for a container type ASN. To begin with, 
pre-generated/generic container IDs are linked to the ASNs through the ASN 
Container Entry window, as well as the PO specified on the container. A container may 
contain line items from a single purchase order only.

You can add containers and items to container type ASNs:

■ Copy: You can add a container and its contents to an ASN by copying an existing 
container from the same ASN. The container thus created has the same PO, line 
item, and unit quantity per case.

■ Replicate: You can add multiple containers by providing the details once and 
entering the number of containers that share those same details. Only manually 
entered ASNs may be edited in RWMS. ASNs received from the host system or via 
electronic data interchange (EDI) cannot be edited.

Once an ASN is entered into RWMS, an appointment is scheduled in the system to 
receive the merchandise in the warehouse.
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Create a Container Type ASN
From the main menu, select Receiving > ASN Entry. The ASN Entry window opens in 
the Editors pane.

Figure 6–1 ASN Entry Window

Add an ASN
1. On the left-hand side of the ASN Entry tab, click the Create Record link. The 

Create Record window opens.

Figure 6–2 Create Record Window

2. In the ASN field, enter the ASN number. 

3. In the Type field, select Container from the drop-down list. 

4. In the Carrier Code field, an optional field, enter the code for the carrier, or click 
the LOV button and select the carrier. 

5. In the BOL Nbr field, an optional field, enter the bill of lading number. 

6. In the Cont Qty field, enter the number of inbound containers that are expected.

7. Click Save to save the changes and close the Create Record window.
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Add a Container to the ASN
The ASN Container Entry Editor allows you to enter or scan Container IDs onto an 
ASN. For each container entered, the system requires the PO Number and Destination.

1. On the ASN Entry tab, click Query to search for a container type ASN that you 
want to edit. An LOV button is enabled next to the ASN field.

2. Enter the ASN number in the ASN field or search for the required ASN using the 
LOV button.

3. Click Enter. The ASN details are displayed in the ASN Details window.

Figure 6–3 ASN Details Window

4. Click the Details link. The ASN Container Entry tab opens. This window has a list 
of links on the left:

■ Create Record: Allows you to create a new container record for the ASN.

■ Delete Record: Allows you to delete a record.

■ Detail Record: Allows you to access the details of a record.

■ Copy Record: Allows you to add another container that contains same 
quantities and items as an existing container.

■ Replicate Record: Allows you to add multiple records with the same details.

■ Print Labels: Allows you to print labels.

Note: Use the add procedure to add containers to an ASN 
one-by-one.
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Figure 6–4 ASN Container Entry Window

5. Click Create Record. 

If you attempt to create more containers than the number mentioned on the ASN 
Entry window for the ASN, you receive an alert stating, Stated container quantity for 
the ASN fulfilled. Continue? Yes / No. Click Yes. The Create Record window opens.

Figure 6–5 Confirm Alert Window

Figure 6–6 Create Record Window

6. In the Container ID field, enter the ID of the container. 
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7. In the PO Nbr field, enter the number of the purchase order, or click the LOV 
button and select the purchase order. 

8. In the Dest ID field, enter the ID of the destination, or click the LOV button and 
select the destination. The Destination ID number pre-marks a merchandize to an 
external entity like a store or another warehouse. If the ASN's final destination is 
the receiving warehouse, the Destination ID of the receiving warehouse must be 
mentioned.

9. Enter any additional details as necessary:

■ Weight

■ Cube

■ Lot Number

■ Expedite Flag

■ ISD

10. Click Save to save the changes and close the Create Record window.

Add Items to a Container
The ASN Container Item Entry Editor allows you to enter or scan item IDs into 
specific container IDs found on an ASN. For each item entered, RWMS requires the 
Unit Quantity.

1. On the ASN Container Entry tab, select the container that you want to edit.

2. Click Detail Record. The ASN Container Item Entry tab opens.

Figure 6–7 ASN Container Item Entry Window 

3. To add all the unappointed or unreceived items from the current purchase order, 
click Add by PO. The items appear on the table. To add selective items from the 
current purchase order, click Create Record. The Create Record window opens.

Note: If a container was not copied or replicated, it remains empty 
until you define the contents.

Note: If the PO already exists for an ASN, you will get an error 
stating the following: “This PO is already on the ASN - cannot add by 
PO.”
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Figure 6–8 Create Record Window

a. In the Item ID field, enter the ID of the inbound item, or click the LOV and 
select the item. The UOM field is automatically populated.

b. In the Unit Qty field, enter the number of inbound units. 

c. Enter any additional details as necessary. The additional details include: Distro 
Nbr, Ticket Type, Retail Price, and Pri Lvi (Privilege level). Best Before Date is 
applicable for perishable items and this field is enabled only for those items. It 
is disabled for non-perishable items. 

d. Click Save to save the changes and close the Create Record window.

Copy a Container

1. On the ASN Entry tab, select the container type ASN that you want to edit.

2. Click Details. The ASN Container Entry tab opens.

3. Select the container that you want to copy.

4. Click Copy Record. The Copy Record window opens.

Note: To edit the record, double-click the entry you want to modify. 
The Modify window opens. Follow steps 1-4 given for the Create 
Record procedure to edit the entries. 

Note: Use the copy procedure to add another container that contains 
the same items and quantities as an existing container.
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Figure 6–9 Copy Record Window

5. In the Generic Cont ID field, enter the ID of the new container. Generic Container 
IDs are pre-existing labels that can be applied to cartons/pallets. They have been 
pre-printed, but RWMS recognizes the label and associated information only when 
they have been applied to a container.

6. Click Save. 

If you attempt to create more containers than the number mentioned on the ASN 
Entry window for the ASN, you get an alert stating, Stated container quantity for the 
ASN fulfilled. Continue? Yes / No. Click Yes. The number in the Cartons Copied field 
is increased by 1.

7. To make another copy of the container, enter another container ID in the Generic 
Cont ID field and click Save.

8. When you are done copying the container, click Exit.

Add Multiple Containers

1. On the ASN Entry tab, select the container type ASN that you want to edit.

2. Click Details. The ASN Container Entry tab opens.

3. Click Replicate Record. The Replicate Record window opens.

4. In the PO Nbr field, enter the purchase order number, or click the LOV button and 
select the purchase order.

5. Enter additional details as necessary.

■ ASN

■ Dest ID

■ Weight

■ Cube

■ Lot Number

■ Expedite Flag

■ Distro Nbr

Note: Use the replicate procedure to add multiple containers with 
the same details.
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■ Item ID

■ UOM

■ Unit Qty

■ Ticket Type

■ Retail Price

■ ISD

■ Pri Lvl

■ Best Before Date

6. In the Number of Cartons field, enter the number of containers that you want to 
add to the ASN.

7. Click Save to add the containers and close the Replicate window.

Figure 6–10 Replicate Record Window

Exit the ASN Entry Windows
Click Exit to close each window.

Edit a Container Type ASN
From the main menu, select ASN Entry. The ASN Entry tab opens.
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Figure 6–11 ASN Entry Window

Display Header Details for All ASNs
In the ASN Entry tab, click Search to view all available ASNs.

Display Header Details for one ASN
1. If any ASNs are currently displayed, click Clear.

2. Click Query. An LOV button displays next to the ASN field.

3. In the ASN field, enter the ID of the ASN, or click the LOV button and select the 
ASN.

4. Click Enter. The header details for the selected ASN appear.

Edit Header Details for an ASN
1. On the ASN Entry tab, double-click the container type ASN that you want to edit. 

The Modify window opens.

Figure 6–12 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save the changes and close the Modify window.

Delete an ASN

Note: An ASN may be deleted if it is not assigned to an appointment 
or if the status of the appointment is Received.
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1. On the ASN Entry window, select the container type ASN that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Edit Containers on an ASN

1. On the ASN Entry window, select the container type ASN that you want to edit.

2. Click Details. The ASN Container Entry tab opens.

3. Double-click the container that you want to edit. The Modify window opens.

Figure 6–13 Modify Window

4. Edit the enabled fields as necessary.

5. Click Save to save the changes and close the Modify window.

Delete a Container from an ASN

1. On the ASN Entry window, select the container type ASN that you want to edit.

2. Click Details. The ASN Container Entry window opens.

3. Select the container that you want to delete.

4. Click Delete Record.

5. When prompted to delete the record, click Yes.

Edit Line Items on an ASN
1. On the ASN Container Entry window, select the container that you want to edit.

2. Click Detail Record. The ASN Container Item Entry window opens.

Note: A container may not be edited if it is assigned to an 
appointment that is not yet received.

Note: A container may not be deleted if it is already received
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3. Double-click the line item that you want to edit. The Modify window opens.

4. Edit the enabled fields as necessary.

5. Click Save to save the changes and close the Modify window.

Delete a Line Item from an ASN

1. On the ASN Container Entry window, select the container that you want to edit.

2. Click Detail Record. The ASN Container Item Entry window opens.

3. Select the line item that you want to delete.

4. Click Delete Record.

5. When prompted to delete the record, click Yes.

Exit the ASN Entry Windows
Click Exit to close each window.

Create a PO Level ASN
From the main menu, select Receiving > ASN Entry. The ASN Entry tab opens.

Figure 6–14 ASN Entry Window

Add an ASN
1. On the ASN Entry tab, click Create Record. The Create Record window opens.

Note: Since the line items are associated with containers, the update 
on them is not allowed if the ASN is associated to any appointment 
which is in pending, open or unreconciled status. Also, a container 
once received cannot be modified. However, any unreceived 
containers on an ASN can be updated - provided there is no 
appointment in pending or open status for that ASN.
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Figure 6–15 Create Record Window

2. In the ASN field, enter the ASN number.

3. In the Type field, select Purchase Order from the drop down list. The choices are 
Container and Purchase Order.

4. In the Carrier Code field, an optional field, enter the code for the carrier, or click 
the LOV button and select the carrier.

5. In the BOL Nbr field, an optional field, enter the bill of lading number.

6. In the Cont Qty field, enter the number of inbound containers that are expected.

7. Click Save to save the changes and close the Create Record window.

Add PO/Items to the ASN
The ASN PO Entry Editor allows you to assign POs to a PO type ASN. This editor 
displays when you create a PO type ASN and click the Details link.

1. On the ASN Entry window, query and select the PO type ASN that you want to 
edit. Click Details. The ASN PO Entry window opens.

Figure 6–16 ASN PO Entry Window

2. To add all items on a purchase order:

Note: Step 2 explains how to add all items from a selected PO. Step 3 
explains how to add a single line item from a selected PO.
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a. Click Add by PO. The Add by PO window opens. If the PO already exists for 
an ASN, you will get an error stating the following: “This PO is already on the 
ASN - cannot add by PO.”

Figure 6–17 Add by PO Window

b. In the PO Nbr field, enter the purchase order number, or click the LOV button 
and select the purchase order.

3. To add a line item from a purchase order:

a. Click Create Record. The Create Record window opens.

Figure 6–18 Create Record Window

b. In the PO Nbr field, enter the purchase order number, or click the LOV button 
and select the purchase order.

c. In the Item ID field, enter the ID of the inbound item, or click the LOV button 
and select the item. The UOM field is automatically populated.

d. In the Unit Qty field, enter the number of inbound units.

e. In the Dest ID field, enter the ID of the destination, or click the LOV button 
and select the destination.

f. For perishable items, enter the expiry date in the DD-MON-YYYY format in 
the Best Before Date field. Example: 12-OCT-2013.

g. Enter any additional details as necessary. 

h. Click Save to save the changes and close the Create Record window.



Create a PO Level ASN

6-16 Oracle® Retail Warehouse Management System UI User Guide

Exit the ASN Entry Windows
Click Exit to close each window.

Edit a PO Type ASN
From the Main Menu > Receiving > select ASN Entry. The ASN Entry tab opens.

Figure 6–19 ASN Entry Window

Display Header Details for All ASNs
In the ASN Entry tab, click Search to view all available ASNs.

Display Header Details for One ASN
1. If any ASNs are currently displayed, click Clear.

2. Click Query. An LOV button displays next to the ASN field.

3. In the ASN field, enter the ID of the ASN, or click the LOV button and select the 
ASN.

4. Click Enter. The header details for the selected ASN appear.

Edit Header Details on an ASN
1. On the ASN Entry tab, double-click the PO type ASN that you want to edit. The 

Modify window opens.

Note: If you log on as a vendor, all ASNs associated with your user 
ID and vendor number are automatically displayed. Only ASNs that 
were manually entered into RWMS may be edited. ASNs received 
from the host system or via EDI cannot be edited.
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Figure 6–20 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save the changes and close the Modify window.

Delete an ASN

1. On the ASN Entry window, select the PO type ASN that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Edit Line Items on an ASN

1. On the ASN Entry window, select the PO type ASN that you want to edit.

2. Click Details. The ASN PO Entry window opens.

Figure 6–21 ASN PO Entry Window

Note: An ASN may be deleted if it is not assigned to an appointment 
or if the status of the appointment is Received.

Note: Line items may not be edited if the ASN is assigned to an 
appointment.
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3. Double-click the line item that you want to edit. The Modify window opens.

4. Edit the enabled fields as necessary.

5. Click Save to save the changes and close the Modify window.

Delete a Line Item from an ASN

1. On the ASN Entry window, select the PO type ASN that you want to edit.

2. Click Details. The ASN PO Entry window opens.

3. Select the line item that you want to delete.

4. Click Delete Record.

5. When prompted to delete the record, click Yes.

Exit the ASN Entry Windows
Click Exit to close each window.

ASN Inquiry
The ASN Inquiry allows you to view the header information for advanced shipment 
notices (ASN). You can access the ASN Detail Inquiry Editor in order to view the 
PO/line items and destinations on an ASN.

From the main menu, select Appointments > ASN Inquiry. The ASN Inquiry window 
opens.

Figure 6–22 ASN Inquiry Window

Display ASNs
1. If any ASNs are currently displayed, click Clear.

2. Click Query.

3. Enter criteria in one or both of the fields.

4. Click Search. The ASNs that match the criteria appear.

Note: A line item may not be deleted if it is assigned to an 
appointment with a status of Open, Pending, Received, or 
Unreconciled.
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View the Details of an ASN
1. On the ASN Inquiry window, select the ASN that you want to view in detail.

2. Click Details. The PO/line items appear in the ASN Detail Inquiry window.

Figure 6–23 ASN Detail Inquiry Window

3. To view details at the style level:

a. Click Style Detail. The details appear in the Style Detail window.

b. Click Exit to close the Style Detail window.

4. Click Exit to close the ASN Detail Inquiry window.

Exit the ASN Inquiry Window
Click Exit to close the window.

Container Checking
The Container Checking Editor allows you to view, add, or delete the items in a 
container. The modifications to container quantities are only allowed for a specific 
amount of time based on the SCP Receipt_Adjustment_Number_Hours. If you 
received this carton 9 hours ago and the SCP is set to 8 hours, RWMS prevents any 
container unit adjustments. Also, when the container is putaway into a storage 
location, RWMS prevents any container checking edits.

To access the Container Checking window, navigate to Receiving -> Container 
Checking. The Container Checking window opens.

Note: You can also access this window from the Appointment ASN 
window.
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Figure 6–24 Container Checking Window

Display the Details of a Container
1. If any details are currently displayed, click Clear.

2. In the Container ID field, enter a container ID, or click the LOV button and select 
the container.

3. Click Search. The details for the specified container are displayed.

Edit an Item in a Container
1.  On the Container Checking window, double-click the item that you want to edit. 

The Modify window opens.

2. Edit the container quantity and unit quantity as necessary.

3. Click Save to save any changes and close the Modify window.

Add an Item to a Container

1. On the Container Checking window, click Create Record. The Create Record 
window opens.

2. In the Item ID field, enter the ID of the item.

3. In the Cntr Qty field, enter the number of containers.

4. In the Unit Qty field, enter the total number of units. The number of units must 
divide evenly into the number of containers.

Note: You can also access this window from the Quality Assurance 
and Carton Process window.

Note: You can make receipt adjustments for a container only if the 
difference between the current time and receipt time is less than or 
equal to the value set in the scp parameter receipt_adj_nbr_hrs.

Note: The container must have a status of Inventory (I) or 
Distributed (D).
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5. Click Save to save the changes and close the Create Record window.

Delete an Item from a Container
1. On the Container Checking window, select the item that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Container Checking Window
Click Exit to close the window.

Door Status
The Door Status allows you to view the status of all receiving and shipping doors. The 
status may be Available or Busy.

To view the door statuses, navigate to Receiving -> Door Status. The status of each 
receiving and shipping door opens in the Door Status window.

Figure 6–25 Door Status Window

Displaying a Specific Door
1. Click Query.

2. Enter the specific door in the Door column.

3. Click Search.

Exit the Door Status Window
Click Exit to close the window.

Vendor Non Conformance Code Details
The Non Conformance Details window allows you to capture non conformance issues 
during the receiving process that can be traced to a vendor. You can capture these 
codes at PO/Item level. You can also add pictures of the issues as attachments to the 
details and send them to the host management system.

To access the Non Conformance Details window, navigate to Receiving -> Non 
Conformance Details. The Non Conformance Details window opens.
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Figure 6–26 Non Conformance Details Window

Display Vendor Non Conformance Code for PO/Item
1. If any appointments are currently displayed, click Clear.

2. Enter, or select from the drop-down list, the appointment number in the Appt Nbr 
field, or the PO number in the PO Nbr field, or the vendor number in the Vendor 
Nbr field.

3. Click Search.

Edit Vendor Non Conformance Code for PO/Item
1. On the Non Conformance Details window, double-click the row you want to edit 

in either of the two blocks. The Modify window opens.
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Figure 6–27 Modify Window

If you double-click a row in the first (top) block, the following Modify window 
opens.

If you double-click a row in the second (bottom) block, the following Modify 
window opens.

2. Edit the different fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add Vendor Non Conformance Code for PO/Item
1. On the Non Conformance Details window, click the Create Record link. The 

Create Record window opens
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Figure 6–28 Create Record Window

2. In the Appt Nbr field, enter the appointment number, or click the LOV button and 
select the appointment.

3. In the PO Nbr field, enter the PO number, or click the LOV button and select the 
PO.

4. In the Non Conformance Code field, enter the non conformance code, or click the 
LOV button and select the code.

5. In the Comment field, enter your comment if necessary.

6. Click Save. The vendor non conformance code is added to the PO/Item.

Add an Attachment for a PO/Item
1. On the Non Conformance Details window, select the appointment and click 

Attachments. The attachments window opens.

Figure 6–29 Attachments Window
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2. Click Upload File button. From the browser, select the file on your local disk and 
click OK.

3. Enter any comments in the Comment field as necessary.

4. Click Save to save any changes.

View an Attachment for a PO/item
1. On the Non Conformance Details window, select the appointment and click 

Attachments. The attachments window opens.

2. Click View to view the file.

Delete an Attachment for a PO/Item
1. On the Non Conformance Details window, select the appointment and click 

Attachments. The attachments window opens.

2. Select the file you want to delete and click Delete.

3. When prompted to delete the record, click Yes.

4. Click Save on the attachments window to save the changes.

Delete Vendor Non Conformance Code for PO/Item
1. On the Non Conformance Details window, select the appointment and click 

Delete Record.

2. When prompted to delete the record, click Yes.

Exit the Non Conformance Details Window
Click Exit to close the window.

Receipt Inquiry
The Receipt Inquiry allows you to view items received by receipt number.

To access the Receipt Inquiry navigate to Receiving -> Receipt Inquiry. The Receipt 
Inquiry window opens.

Figure 6–30 Receipt Inquiry Window
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Display the Details of a Receipt
1. If the details of a receipt are currently displayed, click Clear.

2. Click Query.

3. In the Receipt Nbr field, enter a receipt number, or click the LOV button and select 
the receipt.

4. Click Search. The details of the selected receipt appear.

Exit the Receipt Inquiry Window
Click Exit to close the window.

Generate Receiving Labels
The Receiving Labels window allows you to print receiving packages for one or 
multiple appointments. When choosing to print receiving packages for a group of 
appointments, you are prompted to enter a time range for the selected date. Labels are 
printed for all appointments within the time range that have been marked for group 
printing.

You get the following results depending on system parameters and the type of 
appointment.

You can access the Receiving Package Monitor window in order to view the status of 
receiving packages that are generated for non-ASN type appointments.

To generate receiving labels, navigate to Receiving -> Receiving Labels. The Receiving 
Labels window opens in the Editors pane. The Receiving Labels process must be run 
for PO and ASN type appointments only.

If Then

RWMS is set up for labeled 
receiving

Receiving labels and the Receiving Package Audit List 
report are generated for non-ASN/non-NSC (non-specified 
casepack) type appointments.

RWMS is not set up for 
labeled receiving

The Receiving Package Audit List report is generated for 
non-ASN/non-NSC (non-specified casepack) type 
appointments. RWMS assumes that generic labels are to be 
used for receiving.

The appointment is based on 
container type ASNs

The ASN Receiving Package Audit report is generated, but 
labels are not. Merchandise is received prelabeled.

Note: For Brazilian Installations, RWMS prevents printing receiving 
labels for any appointment without a Schedule Number.
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Figure 6–31 Receiving Labels Window

Display Appointments by Date
1. If any appointments are currently displayed, click Clear.

2. In the Date field, enter a date or click the Calendar icon and select the date.

3. Click Query. The appointments for the selected date appear.

Edit the Group Print Status of Appointments
1. On the Receiving Labels window, double-click the appointment that you want to 

edit. The Modify window opens.

Figure 6–32 Modify Window

2. Select or clear the Group Print check box if necessary.

3. Click Save to save any change and close the window.

Print Receiving Packages for Multiple Appointments
1. On the Receiving Labels window, click Group Print. The Group Print window 

opens.
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Figure 6–33 Group Print Window

2. In the Start field, enter the start time for the range of appointments.

3. In the End field, enter the end time for the range of appointments.

4. Click Print Form. The Select Printer window opens.

5. Click the LOV button and select the Printer Queue.

6. Click Save. The labels and reports for the appointments within the selected time 
range are sent to the selected destinations.

Print a Receiving Package for One Appointment
1. On the Receiving Labels window, select the appointment for which you want to 

print labels and a report.

2. Click Print.

3. When prompted to confirm your request, click Yes. 

4. Click the LOV button and select the Printer Queue.

5. Click Save. The labels are sent to the selected destination.

6. Click Exit to close each window.

Receiving Package Monitor
The Receiving Package Monitor allows you to monitor the print requests for receiving 
packages. In addition to viewing the status of a print request, you can resubmit a 
request that is in Failed or Done status. You might resubmit a request for a receiving 
package that is in Done status if the appointment was modified.

You can mark a print request that is in Submitted status as a rush job. RWMS changes 
the time to that of the earliest print request in Submitted status.

If you no longer want to monitor a print request that is in Submitted, Done, or Failed 
status, you can delete it from the monitor. 

To monitor print requests, navigate to Receiving -> Receiving Package Monitor. The 
Receiving Package Monitor window opens in the Editors pane.
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Figure 6–34 Receiving Package Monitor Window

Delete a Receiving Package from the Monitor

1. On the Receiving Package Monitor window, select the receiving package that you 
want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Reprint a Receiving Package

1. On the Receiving Package Monitor window, select the receiving package that you 
want to reprint.

2. Click Resubmit. 

3. Click the LOV button and select the Printer Queue.

4. Click Save. The labels are sent to the selected destination.

Rush a Request for a Receiving Package
1. On the Receiving Package Monitor window, select the receiving package that you 

want to rush.

2. Click Rush. The Message field is updated to indicate that the request is a rush job. 
The Time field is changed to show that the request is now the earliest request in 
Submitted status.

Exit the Receiving Package Monitor Window
Click Exit to close the window.

Note: Only receiving package records with a status of Submitted, 
Done, or Failed may be deleted from the monitor.

Note:  Receiving packages with a status of Failed or Done may be 
reprinted.
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7
Distribution Planning

Distribution planning can begin when stock orders are received from the host system 
or manually entered (not recommended) into RWMS. Some stock orders received from 
the host are processed automatically. Manually-entered orders and orders marked as 
Manual or PO by the host system must be processed manually by creating a wave.

Stock orders are replenishment requests by stores. These stock orders are referred to as 
distros. For a distribution center that supplies merchandise directly to the consumer, a 
stock order represents a customer order.

Stock orders are categorized as pre-allocations, post allocations, and post allocations 
by PO depending on how the orders are filled.

■ Pre-allocation (also referred to as Predist): The creation of stock orders prior to 
merchandise receipt. When received the stock order is processed against the 
received merchandise generating crossdock and flowthrough tasks

■ Predist enters RWMS in one of two ways: 

■  Stock order and stock allocation records are received from the host 

■ Stock Orders are entered into RWMS directly if the SCP parameter allow_
predist_create is set to Y. All appointment types take advantage of the 
Predist stock orders to generate crossdock and flowthrough shipments.

■ Post allocation: Distribution of merchandise after it is received and put away in 
storage locations. RWMS distributes merchandise by identifying all containers 
eligible for picking. 

■ Post allocation by purchase order: RWMS examines all containers in storage and 
staging locations and retrieves eligible inventory based on the user-entered 
purchase order that is associated with a stock order.

Note: PO type stock orders are not supported by Oracle Retail 
Merchandising System (RMS).

Note: Predist is a distinct form of distributing containers and is 
different from the full distribution as completed through the other 
Waving steps and processes. Thus, different logic is used for Predist 
versus full distribution.

The regular distribution logic is part of the distribution engine 
whereas the pre-distribution logic is handled at the time of receiving. 
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When manual and PO type stock orders are selected for distribution, they are assigned 
to available waves. Each wave may use one of the following distribution methods:

■ Efficiency: The picker is sent to a sequence of locations that fulfills the demand 
with the least number of picks.

■ Pick to clean: The picker is sent to the most locations that can be picked clean in 
order to meet the demand. This frees up the most locations, which can then be 
used to store other inbound merchandise.

Business Process
If you manually select stock orders, you must assign it to an available wave. If all 
available wave numbers are already assigned to a wave you can create new wave 
number using the Wave Editor. Manual and PO type stock orders that are received 
from the host must also be assigned to waves. You can select such stock orders using 
predefined queries or sets of queries.

A wave is a group of stock orders that can be released together for picking and 
shipment. The distribution process varies by the type of wave used to distribute 
merchandise. The type of wave may be:

■ Automatic: All open, automatic type orders that are eligible for distribution are 
assigned to the next available wave of the type Automatic.

■ Manual: DC personnel select manual type orders and assign them to available 
waves of the type Manual.

■ PO: DC personnel select PO type orders and assign them to available waves of the 
type PO.

■ Predist: Inbound appointments access Predist order types to generate crossdock 
and flowthrough shipments.

■ Wave: DC personnel assign specific destinations to daily pick waves of the type 
Wave.

■ Repair: When there is a need for repair to the merchandise at the DC, DC 
personnel select Repair as the stock order type which is picked and sent to third 
party vendors or finishers. The Repair type stock order can be initiated in RMS or 
RWMS.

There are several windows that allow you to monitor the progress of orders, pick 
waves, and pack waves. You can view the percentages of an order that are at the 
various stages of processing. You can view the planned and picked quantities for bulk, 
case, and unit operations by wave and by destination. Pick directives can be viewed 
and purged from RWMS.

This chapter contains the following topics:

■ Distribution Queue Inquiry

■ Manual Wave Review

■ Order Query Editor

■ Pack Wave Inquiry

■ Packing Schedule Setup

■ Print on Demand

■ Put to Store Status

■ Repair Order Container Assignments
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■ Replenishment Summary

■ Select Stock Orders

■ Stock Order Creation

■ Stock Order Inquiry

■ Stock Order Status Inquiry

■ Wave Editor

■ Wave Planning

■ Wave Status

■ Wave Status by Destination

■ View Container Details for a Destination

■ Wave Summary

Distribution Queue Inquiry
The Distribution Queue Inquiry informs you of the status of orders that have been 
placed in the distribution queue.

To view distribution queue, navigate to Distribution Planning -> Distribution Queue 
Inquiry. The progress of the individual pick waves opens in the Distribution Queue 
Inquiry window.

Figure 7–1 Distribution Queue Inquiry Window

Exit the Distribution Queue Window
Click Exit to close the window.

Manual Wave Review
The Manual Wave Review allows you to print pick packages for manual stock orders, 
review the distribution plan, purge distros and parts of distros, and manage the 
picking resources and hours.

To view the Manual Wave Review window, navigate to Distribution Planning -> 
Manual Wave Review. The manual waves for the current date appear in the Manual 
Wave Review window.
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Figure 7–2 Manual Wave Review Window

Display Manual Waves for Another Date
1. If any manual waves are currently displayed, click Clear.

2. In the Waves for Day field, enter the date that you want to review, or click the 
Calendar icon and select the date. The manual waves for the selected date appear.

View Details by Distro
1. On the Manual Wave Review window, select the manual wave that you want to 

view in detail.

2. Click Wave Details. The distros appear in the Wave Details window.

Figure 7–3 Wave Details Window

3. To view details by destination, select the distro that you want to view in detail.

4. Click Order Details. The destinations appear in the Order Details window.
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Figure 7–4 Order Details Window

5. Click Exit to close the Order Details window. Then click Exit to close the 
Distributions for Wave window.

Purge a Distro from a Manual Wave

1. On the Manual Wave Review window, select the manual wave that you want to 
edit.

2. Click Wave Details. The distros appear in the Distributions for Wave window.

3. Select the distro that you want to purge.

4. Click Purge.

Purge a Destination/Item from a Distro

1. On the Manual Wave Review window, select the manual wave that you want to 
edit.

2. Click Wave Details. The distros appear in the Distributions for Wave window.

Note: When you purge a distro from a manual wave, the picks are 
deleted from the wave and the allocations are reset.

Note: When you purge a destination/item from a distro, the picks 
are deleted from the wave and the allocations are reset.
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3. Select the distro that you want to edit.

4. Click Order Details. The Order Details window opens.

5. Select the destination/item that you want to purge.

6. Click Purge.

Edit Resources and Hours for a Manual Wave
1. On the Manual Wave Review window, select the manual wave that you want to 

edit.

2. Click Wave Info. The projected operations appear in the Wave Info window.

Figure 7–5 Wave Info Window

3. Double click a field. The Modify window opens.

Figure 7–6 Modify Window

4. Edit the resources and hours as necessary.

5. Click Save to save any changes and close the Modify window.

6. Click Exit to close the Wave Information window.
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Exit the Manual Wave Review Window
Click Exit to close the window.

Generate Pick Packages for Manual Waves
To generate pick packages for manual waves, navigate to Distribution Planning -> 
Manual Wave Review. The manual waves for the current date appear in the Manual 
Wave Review window.

Figure 7–7 Manual Wave Review Window

Display Manual Waves for Another Date
1. If any manual waves are currently displayed, click Clear.

2. In the Waves for Day field, enter the date that you want to review, or click the 
Calendar icon and select the date. The manual waves for the selected date appear.

Print a Pick Package
1. On the Manual Wave Review window, select the manual wave for which a pick 

package is needed.

2. Click Print Pkg.

3. When prompted to confirm the request, click Yes.

Exit the Manual Wave Review Window
Click Exit to close the window.

Order Query Editor
The Order Query Editor window is used to view and modify saved order queries 
(created through Select Stock Order -> Build Query). You can also use this window to 
copy queries from one set to another, delete one or more queries from a set, or delete 
the complete set. Order queries are used in the Automate Wave process.

To access the Order Query Editor window, navigate to Distribution Planning -> Order 
Query Editor. The current queries appear in the Order Query Editor window.
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Figure 7–8 Order Query Editor Window

Edit a Query
1. On the Order Queries Editor window, double-click the query that you want to 

edit. The Modify window opens.

Figure 7–9 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify Order Queries window.

Copy a Query Set
1. On the Order Queries Editor window, click Copy Set. The Copy Set window 

opens.

Figure 7–10 Copy Set Window

2. In the New Set Name field, enter the name of the new set.
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3. In the From Set Name field, enter the name of the set to be copied.

4. In the Start Primary Seq and End Primary Seq fields, enter the first and last 
primary sequence numbers that you want to include in the range of queries.

5. Click Copy to save the changes and close the window. Any queries from the 
selected set that have primary sequence numbers within the selected range are 
copied to the new set.

Delete a Query
1. On the Order Queries Editor window, select the query that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Delete a Query Set
1. On the Order Queries Editor window, click Delete Set. The Delete Set window 

opens.

Figure 7–11 Delete Set Window

2. In the Delete Set Name field, enter the name of the set that you want to delete.

3. To delete only a range of queries from the selected set, enter the Start Primary Seq 
and End Primary Seq numbers in the appropriate fields.

4. Click Delete. The queries within the range of sequence number are deleted. If no 
sequence numbers were entered, the entire query set is deleted.

Exit the Order Query Editor Window
Click Exit to close the window.

Pack Wave Inquiry
The Pack Wave Inquiry allows you to select a wave number and view how the wave is 
broken out into pack waves, groups, and slot order.

To view pack waves, navigate to Distribution Planning -> Pack Wave Inquiry. The 
Pack Wave Inquiry window opens.
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Figure 7–12 Pack Wave Inquiry Window

Display Pack Waves by Wave
There are four blocks on this window. From top to bottom, they are referred to as the 
Wave block, Pack Wave block, Group block, and Slot block.

1. If any pack waves are currently displayed, click Clear.

2. Click Query.

3. In the Wave Nbr field, enter the wave number, or click the LOV button and select 
the wave.

4. Click Search. The pack wave details for the selected wave are displayed.

View Additional Pack Wave Details
1. On the Pack Wave Inquiry window, select the pack wave that you want to view in 

detail.

2. Click Next. The groups associated with the selected pack wave appear in the Pack 
Wave block.
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Figure 7–13 Pack Wave Block

3. Select the group that you want to view in detail.

4. Click Next. The slots associated with the selected group appear in the Group 
block.

Figure 7–14 Group Block

5. Select the slot that you want to view in detail.
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6. Click Next. The container and items associated with the selected slot appear in the 
Slot block.

Figure 7–15 Slot Block

Exit the Pack Wave Inquiry Window
Click Exit to close the window.

Packing Schedule Setup
The Packing Schedule window allows you to maintain daily packing schedules for the 
current week.

You can access the Pack Schedule Summary window in order to view daily packing 
schedules for the entire week.

To maintain packing schedules, navigate to Distribution Planning -> Packing Schedule 
Setup. The Packing Schedule Setup window opens.
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Figure 7–16 Packing Schedule Setup Window

Display the Packing Schedule for a Day of the Week
1. If a packing schedule is currently displayed, click Clear.

2. Click Query.

3. In the Day of Week field, enter the name of the day, or click the LOV button and 
select the day.

4. Click Search. The waves associated with the selected day appear.

View the Packing Schedules for the Week
The Pack Schedule Summary allows you view daily packing schedules for the entire 
week.

1. On the Packing Schedule window, click Pack Schedule. The packing schedules for 
each day of the week appear on the Pack Schedule Summary window.

2. Click Exit to close the Pack Schedule Summary window.

Add a Wave to a Packing Schedule
1. On the Packing Schedule window, click Create Record. The Create Record 

window opens.

Figure 7–17 Create Record Window

1. Enter the wave number to be added to the schedule.

2. Click Save to save the changes and close the Create Record window.

Delete a Wave from a Packing Schedule
1. On the Packing Schedule window, select the wave that you want to delete.
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2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Packing Schedule Window
Click Exit to close the window.

Print on Demand
The Print on Demand Editor allows you to print labels when desired rather than when 
a wave is created. The option to print on demand is set when you:

■ Define a label configuration, and

■ Associate the label configuration with a process that requires labels for pick 
activities.

 To print labels, navigate to Distribution Planning -> Print on Demand. The Print on 
Demand window opens.

Figure 7–18 Print On Demand Window

The option to print on demand is set when you:

■ Define a label configuration, and

■ Associate the label configuration with a process that requires labels for pick 
activities.
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Put to Store Status
The Put to Store Status window allows you to view the containers currently assigned 
to each Put to Store location and to see when that container was initially opened.

To view open PTS containers, navigate to Distribution Planning -> Put to Store Status. 
The Put to Store Status window opens.

Figure 7–19 Put To Store Status Window

Display All Destinations
Click Query.

Display a Destination
1. If any destinations are currently displayed, click Clear.

2. Click Query.

3. In the Dest ID field, enter the destination ID, or click the LOV button and select the 
destination.

4. Click Search. The details for the selected destination are displayed. 

View Container Level Details
1. On the Put to Store Status window, select the destination that you want to view in 

detail.

2. Click Status Detail. The container level details appear.
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Figure 7–20 Status Detail Window

3. Click Exit to close the window.

Exit the Put to Store Status Window
Click Exit to close the window.

Repair Order Container Assignments
When merchandise stored in the DC needs to be repaired or finished it can be sent to a 
third party by creating a Repair Stock Order/Allocation. Once the Repair Order is 
created, this window automatically imports the orders and allows you to specify the 
Dest ID / Distro Nbr / Item ID combination for picking through the RF Repair Picking 
window. When you select a line item from the upper block, RWMS automatically 
displays eligible containers in the lower block. You must select the specific containers 
that must be picked for repair shipment. These containers must be in staging locations 
(not storage or bulk).

Repair Stock Orders can be initiated in either RMS or RWMS. When initiated in RMS, 
it starts as a transfer with context type as Repair. These are reflected in the RWMS as 
Repair Orders. 

Navigate to Distribution Planning -> Repair Order Container Assignments. The Repair 
Order Container Assignments window opens.

Note: Repair Orders are not distributed through the waving/pick 
directive process. 
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Figure 7–21 Repair Order Container Assignments Window

Display Repair Orders
You can filter existing stock orders for repair using DestID, Distro Nbr, and Item ID.   

1. If an order is currently displayed, click Clear.

2. Click Query. The existing repair orders are displayed on the window.

You may also search using either a Dest ID, Distro Nbr, or any combination. Click 
Search. The repair orders for the selected option appear. 

3. You may opt to view all the repair orders by clearing the Show Open Only check 
box.

Assign Containers
The upper block is populated with Stock Orders that are of the Order Type: Repair. 

To assign containers:

1. Click Query.

2. Enter the Dest ID, Distro Nbr, Item ID to search the Repair Stock Order data. Select 
the Show Open Only check box to search only the Open Repair Stock Orders. You 
can use one or a combination of search criteria to filter the search results.

3. Click Search. The upper block is populated based upon search criteria.

4. One line in the upper block can be selected using the Select option.

Update Containers
Once a row has been selected in the upper block, ’in process’ container data displays in 
the lower block. To display the eligible containers for the chosen row, click Update. 
The Update functionality may be used with search criteria.

1. Click Query.
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2. Enter either the Location ID, Zone, Trouble Code fields or all the fields to search 
for required containers. You can search only individual cases that are in a staging 
location.

3. Select the containers for processing using the Select check box. Click Save . These 
containers are now available for RF Repair Picking.

The Req Qty and Assigned Qty fields display the Required Quantity and the 
currently Assigned Quantity

Unassign Containers
1. Uncheck the Select check box against the container ID.

2. Click Save. The container is removed from the list of containers.

Exit the Repair Order Container Assignment Window
Click Exit to close the window.

Replenishment Summary
The Replenishment Summary allows you to view a real-time picture of any remaining 
picks. You can view pick, case, and unit quantities by From zone/To zone 
combination. In addition, you can view and delete individual replenishment 
directives.

To view the Replenishment Summary window, navigate to Distribution Planning -> 
Replenishment Summary. The Replenishment Summary window opens.

Figure 7–22 Replenishment Summary Window

Display the Remaining Picks
1. If any replenishment records are currently displayed, click Clear.

2. Click Query.

3. In the Replen Type field, select a replenishment type.

4. To narrow the scope of the query, enter criteria in one or more of the fields.

5. Click Search. The remaining picks that match the criteria appear.

View the Pick Directives
1. On the Replenishment Summary window, select the record that you want to view 

in detail.
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2. Click Detail Record. The pick directives associated with the selected record appear 
in the Detail Record window.

Figure 7–23 Detail Record Window

3. Click Exit/Cancel to close the Detail window.

Delete a Pick Directive
1. On the Replenishment Summary window, select the record that you want to view 

in detail.

2. Click Detail Record. The pick directives associated with the selected record appear 
in the Detail window.

3. Select the pick directive that you want to delete.

4. Click Delete Record.

5. When prompted to delete the record, click Yes.

6. Click Exit/Cancel to close the Detail window.

Exit the Replenishment Summary Window
Click Exit to close the window.

Select Stock Orders
The Select Stock Order Editor allows the Wave Management Team to build custom 
waves utilizing query capabilities. RWMS allows users to select from over 100 discreet 
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fields (stock order and item master) to build wave queries to slice and dice the stock 
orders into desired waves.

To review manual stock orders, navigate to Distribution Planning -> Select Stock 
Order. The Select Stock Order window opens.

Figure 7–24 Select Stock Order Window

View Details by Distro
1. On the Select Stock Order window, select the stock order in the Distribute Orders 

block.

2. Click Details. The details appear in the Details for Distro window.

3. Click Exit to close the Details for Distro window.

View Planned Waves by Day
1. On the Select Stock Order window, click Review. The waves for the current date 

appear in the Manual Wave Review window.
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Figure 7–25 Manual Wave Review Window

2. Click Exit to close the Manual Wave Review window.

View a Distribution Summary
1. On the Select Stock Order window, click Summary. The details appear in the 

Summary window.

Figure 7–26 Summary Window

2. Click Exit to close the Summary window.

Exit the Select Stock Order Window
Click Exit to close the window.
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Distribute Manual Stock Orders
To distribute manual stock orders, navigate to Distribution Planning -> Select Stock 
Order. The Select Stock Order window opens.

Figure 7–27 Select Stock Order Window

Query the Stock Orders

1. Select a distribution type. The type may be:

■ Consumer Direct: Restricts the query to all stock orders indicated for shipment 
to a virtual store and stock orders with Consumer Direct flag set to Y. 

■ Store: Restricts the query to all stock orders indicated for shipment to a 
specific non virtual store. There is a System Control Parameter (SCP) default_
dist_type that sets this field to a user selected default value.

2. Select a stock order type. The type may be:

■ Manual: Restricts the query to stock orders that are associated with customer 
orders. The customer orders may be received from the host system or entered 
manually.

Note: You can also access this window from the Stock Order 
Creation window.

Note: There are two blocks on this window. They are referred to as 
the Query Results block and the Distribute Orders block.



Select Stock Orders

Distribution Planning 7-23

■ PO: Restricts the query to stock orders that are associated with inbound 
purchase order receipts.

3. Select a stock order level. The level may be:

■ Customer Order: Customer Order is not supported in the base environment. 
Customer Order may be an option for large scale custom Consumer Direct 
environments.

■ Distro: For a distro to be selected, at least one item on the distro must match 
the selection criteria.

■ Line: For a line item to be selected, it must match the selection criteria.

■ Full distro: For a distro to be selected, all items on the distro must match the 
selection criteria.

4. To display all stock orders that match the previously listed criteria:

a.  Click Build Query. The Build Query window opens.

Figure 7–28 Build Query Window

b. Click List All Ord.

c. When prompted to run the query, click Yes. The results of the query appear in 
the Query Results block.

Select Stock Orders for Distribution
After performing a query, move stock orders to the Distribute Orders block or remove 
any unnecessary stock orders from the block.

Note: You have several tools available in order to query the stock 
orders. You can create and save a query, load and run a query, run a 
set of queries and adjust the results by query.
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■ To move a stock order to the Distribute Orders block, select the stock order and 
click Add Order.

■ To move all the stock orders to the Distribute Orders block, click Add All.

■ To remove a stock order from the Distribute Orders block, select the stock order 
and click Delete Row.

■ To remove all stock orders from the Distribute Orders block, click Clear List.

Review the Selected Stock Orders
You can access several windows in order to review additional details for selected stock 
orders.

■ Details for Distro Nbr: Displays the details of a selected distro by destination.

■ Wave Preview: Displays details of the pick wave. You can also generate the Wave 
Preview report.

■ Order Summary: Displays a summary of the stock orders in the Distribute Orders 
block.

Distribute Selected Stock Orders
1. On the Select Stock Order window, click Distribute. The current pick waves 

appear in the Distribute window.

Figure 7–29 Distribute Window

2. Select a Manual or PO pick wave with a status of Available. If there is no available 
wave, you can add a wave.

a. On the Select Available Wave window, click Create Record. The Create Record 
window opens.

Figure 7–30 Create Record Window
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b. In the Wave Nbr and Description fields, enter a number and description for 
the wave.

c. In the Distribution Method field, select the appropriate method.

d. In the Wave Type field, select the type of wave. The type may be PO or 
Manual.

e. In the Group Qty field, enter the number of slots if slotted picking carts are 
used by the pickers.

f. Click Save to save the changes and close the Create Record window. You can 
then select the new pick wave if desired.

3. Click Process.

4. When prompted to assign the stock orders to the wave, click Yes. The stock orders 
are assigned and you are returned to the Select Stock Order window.

Exit the Select Stock Order Window
Click Exit to close the window.

Run Query Sets on Manual Stock Orders
To run query sets on manual stock orders, navigate to Distribution Planning -> Select 
Stock Order. The Select Stock Order window opens. 

Run a Set of Queries
1. On the Select Stock Order window, click Query Group. The Query Group window 

opens.

Figure 7–31 Query Group Window

2. In the Set Name field, enter the name of a query set, or click the LOV button and 
select the query set.

3. Enter any chute constraints as necessary:

■ Max Distros: Limits the number of distros returned.

■ Max Pack Waves: Limits the number of pack waves generated. It does not 
exceed the number of pack waves designated for the sorter group.

■ Fill Sorter Capacity: Limits the number of orders to what is needed in order to 
fill the sorter.

4. Click Run Set. The set of queries is run, chute logic is applied, and the results 
appear on the Query Results block of the Select Stock Order window.
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Adjust the Results
1. On the Select Stock Order window, click Query Totals. The Query Totals window 

opens.

2. To remove the order lines returned by a specific query in the query set, select the 
query and click Delete. The lines are removed from the Distribute Orders block on 
the Select Stock Order window.

Exit the Select Stock Order Window
Click Exit to close the window.

Run Query Sets on Manual Stock Orders
To run query sets on manual stock orders, navigate to Distribution Planning -> Select 
Stock Order. The Select Stock Order window opens.

Run a Set of Queries
1. On the Select Stock Order window, click Query Group. The Query Group window 

opens.

Figure 7–32 Query Group Window

2. In the Set Name field, enter the name of a query set, or click the LOV button and 
select the query set.

3. Enter any chute constraints as necessary:

■ Max Distros: Limits the number of distros returned.

■ Max Pack Waves: Limits the number of pack waves generated. It does not 
exceed the number of pack waves designated for the sorter group.

■ Fill Sorter Capacity: Limits the number of orders to what is needed in order to 
fill the sorter.

4. Click Run Set. The set of queries is run, chute logic is applied, and the results 
appear on the Query Results block of the Select Stock Order window.

Adjust the Results
1. On the Select Stock Order window, click Query Totals. The Query Totals window 

opens.

2. To remove the order lines returned by a specific query in the query set, select the 
query and click Delete. The lines are removed from the Distribute Orders block on 
the Select Stock Order window.
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Exit the Select Stock Order Window
Click Exit to close the window.

Query Manual Stock Orders
To query manual stock orders, navigate to select Distribution Planning -> Select Stock 
Order. The Select Stock Order window opens.

Figure 7–33 Select Stock Order Window

Run a Query
1. On the Select Stock Order window, click Build Query. The Build Query window 

opens.
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Figure 7–34 Build Query Window

a. If a query opens, click Clear.

b. To load a query, click Load Query. The Load Query window opens:

c. Select the query that you want to use.

d. Click Load Query. The query opens on the Build Query window.

e. Click Run Query. The query is run and the results appear on the Query 
Results block of the Select Stock Order window.

Build a Query
The Build Query window allows you to select fields to use in your query that will be 
used to match against stock orders. The stock orders selected then can be processed as 
a wave if desired or you can simply create a new query to select different stock orders.

1. On the Select Stock Order window, click Build Query. The Build Query window 
opens.

2. In the Column field, select a limiting element.

3. In the Operator field, select a relational operator.

4. In the Value field, enter the value of the element selected in the Column field.

5. In the Logical field, enter the logical operator used to join two or more conditions.

6. Enter additional conditions as necessary.

7. After entering all the conditional statements, enter any chute criteria in the lower 
half of the window as necessary.

8. To include incomplete orders in the results, select the Incomplete Orders check 
box.

9. To save a query:

a. Click Save Query. The Select Order Queries window opens.
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b. In the Save field, enter a name for the query.

c. If the query is to be saved as part of a query set, select the query set in the Set 
Name field, or click the LOV button and select the query set.

d. Click Save to save the query and close the Select Order Queries window.

10. On the Build Query window, click Run Query to run the query or click 
Exit/Cancel to close the Build Query window.

Enter Store Cube/Wt Definition
1. On the Select Stock Order window, click Build Query.

2. On the Build Query window, click Store Cube/Wt Definition. The Store Cube/Wt 
Definition window opens.

Figure 7–35 Store Cube/wt Definition Window

a. Select a store and enter the weights.

b. Click Save.

c. Click Exit to close the Store Cube/Wt Definition window.

Delete a Query
1. On the Select Stock Order window, click Build Query. The Build Query window 

opens.

2. Click Delete Query. The Select Order Queries window opens.

3. Select the query that you want to delete.

4. Click Delete Query.

5. When prompted to delete the record, click Yes. The query is deleted and you are 
returned to the Build Query window.

6. Click Exit to close the Build Query window.

Exit the Select Stock Order Window
Click Exit to close the window.

Stock Order Creation
The Stock Order Creation window allows you to manually create non-consumer direct 
store stock orders in RWMS. RWMS supports the creation of Manual, Predist, and 
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Repair stock order types. To create a stock order you must provide a pick not before 
date (in future), a pick not after date (in future), a destination, an item, and a quantity. 

To maintain manual stock orders, navigate to Distribution Planning -> Stock Order 
Creation. The Stock Order Creation window opens.

Figure 7–36 Stock Order Creation Window

Display a Manual Stock Order
1. If a stock order is currently displayed, click Clear.

2. Click Query.

3. In the Customer Order Number field, enter the customer order number, or click 
the LOV button and select the customer order number.

4. In the Stock Order Number field, enter the stock order number, or click the LOV 
button and select the stock order number.

5. Click Search. The details of the selected stock order appear.

Edit a Manual Stock Order
1. On the Stock Order Creation window, double-click any field other than a text field. 

The Modify window opens.

Note: The stock order number is required if more than one stock 
order is associated with the customer order.
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Figure 7–37 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save the changes and close the Modify window.

Edit Destination Details
1. Click Details. The Detail window opens.

Figure 7–38 Details Window

Note: You cannot edit a Consumer Direct stock order.

Note: For a Consumer Direct stock order, the Create Record and 
Delete Record links are disabled.
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2. Double-click the destination record that you want to edit. The Create Record 
window opens.

Figure 7–39 Create Record Window

3. Edit the enabled fields as necessary.

4. Click Save to save any changes and close the Create Record window.

5. Click Exit to close the Details window.

Add a Manual Stock Order
1. On the Stock Order Creation window, click Create Record. The Create Record 

window opens. 

Note: It is not possible to create Consumer Direct stock order using 
the Stock Order Creation window.
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Figure 7–40 Create Record Window

2. On the Order Type field, select from the drop down list. The available options are:

■ Manual: This type of stock order generates picks from storage.

■ PreDist: This type of stock order generates picks from inbound receipts. The 
PO Number field is mandatory when PreDist is selected.

■ Repair: This type of stock order generates repair/finisher picks from staging.

3. Enter other stock order details. 

4. Click Save to save the changes and close the Create Record window.

5. To add destination details:

a. Click Details. The Details window opens.

b. Click Create Record. The Create Record window opens.

c. In the Dest ID field, enter the destination ID, or click the LOV button and 
select the destination.

d. In the Item ID field, enter the item ID, or click the LOV button and select the 
item.

Note: Only when the system control parameter 
allow_predist_create is set to Y, you can create PreDist type stock 
orders. 
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e. In the Order Line Nbr, enter a line number that is unique for the current stock 
order.

f. Enter as many details as are known.

g. Click Save to save the changes and close the Create Record window.

h. Click Exit to close the Details window.

6. To create another stock order under the same customer order number, click Add 
Stock Order. The Create Record window opens.

Delete Location Details
1. On the Stock Order Creation window, click Details. The Stock Order Detail 

window opens.

2. Select the record that you want to delete.

3. Click Delete Record.

4. When prompted to delete the record, click Yes.

5. Click Exit to close the Stock Order Detail window.

Delete a Manual Stock Order
1. On the Stock Order Creation window, click Delete Record.

2. When prompted to delete the record, click Yes.

Exit the Stock Order Creation Window
Click Exit to close the window.

Stock Order Inquiry
The Stock Order Inquiry window allows you to view the line item details for a selected 
stock order.

To view stock orders, navigate to Distribution Planning -> Stock Order Inquiry. The 
Stock Order Inquiry window opens.

Figure 7–41 Stock Order Inquiry Window

Display All Stock Orders
Click Query.

Note: You cannot delete a Consumer Direct stock order.
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Display a Subset of the Stock Orders
1. If any stock orders are currently displayed, click Clear.

2. Click Query.

3. Enter a customer order number, distro number, or parent customer order number 
in the appropriate field, or click the LOV button and select the desired number.

4. Click Search. The details of the selected stock orders are displayed.

View Address and Shipping Details
1. On the Stock Order Inquiry window, select the stock order that you want to view 

in detail.

2. Click Address. The details appear on the Address window.

Figure 7–42 Address Window

3. Click Exit to close the Stock Order Address window.

View Destinations
1. On the Stock Order Inquiry window, select the stock order that you want to view 

in detail.

2. Click Details. The details appear on the Details window.

Note: You cannot modify a stock order using the Stock Order inquiry 
window.
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Figure 7–43 Details Window

3. Click Exit to close the Details window.

View Containers
1. On the Stock Order Inquiry window, select the stock order that you want to view 

in detail.

2. Click Container Inquiry. The details appear on the Stock Allocation Container ID 
Inquiry window.

Figure 7–44 Stock Allocation Container ID Inquiry Window

3. Click Exit to close the Stock Order CID Inquiry Screen window.
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Exit the Stock Order Inquiry Window
Click Exit to close the window.

Stock Order Status Inquiry
The Stock Order Status Inquiry allows you to view the progress of a stock order. It is 
possible for portions of a stock order to be at various stages of processing. You can 
view the percentage processed at each stage of the processing cycle.

To view stock order statuses, navigate to Distribution Planning -> Stock Order Status 
Inquiry. The Stock Order Status Inquiry window opens.

Figure 7–45 Stock Order Status Inquiry Window

Display the Progress of a Stock Order
1. If a stock order is currently displayed, click Clear.

2. Click Query.

3. In the Cust Order Nbr field, enter the customer order number, or click the LOV 
button and select the customer order number.

4. In the Distro Nbr field, enter the distro number, or click the LOV button and select 
the distro number.

5. Click Search. The progress of the selected stock order opens.

Exit the Stock Order Status Inquiry Window
Click Exit to close the window.

Wave Editor
The Wave Editor allows you to create new waves, define the wave type, and select a 
distribution method. For existing waves, you can view their current status and delete 
them if not used.

To maintain waves, navigate to Distribution Planning -> Wave Editor. The current 
waves appear in the Wave Editor window.
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Figure 7–46 Wave Editor Window

Edit a Wave

1. On the Wave Editor window, double-click the wave that you want to edit. The 
Modify window opens.

Figure 7–47 Modify Window

2. Edit the enabled fields as necessary.

3. Click Save to save any changes and close the Modify window.

Add a Wave
1. On the Wave Editor window, click Create Record. The Create Record window 

opens.

Note: Only waves with a status of Available may be edited.
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Figure 7–48 Create Record Window

2. In the Wave field, enter a unique wave number.

3. In the Description field, enter a description for the wave.

4. In the Distribution Method field, select the appropriate method.

5. In the Wave Type field, select the type of wave.

6. In the Cart Group Size field, enter the number of containers to group in a wave.

7. Click Save to save the changes and close the Create Record window.

Delete a Wave

1. On the Wave Editor window, select the wave that you want to delete.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Wave Editor Window
Click Exit to close the window.

Wave Planning
The Wave Planning window allows you to plan daily picking activities based on 
waves. Waves can consist of one or many destinations that are logically grouped 
according to some criteria such as geographic location. RWMS coordinates the daily 
picking activities based on these individual waves.

To maintain wave plans, navigate to Distribution Planning -> Wave Planning. The 
Wave Planning window opens.

Note: A group refers to the maximum number of customer orders 
that can be picked as a group at one time on the wave. The Cart Group 
Size field controls the group size for only those orders which will be 
fulfilled using the Cart Unit Picking method.

Note: Only waves with a status of Available may be deleted.
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Figure 7–49 Wave Planning Window

Display a Wave Plan
1. If a wave is currently displayed, click Clear.

2. Click Query.

3. In the Wave field, enter the wave number, or click the LOV button and select the 
wave.

4. Click Search. The destinations for the selected wave are displayed.

Add a Destination to a Wave
1. On the Wave Planning window, click Create Record. The Create Record window 

opens.

Figure 7–50 Create Record Window

2. In the Dest field, enter the ID of the destination, or click the LOV button and select 
the destination.

3. Click Save to save the changes and close the Create Record window.

Exit the Wave Planning Window
Click Exit  to close the window.

Wave Status
The Wave Status window allows you to monitor the progress of each pick wave.
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The Wave Status window allows you to view the statuses of all waves. Depending on 
the type of wave, planned and picked quantities appear by bulk, case, and unit, the 
picked and loaded quantities are provided for each wave.

You can access the following windows in order to view additional details:

■ Remaining Pick Detail: Displays remaining pick and replenishment pick quantities 
by bulk, case, unit, and prime unit.

■ Wave Status by Destination: Displays the planned and picked quantities by bulk, 
case, unit, and prime unit for a selected destination. The picked and loaded 
quantities are also provided.

You can choose to close a wave whose status is Open, Picked, or Loaded. The 
following results occur depending on the status of the wave:

■ Open: The pick is not completed and all remaining picks are purged.

■ Picked: The pick is finished and the picked merchandise is available for loading 
into a trailer.

■ Loaded: The pick is finished and the picked merchandise is loaded in a trailer.

To check the wave status, navigate to Distribution Planning > Wave Status. The current 
waves appear in the Wave Status window.

Figure 7–51 Wave Status Window

View Remaining Picks for a Wave
1. On the Wave Status window, select the wave that you want to view in detail.

2. Click Details. The remaining picks appear for the selected wave appear in the 
Details window.
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Figure 7–52 Details Window

3. Click Exit to close the Details window.

View Wave Details by Destination
1. On the Wave Status window, select the wave that you want to view in detail.

2. Click Dest Detail. The details by destination for the selected wave appear in the 
Wave Status by Destination window.
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Figure 7–53 Wave Status by Destination Window

3. Click Exit to close the Wave Status by Destination window.

Close a Wave
1. On the Wave Status window, select the wave that you want to close.

2. Click Close Wave.

3. When prompted to confirm the closure, click Yes. The status of the wave changes 
to Available.

Exit the Wave Status Window
Click Exit to close the window.

Note: You can close a wave in the following statuses:

■ Planned

■ Printed

■ Open

■ Picked

■ Loaded
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Wave Status by Destination
The Wave Status by Destination window allows you to view how much of a wave has 
been picked and loaded by destination.

To view statuses by destination, navigate to Distribution Planning -> Wave Status by 
Destination. The Wave Status by Destination window opens.

Figure 7–54 Wave Status by Destination Window

Display Destination Details by Wave
1. If a wave is currently displayed, click Clear.

2. Click Query.

3. In the Wave Nbr field, enter a wave number, or click the LOV button and select the 
wave.

4. Click Search. The destination details for the selected wave appear.

Note: You can also access this window from the Wave Status 
window.
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View Container Details for a Destination
1. On the Wave Status by Destination window, select the destination that you want to 

view in detail.

2. Click Details. The container details appear in the Wave Status by Destination 
Detail window.

Figure 7–55 Details Window

3. ClickExit to close the Wave Status by Destination Detail window.

Exit the Wave Status by Destination Window
Click Exit to close the window. 

Wave Summary
The Wave Summary window allows you to view the remaining picks for a given wave 
by zone. This information helps you to schedule labor resources more effectively.

To view remaining picks by wave, navigate to Distribution Planning -> Wave 
Summary. The Wave Summary window opens.
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Figure 7–56 Wave Summary Window

Display the Remaining Picks
1. If a wave is currently displayed, click Clear.

2. Click Query.

3. In the Wave field, enter the name of the wave number, or click the LOV button and 
select the wave number.

4. Click Search. The remaining picks for the selected wave are displayed by zone.

Exit the Wave Summary Window
Click Exit to close the window.
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8
Inventory Management

The Inventory Management module provides you with detailed views and reports of 
the current inventory situation. Inventory can be maintained by container and 
locations can be marked for cycle counts.

Business Process
Inventory can be looked at in a variety of ways. You can view inventory by:

■ Item: Look up where an item is stored. You can mark locations for cycle count.

■ Location: Look up which items are stored in a location. You can mark the location 
for cycle count.

■ Purchase order: Look up items that are associated with a purchase order and their 
current locations. You can mark locations for cycle count.

■ Vendor: Look up containers that are associated with a vendor and the current 
locations of the containers.

■ Container: Look up items by container and the current location of the container. 
You can view the child containers of a parent container or the parent container of a 
child container.

■ Summaries: Look up container and unit totals by a variety of search criteria, then 
select how you want to view the details.

Containers and the items within them can be maintained. You can add and delete 
containers in inventory, add and delete the items within a container, or split an item 
between containers.

Items may be transferred from one item ID to another. Inventory is adjusted 
automatically to account for the loss of inventory under the previous item ID and the 
gain in inventory under the new item ID.

As new items are received from the host system, you can apply the appropriate item 
class to each new item. The items inherit the defaults, processes, and equipment 
classes of the item class to which they are assigned.

Paper picks can be confirmed or the pick directives may be purged from RWMS. This 
pertains to unit pick, pick to belt, and pick to pallet activities.

You can look up the locations that are marked for cycle counts. The locations may have 
been manually marked (MM) or system selected (SS). Units of measure and their 
conversion factors can also be viewed.

This chapter contains the following topics:

■ Confirm Paper Pick to Belt
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■ Confirm Paper Pick to Pallet

■ Confirm Paper Unit Picks

■ Container History

■ Inventory Inquiry Summary

■ Inventory Inquiry by Item

■ Inventory Inquiry by Location

■ Inventory Inquiry by Order (Purchase Order)

■ Inventory Inquiry by Vendor

■ Inventory Inquiry/Edit by Container

■ Maintain Inventory by Container

■ Item ID Transfer

■ Mark for SS Cycle Count Editor

■ New Item Inquiry

■ Pending Cycle Count Inquiry

■ Transport Inventory Inquiry by Item

Confirm Paper Pick to Belt
The Confirm Paper Pick to Belt Editor allows you to view, confirm, or purge paper 
picks to belt. The editor shows these picks at the wave and zone level.

To confirm paper pick to belt, navigate to Inventory Management > Confirm Paper 
Pick to Belt. The Confirm Paper Pick to Belt window opens.

Figure 8–1 Confirm Paper Pick to Belt Window

Display all Container Pick Directives
Click Search.

Display a Subset of Container Pick Directives
1. If any container pick directives are currently displayed, click Clear.

2. Click Query.

3. In the Wave Nbr field, enter the wave number, or click the LOV button and select 
the wave.



Confirm Paper Pick to Pallet

Inventory Management 8-3

4. In the Zone field, enter the ID of the zone, or click the LOV button and select the 
zone.

5. In the Container field, enter the ID of the container, or click the LOV button and 
select the container.

6. Click Search. The container pick directives that match the search criteria appear.

Confirm Container Pick Directives
1. On the Confirm Paper Pick to Belt window, select the Confirm check box next to 

each container pick directive that you want to confirm.

2. Click Confirm Record. The selected container pick directives are confirmed. 

3. Click Save to save the changes.

Purge Container Pick Directives
1. On the Confirm Paper Pick to Belt window, select the Confirm check box next to 

each container pick directive that you want to purge.

2. Click Purge Pick Dir. The selected container pick directives are purged. 
Confirming of the pick directives implies processing of the paper picks.

3. When prompted to confirm the purge, click Yes.

Exit the Confirm Paper Pick to Belt Window
Click Exit to close the window.

Confirm Paper Pick to Pallet
The Confirm Paper Pick to Pallet Editor allows you to view, confirm, or purge paper 
pallet pick directives by wave and zone.

To confirm paper pick to pallet, navigate to Inventory Management > Confirm Paper 
Pick to Pallet. The Confirm Paper Pick to Pallet window opens.

Note: To confirm all the container pick directives that are currently 
displayed, click Confirm All.

Note: To purge all the container pick directives that are currently 
displayed, click Purge All.



Confirm Paper Pick to Pallet

8-4 Oracle® Retail Warehouse Management System UI User Guide

Figure 8–2 Confirm Paper Pick to Pallet Window

Display all Pallet Pick Directives
Click Search.

Display a Subset of Pallet Pick Directives
1. If any pallet pick directives are currently displayed, click Clear.

2. Click Search.

3. In the Wave Nbr field, enter the wave number, or click the LOV button and select 
the wave.

4. In the Zone field, enter the ID of the zone, or click the LOV button and select the 
zone.

5. In the Pallet ID field, enter the ID of the pallet, or click the LOV button and select 
the pallet.

6. Click Search. The pallet pick directives that match the search criteria appear.

Confirm Pallet Pick Directives
1. On the Confirm Paper Pick to Pallet window, select the pallet pick directive that 

you want to confirm.

2. Click Confirm Record. The pick quantity is updated to equal the requested 
quantity.

3. Click Save to save the changes.

Purge Pallet Pick Directives
1. On the Confirm Paper Pick to Pallet window, select the pallet pick directive that 

you want to purge.

2. Click Purge Pick Dir. The selected pallet pick directive is purged.

Note: To confirm all the pallet pick directives that are currently 
displayed, click Confirm All.

Note: To purge all the pallet pick directives that are currently 
displayed, click Purge All.
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3. When prompted to confirm the purge, click Yes.

Exit the Confirm Paper Pick to Pallet Window
Click Exit to close the window.

Confirm Paper Unit Picks
The Confirm Paper Unit Pick Editor allows you to view unit, confirm, or purge paper 
unit pick directives by wave and group. You can also generate the Paper Pick 
Directives report.

To confirm paper unit picks, navigate to Inventory Management > Confirm Paper Unit 
Pick. The Confirm Paper Pick window opens.

Figure 8–3 Confirm Paper Pick Window

Display Unit Pick Directives
1. If any unit pick directives are currently displayed, click Clear.

2. Click Query.

3. In the Wave Nbr field, enter the wave number, or click the LOV button and select 
the wave.

4. In the Group ID field, enter the group ID, or click the LOV button and select the 
group.

5. Click Search. The unit pick directives that match the search criteria appear.

Confirm Unit Pick Directives
1. On the Confirm Paper Pick window, select the unit pick directive that you want to 

confirm.

2. Click Confirm Record. The pick quantity is updated to equal the requested 
quantity.

3. Click Save to save the changes.

Note: To confirm all unit pick directives that are currently displayed, 
click Confirm All.
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Purge Unit Pick Directives
1. On the Confirm Paper Pick window, select the unit pick directive that you want to 

purge.

2. Click Purge Pick Dir.

3. When prompted to confirm the purge, click Yes.

Exit the Confirm Paper Pick Window
Click Exit to close the window.

Container History
The Container History Editor allows you to monitor the status history of containers as 
they move through the distribution center. Each time an activity is recorded in RWMS, 
a historical record is added to the container history table. Records are purged from the 
table by a regularly scheduled batch program; however, you can manually request that 
records older than a specified date be purged.

To view container history, navigate to Inventory Management > Container History. 
The Container History window opens.

Figure 8–4 Container History Window

Display all Historical Records

Click Search.

Display a Subset of Historical Records
1. If any records are currently displayed, click Clear.

2. Click Query.

3. Enter criteria in one or more of the fields. 

4. Click Search. The historical records that match the criteria appear.

Purge Historical Records
1. On the Container History window, click Purge. The Purge window opens.

Note: Due to the large volume of records that might be retrieved, it is 
recommended that you enter criteria in order to restrict the results.
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Figure 8–5 Purge Window

2. In the Purge Date field, enter an action date. All records with an action date equal 
to or less than the selected action date are included in the purge request.

3. Click Save to enter the purge request and close the Purge Data window.

Exit the Container History Window
Click Exit  to close the window.

Inventory Inquiry Summary
The Inventory Inquiry Summary window allows you to view a summary of inventory 
by a variety of criteria. The summary includes the number of containers and units that 
match the query criteria, the total number of containers and units in the distribution 
center, and what percentage of the totals that the selected containers and items make 
up.

You can access the Inventory Inquiry Summary Detail window in order to view a 
breakdown of the totals by selected criteria. You would select the check box next to 
each category to be included in the details.

To view inventory summaries, navigate to Inventory Management > Inventory Inquiry 
Summary. The Inventory Inquiry Summary window opens.

Figure 8–6 Inventory Inquiry Summary Window

Query the Inventory
1. Click Query.

2. Enter criteria in the one or more of the fields, or click the desired LOV buttons and 
select the criteria.
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3. Click Search. The inventory totals and percentages are calculated by container and 
unit for the selected criteria.

View Inventory Details
1. On the Inventory Inquiry Summary window, click Detail Record. The Detail 

Record window opens.

Figure 8–7 Detail Record Window

2. Select the check box next to each category that you want to view in detail.

3. Click Search. The details appear for the selected categories.

Exit the Inventory Inquiry Summary Windows
Click Exit to close the windows.

Inventory Inquiry by Item
The Inventory Inquiry by Item window allows you to view the inventory for an item 
at the container and location level. You can view container details such as destination, 
receipt date, putaway date, and dimensions by clicking the Detail Link.

You can mark one or all of the storage locations containing the item for cycle count.

From this window, you can access the Inventory Inquiry by Location window in order 
to view inventory details for a selected location.

To view inventory by item, navigate to Inventory Management > Inventory Inquiry by 
Item. The Inventory Inquiry by Item window opens.
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Figure 8–8 Inventory Inquiry by Item Window

Display Inventory by Item
1. If inventory for an item is currently displayed, click Clear.

2. Click Query.

3. In either the Item ID or Vendor Style field, enter the ID of the item or style, or click 
the LOV button and select the item or style.

4. Click Search. The inventory for the selected item or style opens.

Mark a Location for Cycle Count

1. On the Inventory Inquiry by Item window, select the storage location that you 
want to mark for cycle count.

2. Click Mark Record. An 'MM' opens in the Cycle Count field. The 'MM' indicates 
that the location was manually marked for cycle count.

Note: The option to mark a location for cycle count is not available to 
all users. If the privilege value of the user is less than the value set by 
the system control parameter mm_sec_level_gu, the following error 
message displays: Insufficient privileges to perform the operation.
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Mark All Locations for Cycle Count

On the Inventory Inquiry by Item window, click Mark Grp Rec. An 'MM' opens in the 
Cycle Count field for each storage location where the item exists. The 'MM' indicates 
that the location was manually marked for cycle count.

Exit the Inventory Inquiry by Item Window
Click Exit to close the window.

Inventory Inquiry by Location
The Inventory Inquiry by Location window allows you to view the inventory in a 
location at the item and container level. You can view container details such as 
destination, receipt date, putaway date, and dimensions by clicking the Detail link.

The location may be marked for cycle count if it is a storage location. You can view 
inventory at the next or previous location (in alphabetical or numerical order) by 
clicking Next Record or Previous Record.

To view inventory by location, navigate to Inventory Management > Inventory Inquiry 
by Location. The Inventory Inquiry by Location window opens.

Figure 8–9 Inventory Inquiry by Location Window

Note: Mark all locations means marking all locations where the item 
exists.
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Display Inventory by Location
1. If inventory for a location is currently displayed, click Clear.

2. Click Query.

3. In the Location ID field, enter the ID of a location, or click the LOV button and 
select the location.

4. Click Search. The inventory for the selected location displays.

View Inventory at Other Locations
■ To view inventory at the next location (in alphabetical or numerical order), click 

Next Record.

■ To view inventory at the previous location (in alphabetical or numerical order), 
click Previous Record.

Mark the Location for Cycle Count

On the Inventory Inquiry by Location window, click Mark Record. An 'MM' opens in 
the Cycle Count field. The 'MM' indicates that the location was manually marked for 
cycle count.

Exit the Inventory Inquiry by Location Window
Click Exit to close the window.

Inventory Inquiry by Order (Purchase Order)
The Inventory Inquiry by Order window allows you to view the inventory by 
purchase order at the item and location level. You can view container details such as 
destination, receipt date, putaway date, and dimensions by clicking the Detail Link.

You can mark one or all of the storage locations containing the PO/items for cycle 
count.

From this window, you can access the Inventory Inquiry by Location window in order 
to view inventory details for a selected location.

To view inventory by purchase order, navigate to Inventory Management > Inventory 
Inquiry by Order. The Inventory Inquiry by Order window opens.

Note: You can also access this window from the Inventory Inquiry 
by Item and Inventory Inquiry by Order windows.

Note: The Location ID field is mandatory and Item ID field is 
optional.

Note: The option to mark a location for cycle count is not available to 
all users. If the privilege level of the user is less than the value of the 
system control parameter mm_sec_level_gu, the following error 
message displays: Insufficient privileges to perform the operation.
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Figure 8–10 Inventory Inquiry by Order Window

Display Inventory by Purchase Order
1. If inventory for a purchase order is currently displayed, click Clear.

2. Click Query.

3. In the Order field, enter the purchase order number, or click the LOV button and 
select the purchase order.

4. Click Search. The inventory for the selected purchase order opens.

Mark a Location for Cycle Count

1. On the Inventory Inquiry by Order window, select the storage location that you 
want to mark for cycle count.

2. Click Mark Record. An 'MM' opens in the Cycle Count field. The 'MM' indicates 
that the location was manually marked for cycle count.

Mark all Locations for Cycle Count
On the Inventory Inquiry by Order window, click Mark Grp Rec. An 'MM' opens in 
the Cycle Count field for each storage location. The 'MM' indicates that the location 
was manually marked for cycle count.

Exit the Inventory Inquiry by Order Window
ClickExit to close the window.

Inventory Inquiry by Vendor
The Inventory Inquiry by Vendor window allows you to view the inventory by Vendor 
number at the location and container level. You can view container details such as 
destination, receipt date, putaway date, and dimensions by clicking the Inquiry by 

Note: The option to mark a location for cycle count is not available to 
all users. If the privilege level of the user is less than the value of the 
system control parameter mm_sec_level_gu, the following error 
message displays: Insufficient privileges to perform the operation.
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Location Link. You can mark containers for return to vendor if the container status is 
Inventory (I), Distributed (D), or Troubled (T).

To view inventory by vendor or the status of a container, navigate to Inventory 
Management > Inventory Inquiry by Vendor. The Inventory Inquiry by Vendor 
window opens.

Figure 8–11 Inventory Inquiry by Vendor Window

Display Inventory by Vendor or Container Status
1. If inventory for a vendor is currently displayed, click Clear.

2. Click Query.

3. To search for inventory by vendor number, enter the vendor number in the Vendor 
Nbr field, or click the LOV button and select the vendor. To search for inventory 
by container status, enter the abbreviation for the container status in the Cont 
Status field. To search for inventory by vendor number and container status, enter 
criteria in both fields.

4. Click Search. The inventory for the selected item opens.

Mark a Location for Cycle Count

1. On the Inventory Inquiry by Vendor window, select the storage location that you 
want to mark for cycle count.

2. Click Mark Record. An 'MM' opens in the Cycle Count field. The 'MM' indicates 
that the location was manually marked for cycle count.

Mark All Locations for Cycle Count
On the Inventory Inquiry by Vendor window, click Mark Grp Rec. An MM opens in 
the Cycle Count field for each storage location. The MM indicates that the location was 
manually marked for cycle count.

Exit the Inventory Inquiry by Vendor Window
Click Exit to close the window.

Note: The option to mark a location for cycle count is not available to 
all users. If the privilege level of the user is less than the value of the 
system control parameter mm_sec_level_gu, the following error 
message displays: Insufficient privileges to perform the operation.
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Inventory Inquiry/Edit by Container
The Inventory Inquiry/Edit by Container window allows you to view and edit 
inventory at container level. You can view the child containers associated with a 
parent container and the parent container of a child container.

There are three blocks in this window:

■ Query block: Identify the container that you want to retrieve.

■ Container block: Displays container details. You can edit the type, dimensions, 
weight, best before date, master container ID, and location ID of a container. You 
can add or delete a container. You can view return details if applicable.

■ Item block: Displays item details. You add an item, adjust the unit quantity, or 
delete an item from the container. You can split an item between containers.

To view inventory by container, navigate to Inventory Management > Inventory 
Inquiry/Edit by Container. The Inventory Inquiry/Edit by Container window opens.

Figure 8–12 Inventory Inquiry / Edit by Container Window

Display Inventory by Container
1. If inventory for a container is currently displayed, click Clear.

2. Click Query.

3. In the Container ID field, enter the container ID, or click the LOV button and select 
the container.

4. Click Search. The inventory for the selected container displays.

Note: You can also access this window from the following windows: 
Inventory Inquiry by Item, Inventory Inquiry by Location, Inventory 
Inquiry by Order, Inventory Inquiry by Vendor, WIP Audit Outbound, 
and Stock Order Inquiry window.

Note: There are three blocks in this window. From top to bottom, 
they are referred to as the Query block, Container block, and Item 
block.
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Display Child Containers

1. On the Inventory Inquiry/Edit by Container window, click Children. The child 
containers appear on the Children window.

Figure 8–13 Children Window

2. Select the child container that you want to view in detail.

3. Click Details. The details of the selected child container appear in the Inventory 
Inquiry/Edit by Container window.

Display a Parent Container

On the Inventory Inquiry/Edit by Container window, click Parent. The details of the 
parent container appear in the Inventory Inquiry/Edit by Container window.

View Returns by Container/Item

1. On the Inventory Inquiry/Edit by Container window, click Next to move the 
cursor to the Container block.

2. Click Return Details. The returns appear in the Return Details window.

Note: If the Children check box is selected, then the current container 
has one or more child containers.

Note: If a container ID appears in the Master CID field, then the 
current container has a parent container.

Note: If the status of a container is Non-saleable (N), you can view 
the returns that may be associated with an item in the container.
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3. Click Exit to close the Return Details window.

Exit the Inventory Inquiry/Edit by Container Window
Click Exit to close the window.

Maintain Inventory by Container
To maintain inventory by container, navigate to Inventory Management > Inventory 
Inquiry/Edit by Container. The Inventory Inquiry/Edit by Container window opens.

Figure 8–14 Inventory Inquiry / Edit by Container Window

Display Inventory by Container
1. If inventory for a container is currently displayed, click Clear.

2. Click Query.

3. In the Container ID field, enter the container ID, or click the LOV button and select 
the container.

4. Click Search. The inventory for the selected container displays.

Edit a Container
1. On the Inventory Inquiry/Edit by Container window, click Next to move the 

cursor to the Container block.

2. Double-click any field in the Container block. The Modify window opens.

Note: You can also access this window from the following windows: 
Inventory Inquiry by Item, Inventory Inquiry by Location, Inventory 
Inquiry by Order, Inventory Inquiry by Vendor, WIP Audit Outbound, 
and Stock Order Inquiry window.

Note: There are three blocks in this window. From top to bottom, 
they are referred to as the Query block, Container block, and Item 
block.
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Figure 8–15 Modify Window

3. Edit the enabled fields as necessary.

4. Click Save to save any changes and close the Modify window.

Edit an Item in a Container
1. On the Inventory Inquiry/Edit by Container window, click Next to move the 

cursor to the Item block.

2. Double-click any field in the Item block. The Modify window opens.

Figure 8–16 Modify Window

3. Edit the container quantity and unit quantity as necessary.

4. Click Save to save the changes.

5. When prompted to select a reason for the adjustment, select the reason and click 
OK.

Split an Item between Containers
1. On the Inventory Inquiry/Edit by Container window, click Next to move the 

cursor to the Item block.

2. Select the item that you want to split.

3. Click Split. The Split window opens.
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Figure 8–17 Split Window

4. In the Container field, enter the ID of a new or existing container.

5. In the Unit Qty field, enter the number of items to be placed in the container.

6. Click Save to save the changes and clear the fields.

7. Add any additional splits as necessary.

8. When done, click Exit to close the Split window.

Add a Container
1. On the Inventory Inquiry/Edit by Container window, click Next to move the 

cursor to the Container block.

2. Click Create Record. The Create Record window opens.

Figure 8–18 Create Record Window

3. In the Master CID field, enter the ID of the master, or parent, container if 
applicable.

4. In the Type field, enter the type of container, or click the LOV button and select the 
type.

5. If there is no master container, enter the location ID for the container in the 
Location ID field.

6. Edit the default dimensions as necessary.

Note: The cursor may also be in the Query block.
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7. In the Container Weight field, enter the weight of the empty container.

8. If the container holds a perishable item, enter the best before date in the Best 
Before Date field.

9. Click Save to save the changes and close the Create Record window.

Add an Item to a Container
1. On the Inventory Inquiry/Edit by Container window, click Next to move the 

cursor to the Item block.

2. Click Create Record. The Create Record window opens.

3. In the Item ID field, enter the item ID of the item in the container.

4. In the Cntr Qty field, enter the number of child containers.

5. In the Unit Qty field, enter the number of units.

6. Click Save to save the changes.

7. When prompted to select a reason for the adjustment, select the reason and click 
OK.

Delete a Container
1. On the Inventory Inquiry/Edit by Container window, click Next to move the 

cursor to the Container block.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

4. When prompted to select a reason for the adjustment, select the reason and click 
OK.

Delete an Item from a Container
1. On the Inventory Inquiry/Edit by Container window, click Next to move the 

cursor to the Item block.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Inventory Inquiry/Edit by Container Window
Click Exit to close the window.

Item ID Transfer
The Item ID Transfer window allows you to change the item ID of an item. Inventory 
is automatically adjusted. The inventory under the previous item ID is reduced to 
zero. The inventory under the new number is increased by the number of units that 
were previously credited to the old item ID.

To transfer item IDs, navigate to Inventory Management > Item ID Transfer. The Item 
ID Transfer window opens.
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Figure 8–19 Item ID Transfer Window

Transfer an Item ID
1. In the Item ID field, enter the ID of the item whose ID must be changed.

2. Click Search. Additional information about the item opens.

3. In the New Item ID field, enter the new item ID to be assigned to the item.

4. Click Apply.

5. When prompted to confirm the item ID transfer, click Yes.

Exit the Item ID Transfer Window
Click Exit to close the window.

Mark for SS Cycle Count Editor
You can manage the Cycle Count process within the warehouse to more closely to 
match specific needs using the Mark for SS Cycle Count Editor. The Mark for SS Cycle 
Count Editor allows you to mark specific locations for Cycle Count in addition to 
system generated cycle counts and manually marked locations. These selected 
locations are then designated as System Selected (SS) and the User Selected parameter 
is set to Y.

This editor also shows locations that have been marked for Audit Count. An Audit 
count is generated when the difference between the system count and actual count 
falls outside of the following settings:

■ Item CC Tolerance Percentage - This item master setting determines whether an 
inventory adjustment is allowed immediately or an Audit Count must be 
performed. If the difference between the original system quantity and the cycle 
count quantity is within the tolerance percentage then inventory adjustment is 
allowed immediately and if the difference exceeds the tolerance percentage then 
the CC Min Tolerance Qty is selected.

■ Item CC Min Tolerance Qty - This item master setting determines whether an 
inventory adjustment is allowed immediately or an Audit Count must be 
performed. If the difference between the system count and cycle count exceeded 
the cycle count tolerance percent, then RWMS checks to see if the difference 
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between the system count and cycle count is equal to or less than the minimum 
tolerance unit quantity. If the difference is equal to or less than the minimum unit 
quantity then RWMS immediately posts an inventory adjustment. If the difference 
exceeds the minimum unit quantity then RWMS marks that location for an Audit 
Count and not make an inventory adjustment until the Audit Count is completed.

If the Item CC Tolerance Percentage and Item CC Min Tolerance QTY is not set in 
the item master, RWMS looks to see if the def_cc_tolerance_pct and def_cc_min_
tol_qty are set in the SCP table to determine when to assign an Audit Count. The 
item and global parameters also work in the same way but the item parameters 
when defined take priority over the global settings.

Navigate to Inventory Management > Mark for SS Cycle Count Editor. The Mark for 
SS Cycle Count Editor opens.

Figure 8–20 Mark for SS Cycle Count Window

Display All Locations
Click Search.

Display a Subset of Locations
1. If any locations are currently displayed, click Clear.

2. Click Query.

3. Enter the search criteria in any of the following fields:

■ Zone range: In the From and To fields, enter the zone IDs, or click the LOV 
buttons and select the zones. For proper query results, enter values in both 
From and To fields.

■ Location range: In the From and To fields, enter the location IDs, or click the 
LOV buttons and select the locations. For proper query results, enter values in 
both From and To fields.

■ CC Seq range: In the From and To fields, enter the CC sequence numbers, or 
click the LOV buttons and select the values. For proper query results, enter 
values in both From and To fields.
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■ Enter the following criteria in conjunction with the range criteria to refine your 
search: Item ID, Location ID, Item Class, Location Type, Location Class.

■ Check the Include Already Counted Locations field to include locations that 
are already counted in the current cycle.

4. Click Search. The details of the specified locations are displayed.

Sort Locations
Click the column heading once to sort rows in descending order. Click the column 
heading again to sort the rows in ascending order.

Mark Locations
1. Select the Select check box for the location to be marked for SS cycle count.

■ Click the Select All link to select all the records.

■ Click the Deselect All link to clear all of the selected records.

2. Click the Mark link to mark the location.

Unmark Locations
1. Select the Select check box for the location to be unmarked for SS cycle count:

■ Click the Select All link to select all the records.

■ Click the Deselect All link to clear all of the selected records.

2. Click the Unmark link to clear the location.

New Item Inquiry
The New Item Inquiry allows you to view any new items that were received from the 
host system. When an item is received, an item class is automatically applied to the 
item if the item's attributes and characteristics match the build rules of an existing item 
class. If it matches more than one item class, then you must apply the appropriate item 
class to the item. If the item does not match any item class, the Default item class is 
applied to the item until you choose a more appropriate item class. The item inherits 
the characteristics, attributes, processes, and equipment classes of the item class.

You can access:

■ The Item Class Editor window in order to view the details of any item classes or

■ The Apply Item Class window in order to apply an item class to the item

Note: If you enter values in more than one search criteria, then only 
the locations that match all the criteria are listed on the window.

Note: You cannot select locations that are manually marked and 
those marked as SS by schedule cycle count batch.

Note: The Total Nbr of Location Marked field gets incremented 
when a location is marked to display the total number of locations 
marked for SS cycle count.
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To view new items, navigate to Inventory Management > New Item Inquiry. The New 
Item Inquiry window opens.

Figure 8–21 New Item Inquiry Window

Display All New Items
Click Search.

Display a Subset of New Items
1. If any new items are currently displayed, click Clear.

2. Click Query.

3. To display new items by item class, enter the ID of the item class in the Item Class 
field, or click the LOV button and select the item class. To display new items by 
creation date, enter the range of dates in the From Date and To Date fields, or click 
the Calendar icon and select the dates.

4. Click Search. The new items that match the search criteria appear.

Exit the New Item Query Window
Click Exit to close the window.

Pending Cycle Count Inquiry
The Pending Cycle Count Inquiry allows you to view which locations are marked for 
cycle counts. Locations may have been manually marked (MM) or system selected (SS) 
for cycle counts.

Summary information is also provided, such as the number of cycle counts performed 
and the number pending. Of the remaining cycle counts, the number of cycle counts 
that were manually marked and system marked is provided. The percentage of 
completed cycle counts is calculated for you.

To view pending cycle counts, navigate to Inventory Management > Pending Cycle 
Counts Inquiry. The pending cycle counts and summary details appear in the Pending 
Cycle Counts Inquiry window.

Note: To search for new items on a specific date, enter the same date 
in both date fields.
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Figure 8–22 Pending Cycle Count Inquiry Window

Exit the Pending Cycle Count Inquiry Window
Click Exit to close the window.

Transport Inventory Inquiry by Item
This window allows you to view the current transport asset inventory by item. This 
editor allows you to add or delete inventory of an existing transport item asset.

To transport inventory by item, navigate to Inventory Management > Transport 
Inventory Inquiry Item. The Transport Inventory Inquiry by Item window opens.

Figure 8–23 Transport Inventory Inquiry by Item Window

View an Item
1. If an item is currently displayed, click Clear.

2. Click Query.

3. To search for an item by:

Note: Asset item must be set up on the Transport Asset Editor prior 
to creating inventory.
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■ Transport Item ID: In the Transport Item ID field, enter the ID of the item, or 
button and select the item.

■ Transport: In the Transport field, enter the Transport's ID, or click the LOV 
button and select the item.

■ Vendor Name: In the Vendor Name field, enter the name of the vendor, or 
click the LOV button and select the item.

■ Asset Type: In the Asset Type field, enter the type in the field, or click the LOV 
button and select the item.

4. Click Search. The details for the selected item appear.

Create an Item

To create a transport asset item:

1. Click Create Record. The Create Record window opens.

Figure 8–24 Create Window

2. Enter the Transportation Item ID.

3. Enter the Description.

4. Enter the Quantity.

5. Click Save.

6. Click Exit. The Transport Inventory Inquiry by Item window reopens.

Modify an Item
To modify a transport asset item:

Note: Asset item must be set up on the Transport Asset Editor prior 
to creating inventory.

Note: This is populated once the transport item ID is entered.
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1. Search for an item and double-click it to open the Modify window. The Modify 
window opens.

Figure 8–25 Modify Window

2. Enter the Cycle Count number.

3. The Adjustment Qty is calculated based on the difference of the field Quantity and 
the Cycle Count.

4. Click Approve. The List of Inv. Adj. Reason Codes window opens.

5. Select a reason.

6. Click OK. The Transport Inventory Inquiry by Item window reopens.

Delete an Item
To delete a transport asset item:

1. Select a transport asset item.

2. Click Delete Record.

Exit the Transport Inventory Inquiry by Item Window
Click Exit to close the window.

Note:  If value is entered in the Cycle Count field, saved and is later 
disapproved, the Cycle Count field is cleared and the Adjustment Qty 
is set back to 0. There is no adjustment made. 

Note: You can also click Save without clicking Approve. In this case, 
the Adjustment Qty field is updated on the window and there will be 
no Inv Adjustment Reason Code window opened thus no adjustment 
is made. The Cycle Count field reflects the quantity that was entered 
and the window closes. Once the approve is done, then the 
adjustment is made and the Adjustment Qty will go back to 0.
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9
Processing

Work in Process (WIP) codes may be assigned to containers in order to direct 
personnel in the distribution center to perform value added services to the contents of 
the container. RWMS understands from the WIP code where the container must be 
staged in order for a certain activity to be performed on the container.

In the processing module, you can accomplish the following tasks:

■ Assign WIP codes to containers.

■ Process WIP code activities.

■ Verify that the WIP codes were processed.

Business Process
WIP codes may be assigned to individual containers. As an alternative, you can apply 
a WIP code to all containers that are associated with an appointment, ASN, purchase 
order, item, location, distro, wave, or destination. It is necessary to assign the WIP 
codes in sequential order; that is, in the order that the work must be performed.

Merchandise is routed to the staging location for each WIP on a container's WIP list in 
sequential order. When the activity required by a WIP code is performed, the DC 
personnel must indicate when the activity was started and when it was finished. These 
time stamps allow RWMS to track the status of each WIP code.

The implied status of a WIP code may be:

■ Next: An activity has not been started, but the previous WIP code in the WIP list is 
Closed.

■ Open: An activity has not yet been started.

■ In progress: A start time has been entered for the activity, but not an end time.

■ Closed: An end time has been entered for the activity.

Before merchandise is placed in inventory or shipped, a quality check can be 
performed. During the quality check, you can assign trouble codes as necessary, adjust 
quantities, or record dimensions and attributes for containers and items.

This chapter contains the following topics:

■ Apply WIP Code

■ Assort Break

■ Consolidation Location Inquiry

■ Container WIP Details

■ Container WIP Editor
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■ Gift Card

■ Order Consolidation

■ Packing

■ QC Outbound Audit

■ Quality Assurance

■ Reprint / Null Labels

■ Resolve Trouble

■ Ticketing

■ WIP Inquiry

Apply WIP Code
The Apply WIP Code Editor allows you to apply WIP codes and Trouble Codes to 
containers using multiple selection criteria. These codes may be applied as part of the 
receipt planning process, inventory management process, or stock distribution 
process. You can enter criteria in one or more fields in order to include all containers 
that are associated with the an appointment, ASN, purchase order, item, location, 
distro, wave, or destination; or you can choose to enter a specific container ID.

After entering the selection criteria, you can enter either the WIP code or the Trouble 
Code to be assigned to or deleted from the selected containers. If you enter a Trouble 
Code, the appropriate WIP code is automatically entered.

To apply WIP codes, navigate to Processing > Apply WIP Code. The Apply WIP Code 
window opens.

Figure 9–1 Apply WIP Code Window

Add a WIP Code to Multiple Containers
WIP codes cannot be assigned to containers in Appointed (A), Manifested (M), or 
Shipped (S) status.

1. On the Apply WIP Code window, enter the criteria for the set of containers that 
you want to edit.

2. In the WIP Code field, enter the WIP code, or click the LOV button and select the 
WIP code.

3. Click Create Record. The Create Record window opens. 
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Figure 9–2 Create Record Window

4. [Optional] In the Manual Release Dt field, enter the date, or click the Calendar icon 
and select a date.

5. Click Save.

6. When prompted to continue, click Yes.

Delete a WIP Code from Multiple Containers
1. On the Apply WIP Code window, enter the criteria for the set of containers that 

you want to edit.

2. In the WIP Code field, enter the WIP code, or click the LOV button.

3. Click Delete Record.

4. When prompted to continue, click Yes.

Add a Trouble Code to Multiple Containers
Trouble codes may be added to containers with a status of Appointed (A), Inventory 
(I), Distributed (D), or Troubled (T).

1. On the Apply WIP Code window, enter the criteria for the set of containers that 
you want to edit.

2. In the Trouble Code field, enter the trouble code, or click the LOV button.

3. Click Create Record.

4. When prompted to continue, click Yes.

Delete a Trouble Code from Multiple Containers
1. On the Apply WIP Code window, enter the criteria for the set of containers that 

you want to edit.
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2. In the Trouble Code field, enter the trouble code, or click the LOV button and 
select the trouble code.

3. Click Delete Record.

4. When prompted to continue, click Yes.

Assort Break
The Assort Break is used to view and break the component items related to a master 
item. It also provides the ability to process any WIP Codes associated to the master or 
child item IDs.

■ Assortment: The parent item is known, but the child items must be identified and 
split into their own containers prior to putaway. Adjustments are made to 
inventory in order to account for the child items.

■ Break pack: The child items are known, but they must be split into their own 
containers prior to putaway.

To view the Assort Break Editor, navigate to Processing > Assort Break Editor. The 
Assort Break Editor window opens.

Figure 9–3 Assort Break Editor Window

Display the Component Item IDs for a Container
1. Click Query.

2. In the Container ID field, enter a container ID, or click the LOV button and select 
the container.

3. Click Search. The Component Item IDs for the specified container displays.

Consolidation Location Inquiry
The Consolidation Location Inquiry is a view-only window which displays 
information about the locations defined as the Consolidation type locations within the 
warehouse facility. 

To view the Consolidation Location Inquiry, navigate to Processing -> Consolidation 
Location Inquiry. The Consolidation Location Inquiry window opens.

Note: Deleting a trouble codes does not cause its associated WIP 
code to be deleted.
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Figure 9–4 Consolidation Location Inquiry Window

There are several query criteria to filter the information desired. Using this window, 
you can review information such as all the consolidation type locations present within 
the warehouse, associated consumer direct stock order in a location, and whether the 
contents in the location are ready to be consolidated or not. 

Display All Consolidation Type Locations
On the Consolidation Location Inquiry window, click Search to view all consolidation 
type locations.

Display a Subset of Consolidation Type Locations

1. If any consolidation type locations are currently displayed, click Clear .

2. Click Query. An LOV button displays next to Location ID and Distro Nbr fields.

3. Enter any desired criteria or a combination of criterion to filter the results.

■ Location ID: You can either manually enter (or partially enter) or click the LOV 
button and select the desired consolidation locations for their information to 
be displayed.

■ Distro_nbr: You can query by entered distro number (partial entry allowed).

■ Exclude Empty locations: If this field is selected, only consolidation locations 
associated with a distro, at the moment, are displayed.

■ Display Ready to Consolidate Only: If this field is selected, only those 
consolidation locations are displayed which have all the containers against the 
associated distro.

4. Click Search. The consolidation type locations that match the selection criteria are 
displayed. 

The following details are displayed:

■ Location ID - The consolidation location ID.

■ Distro_nbr - The distro associated to the consolidation location. In case of an 
empty consolidation location, this is left blank.

Note: It is possible to query for a distro which is not yet associated to 
any consolidation location. In such a case, an error message displays. 
However, the details link is enabled, so the user can view all the 
containers associated with it, which are outside the consolidation 
location currently.
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■ First Dropoff - Date of placing the first carton in the consolidation location. In 
case the location is empty, the field is blank.

■ Days open - The number of days the consolidation location has been 
associated with the current distro. In case the location is empty, the field is 
blank.

■ Cartons in location - All the cartons on a distro present in the consolidation 
location. This excludes any cartons present outside the location.

■ Remaining cases - The number of containers on the same distro which are not 
present in the consolidation location or consolidation processing area (where 
the containers are sent from the consolidation locations), but are 
consolidation-eligible. Any P status containers are also included in the 
calculation. In case of no outstanding containers, the field is set to 0. 

In the case of pallets with cases (labeled or unlabeled), the total number of 
outstanding cases is either the sum of the total number of child cases present 
on the pallet. For Unit picked totes, the count is always calculated as 1.

■ Ready to Consolidate flag - If all the consolidation-eligible containers on the 
distro are present in the consolidation location, this flag is set to Y on the 
window.

View Details of the Consolidation Type Location
1. On the Consolidation Location Inquiry window, select the consolidation type 

location that you want to view in detail.

2. Click Details. The Details window displays details of the containers present in the 
consolidation location, as well as the containers on that distro which are not yet 
present in the consolidation location but might be eligible for consolidation.

Figure 9–5 Details Window

The Details window has two blocks. The upper block titled Containers in The 
Consolidation Location displays details of the containers present in the 
consolidation location - Container ID, Status, Dropoff Date (date when the 
container was placed in the consolidation location).
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The lower block displays details of containers on the distro which are not 
consolidation eligible - Container ID, Status, Location ID, Container Quantity. 

Containers displayed in the lower block may also include containers which are 
present in the consolidation processing area. Only master containers are displayed 
in the Container ID field, and the corresponding case quantity (labeled or 
unlabeled) displays in the Container Qty field.

Exit the Consolidation Location Inquiry Window
Click Exit to close the window.

Container WIP Details
The Container WIP Details window allows you to view details of the WIP codes that 
are assigned to a container. The details include special instructions and personalization 
information when applicable.

To view WIP details by container, navigate to Processing > Container WIP Details. The 
Container WIP Details window opens.

Figure 9–6 Container WIP Details Window

Display the WIP List for a Container
1. If the WIP list for a container is currently displayed, click Clear.

2. Click Query.

3. In the Container ID field, enter a container ID, or click the LOV button and select 
the container.

4. Click Search. The WIP list for the specified container displays.

Exit the WIP Detail Window
Click Exit to close the window.

Container WIP Editor
The Container WIP Editor allows you to view and apply WIP codes to a container. 

The status of each WIP code opens:

■ If the Start Date and Finish Date are entered, the WIP code is Closed.

Note: You can also access this window from the Container WIP 
Editor window.



Container WIP Editor

9-8 Oracle® Retail Warehouse Management System UI User Guide

■ If only the Start Date is entered, the WIP code is In Progress.

■ If neither the Start Date nor Finish Date are entered, but the previous WIP code is 
Closed, the WIP code is Next.

You can access the WIP Detail window in order to view additional details about a 
selected WIP code.

To maintain WIP lists by container, navigate to Processing -> Container WIP Editor. 
The Container WIP Editor window opens.

Figure 9–7 Container WIP Editor Window

Display the WIP List for a Container
1. If the WIP list for a container is currently displayed, click Clear.

2. Click Query.

3. In the Container ID field, enter a container ID, or click the LOV button and select 
the container.

4. Click Search. The WIP list for the specified container displays.

Add a WIP Code to the WIP List

1. On the Container WIP Editor window, click Create Record. The Create window 
opens.

Note: You can also access this window from the Stock Order Inquiry 
Screen window.

Note: If you do not want the new WIP code to be placed last in the 
list, select the WIP code that should precede the new one before you 
begin this procedure.
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Figure 9–8 Create Record Window

2. In the WIP Code field, enter the WIP code, or click the LOV button and select the 
WIP code.

3. [Optional] In the Manual Release Dt field, enter the date, or click the Calendar icon 
and select a date.

4. Click Save.

Delete a WIP Code from the WIP List
1. On the Container WIP Editor window, select the WIP code that you want to delete 

from the WIP list.

2. Click Delete Record.

3. When prompted to delete the record, click Yes.

Exit the Container WIP Editor Window
Click Exit to close the window.

Gift Card
The Gift Card window allows you to print the gift cards that are to be shipped with 
items ordered by customers.

You can provide personalized gift card for a specified item ordered by a customer.

To generate a gift card, navigate to Processing -> Gift Card. The Gift Card window 
opens.
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Figure 9–9  Gift Card Window

Display Items by Container
1. If items are currently displayed, click Clear.

2. Click Query.

3. In the Container ID field, enter the ID of the container.

4. Click Search. The items that need gift cards appear.

Generate the Gift Card Report
1. On the Gift Card Report window, select the item that you want to process.

2. Click Save. The report is sent to the default destination.

Order Consolidation
The Order Consolidation window allows you to combine different physical containers 
into one or more containers from the same distro (this is used specifically for consumer 
direct orders). The consolidation is optional but when used, may reduce the outbound 
freight expense.

To consolidate orders navigate to Processing -> Order Consolidation Editor. The Order 
Consolidation window opens.

Figure 9–10 Order Consolidation Window
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Display Order Consolidation Details

1. If Packing Slip Print Queue is enabled, click Query.

2. In the Packing Slip Print Queue field enter the print queue, or click the LOV 
button and select the print queue.

3. In the Container field, enter or scan the container ID.

4. Click Search. The details of the container are displayed on the Order 
Consolidation window.

Figure 9–11 Order Consolidation (Detail) Window

Consolidate Orders
1. On the Order Consolidation window, select the containers to be consolidated 

using the check box.

2. Click Consolidate. The Consolidate window opens.

Figure 9–12 Consolidate Window

3. On the Consolidate window, enter the container ID in the Container ID field. The 
containers being consolidated may be consolidated into a new container ID or 
consolidated into one of the check box selected container IDs.

4. Click Save. The consolidated container displays as a row in the Order 
Consolidation window. Use the Process link to process this container.

Note: The Packing Slip Print Queue field is enabled if the System 
Control Parameter (SCP) packing_slip_qty is set to a value greater 
than zero, and is disabled if packing_slip_qty is set to 0.
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Consolidate/Process Orders
1. On the Order Consolidation window, select the containers to be 

consolidated/processed using the check box.

2. Click Consolidate/Process. The Consolidate/Process window opens.

Figure 9–13 Consolidate/Process Window

3. On the Consolidate/Process window, enter the container ID in the Container ID 
field. The containers being consolidated/processed may be 
consolidated/processed into a new container ID or consolidated/processed into 
one of the check box selected container IDs.

4. Click Save. The container is consolidated/processed at the order consolidation 
station.

Process Orders

1. On the Order Consolidation window, select the container to be processed using the 
check box.

2. Click Process.

3. Click Yes when asked to confirm. The order is processed at the order consolidation 
station.

Exit the Order Consolidation Window
Click Exit to close the window.

Note: The following SCPs must be set for processing a container:

■ packing_slip_qty must be set to a value greater than 0 to print a 
packing slip.

■ mms_location and cd_consolidation_dropoff values must be set. If 
the container is eligible for consolidation, the container is moved 
to the location specified in cd_consolidation_dropoff parameter, 
else the container is moved to the location specified in mms_
location parameter.

Note: Only one container can be processed at a time.
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Packing
The Packing windows allow you to pack consumer direct orders. Based on the type of 
container scanned (pick type and/or pallet configuration), RWMS presents one of 
three different windows:

1. Unit Pick Packing window

2. Pallet With Case Labels Packing window

3. Pallet Without Case Labels Packing window

To pack containers navigate to Processing -> Packing. The Packing window opens.

Figure 9–14 Packing Window

Display Order Details

1. If Packing Slip Print Queue is enabled, click Query.

2. In the Packing Slip Print Queue field enter the print queue, or click the LOV 
button and select the print queue.

3. In the Container field, enter or scan the container ID. You can enter the ID of a 
container entered that is a pick to tote from unit picking or a pallet that contains 
cases that are either labeled or not labeled.

4. Click Search. 

When the container ID entered is that of a consumer direct container with a 
destination ID that is a virtual store, one of the three windows displays allowing 
the packing process to be executed. The window displayed is based upon the pick 
type and/or case label.

Note: The Packing Slip Print Queue field is enabled if the System 
Control Parameter (SCP) packing_slip_qty is set to a value greater 
than zero, and is disabled if packing_slip_qty is set to 0.
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Unit Pick Packing
If the container entered/scanned is a pick to tote from unit picking, the Unit Pick 
Packing window opens.

Figure 9–15 Unit Pick Packing Window

1. The scanned container (case/tote) displays in the Container ID field.

2. In the Ship Container ID field, enter a ship container ID. You can either enter a 
new container ID in this field or use the original container ID as is.

Note:

■ If a container has an unfinished Trouble or WIP Code assigned, 
RWMS returns the message ‘Unresolved Trouble/WIP(s) Exist. 
Proceeding further will process the Trouble/WIP(s). Proceed?’ If 
the question is answered as Y, the unresolved Trouble/WIP 
Code(s) is processed/finished. If the question is answered as N, 
the cursor returns to the Container field so a different container 
may be scanned or manually entered.

■ If a container has been through the consolidation process, a hard 
stop message: The container has already been consolidated displays. 
The container cannot be processed further.

■ If a container that has already been though the packing process 
and has not been consolidated is entered, a warning message, The 
container has gone through QC/packing process. Do you want to 
continue? displays. If the question is answered as Y, the 
appropriate Packing window displays and allows the container to 
be processed. If the question is answered as N, the cursor returns 
to the Container field so a different container may be scanned or 
manually entered.
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3. Once you enter the Ship Container ID, you can start processing. The grab quantity 
for the items in the container can be confirmed as follows:

■ If the item ID has at least one RWMS resident UPC code, scan the item ID or 
the UPC code in the Scan Item ID or UPC field.

■ If the item ID does not have an RWMS resident UPC, confirm the grab 
quantity through a manual entry of the item ID count.

Confirm Grab Quantity
1. On the Unit Pick Packing window, once you have manually entered the count in 

the Scanned Grabs field, click Confirm to confirm the quantity. 

Indicate Shipping Container is Full
1. On the Unit Pick Packing window, click Full. 

By clicking Full, RWMS provides the ability to complete packing of the current 
shipping container and open a new shipping container to process the remaining 
units.

Select All Items
1. On the Unit Pick Packing window, click Select All to select all the applicable check 

boxes. 

Process the Shipping Container

1. On the Unit Pick Packing window, click Process.

2. Click Yes when asked to confirm. The container is processed.

Note: If the original container ID is used as the Ship Container ID 
and processing has begun, you cannot exit the window until the 
container (case/tote) is processed.

Note: To confirm the item ID quantity through manual entry, the 
user attribute pack_scan_upc_not_reqd must be enabled for the user 
ID.

Note: The applicable check boxes may vary based on the item 
ID/UPC data and whether the user attribute pack_scan_upc_not_reqd 
is applied.

Note: The following SCPs must be set for processing a container:

■ packing_slip_qty must be set to a value greater than 0 to print a 
packing slip.

■ mms_location and cd_consolidation_dropoff values must be set. If 
the container is eligible for consolidation, the container is moved 
to the location specified in cd_consolidation_dropoff parameter, 
else the container is moved to the location specified in mms_
location parameter.



Packing

9-16 Oracle® Retail Warehouse Management System UI User Guide

Exit the Unit Pick Packing Window
Click Exit to close the window.

Packing Pallets with Case Labels
If the container scanned is a pallet with labeled cases, the Pallet With Case Labels 
Packing window opens.

Figure 9–16 Pallet With Case Labels Window

Consolidate Containers

1. On the Pallet With Case Labels Packing window, select the containers to be 
consolidated using the check box.

2. Click Consolidate. The Consolidate window opens.

Figure 9–17 Consolidate Window

3. On the Consolidate window, enter the container ID in the Container ID field. The 
containers being consolidated may be consolidated into a new container ID or 
consolidated into one of the check box selected container IDs.

4. Click Save. The consolidated container displays as a row in the Pallet With Case 
Labels Packing window. Use the Process link to process this container.

Note: You can consolidate containers having the same Distro Nbr 
using this window.
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Consolidate/Process Orders

1. On the Pallet With Case Labels Packing window, select the containers to be 
consolidated/processed using the check box.

2. Click Consolidate/Process. The Consolidate/Process window opens.

Figure 9–18 Consolidate/Process Window

3. On the Consolidate/Process window, enter the container ID in the Container ID 
field. The containers being consolidated/processed may be 
consolidated/processed into a new container ID or consolidated/processed into 
one of the check box selected container IDs.

4. Click Save. The container is consolidated/processed.

Process Orders

1. On the Pallet With Case Labels Packing window, select the container to be 
processed using the check box.

2. Click Process.

3. Click Yes when asked to confirm. The container is processed at the packing 
station.

Note: You can consolidate containers having the same Distro Nbr 
using this window.

Note: The following SCPs must be set for processing a container:

■ packing_slip_qty must be set to a value greater than 0 to print a 
packing slip.

■ mms_location value must be set. Once a container is consolidated 
using this window, the container is no longer eligible for further 
consolidation at the consolidation station.

Note: Only one container can be processed at a time.
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Exit the Pallet With Case labels Window
Click Exit to close the window.

Packing Pallets without Case Labels
If the container scanned is a pallet without labeled cases, the Pallet Without Case 
Labels Packing window opens.

Figure 9–19 Packing Pallets Without Case Labels Window

Create Case Labels

1. On the Pallet Without Case Labels Packing window, select the row for which a 
container ID must be assigned.

2. Click Create Case Labels. The Container ID field is enabled for that row.

3. Enter the container ID.

Consolidate Containers

1. On the Pallet Without Case Labels Packing window, select the containers to be 
consolidated using the check box.

2. Click Consolidate. The Consolidate window opens.

Note: Except for when processing at the pallet level, each case/row 
must be assigned a container ID before further processing

Note: You can consolidate containers having the same Distro Nbr 
using this window.
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Figure 9–20 Consolidate Window

3. On the Consolidate window, enter the container ID in the Container ID field. The 
containers being consolidated may be consolidated into a new container ID or 
consolidated into one of the check box selected container IDs.

4. Click Save. The consolidated container displays as a row in the Pallet Without 
Case Labels Packing window. Use the Process link to process this container.

Consolidate/Process Orders

1. On the Pallet Without Case Labels Packing window, select the containers to be 
consolidated/processed using the check box.

2. Click Consolidate/Process. The Consolidate/Process window opens.

Figure 9–21 Consolidate/Process Window

3. On the Consolidate/Process window, enter the container ID in the Container ID 
field. The containers being consolidated/processed may be 
consolidated/processed into a new container ID or consolidated/processed into 
one of the check box selected container IDs.

4. Click Save. The container is consolidated/processed.

Note: You can consolidate containers having the same Distro Nbr 
using this window.
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Process Orders

1. On the Pallet Without Case Labels Packing window, select the container to be 
processed using the check box.

2. Click Process.

3. Click Yes when asked to confirm. The container is processed at the packing 
station.

Print Pallet Level Packing Slip

1. On the Pallet Without Case Labels Packing window, click Print Pallet Level 
packing Slip.

2. Click Yes when asked if you want to process the pallet. Packing slip is printed for 
the entire pallet and the pallet is processed.

Exit the Pallet Without Case labels Window
Click Exit to close the window.

QC Outbound Audit
The QC Outbound Audit allows you to perform a quality audit on the contents of an 
outbound container. If necessary, you can adjust the quantity, and identify the person 
who packed the container.

You can access the WIP Audit Outbound window in order to view details about any 
WIP codes that are associated with a selected line item.

To process outbound containers, navigate to Processing -> QC Outbound Audit. The 
QC Outbound Audit window opens.

Note: The following SCPs must be set for processing a container:

■ packing_slip_qty must be set to a value greater than 0 to print a 
packing slip.

■ mms_location value must be set. Once a container is consolidated 
using this window, the container is no longer eligible for further 
consolidation at the consolidation station.

Note: Only one container can be processed at a time.

Note: If the pallet scanned is for a single SKU and a single distro 
number, the Print Pallet Level Packing Slip link is enabled.

Note: Operationally, the pallet may then be shrink wrapped and 
shipped using the manifest system. The execution of the manifest 
system functionality is through a manual scan
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Figure 9–22 QC Outbound Audit Window

Display the Details of an Outbound Container
1. If the details of a container are currently displayed, click Clear.

2. Click Query.

3. In the Container ID field, enter a container ID, or click the LOV button and select 
the container.

4. Click Search. The contents of specified container appear.

Assign a Packer to the Container
1. On the QC Outbound Audit window, double-click the Packer ID text box. The 

Packer Editor opens.

2. Enter the ID of the packer, or click the LOV button and select the packer.

3. Click Save to save any change and close the Packer Editor window. 

Adjust the Quantity of an Item
1. On the QC Outbound Audit window, double-click the line item that you want to 

edit. The Modify Quantity window opens.

2. Enter the actual quantity in the container.

3. Click Save.

4. When prompted to provide a reason for the adjustment, select the reason and click 
OK.

Process the Quality Audit
1. On the QC Outbound Audit window, click Process Form.

2. When prompted to confirm that the quality audit is done, click Yes.

Exit the QC Outbound Audit Window
Click Exit  to close the window.

Quality Assurance
The Quality Assurance window allows you to view details about a container and its 
contents. You can also apply trouble codes to the container.

There are four blocks in this window:

■ Query block: Identify the container that you want to retrieve.
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■ Container block: Displays container details. You can edit the dimensions, weight, 
lot number, and best before date. You can access the Container Checking window 
in order to view or edit the contents.

■ Item block: Displays item details. You can edit the dimensions, weight, and several 
attributes of the item. You can access the Item Master Editor window in order to 
view or edit additional item details.

■ Trouble code block: Displays a list of trouble codes. You can mark the trouble 
codes that you want to assign to the container.

To process containers for quality assurance, navigate to Processing -> Quality 
Assurance. The Quality Assurance window opens.

Figure 9–23 Quality Assurance Window

Display Container Details
1. If the details of a container are currently displayed, click Clear.

2. Click Query.

3. In the Container ID field, enter a container ID, or click the LOV button and select 
the container.

4. Click Search. The details for the specified container are displayed

Note: There are four blocks in this window. From top to bottom, they 
are referred to as the Query block, Container block, Item block, and 
Trouble Codes block.
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Edit Container Details
1. On the Quality Assurance window, click Next to to the cursor to the Container 

block.

2. Double-click any field in the Container block. The Modify window opens.

Figure 9–24 Modify Window

3. Edit the dimensions, weight, lot number, and best before date as necessary.

4. Click Save to save any changes and close the Modify window.

Edit Item Details
1. On the Quality Assurance window, click Next to move the cursor to the Item 

block.

2. Double-click any field, in the Item block. The Modify window opens.

Figure 9–25 Modify Window

3. Edit the dimensions, weight, and additional details as necessary.

4. Click Save to save any changes and close the Modify window.

Assign Trouble Codes to the Container
1. On the Quality Assurance window, click Next to move the cursor to the Trouble 

Codes block.

2. Select the trouble code that you want to assign to the container.
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3. Click Toggle.

4. When prompted to confirm the action, click Yes. A Y (Yes) appears in the Mark 
field to indicate that the trouble code is assigned to the container.

Process the Quality Assurance Check
1. On the Quality Assurance window, click Next to move the cursor to the Container 

block.

2. Click Quality Checking. The QA check is completed and the fields are cleared.

Exit the Quality Assurance Window
ClickExit to close the window.

Reprint / Null Labels
The Reprint/Null Labels window allows you to reprint labels or null labels for 
appointments or received containers. You may need to reprint labels if the labels 
produced were damaged in some way (unreadable barcodes). You may need to null 
labels if the appointment details are wrong or if the amount received was less than 
previously communicated. You can null labels at the container, appointment, or 
purchase order level. If the labels have been applied to a container, they cannot be 
nulled. This window also allows you to print generic labels at any time.

To reprint labels, navigate to Processing -> Reprint/Null Labels. The Reprint/Null 
Labels window opens.

Figure 9–26 Reprint/Null Labels Window

1. In the Container ID field, enter the ID of the container.

2. To reprint labels for the child containers of a master container, select the Print 
Associated Containers check box.

3. Click Reprint. The Select Printer window opens.

Note: To clear a marked trouble code, select the trouble code and 
click Toggle. The Y no longer appears in the Mark field.
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Figure 9–27 Select Printer Window

4. Click the LOV button and select the Printer Queue.

5. Click Save. The labels are sent to the selected destination.

Resolve Trouble
The Resolve Trouble window allows you to resolve the troubled status previously 
assigned to refuse to specific containers.

Troubled merchandise is found in containers with a status of T (Troubled). By deleting 
the trouble codes associated with the container, you indicate that the issues concerning 
the troubled merchandise have been resolved. If all the trouble codes for a container 
are resolved, the status of the container changes to I (Inventory).

You can refuse merchandise that has not yet been received. Such merchandise is found 
in containers with a status of A (Appointed). When you refuse a container, you are 
prompted to generate the Refusal Advice report. The status of the container changes to 
R (Return to vendor).

To resolve troubled merchandise, navigate to Processing -> Resolve Trouble. The 
Resolve Trouble window opens.

Figure 9–28 Resolve Trouble Window

Display the Details of a Container
1. If any details are currently displayed, click Clear.



Ticketing

9-26 Oracle® Retail Warehouse Management System UI User Guide

2. In the Container ID field, enter the ID of a troubled container, or click the LOV 
button and select the container.

3. Click Search. The details for the specified container are displayed.

Edit a Trouble Code Assigned to a Container
1. On the Resolve Trouble window, double-click the trouble code that you want to 

edit. The Modify window opens.

Figure 9–29 Modify Window

2. In the Trouble Code field, enter a different trouble code, or click the LOV button. 

3. Click Save to save any changes and close the Modify window.

Resolve Troubled Merchandise
1. On the Resolve Trouble window, select the trouble code that you want to remove.

2. Click Resolve.

3. When prompted to delete the record, click Yes. The trouble code is no longer 
assigned to the container.

Refuse Troubled Merchandise

1. On the Resolve Trouble window, click Refuse. 

2. Click the LOV button and select the Printer Queue.

3. Click Save. The Refusal Advice report is sent to the selected destination.

Exit the Resolve Trouble Window
Click Exit to close the window.

Ticketing
The Ticket Editor allows you to define and view a list of ticket types. You can enter a 
message, the maximum quantity, and printer information.

To maintain ticketing, navigate to Processing -> Ticketing. The current print queues for 
tickets appear in the Ticketing window. 

Note: Only merchandise that has not been received can be refused.
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Figure 9–30 Ticketing Window

Edit a Print Queue
1. On the Ticketing window, double-click the print queue that you want to edit. The 

Modify window opens.

2. In the Queue field, enter the name of a print queue, or click the LOV button.

3. Click Save to save any change and close the window.

Display Container/Items to be Ticketed
1. On the Ticketing window, select a print queue and click Continue. The Ticketing 

(container/item) window opens. 

2. Click Query.

3. In the Container ID field, enter the container ID, or click the LOV button.

4. Click Search.

Edit Ticketing Information for a Container/Item
1. On the Ticketing (Container/Item) window, double-click the item that you want to 

edit. The Modify window opens.

2. Edit the ticket type, retail price, and ticket quantity as necessary.

3. Click Save to save any changes and close the Modify window.

Print Tickets for One or all Items in a Container
A trailer ticket is printed after a string of tickets are printed for a container. The user ID 
and container ID are printed on the trailer ticket. If a container has more than one item 
ID and/or ticket type, a trailer ticket is generated for each ticket type.

1. On the Ticketing (container/item) window:

■ Select an item and click Print Item in order to print tickets for the selected 
item.

■ Click Print All in order to print tickets for all the items.

2. When prompted to confirm the request, click Yes. The tickets are sent to the 
selected destination.

Note:  If the container is a master container, ticketing information 
opens for the labeled child containers.
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Exit the Ticketing Window
Click Exit to close the window.

WIP Inquiry
The WIP Inquiry allows you to view all or a subset of open WIP codes. You can view 
the WIP codes by purchase order, distro, wave, bill of lading, item, or WIP code.

You can view the number of containers by status that are associated with a selected 
WIP code.

To view WIP codes, navigate to Processing -> WIP Inquiry. The WIP Inquiry window 
opens.

Figure 9–31 WIP Inquiry Window

Display all Open WIP Codes
Click Query.

Display a Subset of the Open WIP Codes
1. If any WIP codes are currently displayed, click Clear.

2. In one or more of the fields, enter the desired criteria.

3. Click Search. The open WIP codes that match the criteria appear.

View Open WIP Codes by Container Status
1. On the WIP Inquiry window, select the WIP code for which you want to view a 

summary.

2. Click Summary. The container count is summarized in the WIP Container Count 
Summary window.
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Figure 9–32 Summary Window

3. Click Exit to close the WIP Container Count Summary window.

Exit the WIP Detail Window
Click Exit to close the window.

Note: The container status may be: Appointed (A), Inventory (I), 
Distributed (D), Troubled (T), Manifested (M), Shipped (S), Return to 
vendor (R), Not Saleable (N), and Expired (X).



WIP Inquiry

9-30 Oracle® Retail Warehouse Management System UI User Guide



10

Task Management 10-1

10Task Management

Task Management is the process of managing all work (activities) in the warehouse. 
This includes managing both direct activities that are created by RWMS and indirect 
activities that are assigned outside RWMS. Task Management makes use of 
permission, priority, and proximity in conjunction to assign the most productive task 
to each employee at that specific moment in time.

The next best activity for an employee is assigned based on the permission of the 
worker, priority of the work to be done, and the physical proximity of a worker to task 
locations. Task Management specially increases the productivity in large warehouses 
as there are more tasks in such facilities. In many cases, productivity is further 
increased by changing the layout and flow of the warehouse.

Permission
Some workers are not trained to perform certain activities, not permitted in certain 
areas of a warehouse, or not allowed to operate specific types of equipment. RWMS 
checks if the worker has the necessary permissions to perform the activity before 
assigning the activity.

Priority
Priority indicates the importance of an activity. A default priority is set when an 
activity is created in RWMS. At regular intervals (either automatically or manually), a 
new routine is run to re-evaluate each activity based on a predetermined set of rules. If 
any rule is true, the priority of that activity is updated.

For example, a replenishment activity has a default priority of 10 at creation, but upon 
re-evaluation, RWMS determines that the forward pick face has reached its reorder 
point. The priority of this activity is then changed to 1 for immediate assignment.

Proximity
In situations where more than one task is at the same priority level, RWMS breaks the 
tie by looking for the next task closest to their current location in the warehouse. 
RWMS utilizes X, Y, Z coordinates to determine the actual distance to each task.

Business Process
To enable Task Management, configure the following editors:

Define Working Days
Define the working days and appointment intervals for your facility using the 
Working Days Editor found in Setup Administration in Chapter 4 Support Functions.
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Define Work Shifts
Define the operational work shifts for the distribution center. Each shift is identified by 
a Shift ID, Description, Start Time, and End Time. Each shift can be associated with one 
or more breaks for the shift. Each break is identified by a Break ID, Description, Start 
Time, End Time, and Break Type. The Shift Definition Editor is found in Setup DC in 
Chapter 4 Support Functions.

Define Locations
Create all the locations in your facility. Define the X, Y, Z coordinates to use both 
priority and proximity during task assignment. To use only priority, do not define the 
X, Y, Z coordinates. Configure the following editors in Chapter 4 Setup Locations: 
Location Type Editor, Location Editor, Reference Point Editor and Reference Point Map 
Editor.

Define Equipment/Zones
Define the equipment classes used in your facility. Include both vehicles (like forklifts, 
turret trucks, and so on) and devices (like RF handheld, RF wrist, and so on) during 
this stage. 

Identify and define the characteristics of each vehicle and device. The characteristics 
downloaded from the Equipment Class Editor window can be edited so they reflect 
the actual characteristics of the vehicle or device.

Create all the specific zones in your facility using the Zone Editor.

Configure the following editors in Chapter 4 Setup Equipment/Zone: Equipment 
Class Editor, Equipment Editor, Zone Editor, and Equipment Zone Restriction Editor.

Define Activities
Configure the activities that will be task managed and then identify the equipment 
that can be used for each activity. To enable interleaving, create Activity Groups.

Configure the following editors in Chapter 4 Setup Activity: Activity Editor, Activity 
Equipment Editor, and Activity Group Editor.

Create Users
Create all the users in your facility. Indicate the default shift, privilege, language, and 
so on using the User Editor.

Configure the following editors in Chapter 4 Setup User: User Editor, User Equipment 
Class Editor, and User Activity Group Editor.

This chapter contains the following topics:

■ Task Command Queue

■ Task History by User

Task Command Queue
The Task Command Queue allows you to view all outstanding activities that are task 
enabled and reassign their assigned user and or priority if desired. The command 
queue shows activities not started and in progress at the time the query is executed. 
All completed activities are removed from the task queue when the query is 
re-executed.

From the main menu, select Task Management > Task Command Queue. The Task 
Command Queue window opens.
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Figure 10–1 Task Command Queue Window

Display all Tasks (outstanding Activities)
Click Search.

Display Specific Information
1. Click Query.

2. Enter or select from the List of Values any of the selection criterion fields.

3. Click Search. The tasks that match the search criteria displays.

Update a Task
1. On the Task Command Queue window, select the tasks that you want to update. 

You can select task records in the following ways:

■ Select each individual check box next to the task record and then click Mass 
Update.

■ Click Select All which selects each displayed record and then click Mass 
Update.

■ If you have selected the wrong tasks and want to clear all simply click 
Deselect All and all of the check marks are removed. If you want to only clear 
some records, then select the check box next to the record and the check mark 
is cleared.

2. Click Mass Update and the Mass Update window opens. 
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Figure 10–2 Mass Update Window

3. In the User ID field, enter or select the User ID you want to assign to the task that 
is not started (activity). If you want to remove an assigned User ID from a task that 
is not started, select the Remove User ID check box.

4. In the Priority field, enter Priority you want to assign to the task that is not started 
(activity). If you want to remove the Priority from a task that is not started, select 
the Remove Priority check box. When a Priority is assigned in this window, it 
overrides the both the default and rules priority.

5. Click Save to make updates.

Viewing Totals
The Totals link allows a user to view summary data of the tasks (activities) selected in 
the Task Command Queue. If you enter the Task Command Queue and immediately 
click Search the queue shows you all tasks that are not started and tasks that are in 
progress in your facility for activities that are task managed. If you then click the Totals 
link it provides summary data on those tasks selected. If you use any of the filtering 
criteria the totals only reflect the summary data related to the filters applied.

Figure 10–3 Viewing Totals Window
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Run Rules
The Run Rules link when clicked runs a background procedure that checks to see if 
any of the rules applied to the activities in the Activity Priority Rules Editor are true 
and if so changes the Default Priority to the Priority defined within the actual rule.

Exit the Task Command Queue Window
Click Exit to close the window.

Task History by User
The Task History by User window provides management with the ability to view all of 
the tasks completed by a user over a specified range of dates. The online report 
captures the user logon time, breaks, lunch, all direct activities, all indirect tasks, idle 
time, and logoff time. In order to generate the online report, RWMS requires the entry 
of a From Date, To Date, and a User ID. The online report can be printed to paper by 
clicking the Print link and specifying your printer.

From the main menu, select Task Management > Task History by User. The Task 
History by User window opens.

Figure 10–4 Task History by User Window

Create an Online Report
1. Click Query.

2. Enter or select from the List of Values any of the selection criterion fields. You 
must include a From Date, To Date, and User ID to generate an online report.

3. Click Search. The tasks that match the search criteria displays. 

Exit the Task History by User Window
Click Exit to close the window.
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11Outbound

Warehouse outbound activities can be broadly classified into the following:

■ Shipping

■ Trailer Management

Shipping
Many of the shipping tasks are performed using a hand-held, truck mounted, or wrist 
mounted radio frequency (RF) device. The RF device can be used when loading and 
unloading trailers, and to indicate the status of a trailer. Information from the RF 
device is transmitted to RWMS, where it can be monitored.

In RWMS, you can estimate the total weight and volume of a stock order or shipment 
so you can better plan your routes. You can plan the amount of physical space needed 
in the trailer and the best order to load the trailer for the route. You can send the 
estimates to a third party system to determine optimal trailer loading. The third party 
system communicates that information back to RWMS and to the warehouse.

You can monitor the loading progress at shipping doors. The status of a door may be:

■ Available: The door is not blocked or in use. A trailer may be assigned to the door 
for loading.

■ Busy: Either a trailer is being loaded or the door is blocked and cannot be used.

Trailer Management
The Trailer Management module allows you to track and manage the status of 
inbound and outbound trailers. RWMS tracks the status of all trailers in the fleet. The 
status may be:

■ Arrived Inbound: The trailer is checked in and is either staged at a receiving door 
or assigned to a yard location.

■ Checked out: The trailer is checked out.

■ Loaded: The trailer is loaded for outbound transit.

■ Out of service: The trailer is not usable.

■ Scheduled: The trailer has a designated appointment time, but has not yet been 
checked in to the yard.

■ Shipped: The trailer is loaded with outbound merchandise and in-transit to its 
destinations.

■ Unloaded: The trailer is unloaded and released, but still in the yard. Outbound 
arrivals are given this status when they are checked in.
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■ Unloading: The trailer is being unloaded at the receiving door.

You can look up the contents of any inbound or outbound trailer. The details can be 
displayed by item, destination, or container.

This chapter contains the following topics:

■ Ship Cube Inquiry

■ Shipping Status

■ Trailer Status

■ Trailer Tracking

■ Yard Status

Ship Cube Inquiry
To query shipment volume and weight, navigate to Outbound -> Ship Cube Inquiry. 
The Ship Cube Inquiry window opens.

Figure 11–1 Ship Cube Inquiry Window

Run a Query
1. If a query opens, click Clear Query.

2. To load a query:

Note: Check in the trailer to change the status of a trailer from 
Scheduled to Arrived Inbound or from Checked out to Unloaded. 
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■ To run a ship cube query, click Load Ship Cube Query.

■ To run a stock order query, click Load Stock Order Query.

3. Select a query and click Load Query.

4. On the Build Query window, click Run Query.

5. When prompted to continue, click Yes. The results appear on the Query Results 
window.

Route the Query Results
1. On the Query Results window, click Route.

2. The Create Routing File window opens.

3. In the Ship Date field, enter the date the shipment should be sent.

4. Click Route to save your changes and close the window.

Build a Query
1. In the Column fields, select a limiting element.

2. In the Operator fields, select a relational operator.

3. In the Value fields, enter the value of the element selected in the Column field.

4. In the Logical field, enter the logical operator used to join two or more conditions.

5. Enter additional conditions as necessary.

6. You can add the following criteria to restrict your query:

7. To save a query:

a. Click Save Query. The Save Shipping Query window opens.

b. In the Save field, enter the name of the query.

c. Click Save Query to save your changes and close the window.

Delete a Query
1. On the Build Query window, click Delete Query. The Delete Query window 

opens.

2. Select the query that you want to delete.

Table 11–1 Criteria to Restrict Queries

Criteria Restriction

Requested Units The query includes all requested units ordered, regardless of 
distributed status.

Distributed Units The query includes only units that have been distributed

Undistributed Units The query includes only units that are not yet distributed.

Include Crossdock & 
Appointment Date

The query includes units on crossdock orders, after the 
appointment date is specified.

Note: You can only save a shipping query. You can maintain stock 
order queries in the Stock Order windows.
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3. Click Delete Query.

4. When prompted to delete the record, click Yes. The query is deleted and you are 
returned to the Build Query window.

Exit the Build Query Windows
Click Exit to close the window.

Shipping Status
The Shipping Status window allows you to view all shipping doors and see the status 
of the door (available, busy), the outbound trailer in the door, and the destination ID.

To view statuses of all shipping doors, navigate to Outbound -> Shipping Status. The 
statuses of all shipping doors appear in the Shipping Status window.

Figure 11–2 Shipping Status Window

View a Trailer Manifest
1. On the Shipping Status window, select the trailer that you want to view in detail.

2. Click Details. The trailer manifest opens in the Destinations for Trailer window.

Figure 11–3 Destinations for Trailer Window

3. Click Exit to close the window.

Exit the Shipping Status Window
Click Exit to close the window.

Trailer Status
The Trailer Status window allows you to view the status of inbound and outbound 
trailers. You can add trailers to RWMS from this window. You can check-in and 
check-out trailers and you can generate the Trailer Status report. The report displays 
the status and additional details for all trailers, both inbound and outbound. 
Appointment numbers appear for inbound trailers. 
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To view trailer status, navigate to Outbound -> Trailer Status. The Trailer Status 
window opens.

Figure 11–4 Trailer Status Window

Display All Trailers
Click Search.

Display a Subset of Trailers
1. If any trailers are currently displayed, click Clear.

2. Click Query.

3. Click Advance Search. The Advanced Search window opens.

Figure 11–5 Advance Search Window

4. In the criteria fields, enter a partial ID, or click the LOV button and select the 
criterion.

5. Click Search. The trailers appear on the Trailer Status window.

Add a Trailer
1. On the Trailer Editor window, click Create Record. The Create Record window 

opens.
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Figure 11–6 Create Record Window

2. In the Trailer ID field, enter the ID of the trailer.

3. In the Carrier field, enter the code for the carrier, or click the LOV button and 
select the carrier.

4. In the Location ID field, enter the ID of the yard location, or click the LOV button 
and select the location.

5. The Appt Nbr field is disabled. This value is populated when a trailer is associated 
to an appointment in the Appointment Schedule window.

6. The Mode field is disabled. This value is populated when the mode is defined 
while associating the trailer to the appointment.

7. Click Save to save the changes and close the Create Record window.

Edit the Status of a Trailer
1. On the Trailer Status window, select the trailer that you want to edit.

2. Click Check In to change the status of a trailer from Scheduled to Arrived 
Inbound or from Checked-out to Unloaded. 

Click Check Out to change the status of a trailer from Shipped or Unloaded to 
Checked Out.

Exit the Trailer Status Window
Click Exit to close the window.

Trailer Tracking
The Trailer Tracking window allows you to view details about the merchandise loaded 
on both inbound and outbound trailers. You can view items, destinations, and 
container details.

Inbound details are pulled from the appointments that are associated with a trailer. 
Outbound details are pulled from the bills of lading that are associated with a trailer.

You can choose to view details by item, by destination, or by container.

To view merchandise in trailers, navigate to Outbound -> Trailer Tracking. The Trailer 
Tracking window opens.
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Figure 11–7 Trailer Tracking Window

Display All Trailers
Click Search.

Display a Subset of Trailers
1. If any trailers are currently displayed, click Clear.

2. Click Query. The Advanced Search button is enabled.

3. Click Advanced Search. The Advanced Search window opens. 

4. In the criteria fields, enter a partial ID, or click the LOV button and select the 
criterion.

5. Click Search. The trailer or trailers that match the selected criteria appear.

Display a Trailer
1. If any inbound and outbound trailers are currently displayed, click Clear.

2. Click Query.

3. In the Trailer ID field, enter the trailer ID, or click the LOV button and select the 
trailer.

4. Click Search. The details of the selected trailer appear.

View Details by Item
1. On the Trailer Tracking window, click Next Block to move the cursor to either the 

Inbound Statistics or Outbound Statistics table.
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2. Select the trailer that you want to view in detail.

3. Click Detail by Item. The Detail by Item window opens. The details are sorted by 
item ID.

Figure 11–8 Detail By Item Window

4. Click Exit to close the window.

View Details by Location
1. On the Trailer Tracking window, click Next Block to move the cursor to either the 

Inbound Statistics or Outbound Statistics table.

2. Select the trailer that you want to view in detail.

3. Click Detail by Dest. The items and locations for the selected trailer appear. The 
details are sorted by location ID.

4. Click Exit to close the window.

View Details by Container
1. On the Trailer Tracking window, click Next Block to move the cursor to either the 

Inbound Statistics or Outbound Statistics table.

2. Select the trailer that you want to view in detail.

3. Click Container Inq. The Container Inq Window opens.
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Figure 11–9 Container Inquiry Window

4. Click Exit to close the window.

Exit the Trailer Tracking Window
Click Exit to close the window.

Yard Status
The Yard Status window allows you to view the status of trailers at yard locations. You 
can toggle the status of the trailer between Unloaded and Out of Service.

To maintain trailer statuses in the yard, navigate to Outbound -> Yard Status. The Yard 
Status window opens.

Figure 11–10 Yard Status Window

Display Trailers at All Yard Locations
Click Search.

Display Trailers by Yard Location
1. If any trailers are currently displayed, click Clear.
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2. Click Query.

3. In the Location ID field, enter the ID of the yard location, or click the LOV button 
and select the location.

4. Click Search. The trailers at the selected yard location are displayed.

Edit the Status of a Trailer
1. On the Yard Status window, select the trailer that you want to edit.

2. Click Service to toggle the status from Unloaded to Out of Service or from Out of 
Service to Unloaded.

Exit the Yard Status Window
Click Exit to close the window.
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12
Returns

When retailers or consumers return merchandise to the warehouse, a process must be 
in place to handle those returns. There are two basic steps for processing returns: 

■ Receiving the merchandise into the DC

■ Processing the return with disposition codes

Business Process
The host system notifies RWMS of pending returns. You can view the pending returns 
order to gauge the number of returns that are expected to arrive on a particular date.

When the merchandise is received it is moved to the returns area for processing.

Returned merchandise is processed at the item level. For Electronic Returns, the reason 
codes are pre-assigned and cannot be modified. For Paper Returns, you assign the 
reason codes during processing. Furthermore, the Disposition Code is assigned during 
processing. You may assign a WIP code using the link in the left column of the 
window.

Reason codes indicate why the merchandise was returned. Action codes indicate how 
the merchandise should be handled. For example, an item may be returned to 
inventory, replaced with another item, or returned to vendor. The disposition code 
indicates the status of the returned item. The merchandise in the container may be 
marked as saleable or non-saleable. When an item is marked as saleable, it must be 
moved from the original container to a saleable container.

This chapter contains the following topics:

■ Electronic Return Processing

■ Paper Return Processing

■ Return Information Inquiry

■ Returns to Vendor

Electronic Return Processing
The Electronic Return Processing Editor is used to process the containers returned 
against an RMA. When processing the return, you confirm the inventory in the 
returned container. Also, based on the state of the inventory (and/or special 
instructions/business practices), You can determine what needs to be done next with 
the returned goods.

From the main menu, select Returns > Electronic Return Processing. The Electronic 
Returns window opens.
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Figure 12–1 Electronic Return Processing Window

Display Returned Containers
1. If any return details are displayed, click Clear.

2. Click Query. 

3. Enter either the Container ID or RMA Nbr or both. You can use the LOV button to 
select the values. 

4. Click Search. The return details that match the criteria are displayed.

The detail block on the window is divided into two sections:

■ RMA Section: This section displays the details of the RMA selected. These 
details are irrespective of whether the items may have been processed on some 
other container. The section includes following information:

– Select: This check box can be used to select one or more records for mass 
processing.

– Line Nbr: The line number of the item on the RMA.

– Item ID: The item present on the RMA.

Note: If you choose a valid RMA nbr, you can select any 
unprocessed container against the RMA by clicking the LOV button 
next to the Container ID field.

If you select a container ID first, and this container does not have any 
RMA nbr associated with it, you are prompted to associate an RMA 
nbr with the container. If the container scanned has its Receipt Date 
past the expected delivery date of the RMA, a soft warning message 
displays.
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– Description: Description of the item.

– Reason Code: Reason for returning an item, usually provided by the 
customer and downloaded into RWMS from OMS.

– Expected Qty: The units of the item expected to be returned by the 
customer.

– Processed Qty: The quantity processed as part of the returns so far, which 
is in turn added to RWMS inventory as either sellable or non-sellable, 
based on the disposition.

■ Container Section: this section displays the details of the container scanned in 
the header. This section also holds data temporarily for the session, even if the 
RMA is being processed into another container. The section includes following 
information:

– Line Nbr: The line nbr of the item on the RMA.

– Item ID: The item present on the RMA.

– Unit Qty: Number of units processed into the container.

– Disposition: State of the inventory after processing - can be either sellable 
or non-sellable.

– Container ID: Container into which the item was processed.

– Action Code: Action taken (or to be taken) on the line item for processing.

– Reason Code: Reason for which the item was returned to the retailer.

– Processed Date: Date when the return was processed in RWMS.

– Comments: Comments added by you while processing the item.

Receive Container
You can return a new container by scanning a generic container ID with a mandatory 
RMA nbr. The container is assumed to be received at the location for the Return WIP. 
Once received, the container and its associated RMA nbr and other details are 
populated in the header block.

1. On the Electronic Return Processing window, click Receive Container. The 
Receive Container window opens.

Figure 12–2 Receive Container Window
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2. Enter the container ID in the Container ID field.

3. Enter the RMA number in the RMA Nbr field or select from the LOV button.

4. Click Save.

Manage Instructions
If any instructions have been downloaded against the pending return (RMA), the 
Instructions link is enabled.

1. On the Electronic Return Processing window, click Instructions. Any instructions 
available are displayed

Figure 12–3 Manage Instructions Window

Process Item
This link is enabled only when the Select check boxes are clear.

1. On the Electronic Return Processing window, click the Process Item link. The 
Process Item window opens.
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Figure 12–4 Process Item Window

2. Enter the enabled fields:

■ Line Nbr/Item ID: Pre-populated details of the selected line number and item 
ID.

■ Unit Qty: You can enter a valid value to set the number of units of the item 
being processed.

■ Disposition: You can select the disposition of the inventory once processed - 
either sellable or non-sellable. This determines the status of the container into 
which the merchandise is processed - I or N, respectively. Two items cannot be 
added to the same container, if they are non-saleable but have a different 
disposition.

■ Description: Description of the selected disposition code.

■ Container ID: You can scan the return received container (only if the selected 
disposition is non-sellable). Or you can choose to scan a generic container to 
receive the merchandise as either non-sellable or sellable. In case you scan an 
existing I status container, it is not required to be the same RMA nbr. however, 
it is required that in the case of multiple items on the same container, each of 
the items should have a forward unit pick.

■ Reason Code: Pre-populated field with the reasons for the return downloaded 
from OMS. In the case of more than one reason, the word Multiple displays 
but you can click the LOV button next to the field to view all the individual 
reasons.

■ Action Code: You must select only one action code from the Action Code LOV 
button. It is mandatory and signifies the action taken (or to be taken) against 
the line item being processed. If the business chooses to have no action code, a 
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dummy value such as NONE may be created for an action code, to be used 
whenever desired.

■ Comment: You can choose to enter free-form text as comments in this field.

3. Click Save. The records are processed and published to OMS using the 
RETURNS_UPLOAD table.

Process Selected
1. Select a minimum of one check box from the RMA block and click the Process 

Selected link to process all the selected items in a single instance.

2. The Process Selected window opens with all the selected details pre-populated.

Figure 12–5 Process Selected Window

3. Enter the unit quantity in the Unit Quantity field.

4. Select a disposition using the LOV button in the Disposition field.

5. Scan the container ID in the Container ID field.

6. Select the Reason Code, Action Code and insert a Comment.

7. Click Process.

Container Complete
1. On the Electronic Return Processing window, click Container Complete. 

This signals completion of the processing of container, by an implicit processing of 
the Return WIP on the container. Once processed, the container can no longer be 
processed through the Paper Return Processing window.

Apply WIP Code
1. On the Electronic Return Processing window, click Apply WIP Code. The Apply 

WIP Code window opens with the container details pre-populated.

For more information, see Apply WIP Code.

Exit the Electronic Return Processing Window
Click Exit to close the window.

Paper Return Processing
The Paper Returns Processing window is used to process container returns against a 
customer order number when an RMA number is not provided. The item and quantity 
details are not pre-populated in RWMS for a paper return. The Paper Returns 
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processing window is used to enter the information for a paper return in RWMS and 
publish it to the Order Management System.

From the main menu, select Returns > Paper Return Processing. The Paper Return 
Processing window opens.

Figure 12–6 Paper Return Processing Window

Display Returned Containers
1. If any return details are displayed, click Clear.

2. Click Query. 

3. Enter either the Container ID or Cust Order Nbr or both. You can use the LOV 
button to select the values. 

4. Click Search. The return details that match the criteria are displayed.

Receive Container
1. On the Paper Return Processing window, click Receive Container. The Receive 

Container window opens.

Figure 12–7 Receive Container Window

Note: If you scan a container ID, which has been received through 
the Return Receiving window but has neither a Customer Order Nbr 
nor an RMA Nbr associated with it, you are prompted to associate a 
customer order number with the container, when the container ID is 
scanned on the window.
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2. Enter the container ID in the Container ID field.

3. Enter the customer order number in the Cust Order Nbr field.

4. Click Save.

Manage Instructions
If any instructions have been downloaded against the pending return, the Instructions 
link is enabled.

1. On the Paper Return Processing window, click Instructions. Any instructions 
available are displayed

Figure 12–8 Manage Instructions Window

Figure 12–9 Manage Instructions Window

Add Items
1. On the Paper Return Processing window, click Add Items. The Add Items 

window opens.
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Figure 12–10 Add Items Window

2. Enter the following information:

■ Item ID: Scan any item ID present in RWMS. If the item has not been marked 
as Returnable in the item master, a warning message displays  while adding 
the item on the window. The message can be overridden.

■ Unit Qty: Enter the unit quantity of the item to be processed against a certain 
disposition/reason/action code.

■ Disposition: Select a code which determines whether the item will be 
processed as Inventory or Non-saleable. Two items cannot be added to the 
same container, if they are non-saleable, but have different disposition. 

■ Container ID: You must scan a container ID. It can either be the N status return 
received container for the same customer order number or a generic container. 
If you scan an existing I status container, it is not required to be of the same 
customer order number. However, it is required that in the case of multiple 
items on the same container, each of the items should have a forward unit 
picking location associated with it.

■ Reason Code: You can click  the LOV button next to the field, and select one or 
more reason codes, which describe the reasons for the return of the line item.

■ Action Code: You must select only one action code from the LOV button. The 
Action Code is mandatory and signifies the action taken (or to be taken) 
against the line item being processed. If the business chooses to have no action 
code, a dummy value such as NONE may be created for an action code, to be 
used whenever desired.

■ Comment: You can choose to enter free-form text as comments in this field.

3. Click Process. The records are processed and published to OMS.

4. Click Exit to roll back the changes.

Container Complete
1. On the Paper Return Processing window, click Container Complete. 

This signals completion of the processing of container, by an implicit processing of 
the Return WIP on the container. Once processed, the container can no longer be 
processed through the Paper Return Processing window.

Apply WIP Code
1. On the Paper Return Processing window, click Apply WIP Code. The Apply WIP 

Code window opens with the container details pre-populated.

For more information, see Apply WIP Code.
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Exit the Paper Return Processing Window
Click Exit to close the window.

Return Information Inquiry
The Return Information Inquiry window shows the return details for both Electronic 
and Paper Returns. The window provides you with the ability to see returns in both 
pending and processed statuses.

From the main menu, select Returns > Return Information Inquiry. The Return 
Information Inquiry window opens. 

Figure 12–11 Return Information Inquiry Window

Display All Returns
On the Return Information Inquiry window, click Search.

Display a Subset of Returns
1. On the Return Information Inquiry window, if any data displays click Clear.

2. Click Query.

3. Enter one or all the search criteria:

■ Return Type: From the drop-down list, you can select paper, Electronic, or All. 
The default is All.

■ Item ID: The resulting data displays all the RMAs/Cust Order Nbrs which 
include the entered Item ID. However, on querying for the details of the 
resulting RMAs/Cust Order Nbrs, all the items associated with the 
RMA/Cust Order Nbr are displayed.

■ Cust Order Nbr: You can enter partial or complete cust_order_nbr. This is 
validated with the existing cust_order_nbr records in the pending_returns 
table.

■ RMA Nbr: You can enter partial or complete RMA Nbr and query the data.

■ Display Pending Only (Check box): This check box is automatically selected 
unless Electronic is the selected Return Type. If the Display Pending Only field 
is selected, then only those RMA records are displayed which have at least one 
line item record where the expected unit quantity is greater than the processed 
unit quantity. If the field is clear, then all the records are displayed.
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■ Expected receipt:

– From date

– To date

■ To receipt:

– From date

– To date

4. Click Search. The details matching the selected criteria displays:

■ RMA Nbr: If the displayed record is for an electronic return, this field is 
populated. Otherwise, it is set to None.

■ Customer Order Nbr: If the displayed record is for a paper return, this field is 
populated. Otherwise, it is set to None.

■ Expected Receipt: The expected receipt date for the Return.

■ Actual Receipt: The date on which the last container was received for that 
return.

■ Instructions: The field is selected if there are any instructions for the return 
processing (which can be viewed through the Instructions link on the left 
toolbar of the window).

■ System Indicator: Selected for electronic returns.

Item Detail
1. On the Return Information Inquiry window, click Item Details. The detailed 

information about all the items expected to be returned are displayed on the Item 
Detail window. 

Figure 12–12 Item Detail Window

2. Following information displays:

■ Header block

– RMA_nbr (populated for electronic returns, otherwise NONE)

– Customer Order Number (populated for paper returns, otherwise NONE)

– Expected and actual receipt

Note: This is specific to electronic returns only. For paper returns, 
such a scenario will never be encountered.



Return Information Inquiry

12-12 Oracle® Retail Warehouse Management System UI User Guide

■ Detail block

– Line Number: The sequence number of the item on the return.

– Item ID: Item ID of the item on the return.

– Description: Description of the item on the return.

– Reason Code: Reason for the return of the item. If multiple reasons have 
been selected, the word Multiple displays. You can click  the LOV button 
next to the reason code field to view all the reason codes associated with 
the item return.

– Expected Unit Qty: The number of units of the item expected against the 
return.

– Processed Unit Qty: The number of units of the item which have been 
processed in RWMS (either as non-saleable, or saleable) and are part of the 
DC's inventory (available or non-available).

3. Click Exit to close the window and return to the Return Information Inquiry 
window.

Container Detail
1. On the Return Information Inquiry window, click Container Details. The 

Container Details window opens with detailed information about all the 
containers (processed or non-processed) against the selected return.

Figure 12–13 Container Details Window

2. The Container Details window has the following information:

■ Header block

– RMA_nbr (populated for electronic returns, otherwise NONE)
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– Customer Order Number (populated for paper returns, otherwise NONE)

– Expected and actual receipt

■ Detail block

– Container ID: All of the container IDs associated with the selected return 
are displayed.

– Location ID: Current location of the container.

– Container Status: The current container status. It can either be Inventory 
or Non-saleable.

– Receipt Date: The date the container was received at the return receiving 
window or in the case of an Inventory container, when the items were 
processed into a generic I status container.

3. You can view details of each container by using the Detail link on the window. 
This link is enabled only for containers which have at least one item associated to 
them through return processing. For containers which have no item associated 
with them, the link is disabled.

Select a container with item details associated with it, and click the Detail link. 
The Processed Item Details window opens with a header and detail block.

Figure 12–14 Processed Item Details Window

The header block has the following information:

■ Container: The selected container ID.

■ Status: Status of the container.
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■ Receipt Date: Receipt date of the container.

■ Location ID: Current location of the container.

■ RMA_nbr/cust_order_nbr: RMA_nbr/cust_order_nbr against which the 
container was received/processed.

The detail block has the following information:

■ Line Nbr: The sequence number of the item on the selected return.

■ Item ID: This displays the items present in the selected container.

■ Unit Qty: Unit quantity of the item present in the container.

■ Disposition: Disposition of the inventory selected at the time of processing. If 
the container is in N status after processing, there can only be one disposition 
across items.

■ Action Code: Action code added to the line item record while processing the 
return. There can be multiple records for the same item on the container with 
different action codes.

■ Reason Code: Reason for the return of the item. If multiple reasons have been 
selected, the word Multiple displays. Click the LOV button next to the reason 
code field to view all the reason codes associated with the item return.

■ Processed Date: The date when the item was associated to the container 
through the Return processing operation.

■ Comments: Displayed, if you add any comments while processing the item 
into the container.

4. Click Exit to return to the previous window.

Returns Process
1. On the Return Information Inquiry window, select a record and click Returns 

Process.

If you select a paper return record, the Paper Return Processing window opens 
with the relevant details populated. If you select an electronic return record, the 
Electronic Returns Processing window opens.

Manage Instructions
If the selected record has the Instructions field selected, the Instructions link is 
enabled

1. On the Return Information Inquiry window, click Instructions. Any instructions 
available are displayed
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Figure 12–15 Manage Instructions Window

Exit the Return Information Inquiry Window
Click Exit to close the window.

Returns to Vendor
The Return to Vendor window allows you to process a return to vendor (RTV). If the 
default address for the vendor is not the desired address, you can choose or enter 
another address.

When you process the RTV, the Return to Vendor Advice report is generated. It 
contains the vendor, vendor address, and authorization number. It lists the items to be 
returned as well as their vendor styles, container quantities, and unit quantities.

You can also generate the Return to Vendor report. It lists the RTV IDs and container 
IDs that are associated with a vendor number and authorization number.

From the main menu, select Returns > Return to Vendor. The Return to Vendor 
window opens.

Figure 12–16 Return to Vendor Window

Note: You can also access this window from the Inventory Inquiry 
by Vendor window.
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Display a Return to Vendor
1. Click Query.

2. In the Container ID field, enter the ID of the container, or click the LOV button and 
select the container.

3. Click Search. The details of the return to vendor appear.

Process a Return to Vendor
1. On the Return to Vendor window, enter the vendor number in the Vendor Nbr 

field.

2. To enter an address for the vendor:

a. Click Vendor Address. The Vendor Address window opens.

Figure 12–17 Vendor Address Window

b. Enter the ship-to address of the vendor or click Vendor Address and select the 
address.

c. Click Save to save any changes and close the Vendor Address window.

3. In the Authorization field, enter the authorization number from the vendor.

4. Click RTV.

5. When prompted to confirm the return to vendor, click Yes.

6. When prompted to select a reason for the inventory adjustment, select the reason 
and click OK. The report is sent to the destination that is set for printing.

Exit the Return to Vendor Window
Click Exit to close the window.
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Activity Log History

The activity history log allows you to track historical information about activities 
within a distribution center. You can choose which data should be tracked and specify 
the sources of that data.

Some basic reports and simple query functionality are provided within RWMS. It is 
recommended that more extensive manipulation of the data be performed with data 
warehousing tools.

As containers pass through distribution center, historical records are kept in RWMS. 
You can use this information to track a container's progress.

Business Process
There are three phases to setting up the activity history log in RWMS:

■ A system option must be set to turn on the logging function.

■ You must indicate how many days worth of data to retain for each table. Data 
older than the set number of days are purged from the log.

■ You must select the fields against which activity is logged. You can select those 
fields by window or by table/field. Some activities, however, are always logged. 
These activities involve users overriding certain defaults and skipping activities.

Simple queries can be run on the data from within RWMS.

System Administration
For activities to be logged, the activity history log functionality must be turned on. The 
setting for the system parameter, ahl_log, may be:

■ 0 (zero): The functionality is turned off.

■ 1: The functionality is turned on. Activities are written to the ACTIVITY_LOG 
table.

■ 2: The functionality is turned on. Activities are written to an Oracle database 
queue. Customization is required to write the data to the ACTIVITY_LOG table.

This chapter contains the following topics:

■ Activity Log Inquiry

■ Define Purge Frequencies

■ Set Log by Screen

■ Set Log by Table/Field
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Automatic Overrides and Skips
The following user actions are always recorded in the activity history log:

■ During the putaway process, a suggested putty location is overridden.

■ During bulk picking or bulk replenishment picking, a suggested pick from 
location or quantity is overridden.

■ During container picking, a suggested location or quantity is overridden.

■ During container replenishment picking, a suggested location is overridden.

■ During put-to-store picking, a suggested location is overridden.

■ During cycle counting, a location marked for counting is skipped.

Activity Log Inquiry
From the main menu, select Activity History Log > Activity Log Inquiry. The Activity 
Log Inquiry window opens.

Figure 13–1 Activity Log Inquiry Window

Query the Activity History Log
1. On the Activity Log Inquiry window, click Build Query. The Build Query window 

opens.

Figure 13–2 Build Query Window

2. If a query opens, click Clear Query.

3. To load a query:
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a. Click Load Query. The Load Query window opens.

b. Select the query that you want to use.

c. Click Load Query. The query opens on the Build Query window.

4. Click Run Query. The query is run and the results appear on the Activity Log 
Inquiry window.

Build a Query
1. On the Activity Log Inquiry window, click Build Query. The Build Query window 

opens.

2. In the Column field, select a limiting element.

3. In the Operator field, select a relational operator.

4. In the Value field, enter the value of the element selected in the Column field.

5. In the Logical field, enter the logical operator used to join two or more conditions.

6. Enter additional conditions as necessary.

7. To save a query:

a. Click Save Query. The Save Query window opens.

b. In the Save field, enter a name for the query.

c. Click Save to save the query and close the Activity Log Queries window.

8. On the Build Query window, click Run Query to run the query or click 
Exit/Cancel to close the Build Query window.

Delete a Query
1. On the Activity Log Inquiry window, click Build Query. The Build Query window 

opens.

2. Click Delete Query. The Delete Query window opens.

Figure 13–3 Delete Query Window
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3. Select the query that you want to delete.

4. Click Delete Query.

5. When prompted to delete the record, click Yes. The query is deleted and you are 
returned to the Build Query window.

6. Click Exit/Cancel to close the Build Query window.

Exit the Activity History Log Window
Click Exit to close the window.

Define Purge Frequencies
From the main menu, select Activity History Log > Define Purge. The current purge 
settings appear in the Purge Define window.

Figure 13–4 Define Purge Window

Edit Purge Frequencies
1. On the Purge Define window, double-click the table that you want to edit. The 

Modify window opens.

Figure 13–5 Modify Window

2. In the Purge Frequency field, edit the number of days for which you want to retain 
data.

3. Click Save to save any changes and close the Modify window.
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Exit the Purge Define Window
Click Exit to close the window.

Set Log by Screen
From the main menu, select Activity History Log > Set Log by Screen. The Set Log by 
Screen window opens.

Figure 13–6 Set Log By Screen Window

Display Tables and Fields for All Screens

Click Search.

Display a Subset of Screens
1. If any screens are currently displayed, click Clear.

2. Click Query.

3. To display tables and fields by screen (or window), enter the screen name in the 
Screen Name field, or click the LOV button and select the Screen. To display 
screens by table or field, enter the table name or field name in the appropriate 
fields, or click the LOV buttons and select the table or field.

4.  Click Search. The screens, tables, and fields that match the criteria appear.

Set Screen Level Activity Logs
1. On the Set Log by Screen window, select the Log Flag check box next to each 

screen/table/field that you want to include in the activity history log.

Note: Due to the large volume of fields that would be retrieved, it is 
recommended that you enter criteria in order to restrict the results.

Note: The Log Flag for a screen can be selected only if Purge Days 
are defined for the screen in Define Purge window.
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2.  Clear the Log Flag check box next to each screen/table/field that you do not want 
to log.

3. Click Save to save any changes.

Exit the Set Log by Screen Window
Click Exit to close the window.

Set Log by Table/Field
From the main menu, select Activity History Log > Set Log by Table/Field. The Set 
Log by Table/Field window opens.

Figure 13–7 Set Log By Table Field Window

Display All Tables and Fields

Click Search.

Display a Subset of Tables and Fields
1. If any tables and fields are currently displayed, click Clear.

Note: To select or clear the Log Flag check boxes for all the currently 
displayed screen/table/field records, select or clear the Select All 
check box.

The Select All check box can used only if the table associated to the 
windows has Purge Days defined. If Purge Days are not defined for 
the table, then selecting the Select All check box triggers a warning 
message to define the Purge days on the table.

Note: Due to the large volume of fields that would be retrieved, it is 
recommended that you enter criteria in order to restrict the results.
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2. Click Query.

3. Enter criteria in one or both of the text fields. 

4. Click Search. The tables and fields that match the criteria appear.

Set Table/Field Level Activity Logs
1. On the Set Log By Table Field window, select the Log Flag check box next to each 

table/field that you want to include in the activity history log.

2. Clear the Log Flag check box next to each screen/table/field that you do not want 
to log.

3. Click Save to save any changes.

Exit the Set Log By Table/Field Window
Click Exit to close the window.

Note: To select or clear the Log Flag check boxes for all the currently 
displayed table/field records, select or clear the Select All check box.

Select All check box can used only if the table associated to the screens 
has Purge Days defined. If Purge Days are not defined for the table, 
then selecting the Select All check box triggers a warning message to 
define the Purge days on the table.
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Database Administration

Database administrators can use the options available on the DBA Administration 
menu to monitor a variety of database activities. Database administrators can view 
information regarding indexes, tables, table locks, rollbacks, sequences, and the error 
log.

Business Process
There is no business process pertaining to database administration.

This chapter contains the following topics: 

■ Display Error Log

■ Display Index Information

■ Display Locks on Tables

■ Display Rollback Information

■ Display Sequences Information

■ Display Table Information

■ Manual Script Launch Editor

Display Error Log
The Error Log allows you to view and delete logged errors. These are unanticipated 
errors or errors occurring in background processes.

You can generate the Error Log report. The report provides the following information 
for each error: user ID, error time, code, source, location, and message.

From the main menu, select DBA Administration > Display Error Log. The Error Log 
window opens.
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Figure 14–1 Error Log Window

Display All Errors
Click Search

Display Errors by User, Error Code, or Date
1. If any errors are currently displayed, click Clear. 

2. Click Query.

3. To restrict the list of errors to a specific user, error code, or date, enter the criteria in 
the appropriate text fields. 

4. Click Search. The errors that match the criteria appear.

View Additional Details of an Error
1. On the Error Log window, select the error that you want to view.

2. Click Details. The details of the selected error appear in the Detail window.

Figure 14–2 Detail Window

3. Click Exit to close the Error Detail window. 

Delete an Error Record
1. On the Error Log window, select the error that you want to delete.

2. Click Delete Record. 
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3. When prompted to delete the record, click Yes.

Exit the Error Log Window
Click Exit to close the window.

Display Index Information
The Display Index Information allows you to view sizing information for the database 
indexes. You can use this information to analyze the growth of the database indexes, 
which can indicate table growth.

From the main menu, select DBA Administration > Display Index Information. The 
Display Index Information window opens.

Figure 14–3 Display Index Information Window

Display Details for All Indexes
Click Search.

Display Details for One Index
1. If any index details are currently displayed, click Clear. 

2. Click Query.

3. In the Target Index field, enter the name of an index, or click the LOV button and 
select the index. 

4. Click Search. The details for the selected index appear.

Exit the Display Index Information Window
Click Exit to close the window.

Display Locks on Tables
The Display Locks on Table window allows you to view the database tables which are 
locked.

From the main menu, select DBA Administration > Display Locks on Tables. The 
currently locked tables appear in the Display Locks on Tables window. 
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Figure 14–4 Display Locks on Tables Window

Exit the Display Locks on Tables Window
Click Exit to close the window.

Display Rollback Information
The Display Rollback Information allows you to view information about rollbacks. 
You can use this information to determine whether the rollback segments need to be 
enlarged for a specific installation.

From the main menu, select DBA Administration > Display Rollback Information. The 
current rollback segments appear in the Display Rollback Information window.

Figure 14–5 Display Rollback Information Window

Exit the Display Rollback Information Window
Click Exit to close the window.

Display Sequences Information
The Display Sequences Information allows you to view sizing information specific to 
the sequences used by RWMS. You can use this information to determine whether a 
sequence is being called as many times as originally planned.

From the main menu, select DBA Administration > Display Sequences Information. 
The current sequence details appear in the Display Sequences Information window. 
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Figure 14–6 Display Sequences Information Window

Exit the Display Sequences Information Window
Click Exit to close the window.

Display Table Information
The Display Table Information allows you to view sizing information for database 
tables. You can monitor the number of extents in order to detect table growth. A large 
extent value indicates possible table fragmentation. If the number of extents becomes 
too large, the table should be rebuilt.

From the main menu, select DBA Administration > Display Table Information. The 
current tables appear in the Display Table Information window.

Figure 14–7 Display Table Information Window

Display Details for One Table
1. If any table details are currently displayed, click Clear 

2. Click Query.

3. In the Find Table field, enter the name of a table, or click the LOV button and select 
the table. 

4. Click Search. The details for the selected table appear.

Exit the Display Table Information Window
Click Exit to close the window.
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Manual Script Launch Editor
The Manual Script Launch Editor allows you to submit a batch job with its required 
parameters from the GUI window that in previous versions had to be launched using 
SQL in the background. The scripts that can be launched include: Automate Wave, 
Inventory Balance Upload, Process Diverts, Purge RWMS Tables, Run Distribution, 
Run Task Priority, Schedule Cycle Count, Schedule ROP Distribution, Unreconciled 
Appointment Monitor, Maintain Wave Statistics, and Insert Distribution Queue.

From the Main Menu select DBA Administration > Manual Script Launch Editor.

Figure 14–8 Manual Script Launch Editor window

Running a Script
1. Select the Program Name of the script you want to run.

2. Based on the Program Name selected set your Program Parameters and then click 
Run Now.

3. Enter the date range (Start Date and End Date) to view Program Execution 
History. These are the jobs that have run successfully in this time frame.

4. View batch results in the Program Execution Details section.

Exit Manual Script Launch Editor
Click Exit to close the window.
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BI Reports

RWMS uses Oracle BI Publisher as the interface for RWMS reports. RWMS reports 
may be custom-designed by your own organization. The BI Publisher interface is also 
customized to organize and present the reports available to RWMS users. The BI 
Publisher tool also exposes its reports as a web service which can be accessed from the 
Oracle forms.

Log in to BI Publisher
1. Click Reports from the top horizontal navigation menu of the RWMS user 

interface. The Oracle BI Publisher 12c web interface opens on a separate 
window/tab on your browser.

Figure 15–1 shows the default view when BI Publisher is opened from RWMS.

Figure 15–1 BI Publisher Default View when Opened from RWMS

2. By default, you are logged in as XMLP_GUEST, which is the Guest account. If you 
need to perform additional operations, you need to log in. Click the Sign In link 
on the top to go to the login page.

3. Enter the Username and Password provided by your administrator. You can also 
log in as a Guest if the option has been enabled by your Administrator. To log in as 
a Guest, click Guest.

Note: You can use Oracle BI Publisher in your web browser to view 
reports. The RWMS application is still available and you can continue 
with the operations.
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Figure 15–2 Login Window

4. Select Accessibility Mode to view the Reports home page in an accessible tree 
structure.

5. Select the language you prefer for the user interface from the drop-down list.

6. Click Sign In.

Log out of BI Publisher
To log out of BI Publisher, click Sign Out.

Figure 15–3 Logout Window

BI Publisher 12c Home Window
The home window of the BI Publisher 12c web interface displays all the reports you 
have accessed/edited recently.

Note: A Guest user does not require credentials and has privileges 
only to view reports available in the Guest folder.
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Figure 15–4 Home Window

■ The existing list of reports can be accessed by clicking the Catalog link at the top 
right of the page, and also from the left navigation menu under Browse/Manage.

■ The existing list of scheduled reports can be accessed by clicking Report Jobs 
under Browse/Manage.

■ New reports can be created by clicking on Report link under Create from the left 
navigation menu. New schedules for reports can be created by clicking Report Job 
under Create.

Catalog View
The Catalog view displays a list of all the folders created by you and all the reports in 
them.

Figure 15–5 Catalog View

If you are signed in to BI Publisher, you can view, schedule, view history, edit, and 
configure the report from this view.
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View Reports
1. To view a report, click the report name to open its contents.

2. Click Open.

Figure 15–6 Open

3. From the Report view, enter the required data and click Apply.

4. Select the Webpage icon on the top right corner to choose your desired output 
type, such as, PDF, Excel, CSV, XML, and so on.

Figure 15–7 Output Types

5. If you want to save a report, you need to export it. The generated report can also 
be exported to the desired format.
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Figure 15–8 Export

Print Reports
1. To print the generated report, click Send or Schedule from the drop-down list 

shown in Figure 15–8.

2. On the next page, select the Output tab.

3. From the Destination part, select Printer as the Destination Type.

4. Click Submit to print.

Figure 15–9 Print Report

Schedule Reports
1. To print the generated report, click Send or Schedule from the drop-down list 

shown in Figure 15–8.
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2. On the next page, select the Schedule tab.

3. Set your frequency and other required parameters and then click Submit.

Figure 15–10 Schedule Report Job

Administration
The Administration link is enabled only if you have logged in with Administrator 
privilege. Your system administrator sets up the various parameters required to 
view/edit reports. It allows the administrators to perform administrative tasks such as 
system maintenance, integration, adding new database connections, printers, and so 
on.

Related Documents
For information about using Oracle BI Publisher, see the Oracle Business Intelligence 
Publisher User's Guide.

The Oracle Retail Warehouse Management System Implementation Guide provides more 
information about reports for RWMS system implementers and administrators.
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16Dashboards

Activity Monitor Dashboard
The Activity Monitor dashboard provides at-a-glance views of Key Performance 
Indicators (KPIs) relevant to a specific warehouse process (Receiving, Transport, Cycle 
count, Replenishment, Picking, and Shipping). They graphically present the current 
status (snapshot) and historical trends of the KPIs, so Warehouse Management can 
make informed decisions quickly. The dashboards provide an easy-to-read, real-time 
interface into tasks that are Not Started, In Progress, or Completed.

This chapter contains the following topics:

■ Navigation and Status Legend

■ Summary Pie Charts

■ Inbound Tab

■ Transport Tab

■ Cycle Count Tab

■ Picking Tab

■ Outbound Tab

Navigation and Status Legend
The following functionality is described:

■ Navigation to the Activity Monitor

■ Window Expansion and Compression

■ Export Panel Controls

Navigation to the Activity Monitor
To navigate to the WMS Activity Monitor:

1. Log in to the RWMS system. The Main Menu appears.
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Figure 16–1 Main Menu

2. On the Main Menu, select Dashboards.

3. Select Activity Monitor. The dashboard appears.

Figure 16–2 Activity Monitor

Window Expansion and Compression
There are four arrows on the window that enable you to expand or compress the view 
based on your current need. The views dynamically resize based on which arrow is 
selected. Figure 16–3 shows the location of each arrow.
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Figure 16–3 Expansion and Compression Arrows

Export Panel Controls
This section describes the buttons available when exporting data to Excel.

Figure 16–4 Export Panel Controls

The following list describes each button illustrated in Figure 16–4:

■ The View (A) drop-down enables you to: Add, remove, and order the columns 
displayed by the enclosed table. The Columns option shows a child menu that lists 
each column with a tick that represents the visibility of the column.

Note: Sort ascending and descending options under View for the 
Activity Monitor are unavailable based on ADF framework 
restrictions.
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■ The Export (B) button performs an export operation of the displayed results to an 
Excel file. A Save As window opens that allows you to save the Excel file to your 
desired location.

■ The Fetch All (C) button executes the underlying query and fetches all the data 
that is associated with the drill down table. This means that all the summary data 
in this example is populated into the drill down which can then be exported by 
clicking the Export function. This feature allows all the rows of the specific 
grouped category to be presented in the table because the graph or table selections 
only provide a subset of this data.

■ The Print (D) button pops up the entire table as a separate printer friendly HTML 
window.

■ The Refresh (E) button refreshes the details for the last selected item in the graph 
(or Fetch All selection) with data updates from the last poll event.

■ The Query By Example (F) button displays a blank record with a space for each 
field. You can then enter conditions for each field that you want to be included in 
the query.

■ The Detach (G) button detaches the entire component and presents it in a new 
modal window that fills the entire Dashboard portion of the application window.

Summary Pie Charts
The pie charts summarize the different tasks within each operational area by status.

Figure 16–5 Summary Pie Charts

The pie charts provide the RWMS Supervisors with a summary of all the daily tasks in 
the four operational areas (Inbound, Transport, Cycle Count, and 
Picks/Replenishments). They enable the Supervisors to see how many tasks are Not 
Started, Printed, In Progress, or Completed at any specific time of the day.

Dashboard Statuses
Following are the statuses that are used:

■ Not Started means that a user has not started the task yet. The one exception to 
this rule is the Inbound Dashboards where Not Started equals Scheduled.

Note: If you use Internet Explorer, the security setting must be 
modified to export the files. To modify the security setting, go to Tools 
-> Internet Options. On the Security tab and click Custom Level. To 
turn off the Information bar for file downloads, scroll to the 
Downloads section of the list, and then, under Automatic prompting 
for file downloads, click Enable.
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■ Printed means that you have printed labels for the Inbound Appointment. This 
status is only used on the Inbound Daily Status Tab and only for PO and ASN 
appointment types.

■ In Progress means that a user has started the task but has not finished the task. 
The one exception to this rule is the Inbound Dashboards where In Progress equals 
Open.

■ Completed means that a user has started and finished the task. The one exception 
to this rule is the Inbound Dashboards where Completed equals Received. The 
Completed status only reports tasks completed from now minus 24 hours

Inbound Pie Chart
The Inbound pie chart shows the total number of appointments across all appointment 
types (PO, ASN, NSC, FPR with Details, FPR without Details, and Blind) in the four 
statuses (Not Started, Printed, In Progress, and Completed) for that current day. The 
current day for this Pie Chart includes any past or current day Not Started, Printed, 
and In Progress appointments and any Completed appointments in last 24 hours (now 
minus 24 hours).

Transport Pie Chart
The Transport pie chart shows the total number of transports for putaways and moves 
in the three statuses (Not Started, In Progress, and Completed) for that current day. 
The current day for this Pie Chart includes any past or current day Not Started, 
Printed, and In Progress transports and any Completed transports in last 24 hours 
(now minus 24 hours).

Cycle Count Pie Chart
The Cycle Count pie chart shows the total number of cycle counts for system 
generated, manual marked, and audit count in the three statuses (Not Started, In 
Progress, and Completed) for that current day. The current day for this Pie Chart 
includes any past or current day Not Started, Printed, and In Progress cycle counts and 
any Completed cycle counts in last 24 hours (now minus 24 hours).

Pick Pie Chart
The Pick (includes Replenishments) pie chart shows the total number of Picks and 
Replenishments (Bulk Picks, Case Picks, Forward Case Picks, Unit Picks) in the three 
statuses (Not Started, In Progress, and Completed) for that current day. The current 
day for this Pie Chart includes any past or current day Not Started, Printed, and In 
Progress picks and any Completed picks in last 24 hours (now minus 24 hours).

Inbound Tab
This tab provides the following views:

■ Daily Status View

■ Scheduled Appointment View

■ Unscheduled Purchase Orders View

■ Count History View

Daily Status View
The Daily Status view enables Supervisors to see how many appointments across 
appointment types are in the different statuses for the current day, so they can gauge 
the flow of the receiving operation.
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Figure 16–6 Inbound Tab - Daily Status View

■ The Daily Status view shows all appointment types (ASN, PO, Blind, NSC, FPR 
with Details, and FPR without details) and all statuses in both a Bar Chart and Pie 
Chart view for the current day plus any in the past that have not been Completed.

■  The Bar Chart shows the number of appointments in each status. The Printed 
status only applies to PO and ASN appointment types.

■ The Pie Chart shows the percentage in each status for each appointment type with 
case and unit totals. The case and unit totals for Not Started, Printed, and In 
Progress are based on appointed quantities while the Completed totals are based 
on actual received quantities.

■ The Not Started status includes appointments not started in past plus any 
scheduled for next 24 hours (now plus 24 hours).

■ The Completed status includes any appointments received in last 24 hours (now 
minus 24 hours).

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. To refresh the 
export data, you must reselect a bar.

Scheduled Appointment View
The Scheduled Appointment view enables the Supervisor to see the number of 
appointments scheduled by day and appointment type, so the number of resources 
needed to get the job done can be determined

Figure 16–7 Inbound Tab - Scheduled Appointment View

■ The Scheduled Appointment view shows how many appointments by 
appointment type are in Scheduled (Not Started) status in the past and for the next 
30 days into the future.
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■ Each Appointment Type is a unique color and displayed in a Stacked Bar Chart.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. Note that the 
export data is designed to export at the item level, so the appointment number 
repeats for each item in the Purchase Order. To refresh the export data, you must 
reselect a bar.

Unscheduled Purchase Orders View
The Unscheduled Purchase Order view shows purchase orders due in the near future 
that still do not have any scheduled appointments created. The Receiving Team can 
call the Vendors for these purchase orders to determine the current status of these 
inbound shipments.

Figure 16–8 Inbound Tab - Unscheduled Purchase Orders View

■ The Unscheduled Purchase Order tab shows any unscheduled purchase orders for 
the next four weeks into the future. If any line item in the PO is scheduled, the PO 
does not appear in this tab.

■ The Unscheduled Purchase Orders are displayed in the bar chart based on their 
Deliver Not Before date. If a purchase order has not been scheduled and its 
delivery is not before a date in the past, that purchase order displays in the first 
date (bar) in the bar chart. This means the first bar includes unscheduled POs in 
the past and any with a delivery date not before the current date.

■ The right-hand view displays, for each date, the number of Purchase Orders 
unscheduled with the actual number of items and units ordered in those POs.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. Note that the 
export data is designed to export at the item level, so the purchase order number 
repeats for each item. To refresh the export data, you must reselect a bar.

Count History View
The Count History view enables the Warehouse Management team to see the volume 
of appointment types being received and arrange their resources in the future 
accordingly.
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Figure 16–9 Inbound Tab - Count History View

■ The Count History view shows how many appointments by appointment type are 
in Received (Completed) status from the current date/time back to the purge date.

■ Each Appointment Type is a unique color and displayed in a Stacked Bar Chart.

■ You can specify a From and To date range to populate the Bar Chart.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. The following 
export capabilities are supported:

– Date Range–When you select any bar, you get all the data across the entire 
date range.

– Date–When you select any bar, you get only the data related to that bar.

– Activity–When you select a section of a bar, you get only the data related to 
that section of the bar.

Transport Tab
The Transport tab enables the Transport Supervisor, often called Putaway Supervisor, 
to track the progress of all move and putaway tasks to determine if more or less 
resources need to be deployed. The Transport tab has two sub-tabs enabling the 
separate tracking of Moves and Putaways. The views for both Moves and Putaway are 
named the same, with exactly the same functionality, and both track at the case and 
pallet levels.

This tab provides the following views:

■ Summary View

■ Store/Internal Location/Zone View

■ Count History View

■ Closure Time View
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Summary View

Figure 16–10 Transport Tab - Summary View

■ The Summary views shows case and pallet tasks separately and reports how many 
of each type is in each status (Not Started, In Progress, and Completed).

■ The Summary view shows any Not Started and In Progress moves from the past 
and current day plus completed tasks for the last 24 hours (now minus 24 hours).

■ The Pie Chart shows the percentage in each status with pallet and carton totals. 
The pallet and carton totals for all statuses are based on actual receipts.

■ When the RF Build Container option is used, individual case tasks are reduced 
and pallet tasks are increased.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. To refresh the 
export data, you must reselect a bar.

Store/Internal Location/Zone View
The Transport Location view enables the Supervisor to see the volume of tasks 
assigned to specific internal locations or storage zones. Based on the volume to specific 
areas, the supervisor may choose to reallocate resources from one area of the 
warehouse to another area.

Figure 16–11 Transport Tab - Store/Internal Location/Zone View

■ The Store/Internal/Zone view shows the number of case or pallet tasks destined 
for a store (Crossdock), an internal destination (flowthrough or internal pick 
systems), or a storage zone.

■ The Move Store/Internal Location and Putaway Zone view shows the actual 
number of pallets, cartons, and units in Not Started and In Progress status from 
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the past and the current day plus Completed status for last 24 hours (now minus 
24 hours).

■ The Putaway Zone view determines the Not Started and In Progress zone by 
looking at the first zone defined in the Putaway Plan Editor. The Completed zone 
is the actual zone for the putaway location.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. To refresh the 
export data, you must reselect a bar.

Count History View
The Transport Count History view enables the Warehouse Management team to see 
the volume of transport tasks (move and putaway) being completed by day and 
determine if resources are deployed correctly.

Figure 16–12 Transport Tab - Count History View

■ The Count History view shows the Completed Moves and Putaways from the 
current day/time back to the purge date.

■ The Stacked Bar Chart displays the number of pallet tasks versus the number of 
case tasks completed by day.

■ You can specify a From and To date range to populate the Bar Chart.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. The following 
export capabilities are supported:

– Date Range–When you select any bar, you get all the data across the entire 
date range.

– Date–When you select any bar, you get only the data related to that bar.

– Activity–When you select a section of a bar, you get only the data related to 
that section of the bar.

Closure Time View
The Transport Closure Time view enables the Supervisor to see how long it has taken 
to complete a transport and if the amount of time taken is under or equal to 
established standards.
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Figure 16–13 Transport Tab - Closure Time View

■ The Closure Time view shows how long it took to complete a move or putaway by 
type (case or pallet) from the time it was received on the dock until the task was 
actually confirmed in its final location.

■ This view displays all completed moves and putaways from the current day/time 
back to the purge date and summarizes how many were completed in specific 
time (hours) buckets.

For example, the view would show that over the last 60 days (purge setting) that 
500 moves were done in under 1 hour, 400 done between 1 hour and 2 hours, 800 
done between 2 hours and 3 hours, and 200 done in over one day.

Cycle Count Tab
This tab provides the following views:

■ Summary View

■ Zone View

■ Count History View

■ Closure Time View

Summary View
The Cycle Count Summary view enables the Inventory Supervisor to track the 
progress of all cycle count tasks to determine if more or less resources need to be 
deployed.

Figure 16–14 Cycle Count Tab - Summary View
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■ The Cycle Count Summary view shows the three cycle count types (System, 
Manually Marked, and Audit) and reports how many of each type is in each status 
(Not Started, In Progress, and Completed).

■ The Summary view shows any Not Started and In Progress cycle counts that are 
from the past and current day plus completed cycle counts for the last 24 hours 
(now minus 24 hours).

■ The Pie Chart shows the percentage in each status with pallet and carton totals. 
The pallet and carton totals for all statuses are based on actual cycle counts.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. To refresh the 
export data, you must reselect a bar.

Zone View
The Cycle Count Zone view enables the Supervisor to see the volume of cycle counts 
assigned to specific zones. Based on the volume in specific zones, the supervisor may 
choose to reallocate resources from one area of the warehouse to another area.

Figure 16–15 Cycle Count Tab - Zone View

■ The Cycle Count Zone tab shows the number of cycle counts by zone by status 
(Not Started, In Progress, and Completed).

■ The Cycle Count Zone tab shows the actual number of pallets, cartons, and units 
in Not Started and In Progress status from the past and the current day plus 
Completed status for last 24 hours (now minus 24 hours). 

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. To refresh the 
export data, you must reselect a bar.

Count History View
The Cycle Count History view enables the Warehouse Management team to see the 
volume of cycle count tasks being completed by day and determine if resources are 
deployed correctly.
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Figure 16–16 Cycle Count Tab - Count History View

■ The Count History view shows the Completed Cycle Counts from the current 
day/time back to the purge date.

■ The Stacked Bar Chart displays the number of cycle counts completed by day.

■ You can specify a From and To date range to populate the Bar Chart.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. The following 
export capabilities are supported:

– Date Range–When you select any bar, you get all the data across the entire 
date range.

– Date– When you select any bar, you get only the data related to that bar.

– Activity–When you select a section of a bar, you get only the data related to 
that section of the bar.

Closure Time View
The Cycle Count Closure Time view enables the Supervisor to see how long it has 
taken to complete a cycle count and if the amount of time taken is under or equal to 
established standards.

Figure 16–17 Cycle Count Tab - Closure Time View

■ The Closure Time view shows how long it took to complete a cycle count from the 
time it was created until the count was actually completed.
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■ This view displays all completed cycle counts from the current day/time back to 
the purge date and summarizes how many were completed in specific time 
(hours) buckets.

For example, the view would show that over the last 60 days (purge setting) that 
500 cycle count were done in under 1 hour, 400 done between 1 hour and 2 hours, 
800 done between 2 hours and 3 hours, and 200 done in over one day.

Picking Tab
The Picking Tab enables the Picking/Replenishment Supervisor to track the progress 
of all bulk pick and replenishment tasks to determine if more or less resources need to 
be deployed. This tab provides the following views:

■ Bulk (Pallet) Summary View

■ Bulk Wave View

■ Bulk Count History View

■ Bulk Closure Time View

■ Case Pick, Forward Case Pick, and Unit Pick Views

Bulk (Pallet) Summary View

Figure 16–18 Picking Tab - Bulk (Pallet) Summary View

■ The Bulk Pick Summary view shows the eight types of bulk picks/replenishments 
(B, BD, BP, BR, BT, PR, PL, PT) and reports how many of each type is in each status 
(Not Started, In Progress, and Completed).

■ The Summary view shows any Not Started and In Progress bulk 
picks/replenishments that are from the past and current day plus Completed for 
the last 24 hours (now minus 24 hours).

■ The Pie Chart shows the percentage in each status with pallet, carton, and unit 
totals. The pallet and carton totals for all statuses are based on actual bulk picks.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. To refresh the 
export data, you must reselect a bar.

Bulk Wave View
The Bulk Wave view enables the Supervisor to see the volume of pallet picks and 
pallet replenishments assigned to specific waves and zones. Based on the volume in 
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specific zones, the supervisor may choose to reallocate resources from one area of the 
warehouse to another area.

Figure 16–19 Picking Tab - Bulk Wave View

■ The Bulk Wave view shows the number of bulk picks/replenishments by wave 
number by status (Not Started, In Progress, and Completed).

■ The Bulk Wave tab shows the actual number of pallets, cartons, and units in Not 
Started and In Progress status from the past and the current day plus Completed 
status for last 24 hours (now minus 24 hours).

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. To refresh the 
export data, you must reselect a bar.

Bulk Count History View
The Bulk Count History view enables the Warehouse Management team to see the 
volume of Bulk Pick and Replenishment tasks being completed by day and determine 
if resources are deployed correctly.

Figure 16–20 Picking Tab - Bulk Count History View

■ The Bulk Count History view shows the Completed bulk picks/replenishments 
from the current day/time back to the purge date.

■ The Stacked Bar Chart displays the number of bulk picks/replenishments 
completed by day.

■ You can specify a From and To date range to populate the Bar Chart.
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■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. The following 
export capabilities are supported:

– Date Range–When you select any bar, you get all the data across the entire 
date range.

– Date–When you select any bar, you get only the data related to that bar.

– Activity–When you select a section of a bar, you get only the data related to 
that section of the bar.

Bulk Closure Time View
The Bulk Closure Time view enables the Supervisor to see how long it has taken to 
complete a Bulk Picks and Replenishments and to see if the amount of time taken is 
under or equal to established standards.

Figure 16–21 Picking Tab - Bulk Closure Time View

■ The Bulk Closure Time view shows how long it took to complete a bulk 
pick/replenishment from the time it was created until it was actually completed.

■ This view displays all completed bulk picks/replenishments from the current 
day/time back to the purge date and summarizes how many were completed in 
specific time (hours) buckets.

For example, the view would show that over the last 60 days (purge setting) that 
500 bulk picks were done in under 1 hour, 400 done between 1 hour and 2 hours, 
800 done between 2 hours and 3 hours, and 200 done in over one day. 

Case Pick, Forward Case Pick, and Unit Pick Views
These views have the same exact views with the same functionality as the Bulk Pick 
tab.
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Figure 16–22 Picking Tab - Case Pick, Forward Case Pick, and Unit Pick Views

■ The Case Pick view displays data related to the following case pick/replenishment 
types: Case Picks, CD Replen, CP Replen, CR Replen, CT Replen, and Case PTS.

■ The Forward Case Pick view displays data related to the following 
pick/replenishment types: CF Picks, CB Picks, CE Replen, CL Replen, CO Replen, 
CS Replen, CT Replen, and C3 Replen.

■ The Unit Pick view displays data related to the following unit pick/replenishment 
types: Less Than Case, UP Replen, and Unit PTS.

Outbound Tab
This tab provides the following views:

■ Open Trailer View

■ ASN History View

Open Trailer View
The Open Trailer view shows the Available Containers to load and the Loaded 
Containers for each trailer currently in Open status.

Figure 16–23 Outbound Tab - Open Trailer View

■ A trailer can be opened for a specific destination (store) or by 
Carrier/Service/Route (multiple destinations).

■ The Available Containers include crossdock cartons, bulk outbound picks, case 
outbound picks, less than case cartons in the In-transit location, unit put to store 
cartons with a close date, and case put to store cartons with a close date.
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■ The Available Containers is a list of containers that can be loaded on the trailer but 
it does not mean they have to be loaded. Any unloaded Available Containers will 
be available for the next open trailer to that destination.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. To refresh the 
export data, you must reselect a bar.

ASN History View
The ASN History view shows the number of Outbound ASNs created each day.

Figure 16–24 ASN History View

■ Outbound ASNs are generated for each specific store that ships so one outbound 
trailer can create multiple Outbound ASNs if the trailer was opened using 
carrier/service/route.

■ You can specify a From and To date range to populate the Bar Chart.

■ If you select any bar within the chart, RWMS displays the data contained in the 
bar and provides the ability to export that to an Excel spreadsheet. The following 
export capabilities are supported:

– Date Range–When you select any bar, you get all the data across the entire 
date range.

– Date–When you select any bar, you get only the data related to that bar.

– Activity–When you select a section of a bar, you get only the data related to 
that section of the bar.

Labor Management Dashboard 
The Labor Management Dashboard provides an at-a-glance view into how well 
Warehouse Staff are performing against the Engineered Labor Standard. This means 
the actual time to complete an activity (task) is compared to the engineered labor 
standard and reported on the dashboard as a percent of standard. If the dashboard bar 
is green (under 100%) this means the actual time to complete the activity was less than 
the engineered labor standard. If the dashboard bar is red (over 100%) this means the 
actual time to complete the activity was more than the engineered labor standard.  

The dashboard provides three distinct tabs (picking, replenishment, and transport) so 
management can measure performance in each processing area. Each tab provides 
three filters used in unison to customize the results of the dashboard.
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To access the Labor Management Dashboard, navigate to Dashboards then select 
Labor Management. The Labor Management Dashboard window opens.

Figure 16–25 Labor Management Dashboard Window

Displaying the Labor Management Dashboard
The Labor Management Dashboard option only appears in the Dashboard Module 
when the Enable Labor MGMT SCP is set to Yes and the Task Log SCP is set to 2.

The default view of the Labor Management Dashboard displays:

■ The current date with a 24 hour time range

■ The Picking tab

■ Each filter (Activity, Shift, and User) set to All

Customized Display Using Filters
To customize the information displayed within the dashboard, you can modify the 
date range and filters as desired within the tab.When the date range and filters are set, 
you can select the Synchronize Tabs check box to use the same date range and filters 
for the other two tabs. 

Each tab provides these three filters:

Activity — The activity filter allows you to select all activities, multiple activities, or a 
single activity to display labor standard results. You can also check the Labor Code 
box to break an activity level down to defined Labor Codes.

Shift — The shift filter allows you to select all shifts, multiple shifts, or a single shift to 
display labor standard results.

User — The user filter allows you to select all users, multiple users, or a single user to 
display labor standard results. 

These filters may be used in unison to customize the results of the dashboard.
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Window Expansion and Compression
There are three arrows on the window that enable you to expand or compress the view 
based on your current need. The views dynamically resize based on which arrow is 
selected.Figure 16–26 shows the location of each arrow.

Figure 16–26 Expansion and Compression Arrows

Graph Display
When dashboard results are displayed, the X axis (horizontal) always shows the 
Percent of Standard. The Y axis can be modified by selecting one of the Y Axis option 
buttons in the filter control blocks. You can choose to display the Y axis as Activity, 
Shift, or User. Only one Y axis choice is allowed.

The bars on the graph appear as either green if the actual time to complete the activity 
was less than the standard time allotted or red if the actual time to complete the 
activity was more than the standard time allotted. 

To the right of each bar displayed on the graph is the percent of standard achieved and 
the number of aggregated assignments (tasks) compiled based on the search criteria.

The block to the right of the graph is a spreadsheet of the graphical data provided in 
written form.

To populate the spreadsheet at the bottom of the window, you can select any bar 
within the graph and RWMS then imports the data related to that specific bar.

Export Panel Controls
The data in the bottom panel spreadsheet can be exported to an Excel spreadsheet.



Labor Management Dashboard

Dashboards 16-21

Figure 16–27 Export Panel Controls

The View drop-down menu allows you to add, remove, and order the columns 
displayed in the table. The Columns option lists each column with a check box that if 
selected displays the column and if clear, hides the column.

Click Export to open the displayed results in an Excel file. 

Click Fetch All to obtain all the data that is associated with the drill down table. This 
means that all the summary data in this example is populated into the drill down 
which can then be exported by clicking the Export function. This feature allows all the 
rows of the specific grouped category to be presented in the table because the graph or 
table selections only provide a subset of this data.

Click Detach to detach the table and open it in a new full-sized window.

Exit
Click Exit to close the window.

Note: Sort ascending and descending options under View for the 
Labor Management Dashboard are unavailable based on ADF 
framework restrictions.
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17Mobile User Interface

Tablet-optimized versions of the following desktop workflows allow warehouse 
personnel, especially supervisors, the convenience and flexibility of monitoring 
warehouse operations without being tethered to a desktop computer:

■ Mobile Activity Monitor Dashboard

■ Mobile Labor Management Dashboard

■ Mobile Appointment Calendar

The functionality of the tablet workflows is exactly the same as the functionality 
provided in the desktop version of the windows, but navigation differs.

Navigation
The following sections describe navigation functions for the mobile version.

Mobile User Login
The login is similar to what is used on the desktop version.

When you access the tablet application, the User Login opens. 

Figure 17–1 User Login

Logging In
1. In the Username field, enter the user ID.

2. In the Password field, enter the password. 

3. In the Facility ID field, enter the facility ID or select an ID from the list.
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4. Tap Submit to access the Home screen.

Figure 17–2 Home Screen

About the Home Screen
The Home screen displays the same information that is at the top of the Activity 
Monitor Dashboard and provides an overview of warehouse work progress. The pie 
charts are color coded:

■ Red indicates Not Started

■ Green indicates Completed

■ Yellow indicates In Progress

■ Blue indicates Printed and applies to Inbound only, but not yet opened 
appointments.

Logging Out
The Home screen includes a menu icon in the top left corner that, when tapped, 
displays the menu where you can access other mobile screens.

Before you begin using the mobile Oracle RWMS, familiarize yourself with basic 
mobile navigation, including:

■ Menu Bar

■ Menu

■ Page

Figure 17–3 shows the mobile RWMS, including its basic components and layout.
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Figure 17–3 Mobile Components

Menu Bar
The Menu bar is the horizontal bar at the top of the screen. Tap Logout to exit.

Menu
The icon in the top left corner is the menu. The drop-down menu displays the mobile 
menu options:

■ Home

■ Activity Monitor Dashboard

■ Appointment Calendar View

■ Labor Management Dashboard

These options use a responsive design of what is seen on the desktop in order to make 
the best use of the screen size available on the mobile device. These options are 
functionally equivalent to their desktop UI counterparts, but appear differently as 
sections are collapsed in favor of other sections. 

Page
The page area is similar to the tabbed panels on the desktop, except that it only allows 
one tab. When a new page item is selected from the drop-down menu, it closes the 
current tab within the page area and opens the new tab.

Typically, the pages collapse the filters, but can also display differently based on 
portrait or landscape view. 

Note: Always use landscape view for best results.
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Figure 17–4 Portrait and Landscape View

Mobile Activity Monitor Dashboard
The mobile Activity Monitor dashboard displays warehouse work progress for 
Inbound, Transport (put-away and move operations), Cycle Counting, Picking, and 
Outbound. By navigating the various tabs and sub-tabs, you can access 34 different 
views of warehouse activity. 

Tasks are color coded according to progress: 

■ Red indicates Not Started

■ Green indicates Completed

■ Yellow indicates In Progress

■ Blue indicates Printed and applies to Inbound only, but not yet opened 
appointments.

The default view displays data by activity for the past 24 hours. 

Access
To access the dashboard, tap Activity Monitor from the menu icon.

Note: Screens and data on the mobile Activity Monitor dashboard 
are similar to the desktop version of the Activity Monitor Dashboard. 
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Figure 17–5 Accessing the Mobile Activity Monitor Dashboard

Figure 17–6 shows the mobile Activity Monitor dashboard. 

Figure 17–6 Mobile Activity Monitor Dashboard

Navigating the Mobile Activity Monitor Dashboard
The following sections describe specific navigation for the mobile Activity Monitor 
dashboard.

Tabs
Tap any of the tabs to navigate among the many views of warehouse activity. Tapping 
a tab displays the corresponding details in the data pane at the bottom of the screen.
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Figure 17–7 Mobile Tabs

Pie Chart Display
The pie charts display the overall status and are collapsed in the default view to 
provide maximum space for the tab-specific data shown in Figure 17–6. The pie charts 
can be displayed or hidden by tapping the expansion arrow as shown in Figure 17–8.

Figure 17–8 Pie Chart Expansion Arrow

Pane Resizing
The screen panes can be resized and collapsed by dragging or tapping the expansion 
and collapse arrows. Dividers allow you to drag and resize the panes as shown in 
Figure 17–9.

Figure 17–9 Arrows and Dividers to Resize
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Data Details
As shown in Figure 17–10, tap any bar in the vertical bar graph to display detailed 
data in the pane located below the graph.

Similar to the functions in the desktop version, you can detach, sort, and move 
columns in the data table.

Figure 17–10 Data Details

Mobile Labor Management Dashboard
The Labor Management Dashboard displays productivity levels compared to expected 
standards. Data can be viewed by Activity or Labor Code, by Shift, or by User. There 
are filters available for each. A date range can also be specified.

The default view displays data by activity for the past 24 hours. 

Access
To access the dashboard, tap Labor Management from the menu icon.

Note: Currently, you cannot export the data table to Microsoft Excel 
in the mobile Activity Monitor dashboard.

Note: Screens and data on the mobile Labor Management dashboard 
are similar to the desktop version of the Labor Management 
Dashboard. 
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Figure 17–11 Accessing the Mobile Labor Management Dashboard

Figure 17–12 shows the mobile Labor Management dashboard. 

Figure 17–12 Mobile Labor Management Dashboard

Navigating the Mobile Labor Management Dashboard
The following sections describe specific navigation for the mobile Labor Management 
dashboard.

Tabs
Tapping a tab, displays the corresponding details in the data pane at the bottom of the 
screen

Similar to the desktop version, labor management data is divided into three tabs: 

■ Picking
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■ Replenishment

■ Transport

Filters
Use Filters to specify the criteria for the data displayed on the screen. As shown in 
Figure 17–13, to change the criteria, tap the Filters expansion arrow to display the 
criteria fields in the Filters pane.

Figure 17–13 Using Filters

Enter the desired criteria and tap Apply to display the data. Once the data is retrieved, 
the Filters pane collapses to provide the maximum view of the data.

Pane Resizing
The screen panes can be resized and collapsed by dragging or tapping the expansion 
and collapse arrows Dividers allow you to drag and resize the panes as shown in 
Figure 17–9.

Data Details
As shown in Figure 17–10, tap any bar in the vertical bar graph to display detailed 
data in the pane located below the graph.

Mobile Appointment Calendar
The mobile Appointment Calendar provides a graphical view of receiving door usage. 
It displays all scheduled appointments along with their color-coded status in a 
horizontal Gantt chart format. It also provides various detail views for a specific 
receiving door in a variety of formats. 

The default view displays data by activity for the past 24 hours.

Note: Screens and data on the mobile Appointment Calendar 
dashboard are similar to the desktop version of the Appointment 
Calendar.



Mobile Appointment Calendar

17-10 Oracle® Retail Warehouse Management System UI User Guide

Access
To access the appointment calendar, tap Appointment Calendar from the menu icon.

Figure 17–14 Accessing the Appointment Calendar

Figure 17–12 shows the mobile Appointment Calendar. 

Figure 17–15 Mobile Appointment Calendar 

Navigating the Mobile Appointment Calendar Dashboard
The following sections describe specific navigation for the mobile Appointment 
Calendar.
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Search/Filters
Use Search/Filters to specify the criteria for the data displayed on the screen. As 
shown in Figure 17–13, to change the criteria, tap the Search/Filters expansion arrow 
to display the criteria fields in the Search/Filters pane.

Figure 17–16 Using Search/Filters

Enter the desired criteria and tap Search to display the data. Once the data is retrieved, 
the Filters pane collapses to provide the maximum view of the data.

Pane Resizing
As with the mobile dashboards, the Door list and Calendar panes can be resized and 
collapsed by dragging or tapping the expansion and collapse arrows Dividers allow 
you to drag and resize the panes as shown in Figure 17–9.

Dragging the horizontal bar for the Calendar displays different time frames for the 
selected day. Dragging the Calendar pane either vertically or horizontally, allows you 
to scroll the doors.

Appointment Details
As shown in Figure 17–17, tap any bar in the calendar to display detailed data in the 
pane located below the graph. By taping, holding, and then releasing an appointment, 
the details are shown in a pop-up display.
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Figure 17–17 Appointment Details

Tap to select or clear the Display Vendor check box and toggle the display to show 
either the vendor or carrier information as shown in Figure 17–18. 

Figure 17–18 Display Vendor Check Box

Door details display on a tablet the same as on the desktop version. For more 
information of functionality, see the section, Appointment Calendar. 



Mobile Appointment Calendar

Mobile User Interface 17-13

Tap on a door and then tap Door Calendar, to display the details view as shown in 
Figure 17–19. The display defaults to the weekly view.

Figure 17–19 Door Details

Tap the calendar icon to display different views including daily, monthly, and detail. 
Figure 17–20 shows the detail view. 

Figure 17–20 Calendar Detail View
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A
Acronyms

This chapter lists the acronyms used in the RWMS user guide. 

 

Table 17–1 Acronyms used in the RWMS documentation

Acronym Term

DC Distribution Center

FCP Forward Case Pick

FCPL Forward Case Pick Location

FPL Forward Pick Location

FPR Flexible Pallet Receiving

KPI Key Performance Indicator

LMS Labor Management System, also referred to as Oracle Retail 
Labor Management

LTC Less Than Case

PF&D Personal Fatigue and Delay

PO Purchase Order

PRO Progressive Rotating Order

PTS Put to Store

RIB Oracle Retail Integration Bus

RF Radio Frequency

RLM Oracle Retail Labor Management, also referred to as Labor 
Management System

RWMS Oracle Retail Warehouse Management System

ROP Re-order Point

SCP System Control Parameter

TM Truck-mounted

UPC Universal Product Code

UPS Unit Pick System

WIP Work in Process

WMS Warehouse Management System
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Glossary

Activity

A task performed within a warehouse like case picking, unit picking, put-away, 
receiving, cycle counting, and so on.

Actual Cube

Dimensions = length x width x height - usually pertains to a trailer capacity, shelf 
location capacity, or item or pallet dimensions.

Address

The place where a person or organization can be sent mail, bills, purchase orders, and 
shipments.

Advanced Shipment Notice (ASN)

An Advance Ship Notice or Advance Shipping Notice (ASN) is a notification of 
pending deliveries, similar to a packing list. It is usually sent in an electronic format 
and is a common EDI document. In the EDI X12 system, it is known as the EDI 856 
document. The ASN can be used to list the contents of a shipment of goods as well as 
additional information relating to the shipment, such as order information, product 
description, physical characteristics, type of packaging, markings, carrier information, 
and configuration of goods within the transportation equipment. The ASN enables the 
sender to describe the contents and configuration of a shipment in various levels of 
detail and provides an ordered flexibility to convey information.

Allocation

A buying, planning, and distribution process in which the need of a store is 
determined based on the difference between the current on hand inventory and the 
forecasted need of inventory for that item for the next x number of weeks.  The 
additional need calculated is sent to the distribution center as a stock allocation for 
picking and shipment to the store.

Appointment

The time, date, and door given to the carrier/supplier for delivery of an inbound 
shipment to the warehouse.

Attribute

An attribute is a characteristic that can be added to a Distribution Center process, 
location, item or user that influences the process to perform in a different manner.
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Audit

A formal examination of an organization's or individual's account or financial 
situation. For distribution, it is a formal audit of the physical inventory within a 
distribution center (also called a Physical Inventory).

Authorization Number

An authorization number is a number that allows a transaction to proceed with 
pre-approval. For distribution, authorization numbers are usually required by the host 
system to process returns in the distribution center.

Bill of Lading

A Bill of Lading (sometimes referred to as a BOL, or B/L) is a document issued by a 
carrier to a shipper, acknowledging that specified merchandise has been received on 
board the trailer (plane, boat, train, and so on.) for shipment to a named place for 
delivery.

Bulk Pick

A pick of an entire pallet at one time destined for a single location.

Carrier

The freight company that delivers the shipment.

Carton

A carton is a type of packaging used to transport merchandise. In logistics, a case, a 
carton, and a casepack will often be used interchangeably.

Casepack

A casepack is the number of units (each) contained in a case/carton. For example, if 
you buy a 12 pack of coke the casepack is 12 and the number of units in the case is 12.

Catch Weight

Catch weight - used primarily in the food industry for products such as sea food, 
meats, and cheeses; catch weights refer to the actual weight of variable-weight items 
that use weight as the sales unit of measure. Catch weights are generally recorded 
during the order picking or shipping process.

Class

In retail distribution, class is a level within the Merchandise Hierarchy used to group 
items for reporting and financial planning. Best practice retailers track their items 
using the following hierarchy: company, division, department, class, and possibly 
sub-class level.

Container

An item in which objects or materials can be stored or transported. In RWMS a 
container refers to the type of object used to receive or ship an item.  For example some 
items arrive and ship in a carton (case) and some items arrive and ship on a pallet.  In 
both cases these are considered containers in RWMS.

Cubiscan

Cubiscan is a device (varies in size) that scans an item or case to record product 
dimensional data and weights.
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Cycle counts

Cycle counting is an inventory process where items are counted on a cyclic schedule 
rather than the traditional inventory process which occurs once a year.  If the cycle 
count process is accepted in your organization it may replace a physical inventory 
taken once a year.

Default

A default is a value that a program or operating system assumes, or a course of action 
that a program or operating system will take, when the user or programmer specifies 
no overriding value or action..

Deliver Not Before Date

This is the date on the purchase order that tells the vendor/carrier the first day the 
distribution center will accept the shipment. Any deliveries before this date is refused.

Deliver Not After Date

This is the date on the purchase order that tells the vendor/carrier the last day the 
distribution center will accept the shipment. Any deliveries after this date is refused.

Delivery

The act of delivering a shipment to a location.

Department

In retail distribution, department is a level within the Merchandise Hierarchy used to 
group items for reporting and financial planning. Best practice retailers track their 
items using the following hierarchy: company, division, department, class, and 
possibly sub-class level.

Destination (Dest)

In distribution, destination is the final delivery location for a shipment.  In retail, the 
destination for shipments from vendors is usually the distribution center and the 
destination from distribution centers is usually the store. For consumer direct 
shipments the final destination is the customer's home.

Diff

A characteristic of an item that distinguishes it from another item.

Diff Group

A tool used to logically group diff IDs by type.

Distribution Center (DC)

Distribution Center is a warehouse or storage facility where the emphasis is on 
processing and moving goods to wholesalers, retailers, or consumers rather than to 
storage.  These facilities concentrate on crossdocking and flowthrough opportunities.

Distro

In RMWS the term Distro number is synonymous with Stock Allocation number.  They 
refer to the item orders that are downloaded from the host that are picked in the 
distribution center for shipment to stores.

Doors

The physical location at a warehouse where inventory is received or shipped.
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Electronic Data Interchange

Electronic Data Interchange: the computer-to-computer exchange of structured 
information, by agreed message standards, from one computer application to another 
by electronic means and with a minimum of human intervention.

Filter

A filter limits or constrains the data in the report so that it contains only the 
information that is pertinent to the problem that is being investigated.

Forward Case Pick Location (FCPL) 

This is a picking area in the warehouse which is dedicated to picking of cases only.

Grabs

The number of picks you can make from a case.  If the casepack is 12 and the inner 
pack quantity is 3 then you have 4 grabs.  If the casepack is 12 and the inner pack 
quantity is 1 then you have 12 grabs.

Hierarchy

Hierarchy is the process of linking products together in groups that have similar 
characteristics.

Inner pack

A sub-package within a carton/casepack.  An inner pack is individually wrapped or 
boxed inside of an existing carton/casepack.  For example if you have a casepack of 12 
shirts and inside the carton you have 4 bags each containing 3 shirts then you have 4 
inner packs.  The inner pack is the lowest shippable quantity in RMWS.

Inventory

A company's merchandise, raw materials, and finished and unfinished products which 
have not yet been sold.

Lead Time

The amount of time between placing an order with a vendor and the receipt of the 
inventory at the distribution center.

Less Than Case Picking Location

An area dedicated to picking of units only.

Load Sequence

The sequence in which each store's merchandise is to be loaded when multiple stores 
are being loaded onto the same truck.

Location

A physical and logical space in a distribution center that has been defined in the 
RWMS system used to locate merchandise.

Pick

The process of selecting an item from a location and placing it on a container for 
shipment to its next destination.
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Pick to Belt

Picking merchandise from a forward case picking location onto a conveyor belt. This 
pick type allows the user to pick with labels only and does not require the use of an RF 
device.

Pick to Pallet

Picking merchandise from a forward case picking location onto a pallet. This picking 
method requires the use of an RF device and does not use pre-printed labels.

Pre-distribution 

Allocation of merchandise in advance of receipt to facilitate flow through or 
cross-dock upon arrival, bypassing storage, and going directly to break case picking 
area or shipping.

Purchase Order

The list of items and quantities authorized to receive from a specific vendor.

Putaway

The task of directing received items to specific storage locations based on a 
pre-determined set of rules.

Record

A single line of data in a file.

Radio Frequency (RF)

A frequency in the range within which radio waves may be transmitted, from about 3 
kiloherts to about 300,00 megahertz. Radio Frequency devices are used in the 
warehouse to receive new tasks and to confirm the completion of tasks.

Replenishment

The process of moving items from storage locations to picking locations based on a 
reorder point trigger or actual need.

Reserve Storage

Locations in the distribution center that contains inventory on items that have not been 
distributed yet (do not have a final destination).

Return to Vendor

The process of sending back the merchandise to the supplier/vendor from the 
warehouse for various reasons (damaged, defects and so on).

Route Day/Date

The day of week that merchandise going on a route will be processed.

Slot

 A period of time in which an appointment may occur.

Supplier

The person or company that provides items to a retailer.

Tare

The tare weight is the weight of the container on which items are stored.
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Trailer

A truck or shipping container into which merchandise will be loaded/shipped, or 
which it will be received.

Transfer

An internal movement of stock from one location to another.

Trouble Code

A code applied to a container when a container cannot be picked from due to some 
sort of problem (for example water damage).

Unit Cost

The cost per unit of the item.

Unit of Measure

The unit in which the quantity of an item is managed, for example, pounds, box of 12, 
package of 20, or case of 144. Various UOM may exist for a single item. For example, a 
product may be purchased in cases, stocked in boxes and issued in single units.

Unit Pick System (UPS)

Any picking system where you pick quantities less than full case from location..

User Defined Attribute

An identifying characteristic that has been set up by the user..

Vendor

A company or person who sells finished or unfinished goods to another company or 
person for money.

Wave

A group of orders that can be released together for picking and shipment.

Work in Progress (WIP) Code

It is a code assigned to merchandise that needs processing of any form. It could be a 
value addition activity like packaging, gift wrapping and so on. It could also be 
correction of a 'trouble' or a defect that was raised on a given merchandise, like 
repairing the damage, repacking and so on.
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currency codes, 4-31
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doors, 4-70
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location class, 4-191
location types, 4-207
manual waves, 7-3
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receiving packages, 6-28
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regions, 4-82
sorter groups, 4-86
stock order upload codes, 4-47
system parameters, 4-51
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ticket types, 4-55
trailer status, 11-4
transaction codes, 4-56
translations of field labels, 4-57
transport inventory inquiry, 8-24
troubled merchandise, 9-25
unit pick systems, 4-91
ups chutes, 4-88
ups destinations, 4-93
users, 4-263
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paper pick, 8-3
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change, 2-2
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Repair, 7-2
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rollback, 14-4
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date, 4-246
day, 4-248
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S
sequence, 14-4
service routes, 4-239

Setup - Activity, 4-2

T
tables, 14-5
task groups, 4-19
trailers, 4-253
translations, 4-43
transportation setup, 4-236

routes, 4-236
transshipment facilities, 4-36

U
upc, A-1
ups, A-1
user classes, 4-260

V
view inventory, 8-8

item, 8-8
location, 8-10
summaries, 8-7
vendor or container status, 8-12
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